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Alphabetical Command List 

Listed below are commands active in the "base level" of NUTS (as opposed to within 
subroutines).  Most are 2-letter commands that are executed immediately, without 
requiring <ENTER>.  As of 5/15/99, there is an optional command mode that allows use 
of longer commands, including arguments as appropriate, and requiring <ENTER> 
before the command is executed.  Where an equivalent longer command exists, it is listed 
together with the corresponding 2-letter command.  See detailed explanation of this "non-
2-letter command" mode. 

*2 -- Expand data by factor of 2 ....................................................................................... 65 
/2 -- Decimate FID.......................................................................................................... 267 
/2 -- Reduce spectrum by factor of 2 ................................................................................ 65 
21 -- Convert spectrum to one .......................................................................................... 61 
2A -- Number of points to average ................................................................................... 86 
2F – Turn off 2-letter command mode.............................................................................. 10 
2L -- Convert spectrum to line.......................................................................................... 62 
2N – Turn on 2-letter command mode.............................................................................. 11 
2S -- 2-Point Smooth ...................................................................................................... 132 
3S -- 3-Point Smooth ...................................................................................................... 133 
A0 - A9 -- Execute Link ................................................................................................. 135 
AB – Swap quadrants in phase-sensitive arrayed mode ................................................. 425 
AC -- Amplitude Change .................................................................................................. 39 
AD -- Add DC................................................................................................................... 62 
AF -- Turn off integral display........................................................................................ 112 
AI -- Automatic Integration ............................................................................................ 110 
AL -- Load Add/Subtract buffer ..................................................................................... 149 
AM -- Add/Subtract Multiplier....................................................................................... 149 
AN -- Turn on integral display........................................................................................ 112 
AP – Automatic Phasing................................................................................................... 69 
AS -- Add/Subtract Subroutine....................................................................................... 148 
AxisPen ............................................................................................................................. 36 
BA -- Baseline Average .................................................................................................... 52 
BC -- Baseline Correction of the FID............................................................................... 52 
BC -- Baseline Correction of the spectrum....................................................................... 85 
BD -- Buffer to Data ......................................................................................................... 61 
BF -- Baseline Flatten ....................................................................................................... 85 
BF and FR – Flattening a region of the spectrum............................................................. 87 
BR -- Baseline correct Bruker digitally filtered data ........................................................ 86 
BS -- Byte Swap.............................................................................................................. 298 
BT -- Bruker Transform.................................................................................................... 66 
BU -- Buffers .................................................................................................................. 218 
BV -- Byte Swap to VAX byte order.............................................................................. 298 
BZ -- Baseline Zero ........................................................................................................ 129 
C+, C- and C0 -- Display positive, negative or all contour levels .................................. 346 
C1 – Combine Mode #1.................................................................................................. 359 
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C2 – Combine Mode #2.................................................................................................. 360 
C3 – Combine Mode #3.................................................................................................. 360 
C4 – Combine Mode #4.................................................................................................. 360 
CA -- Apply Convolution function ................................................................................. 254 
CC -- Close file C ........................................................................................................... 360 
CF -- Create Convolution Function ................................................................................ 253 
CH -- Chloroform lineshape display............................................................................... 133 
CL -- Chloroform lineshape............................................................................................ 133 
Control A -- Axis label ..................................................................................................... 35 
Control E -- Expanded display........................................................................................ 124 
Control F -- Full display ................................................................................................. 124 
Control-D -- Points/Lines toggle ...................................................................................... 36 
Control-I -- Toggle on/off integral display ..................................................................... 112 
Control-L -- Display parameters....................................................................................... 38 
Control-N -- Display Notes............................................................................................... 39 
Control-P -- Toggle peak labels on/off ........................................................................... 167 
Control-Y -- Set Vertical Scaling (Same as MF -- Make Full command)........................ 40 
Copy and Paste to the Windows Clipboard ...................................................................... 15 
CP -- Contour Plot .......................................................................................................... 346 
CR -- Set contour colors ................................................................................................. 348 
CS -- Clear fixed Scaling .................................................................................................. 40 
CT -- Complex Fourier Transform ................................................................................... 68 
Ctrl-G -- Toggle on/off display of grid lines .................................................................. 348 
Ctrl-P -- Toggle on/off display of peak labels ................................................................ 127 
Ctrl-Z -- recall previously saved data ............................................................................... 12 
CV -- View Convolution function .................................................................................. 254 
CX -- Convert data.......................................................................................................... 298 
D1 -- Time values for arrayed experiment...................................................................... 174 
D2 -- Decimate data by 2 ................................................................................................ 267 
DB -- Data to Buffer ......................................................................................................... 61 
DC -- DC offset for display .............................................................................................. 40 
DD -- Dual Display......................................................................................................... 147 
DE -- Delete file................................................................................................................ 46 
DF -- Digital Filter and FT................................................................................................ 67 
DH -- Digital High pass filter ......................................................................................... 266 
Divide.............................................................................................................................. 245 
DL -- Digital Low pass filter .......................................................................................... 266 
DM -- Database Make..................................................................................................... 274 
DP -- Define Peaks.......................................................................................................... 163 
DR -- Data Reduction ..................................................................................................... 175 
DS -- Database Search .................................................................................................... 274 
E1, E2, E3, E4 and E5 - Exporting Data......................................................................... 312 
E6 -- Export as JCAMP-DX using NTUPLES format ................................................... 312 
ED - Eliminate Dispersion .............................................................................................. 263 
EF -- Email File ................................................................................................................ 43 
EI – increment extension for file export ......................................................................... 137 
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EJ -- Export as JCAMP-DX (Real data points only) ...................................................... 312 
EM -- Exponential Multiplication..................................................................................... 53 
Ernst  -- Calculate Ernst angle ........................................................................................ 130 
EZ -- Enter limits for Zoom regions ............................................................................... 124 
FA -- Set axis font........................................................................................................... 340 
FB -- Fit Baseline.............................................................................................................. 90 
FC -- Set font for clipboard display ................................................................................ 340 
FF - Find File .................................................................................................................. 142 
FH -- Set font for horizontal peak labels ........................................................................ 341 
FI -- Set font for Integral labels ...................................................................................... 341 
FL -- Set font for command line ..................................................................................... 341 
FM -- Set font for parameter list on plots ....................................................................... 340 
FN -- File New................................................................................................................ 214 
FP – FID Play.................................................................................................................. 130 
FR -- Flatten Region ......................................................................................................... 86 
FS -- Fix Scaling ............................................................................................................... 40 
FT -- Fourier Transform.................................................................................................... 66 
FV -- Set font for vertical peak labels............................................................................. 341 
FX -- Fit Baseline.............................................................................................................. 92 
GA -- Get data set A ......................................................................................................... 42 
GB -- Get data set B.......................................................................................................... 43 
GC -- Get data set C........................................................................................................ 360 
GF -- Gaussian Factor for LG command .......................................................................... 56 
GM -- Gaussian Multiplication......................................................................................... 53 
GR -- Get Relaxation data............................................................................................... 174 
GS - Get Sample ............................................................................................................. 288 
Header – Select which of 3 file formats to use ............................................................... 313 
HeaderSearch (or hdrsearch) – Search files by keyword.................................................. 47 
HI - Histogram ................................................................................................................ 267 
HT -- Hilbert Transform ................................................................................................... 68 
IA -- Increment slice for file A ....................................................................................... 135 
ID – Enter Integration routine......................................................................................... 106 
IE -- Increment file Extension......................................................................................... 136 
IF -- File Information ........................................................................................................ 45 
IG -- Incrementally Shifted Gaussian ............................................................................... 55 
II -- Invert Imaginaries.................................................................................................... 130 
IL -- Integral List ............................................................................................................ 111 
IM -- Import File............................................................................................................. 297 
IMAGE – Image display................................................................................................. 444 
IN -- INcrement slice number or file extension .............................................................. 135 
Interleave......................................................................................................................... 358 
IP -- Intensity Plot........................................................................................................... 345 
IS – Inset plots ................................................................................................................ 159 
IT -- Inverse Transform .................................................................................................... 68 
IV -- InValidate the data ................................................................................................. 131 
JE -- Baseline correct JEOL digitally filtered data ........................................................... 86 
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JJ - 13C Chemical Shift Searching................................................................................... 275 
JT -- S-TRAF resolution enhancement ............................................................................. 56 
L0 - L9 -- Edit Link ........................................................................................................ 135 
LB -- Linebroadening ....................................................................................................... 52 
LF – Line fit .................................................................................................................... 199 
LG -- Lorentzian/Gaussian resolution enhancement ........................................................ 55 
LI - Linked Command Lists............................................................................................ 133 
LL - Line List.................................................................................................................. 366 
LN - Linear Prediction .................................................................................................... 227 
LO -- Look at data file .................................................................................................... 298 
LP -- Parameter display on plot ........................................................................................ 38 
LS -- Left Shift data .......................................................................................................... 66 
LV -- Set contour levels.................................................................................................. 348 
LZ -- Last Zoomed region............................................................................................... 124 
M2 -- Power spectrum ...................................................................................................... 74 
MA -- Math functions in NUTS...................................................................................... 240 
MC -- Magnitude Calculation........................................................................................... 72 
MH - Minimum Height, the threshold for selecting peaks ............................................. 127 
ML - Molecule subroutine .............................................................................................. 193 
MO -- Meta Objects on plots .......................................................................................... 184 
MR or MRI – Image display........................................................................................... 444 
MS -- Multiply Sine .......................................................................................................... 57 
Multiply........................................................................................................................... 245 
NB - Nuts Bug flag ......................................................................................................... 303 
NF -- Calculate system noise figure................................................................................ 131 
NO – Notes Subroutine................................................................................................... 155 
NS – Enter spectrum simulation ..................................................................................... 210 
O1 and O2-- Frequency Offset ......................................................................................... 34 
OC -- Open file C............................................................................................................ 360 
passwd - Password ............................................................................................................ 48 
PC -Specifying numerical phase values............................................................................ 71 
PE -Phasing expanded regions.......................................................................................... 70 
PF - Peak labels off ......................................................................................................... 127 
PF -- Toggle peak labels off............................................................................................ 168 
PH - Mouse phasing.......................................................................................................... 70 
PI - Incremented phase...................................................................................................... 72 
PJ -- Projection................................................................................................................ 350 
PL -- Plot........................................................................................................................... 14 
PN - Peak labels on, to display peak labels .................................................................... 127 
PN -- Turn peak labels on ............................................................................................... 168 
PP – Peak pick ................................................................................................................ 127 
PR -- Position Reference................................................................................................... 14 
PROJ (or PROJECTION) - specify projection file and position .................................... 351 
QA – Automatic Phasing, zero-order only ....................................................................... 69 
QB -- (or BASELINE) Quick Baseline correction ........................................................... 93 
QD -- Quick Display......................................................................................................... 36 
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QP – Quick Automatic Phasing ........................................................................................ 69 
R0 – R9 – Register spectra.............................................................................................. 125 
RD -- Rotate Data ............................................................................................................. 65 
RE -- Resonance Elimination.......................................................................................... 132 
RE -- Resonance Elimination.......................................................................................... 258 
RI -- Exchange Real & Imaginary data........................................................................... 130 
RL – Read License File..................................................................................................... 46 
RM - RMS noise parameter, to distinguish between a peak and noise........................... 127 
RO -- Square Root of data ................................................................................................ 75 
RR -- Read Relaxation data file ...................................................................................... 179 
RS -- Right Shift data........................................................................................................ 66 
RT -- Real Transform........................................................................................................ 68 
RU – Run macro ............................................................................................................. 137 
S# -- Phase shift for sine multiplication............................................................................ 59 
S@ -- Shrink by ................................................................................................................ 64 
S0 -- Scale Zero ................................................................................................................ 40 
SA -- Save dataset A......................................................................................................... 43 
SB -- Save dataset B ......................................................................................................... 43 
SC -- Save dataset C ....................................................................................................... 354 
SD -- Slow Display ........................................................................................................... 36 
SE -- Visually inspect data file ....................................................................................... 299 
SG -- Shifted Gaussian...................................................................................................... 54 
SH -- SHrink data.............................................................................................................. 64 
SL -- Set Slice ................................................................................................................. 349 
SM - Shimming Simulation ............................................................................................ 284 
SN -- Signal to Noise ...................................................................................................... 130 
SO -- Smooth .................................................................................................................. 133 
SP -- Stacked Plot ........................................................................................................... 352 
SP - Stacked plots ........................................................................................................... 235 
SQUARE2D -- Force plots to be square......................................................................... 352 
SR -- Spectrum Reverse.................................................................................................. 130 
SS -- Set 2D data Scale ................................................................................................... 348 
ST -- Store Tagged data .................................................................................................. 359 
SU or sum -- Sum slices.................................................................................................. 349 
Substitute -- Slice substitution ........................................................................................ 355 
SUM -- Sum planes......................................................................................................... 350 
SV (or SOLVENT) ........................................................................................................... 34 
SY -- Symmetrize 2D data set ........................................................................................ 353 
SZ -- Set Frequency to Zero.............................................................................................. 13 
T+ -- Tailer add................................................................................................................. 45 
T1 -- Trapezoidal multiplication parameter ...................................................................... 59 
T2 -- Trapezoidal multiplication parameter ...................................................................... 60 
TA – Read Tailer .............................................................................................................. 44 
TD -- Transpose Data...................................................................................................... 354 
TF -- TRAF resolution enhancement................................................................................ 56 
TI -- Tag Imaginaries ...................................................................................................... 359 
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TJ -- Transform JEOL....................................................................................................... 67 
TL (or Tilt) -- Tilt of 2D data.......................................................................................... 356 
TM -- Trapezoidal Multiplication..................................................................................... 59 
TR -- Tag Reals............................................................................................................... 358 
TS – Tailer Save................................................................................................................ 45 
UD -- Update Display ....................................................................................................... 36 
UF -- Un-Do Off ............................................................................................................... 12 
UH -- Update Header ...................................................................................................... 354 
UID - Unique Identifier .................................................................................................... 48 
UN -- Un-Do On ............................................................................................................... 11 
VP -  Virtual Parameters ................................................................................................. 288 
VS -- View Database Search........................................................................................... 275 
VW -- View 2D data slices ............................................................................................. 349 
WP - Which Path ............................................................................................................ 303 
WS -- Window Size .......................................................................................................... 37 
WV - Window View ....................................................................................................... 248 
WV -- Window View........................................................................................................ 52 
X0 – X9 – Extract pre-defined spectral region ............................................................... 132 
XC -- Clear projections................................................................................................... 352 
XL -- Extract Line........................................................................................................... 131 
XL -- Extract Line........................................................................................................... 269 
XT -- Extract Region ...................................................................................................... 269 
XT -- Extract Spectral Region ........................................................................................ 131 
Y0 – Y9 – Sum block-averaged spectra ......................................................................... 126 
Z0 – Z9 – Display a previously defined spectral region................................................. 124 
ZE -- ZEro data set.......................................................................................................... 129 
ZeroDiagonal .................................................................................................................. 356 
ZF -- Zero Fill ................................................................................................................... 62 
ZG -  Zero & GO ............................................................................................................ 288 
ZI -- Zero Imaginaries..................................................................................................... 129 
ZL – Zero Peak Pick List, clears the list of peaks .......................................................... 127 
ZN -- Zero Negative points............................................................................................. 129 
ZO – Enter the Zoom subroutine .................................................................................... 123 
ZR -- Zero Reals ............................................................................................................. 129 
ZZ - Auto importing........................................................................................................ 297 

 

Longer commands 

NUTS has an optional command mode in which commands can be more than just 2 
letters long.  When in the "non-2-letter" command mode, a carriage return is required 
after any command is typed before it is executed.  This applies only to the base level 
commands, and not to commands within any of the subroutines.   

2F – Turn off 2-letter command mode 
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2N – Turn on 2-letter command mode 

The default command mode can be specified in the nuts.ini file, with the following lines: 

CR_FOR_COMMANDS = FALSE    or     CR_FOR_COMMANDS = TRUE 

When this flag is set to TRUE, the longer command mode is active, and all commands 
will require an <ENTER> before they execute. 

The reasons for the change are shortage of "logical" 2-letter commands, and to provide 
additional flexibility (such as the ability to specify arguments on the command line). 

In the new mode of operation, the commands can be up to 32 characters long and some 
commands can take arguments.  The same two letter commands as before still work but 
they require an <ENTER> before they are executed.  Commands selected from a menu 
automatically detect the mode of operation and supply the <ENTER> when necessary.  
Links and Macros will need modification to execute properly.  The simplest solution for 
existing macros is to add a 2N command at the beginning.  To use the longer commands 
in a link or macro, a comma is used to tell Nuts to insert an <ENTER>.   

All commands, whether long or short, are listed in the command list.  

See also:  3D processing, macros 

It is possible to undo many NUTS operations. This works only in the base level of NUTS, 
not in the subroutines.  Before a command is executed, the current data is copied into a 
temporary 10-layer file cache.  This functions like the stack in a reverse polish 
calculator.  Each time a command is executed, the data is added to the stack, and previous 
entries roll up.  The user can then recall each previous version sequentially, causing the 
stack to roll down, using Ctrl-Z. 

The user can choose to enable or disable the Un-Do process.  This can be done while 
NUTS is running, using UN and UF to turn Un-Do on and off, respectively.  This can 
also be done in the nuts.ini file, with the following line: 

UNDO = FALSE    or    UNDO = TRUE 

In a link or macro, or when processing 2D data in non-arrayed mode, saving of data to 
the Un-Do cache is automatically disabled.   

UnDo will work for 2D data while in the Arrayed Mode.  However, the time required to 
write copies of a large 2D file probably makes this inadvisable, and it is suggested that 
Un-Do be disabled before processing 2D data. 

UN -- Un-Do On 
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UF -- Un-Do Off 

Ctrl-Z -- recall previously saved data  

Note that Ctrl-Z while in the Zoom subroutine is a completely unrelated command 
(zeroes the data in the expanded region). 

Introduction to NUTS 

This section is an introduction to the basics of navigating around the program, scaling the 
display, using the cursor, setting the chemical shift reference, plotting and copying. 

In addition to the operation of the program from the menus, a command line user 
interface is also active. When the menus are pulled down with the mouse and the menu 
choices are displayed, the keyboard letters corresponding to each command are also 
shown. This "learn as you go" approach allows the user interested in operation of NUTS 
from the command line to become familiar with the necessary commands in the course of 
normal operation and minimizes the frustrations of searching through manuals. Some of 
the more advanced features are not available from the menus. On-line Help is also 
available. 

See Getting Started section below. 

Base Level Operation 

The base level of operation is the starting point when the NUTS program is run. Many 
functions of NUTS, such as Zoom and Integration, operate as subroutines of the base 
level. Sample files are available for download, and can be opened in NUTS by using the 
menu and selecting File/Open. A dialog box appears and allows the user to select an 
NMR file. If the file is an FID it will need to be transformed (FT) and phased. If the file 
was a spectrum (previously processed and stored) it will be displayed and is ready for 
further perusal. The spectrum can be printed using the File/Print menu option, which 
displays a Print Setup dialog box. The Zoom subroutine is used for horizontal 
expansions, to display a selected region of the spectrum. The horizontal scroll bar at the 
bottom of the screen will shift the display left and right if an expanded region is currently 
displayed.  

The NUTS base level of operation is characterized by the following general features. 

Vertical scaling The spectrum will be automatically scaled to display the tallest peak 
full height. Vertical scaling can be done using the scroll bar on the right. Vertical scaling 
can also be done with the "<", ">", up and down cursor control keys, PAGE UP, or 
PAGE DOWN keys. At any time, the vertical scale can be reset to zero with S0 or the 
largest displayed peak can be made full height with Control-Y. See also scaling the 
display.  
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Cursor A mouse cursor (ARROW) will be shown on the display and its position is a 
function of the mouse movements. If the left mouse button is depressed and held, a full 
window crosshair will replace the mouse cursor and its x and y position displayed in real 
time in the lower right corner of the window as the mouse is moved. The x position is 
shown as data point number, Hertz, and PPM. The vertical position is shown as a percent 
of the tallest peak in the spectrum. This information is displayed as long as the mouse 
button is depressed.  

The cursor information can optionally be displayed in difference mode. While holding 
down the left mouse button, click the right mouse button. The current x position of the 
vertical crosshair will be marked and an additional line of readout will be displayed at the 
bottom right of the window. This additional line of display shows, in real time, the 
current cursor x position relative to the marked position. As the mouse is moved, while 
still holding down the left mouse button, this difference display is updated. This is useful 
for quickly measuring coupling constants, line widths, etc.  This line also shows the 
average of the frequencies of the marker and crosshair cursors, for easy determination of 
the chemical shift of mutiplets such as doublets. 

All functions return to the default base state of operation when the left mouse button is 
released. Users with a single-button mouse can press the period key on the keyboard in 
place of the right mouse button. 

Show me about using the cursor. 

Setting Chemical Shift Reference 

The easiest way to set a peak to a specific chemical shift is to hold down the left mouse 
button, place the cursor on the peak and type O (for offset). A dialog box appears which 
allows you to set the frequency in either Hz or PPM. Note that this function operates at 
the base level of NUTS and not in the Zoom subroutine. 

If the current file is a 2D file, the same procedure is used to set the shift in both 
dimensions. 

If the chemical shift of the reference peak is to be set to zero, the SZ command provides a 
quicker way to set the reference. Use Zoom to expand around the peak and SZ sets the 
value of the largest peak in that region to zero. 

The way Nuts keeps track of the chemical shift is via the O1 (offset) parameter. (Note 
that this does not have the same meaning as in Bruker software.) O1 is the offset, in Hz, 
from the center of the spectrum to 0 ppm. 

It is also possible to reference an X-nucleus spectrum indirectly, via the proton frequency 
of TMS on a specific spectrometer.  See sample macro. 

SZ -- Set Frequency to Zero 
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Sets the frequency of the largest peak in the currently displayed region to Zero. This can 
be used to set the chemical shift reference by first Zooming in on the TMS peak, then 
typing SZ. This now works for 2D data as well. If the data is displayed as a contour plot 
or intensity plot, then the largest displayed peak will be set to a shift of zero in both 
dimensions. Note that in cases of limited digital resolution, the zero value may not appear 
in the center of the chosen contour, and will need to be adjusted using the cursor and the 
Offset (O) command, as described in the preceeding paragraph. 

PR -- Position Reference 

Sets the frequency of the largest peak in the currently displayed region to a value 
previously set in a macro with the Ask Shift command.  

Plotting The displayed spectral region is plotted using the File/Print menu selection. 
The NMR data will be plotted as it is currently being displayed. Spectral parameters will 
be plotted at the bottom of the NMR plot. These parameters are spaced expecting a 
Landscape 8.5" x 11" plot. If the printer is not currently in the landscape mode, it should 
be placed into the landscape mode with the printer dialog box when printing. The printed 
spectrum will have the characteristics of the displayed spectrum. The spectrum height 
will fill the plot the same as the display window. The axis type will be the same as the 
displayed axis type. If an integral is being displayed with values on the screen, it will be 
plotted with values on the paper. There is a Page Setup option under the File menu which 
allows several plot features to be set. 

PL -- Plot 

Prints the displayed spectrum to the currently selected printer. The first time PL is 
executed (unless a Print Setup has already been performed) a Print Setup dialog box is 
displayed, allowing selection of printer device and print parameters. Once printer 
parameters are selected, clicking OK causes the plot to be printed. Thereafter, when the 
PL command is entered, printing is performed directly. The printer parameters can be 
changed at any time by selecting Print Setup from the File menu. Printing can also be 
performed from the File menu. 

The user can set several options, including whether or not to print parameters on the 
bottom of plots, whether or not to draw a box around plots, margins, color printing and 
line thickness by selecting Page Setup under the file menu. NUTS plots are configured 
for 8.5x11 paper in Landscape orientation and are sized to be as large as possible. By 
default, plots include the parameter list and box, and all colors on the screen are mapped 
to black for printing.  

Page Setup allows larger margins to be set. Even when margins are set to zero, the plot 
will always have small margins on all sides. The size of these margins is dependent on 
the particular printer and printer driver being used. Setting margins to non-zero values 
adds the entered values to the default small margins. Note that margins are set in mm. 
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There is also an option in the Page Setup box for making 2D plots square, making it 
easier to view data from homonuclear experiments. The plot will be the maximum size 
possible, which is about 7 inches, plus axes, for 8.5x11 paper. This option affects only 2D 
plots. 

Fonts for the different types of text can be changed by choosing Set Fonts from the Edit 
menu. 

Some of these options can be set in the NUTS.INI file, so that they are invoked every 
time NUTS is run. 

Copy and Paste to the Windows Clipboard  

The currently displayed spectrum can be placed in the Windows clipboard using the Edit 
/ Copy menu option. From the clipboard, it can be placed into other Windows programs, 
such as word processing programs for inclusion in reports, using Paste. The picture is a 
bit map and the result will have the best quality if the NUTS window is set at maximum 
size, completely filling the screen, before the Edit / Copy operation is performed. NUTS 
also provides the option of copying the spectrum as a Metafile, rather than a bitmap, 
which results in a better quality picture.  See details. 

See also: Zoom, Phasing, Integration, Peakpicking 

Getting Started – Open a file and perform basic 
processing 

This section illustrates some of the basic operations in NUTS, including FT, automatic 
phasing, automatic integration and peak picking. 
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Choose Open from the File menu and select the file corresponding to the FID data. 

  

 

Select Fourier Transform from the Process menu.  
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The simplest way to phase is using automatic phasing. Choose Quick Phase from the 
Process/Phasing menu. 

  

 

The resulting phase is fairly good, and can be manually touched up using interactive 
phasing methods. See section on phasing. 
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Choose Automatic Integration from the Tools menu. 
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NUTS has automatically set the smallest integral to 1 and created separate integrals for 
peaks which are sufficiently separated. 

Numerical values can be reset and additional integrals defined manually using the 
integration subroutine. 

Display of integrals can be toggled on and off from the View menu selection Show 
Integrals. 

(Note that if the smallest integral is negative, due to poor phasing, integral labels will not 
be displayed.) 

  

 

Select Peak Pick from the Process menu. All peaks above the threshold are temporarily 
indicated with small vertical red lines, and peak labels are displayed at the top of the 
screen. See Peak Picking for details, including how to set the threshold and options for 
peak labels. 

When PP is executed, a peak list is automatically placed into the Clipboard, from which it 
can be pasted into any text editor for printing. The list can also be placed on the screen by 
selecting Show Clipboard Text from the View menu. 

Display of the peak labels can be toggled on and off with Ctrl-P. 
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Using the cursor and the zoom routine 

This section illustrates use of the Zoom expansion routine, and using the cursor to set the 
chemical shift reference and to measure chemical shifts and coupling constants. 

 

Choose Start Zoom Operation from the View menu. Note that typing ZO on the keyboard 
is equivalent. 
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To select a region for expansion, press and hold the left mouse button, and drag across 
the chosen region, which is highlighted in red.  

To display this expanded region, choose Zoom Region from the Display menu or type 
Ctrl-E. 

To return to displaying the full spectrum, choose All Reals from the Display menu, or 
type Ctrl-F.  

  



22 

 

Specific frequency limits can be entered by choosing Set Frequency Limits from the 
Display menu, or by typing F. Limits can be set in points, Hz or ppm. 

The right hand half of this dialog box applies to the second dimension of 2D data. 

Exit the Zoom subroutine by selecting Exit Zoom from the File menu or by typing 
<Enter>. The currently expanded region remains on the screen. 

For details, see description of the Zoom subroutine. 
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The cursor can be used to set a chemical shift reference. This is done from the base level 
of NUTS, not from within the Zoom routine. 

Press and hold the left mouse button, and place the cursor on the reference peak. While 
holding down the mouse button, type O (Offset) on the keyboard. 

A dialog box is displayed allowing the frequency at the cursor position to be entered. 

As before, the section labeled Vertical Dimension applies to 2D data. 

See also: SZ and PR commands, and a sample macro for indirect referencing. 
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The cursor can be used to display the frequency of any point in the spectrum.  

Press and hold the left mouse button to display a cross-hair cursor. The location of the 
cursor is displayed at the bottom of the screen as point number, Hz and ppm. 

The height of the horizontal cursor is also displayed, expressed as a percentage of the 
tallest peak in the spectrum. 
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Frequency differences can be measured using the cursor in difference mode. 

Press and hold the left mouse button and position the cursor on the first peak of interest. 
Click once with the right mouse button, without releasing the left button. This sets a 
marker cursor (green). 

(Alternately, or for users with a single button mouse, pressing the period key on the 
keyboard can be used instead of clicking the right mouse button.) 

While still holding down the left mouse button, move the cursor. The position of that red 
cursor is shown as before, but above it is displayed the frequency difference between the 
marker cursor and the current red cursor position.  

A multiplet can be labeled with splitting values in Hz.  While the difference information 
is displayed, typing L on the keyboard will create a text annotation with the frequency 
difference in Hz.  This can be edited, etc, from the Notes subroutine.   

Menus 

Toolbar 

Starting with version 980310, NUTS has a toolbar with icons for common commands. 

 

The corresponding commands are, starting at the left:  

File Open (GA)  
File Save (SA) 
Copy as bitmap (Ctrl-C)  
Print (PL) 
Page Setup 
Fourier Transform (FT) 
Phase by Mouse (PH) 
Enter Zoom subroutine (ZO) 
Automatic Integration (AI) 
Peak Pick (PP) 
Run Link #1 (A1) 
Help on Nuts  

  



26 

Menus 

Within the NUTS base level, the menu choices are shown below, along with commands 
which can be found within each menu. Details can be found by following the links down 
through layers of menus. 

File -- opening and saving files, run macro, printing, page setup and exit Nuts 

Edit -- copying spectra, setting fonts, left and right shift, zeroing data, spectrum reverse 

View -- Acquisition parameters, Zoom, vertical offset, scaling, dual display 

Process -- window functions, Fourier transforms, phasing, Link command strings, 
baseline correction, integration 

2D Process -- intensity and contour plots, step-wise viewing of slices, projections, 
symmetrize 

Tools -- Add/subtract, reference deconvolution, linefitting, spectrum simulation 

vSpec (Virtual Spectrometer) -- Simulation of FT-NMR data acquisition. 

Help -- Open on-line Help, toggle on/off Helper windows, NUTS data file format, 
technical support information, About Nuts 

File Menu Commands 

New (FN) -- Used with spin simulation (NS) routine, to define spectral parameters. 

Run Macro (RU) -- Execute a Nuts macro for automated processing. 

Open (GA) -- Open a NUTS file 

Save (SA) -- Save a file in NUTS format 

Save As (SB) -- Save a file using a new name. 

Auto Tailer Read -- Sets a flag to automatically read items from the file tailer when file is 
opened. 

Auto Tailer Overwrite --  

Delete (DE) -- Delete a file. 

Email File (EF) -- Email the current NUTS data file (Win95/98/NT only). 
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Export -- Export data as ASCII file in one of 5 possible formats, or as JCAMP. 

Import -- Import foreign data by automatically detecting the file type (IM). 

Print Setup -- Opens dialog box for choosing printer and print options. 

Page Setup -- Allows selection of margins, pen width, color and other display and print 
options. 

Printer dialog -- Opens print dialog box. 

Print (PL) -- Print the currently displayed region. 

Exit (XX) -- Exit the Nuts program. 

Edit Menu Commands 

Copy bitmap to clipboard (Ctrl-C) -- See Copying Spectra for description of this and 
subsequent copy commands. 

Copy standard metafile to clipboard (Alt-Shift-C) 

Copy enhanced metafile to clipboard (Alt-Shift-E) 

Copy printer Device Context enhanced metafile to clipboard (Alt-Shift-P) 

Copy standard metafile to file (Ctrl-Alt-C) 

Copy placeable metafile to file (Ctrl-Alt-L) 

Copy enhanced metafile to file (Ctrl-Alt-E) 

Copy printer device context ehnanced metafile to file (Ctrl-Alt-P) 

Zero Zoom Region (BZ) -- Zero all points in expanded region. 

Zero Full Data Region (ZE) -- Zero all data points. 

Zero Reals (ZR) -- Zero all real points. 

Zero Imaginaries (ZI) -- Zero all imaginary points. 

Left Shift (LS) -- Shift data one point to the left. 

Right Shift (RS) -- Shift data one point to the right. 
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Spectrum Reverse (SR) -- Reverse spectrum left to right. 

Swap Real & Imag (RI) -- Exchange real and imaginary halves of the data. 

Invert Imaginaries (II) -- Invert all imaginary data points. 

Set Fonts -- Set fonts for axis (FA), clipboard (FC), integral labels (FI), command line 
(FL), parameters on bottom of plot (FM) and peak labels (FP). 

UnDo (Ctrl-Z) -- UnDo last command.   

View Menu Commands 

Spectral Parameters -- Acquisition parameters imported with the data, as follows:  

Comment (CO) -- Up to 80 characters used for description of data. 
User (US) -- User's name or initials. 
Date (DA) -- Date data were acquired. 
Frequency in 1st Dimension (F1) -- Spectrometer frequency in MHz.  
Frequency in 2nd Dimension (F2) -- Spectrometer frequency for 2nd dimension 
in MHz. 
Offset Frequency in 1st Dimension (O1) -- Offset in Hz from center of spectrum 
to 0 ppm. 
Offset Frequency in 2nd Dimension (O2) -- Offset in Hz from center of spectrum 
to 0 ppm, for 2nd dimension. 
Sweep Width in 1st Dimension (W1) -- Spectral width in Hz. 
Sweep Width in 2nd Dimension (W2) -- Spectral width in Hz, for 2nd dimension. 
Slice (SL) -- Slice number of currently displayed slice. 
Experiment (EX) -- Name of pulse program used to acquire data. 
Number of Acquisitions (NA) -- Number of scans acquired. 
Pulse Width (PW) -- Observation pulse width in usec. 
Pulse Delay (PD) -- Relaxation delay in sec 

Type -- Allows selection of Display Full or Zoomed region, Real and/or Imaginary data 
points, and axis label (ppm, Hz, points or none) 

Show All Reals (Ctrl-F) -- Set display to show full spectrum. 

Show Zoom Region (Ctrl-E) -- Set display to previously defined frequency limits. 

Show Integrals (Ctrl-I) -- Toggle on/off display of integral trace. 

Show Peak Labels (Ctrl-P) -- Toggle on/off display of peak labels defined in DP routine.  

Start Zoom operation (ZO) -- Enter Zoom expansion subroutine 
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Vertical Offset (DC) -- Allows position of spectrum's baseline to be moved up the screen. 

Amplitude Change (AC) -- Allows entry of a multiplying factor to scale display. 

Make Full Scale (MF) -- Reset display scale to make the largest displayed peak full scale. 

Reset Scaling to 1 (S0) -- Remove all scaling factors. 

Dual Display (DD) -- Toggle on/off display of a spectrum which has been loaded into the 
dual display buffer. 

Multiple Buffer Display (BU) -- Enter Buffers subroutine for display of multiple spectra. 

Total Phase (TP) -- Display the values of zero- and first-order phase which have been 
applied. 

Parameters to Clipboard (LP) -- Copy spectrum parameters to the Windows clipboard for 
display on the screen or pasting into other applications. 

Show Clipboard Text (CB) -- Toggle on/off display of Windows clipboard on the screen 
(text only). 

Fix Auto Scaling Factor (FS) -- Disables automatic adjustment of the display scale, so 
that different data sets can be compared. 

Clear Fixed Auto Scale (CS) -- Removes the effects of the FS command. 

Process Menu Commands 

Conditions -- Displays a parameter box allowing setting of parameters for window 
functions, peak picking and phasing. 

Links (LI) -- Allows definition of 10 Linked command lists. 

Window functions:  

Exponential Multiply (EM) -- Applies exponential apodization function using 
previously defined Line Broadening value. 
Gaussian Multiply (GM) -- Applies gaussian apodization function using 
previously defined Line Broadening value. 
Lorentzian/Gaussian Multiply (LG) -- Applies Lorentzian/Gaussian resolution 
enhancement. 
TRAF function (TF) -- Applies Traficante resolution enhancement. 
Trapezoidal Multiply (TM) -- Applies trapezoidal apodization function using 
previously defined parameters. 
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Sine Multiply (MS) -- Applies sine apodization function with phase defined by 
S#.  

Transforms:  

Fourier Transform (FT) -- Forward Fourier transform. 
Real Transform (RT) -- Real Fourier transform. 
Bruker Transform (BT) -- For Bruker sequential data. 
Complex Transform (CT) -- Complex Fourier transform. 
Inverse Transform (IT) -- Inverse Fourier transform. 
Hilbert Transform (HT) -- Inverse Fourier transform starting from real data. 

Phasing:  

Auto Phase (AP) -- Automatic adjustment of zero- and first-order phase. 
Quick Phase (QP) -- Automatic adjustment of zero- and first-order phase. 
Phase Correct (PC) -- Manual phasing using previously set values of PA and PB. 
Phasing Expanded (PE) -- Phase using 2 previously defined spectral regions. 
Phasing by Mouse (PH) -- Phase entire spectrum using mouse buttons to adjust 2 
phase parameters. 
Phase Same (PS) -- Apply same phasing as used on previous spectrum. 
Zero Phase (ZP) -- Remove all phase adjustments. 

Digital Filter:  

Digital Low Pass (DL) -- Apply low pass filter. 
Digital High Pass (DH) -- Apply high pass filter. 

Baseline Correct (BC) -- Remove DC offset and tilt of entire spectrum. 

Zero Fill (ZF) -- Double the number of data points by adding zeros. 

Shrink Data (SH) -- Reduce the number of data points by deleting points from the right-
hand end, as defined by the S@ parameter. 

Peak Pick (PP)-- Select peaks above minimum height and place peak list into the 
clipboard. 

Fit Baseline (FB) -- Enter polynomial baseline fitting subroutine. 

Baseline Flatten (BF) -- Remove DC offset and tilt of displayed spectral region. 

Integrate Display (ID) -- Enter integration subroutine. 

Magnitude Calculation (MC) -- Computes magnitude spectrum of the current data set so 
all peaks appear positive. 
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Power Spectrum (M2) -- Computes power spectrum of the current data set so all peaks 
appear positive. 

2D Processing Menu Commands 

Set 2D scale (SS) -- Calibrates intensity scale for use in calculating contour levels.  

View 2D slices (VW) -- Stepwise viewing of slices of a 2D data set. 

Transpose data (TD) -- Rotate data by 90 degrees. 

Project 2D file (PJ) -- Calculate horizontal projection of currently displayed region. 

Intensity Plot (IP) -- Display quick intensity map of 2D data. 

Contour Plot (CP) -- Calculate and display contour map of 2D data. 

Get Slice (SL) -- Display a selected slice of the 2D data set. 

Symmetrize (SY) -- Symmetrize the data to remove artifacts. 

Tools Menu Commands 

Add/Subtract Routine:  

Enter Add/Subtract Subroutine (AS) -- Enter subroutine and display buffer 
spectrum above current spectrum. 
Load Add/Subtract Buffer (AL) -- Copy current spectrum into buffer. 
Edit Add/Subtract Parameters (AM) -- Allows setting buffer multiplier, vertical 
offset and frequency offset. 

Convolution:  

Apply Convolution filter (CA) -- Apply previously calculated function to 
displayed FID. 
Calculate Convolution filter (CF) -- Calculate reference deconvolution function 
from displayed peak. 
View Convolution filter (CV) -- Display previously calculated function. 
Get Convolution filter -- Read previously saved function from file. 
Save Convolution filter -- Save calculated function to a file. 

  
Searchable Archive: 

Database Make (DM) -- Create archive file from set of NUTS spectra 
Database Search (DS) -- Search NUTS archive file 

Relaxation:  



32 

Read Relaxation Data (RR) -- Read list of intensity vs. time from a file. 
Data Reduction (DR) -- Display relaxation data as intensity vs. time plot. 
Get Relaxation Data (GR) -- Measure intensity of displayed peak in each slice of 
the current 2D data set. 

Extract:  

Extract Spectrum (XT) -- Extract displayed region to a new data set. 
Extract Line (XL) -- Extract tallest peak in displayed region to a new data set. 
Extract Bottom Projection (XB) -- Save displayed region as horizontal projection 
for a 2D plot. 
Extract Right Projection (XR) -- Save displayed region as vertical projection for a 
2D plot. 
Clear Extracted Projections (XC) -- Clear previously defined projections. 

Automatic Integration (AI) -- Perform automatic integration on displayed region. 

Define Peaks (DP) -- Enter Define Peaks subroutine for manual peak picking. 

Line Fit (LF) -- Enter line fit subroutine for peak deconvolution. 

NMR Simulation (NS) -- Enter spin simulation subroutine. 

MetaObjects (MO) -- Enter subroutine for handling graphical objects. 

Calculation Type (TC) -- Native (for Macintosh without coprocessor) or Win32 (default).  
(Obsolete). 

Stacked Plot (SP) -- Display stacked plot of a 2D or arrayed 1D data set. 

Inserts (Inset Plots) (IS) -- Enter subroutine for creating inset plots 

Notes (NO) -- Enter subroutine for creating text annotations 

Math Routines (MA) -- Display "calculator" window for performing math functions. 

Shim (SM) -- Enter subroutine for shimming simulator. 

  

vSpec Menu Commands 

Virtual Parameters (VP)  -- Opens a dialog box to set acquisition parameters. 

Get Sample (GS) -- Specifies the file from which frequencies will be read. 
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Zero & GO (ZG) -- Reads the file containing frequencies and generates the NMR data. 

Note that these commands and the vSpec menu are disabled in the Anasazi Instruments 
OEM version of NUTS. 

  

Help Menu Commands 

Help on NUTS - Displays Help in either WinHelp or HTML Help formats. 

Helper Windows - Toggles on/off display of Helper window in the MO subroutine. 

Technical Support - How to reach us. 

Data File Format - Description of the NUTS file format.  

Set NetTime - Synchronize your computer's time to an Internet Time Server 
(Win95/98/NT only). 

About NUTS - Displays license information, support date and compile date. 

Viewing acquisition parameters 

The following parameters can be examined and/or changed from the View/Spectral 
Parameters menu or by typing the 2-letter names. In both cases, a dialog box appears 
displaying the chosen parameter and related parameters. Many of these parameters are 
printed on plots. The NUTS data translation attempts to translate and insert into the 
NUTS file header as many parameters from the original file as possible. Some parameters 
refer to the total data set, such as Date and Number of scans. For others, two sets of 
parameters are listed for the two dimensions, such as Spectrometer Frequency and Sweep 
Width. 

CO -- Comment (eg., sample name or number). 

UID -- Unique identifier 

DA -- Date of data acquisition. 

EX -- Name of pulse experiment used to acquire data. 

F1, F2 -- Spectrometer frequencies in the first and second dimensions. 

NA -- Number of scans acquired. 

O1, O2 -- Spectrum offsets in the first and second dimensions. 

PD -- Pulse delay used in data acquisition.  

PW -- Pulse width used in data acquisition.  
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SF -- Spectrometer Frequency. 

SV -- Solvent. 

SW -- Sweep width in Hz. 

US -- User name or initials 

W1, W2 -- Sweep width in the first and second dimensions. 

SV (or SOLVENT)  

Entering this command with no subsequent argument returns the current solvent.  In the 
non-2-letter command mode, it allows the solvent to be set.  For example, 

sv DMSO-d6<ENTER> 

sets the solvent parameter to DMSO-d6. 

O1 and O2-- Frequency Offset  

Each of these values is the difference, in Hz, between the center of the spectrum and 0 
ppm.  This is how NUTS keeps track of the chemical shift scale.  For 1D data, normally, 
the chemical shift reference is set using the cursor or, for TMS, the SZ command.  
However, offset values may be entered directly.  For 2D data, the cursor can be used to 
set the shift reference; see details. 

Number of points 

The number of points in the data set, listed for both dimensions. 

Dwell Time 

This is calculated from the sweep width.  

Acquisition Time 

This is calculated from the sweep width and the number of data points. 

Domain 

NUTS must keep track of whether the data is an FID (Time domain) or a spectrum 
(Frequency domain). Occasionally, NUTS fails to correctly identify when the data 
represent an FID or a spectrum, and this can be corrected by entering the appropriate 
word in the Domain box. Save the change by executing a UH (update header) command.  

Data Type 
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There are 3 possible values for this parameter: Complex, Real and TPPI. The latter is 
used to indicate that the data were acquired using Bruker's sequential acquisition, and for 
2D data which was acquired using TPPI in the indirect dimension. 

2D Nomenclature 

Keep in mind that NUTS will label the dimensions as 1 and 2, with 1 always being the 
dimension that is currently displayed horizontally. So when you are viewing, for 
example, a HETCOR spectrum from a 300 MHz instrument, with the carbon dimension 
displayed horizontally, that is dimension 1. So F1 (SF for dimension 1) will be 75 MHz. 
When you do a TD, the 1H dimension is now horizontal, so dimension 1 is 1H, and F1 is 
now 300 MHz.  

It's easiest to ignore 1 and 2, and just look at the parameters window, keeping in mind 
that the left column of parameters applies to the dimension that you have displayed 
horizontally and the right column applies to the vertical dimension. 

Note that a common practice is to label the indirect dimension as "1" (even though it's the 
secondary dimension, and is processed second) because the corresponding t1 period in the 
pulse sequence (the incremented time variable) occurs before the acquisition time.  To 
avoid confusion, the NUTS documentation uses the terms direct and indirect to refer to 
the different dimensions, which is unambiguous. 

If considering only 1D data, the parameters can have the obvious names SF, SW and OF.  
But with 2 dimensions, we need to add labels 1 and 2. But in Nuts, everything is 2 letters. 
So these parameters became: 

SF ==> F1 and F2 

SW ==> W1 and W2 

OF ==> O1 and O2 (NOT to be confused with Bruker's O1 and O2, which are defined 
differently!) 

The NUTS offset is defined as the number of Hz between the center of the spectrum and 
0 ppm. This is the parameter that keeps track of the chemical shift referencing.  

 Display 
Control A -- Axis label 

Toggles the axis label among the choices: points, Hz, PPM and none. Direct selection is 
available by choosing Type from the View menu. The font used for the axis label can be 
set with FA or by choosing Set Fonts from the Edit menu. The default axis type and its 
font can be set in the NUTS.INI file. 
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Control-D -- Points/Lines toggle 

Toggles the display between drawing the data points and drawing lines to connect the 
points. The default is to draw lines between the data points. This applies to the real part 
of the data. Typing Ctrl-D a second time returns the display to the original state. 

Note that redrawing the screen while displaying points can become quite slow as the 
number of points in the display region becomes large. 

AxisPen  

When NUTS is in the non two-letter command mode, the command "axispen" may be 
used to change some of the characteristics of the axis line. Examples are:  

Change the screen only axis line to a width of 2  
axispen screen 2  

Change the axis line to a width of 2 only when printing  
axispen print 2  

Change the axis line to a width of 2 for both screen display and printing  
axispen both 2  

Change the color of the axis line to red  
axispen 255 0 0  

Change the color of the axis line to green  
axispen 0 255 0  

Change the color of the axis line to blue  
axispen 0 0 255 

UD -- Update Display 

Forces NUTS to repaint the screen. This can be used in macros to allow the user to 
monitor progress of the macro.  

QD -- Quick Display 

Changes the display mode to a compressed display, which paints the screen faster. This is 
the default mode of display and is faster than displaying every point with the Slow 
Display (SD) mode. The difference in display speed between QD and SD becomes more 
apparent as the size of the data file increases. 

SD -- Slow Display 
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Changes the display mode to displaying every point. This display mode is slower than the 
compressed display under the Quick Display (QD) mode. The difference in display speed 
becomes larger as the size of the NMR data set increases. By default, NUTS uses the 
faster Quick Display. 

WS -- Window Size 

Allows the user to set the size of the NUTS screen in pixels. This is useful for copying 
spectra as bitmaps or doing screen captures. It is desirable not to resize a bitmap after it 
has been created, because this can cause distortions. So the NUTS screen can be set to the 
desired size for the final image before copying. 

Control-B -- Toggle on/off Clipboard Display (same as CB -- Clipboard 
on/off) 

Toggles on and off display of text currently saved in the Windows clipboard. This can be 
used to place information such as peak lists on plots. This command is also available 
from the View menu. Ctrl-B is active at all times, including in subroutines. To use this in 
a link or macro, use "^B". 

By default the text is displayed in the upper left corner of the screen. This can be changed 
by holding down the left mouse button and placing the cross-hair cursor at the position 
desired for the top left corner of the text region. While still holding down the mouse 
button, type C. Because this involves using the cursor, it must be done from the NUTS 
base level, not within a subroutine. 

When peak picking is performed (with PP), the peak list is automatically placed in the 
Windows clipboard. If clipboard display is turned on, this list appears on the screen as 
soon as the display is refreshed. To get a list of integral values, display the integral (with 
ID) and (after defining sub-regions), type T to copy the integral information into the 
clipboard. Toggling Ctrl-B on then displays the integral information. The integral list can 
also be placed into the clipboard without entering the integration routine using the IL 
command. 

A list of spectral parameters can also be displayed by typing ctrl-L (which places a list of 
parameters into the clipboard).  

To edit the displayed text, first paste the text into the Windows Notepad or other text 
editing program. Perform the necessary editing, then select and copy to the clipboard the 
text you want on the plot. Return to NUTS and toggle clipboard display on. This can be 
used to place a title, sample description or other text on a plot. 

The font used for the displayed text can be set with FC or by choosing Set Fonts from the 
Edit menu. It can also be set in the NUTS.INI file. 
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In the non-2-letter command mode, clipboard display can be explicitly turned on/off with 
the commands CB on and CB off.   

LP -- Parameter display on plot 

Displays the list of acquisition and processing parameters shown below on the plot, at the 
upper left corner. The parameter list is placed into a "Note", which is how text 
annotations on plots are handled.  The list can be edited from within the Notes routine 
(requires at least NUTS-1D).  The parameter list is simultaneously copied to the 
clipboard, so can be pasted into other applications.  As with all Notes, display can be 
toggled on and off with Ctrl-N.    

This is the same result as the P subcommand inside the Notes routine.  

C:\NUTS\DATA\NT.FID 
Sample A13-402 
 13FEB90 
USER: WWC 
SOLVENT:  
Experiment = 1Pulse 
Pulse length = 7.700 usec 
Recycle delay = 5.000 sec 
NA = 128  (Number of Acquisitions) 
Temperature = 22.0 
Changer Slot = 7 
FID PTS1d = 8192  
PTS1d = 8192  
SF1 = 361.211121 MHz 
SW1 = 2801.10 Hz  
Acquisition time = 2.92 sec 
Hz per Pt 1stD = 0.34 Hz  
O1 = 1201.9000 Hz  
LB1 = 0.00 Hz   (Line broadening) 
TP A = 0.00 (Total Phase applied (A=zero-order, B=first 
order, C=second-order) ) 
B = 0.00  
C = 0.00 
1H TMS Frequency  =  399.7822082 MHz 
 

A list of parameters can also be printed on the bottom of plots. This option can be 
selected by choosing Page Setup from the File menu or set in the NUTS.INI file.  

Control-L -- Display parameters 

Toggles on/off display of the list of acquisition parameters created with LP (or Notes 
subcommand P). If the list hasn't been created, Ctrl-L does nothing. Ctrl-L also interacts 
with a related command, Ctrl-N, which toggles on/off display of all text boxes defined in 
the Notes routine. If Ctrl-N is toggled off, then Ctrl-L turns on/off display of the 
parameter list. If Ctrl-N is toggled on, Ctrl-L does nothing. 
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Control-N -- Display Notes 

Toggles on/off display of all text boxes defined in the Notes subroutine. This is the same 
as the Notes subcommand S, but is active outside of the subroutine. 

 Scaling the data 

These commands adjust the display of the data, and do not actually change values of data 
points. 

Scaling the spectrum display 

The vertical scale of the displayed data can be adjusted in several ways: by using right 
hand scroll bar, with the greater than and less than keys ( > and < ) for changes by factors 
of 2, with the Page Up and Page Down keys and with the cursor up and down arrow keys 
for finer adjustment. 

There are also several commands that change or affect the display scale: 

AC -- Amplitude change; enter multiplying factor 

Ctrl-Y -- Scales the tallest displayed peak to be full scale.  

MF -- Scales the tallest displayed peak to be full scale.  

S0 -- Scale Zero; sets scroll bar to zero 

FS -- Fix scale 

CS -- Clear fixed scale 

It is important to understand that these commands affect only display of the data. They do 
not change the values of the data points. NUTS does all operations in floating point, 
rather than integer, arithmetic. This eliminates the need for a scaling or normalization 
constant which is necessary for data represented as integers, because there is a limited 
dynamic range for integers. Therefore, the absolute values of the data points in NUTS can 
be directly compared from spectrum to spectrum without the need for fixing Absolute 
Intensity. 

AC -- Amplitude Change 

Opens a dialog box for input of a vertical scaling factor. This command is also available 
from the View menu. 

When used in a macro, the current value for the scaling factor is applied, without asking 
for user input. Therefore, to use AC in a macro, first use the command SET AC to enter a 
value, then use the AC command to apply that scaling. 
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The scaling factor is applied to the spectrum as it is currently displayed. This allows the 
user to change the vertical scale by a specific factor. The vertical scale can also be 
adjusted with the right hand scroll bar, with the Page Up and Page Down keys, with the 
up and down cursor keys and with the < and > keys. 

Control-Y -- Set Vertical Scaling (Same as MF -- Make Full command) 

Adjusts the vertical scaling so that the largest peak in the currently displayed region 
becomes full scale. This command is also available from the View menu. This command 
is active in all subroutines. To use Ctrl-Y in a Link or Macro, use " ^Y ". The vertical 
scale can also be adjusted with the right hand scroll bar, with the Page Up and Page 
Down keys, with the up and down cursor keys and with the < and > keys. The Amplitude 
Change (AC) command allows input of a specific scaling factor. 

FS -- Fix Scaling 

This disables automatic scaling of the data display, allowing a series of spectra to be 
displayed with the same vertical scale. In its default operation, NUTS scales the data 
using two different scaling factors. One scaling factor is determined by the position of the 
right scroll bar. The other scale factor is automatically determined by NUTS and is the 
absolute difference between the minimum and maximum of the current spectrum. When 
the FS command is given, the latter number is fixed at the current level until the CS 
(Clear Scaling) command is given. This allows other spectra to be loaded and their 
amplitudes directly compared. 

This scaling affects display only. NUTS performs all operations in floating point, not 
integer math. This obviates the need for applying and keeping track of a scaling or 
normalization constant in order to compare data. Note that setting minimum height for 
peak picking using the cursor does not work properly when FS is enabled.  

CS -- Clear fixed Scaling 

Clears display scaling previously fixed by FS command. 

S0 -- Scale Zero 

Returns the right-hand scroll bar to zero and removes all vertical scaling applied with 
either the scroll bar or keyboard (page up/down or <> keys). 

DC -- DC offset for display 

Allows the user to override the default value for the vertical position of the spectrum on 
the screen. This is useful for displaying spectra with negative peaks. After entering the 
DC routine, a scroll bar on the left side of the NUTS window appears and can be used to 
adjust the vertical position of the spectrum display. Typing <Enter> exits the DC routine, 
and the new vertical position of the spectrum display remains the default until reset or the 
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program is restarted. To reset the vertical position back to the bottom of the screen, enter 
the DC routine and type 0 (zero).   The offset can be set to a specific fraction of the 
screen by typing a single digit (1, 2... 9) while in the DC routine.  For example, typing 2 
moves the display approximately 20% up the screen. 

Ttype <Enter> to exit the DC routine. 

File handling 

This section describes how NUTS keeps track of file names, opening and saving data 
files and the file "tailer". 

A data file (either an FID or a spectrum) can be read into NUTS using the File/Open 
menu command or, equivalently, the GA command. The GA command can be used for 
both 1D and 2D data sets. The current working directory is established each time a file 
open or file save command is completed. A file can be saved using the same name 
(writing over the original data) or a new name. These are the Save and Save As 
operations, respectively, found under the File menu. The equivalent 2-letter commands 
are SA and SB, respectively. Either command brings up a dialog box allowing a file 
name to be entered. The difference between the two commands has to do with the file 
name which NUTS assigns to the currently displayed data. The currently displayed file is 
always designated as file A and its file name is displayed at the top of the screen and is 
printed on plots. Saving the data with a new name using SA will cause the name at the 
top of the screen to change. The same operation using SB leaves the name at the top of 
the screen unchanged. This allows NUTS to keep track of two different file names, and 
becomes important in operations which involve processing of a series of files, by 
allowing the processed data to be saved using a new name rather than being written over 
the original file.  

The Import (IM) command (also available from the File menu) operates on data which 
has not been translated into the NUTS file format. NUTS will attempt to identify the 
data's source and apply the appropriate translation. The translated file is created with the 
same name, but with a $ appended to the beginning, so that the original data is never 
altered. This new file becomes the current file in NUTS. The translated file is always 
written to disk, to the current data directory.  See also the section on importing data. 

The default directories for file importing and for the file Open/Save operations (eg, GA 
and SA) can be different and can also be set in the NUTS.INI file. (Note that this does not 
work correctly on the Mac.) If a file is imported from a different directory, this new 
directory becomes the import directory, and will be the directory displayed for 
subsequent IM commands. Similarly, if a file is read from or saved to a different 
directory from the default data directory, this operation changes the data directory for 
subsequent Open and Save operations. The WP command (Which Path) displays the 
current directories for Read/Write and for Import, so the user can keep track of them. 
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The S2 command is available for making copies of a 2D file and for saving a 2D file after 
modifying an individual slice.  

The user needs to be aware that the command GA (open file A) when applied to a 2D file 
behaves slightly differently in macros or Links from when it is entered directly. The 
difference lies in whether NUTS reads just a slice of the 2D data or reads both the slice 
and the data header. While in a Link (either by itself or within a macro), NUTS reads the 
data header only once, for the first slice. This makes reading subsequent slices faster. 
When GA is used to read a 2D file in a Link, NUTS assumes that the user loaded the first 
slice manually (with GA) immediately before executing the Link. This reads in the file 
header and all is well. If the same Link is embedded in a macro, NUTS can be forced to 
read the file header by inserting the following line just before the line containing the 
Link: 

Set SL 1 

The take-home message is that in macros always set SL to one before a Link in which 
GA will operate on a 2D file. When executing a Link not in a macro, always do a GA on 
the starting file just before executing the Link. 

In Macros: 

When using the Set command to specify a file name, the default path name is the current 
working directory. The current working directory is established each time a GA or GB 
command is completed. Therefore, always execute a GA after an Ask FileA command: 

Ask FileA 
GA 

This establishes the working directory, and subsequent Set FileX commands will use that 
directory. 

If the user wants to specify a different path for a file in a Set command, use  

Set FullFileA name 

Note that if a new path is specified for file A or B, the working directory will be changed 
when a GA or GB command is next executed. 

See also: Linked Command Lists 2D Processing, Importing data, Exporting data 

GA -- Get data set A 

Opens the dialog box for reading a file. The last name used for File A, if any, will be the 
default selected name.  



43 

If the file name entered corresponds to a file which is not in the NUTS CDFF format, a 
dialog box asks if the file should be imported. If the user answers Yes, NUTS will 
attempt to detect the file type and apply the appropriate translation. This is the same 
operation performed by the Import ( IM ) command. 

GA can be used in a Link for processing a 2D data set or a series of 1D spectra. In this 
case, the Link will end with an IN command, which causes the processing to loop back to 
the beginning of the Link and will increment either the slice number (for a 2D file) or the 
file extension (for 1D files) so that the next slice or spectrum is read in. 

See also: Long command names, Importing data, Linked command lists, 2D Processing. 

GB -- Get data set B 

Opens the dialog box for loading a file. The last name used for File B, if any, will be the 
default selected name.  

SA -- Save dataset A 

Saves the current data set under the File A name or a different name. This command is 
also available from the File menu. 

SB -- Save dataset B 

Saves the current data set, allowing the entry of a different file name. The name of the 
currently displayed file, designated as File A, is unchanged. This command is available 
from the File menu. 

EF -- Email File 

A file can be emailed, provided an email client has been set up.  The current NUTS data 
file is attached to an email message, and the user specifies the email address and can 
optionally add a message.   The file is sent from the disk, so it is necessary to save the 
current file before executing the EF command.  This command is available from the File 
menu.   

See also:  Paperless data distribution 

File Tailer 

The peak list, integral list and some additional data are saved in the data file.  (Originally, 
this was saved in a file "tailer", appended to the end of the data file.  With conversion to 
NUTS file format Type 3, this information is now stored in the file Header, but this 
command retains its original name.) 
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A flag found in the File menu determines whether or not information is automatically 
read from the tailer when a file is opened.  This option can also be set in the nuts.ini file. 

The NUTS commands which pertain to this are: 

TA -- Read all information from file tailer. 
TS -- Save tailer information to a separate ASCII file. An example is shown 
below. 
IF -- Enter other information to be saved in tailer. 
T+ -- Replace the existing file tailer with the contents of a specified text file. 

If integral regions have been defined at the time a file is saved, they are saved in the file 
tailer. Similarly, if peaks have been selected in the DP subroutine, that peak list is saved. 
The comment line (CO) and the path to the file are also saved in the tailer. The additional 
information which can be saved, using the IF command, includes 3 lines of text, a 
molecular formula and nucleus type(s).   

Four nuclei can be defined, for up to 4 dimensional data.  These can be entered via the IF 
command, or with the NU command (or the equivalent, non-2-letter command 
NUCLEUS).   Typing NU returns the current solvent for the direct (first) dimension.  In 
the non-2-letter command mode, the nucleus type can be set using 2 arguments.  The first 
argument is a number (from 1 to 4) corresponding to the dimension, and the second 
argument is the name of the solvent.  For example, 

nu 1 13C<ENTER> 

sets the first dimension nucleus to 13C. 

Any inset plots or text notes which have been defined are also saved with the file. 

One note of caution: Because integral and peak lists, inset plots and notes are not cleared 
when a new data set is opened, it is possible to save irrelevant information in the file 
tailer of that new file when it is subsequently saved. Also, some peaks or integrals 
previously defined may fall outside the spectral limits of the second file. In this case, the 
invalid peaks are reset to the closest valid data point, and invalid integral regions are not 
displayed. 

File Header Type 3 provides for an expandable file header for parameters with a flexible 
format.  For Type 3 files, the "tailer" information is no longer saved in the tailer, but is 
instead included in the header.  

TA – Read Tailer 

Reads all information from the file tailer. From within the Integration subroutine, integral 
regions only can be recalled from the tailer from the Edit menu, or using the keyboard 
command R.  



45 

TS – Tailer Save 

Creates a text file containing the information which is saved in the file tailer when a Nuts 
file is saved. A sample of a file Tailer, as saved using TS, is: 

INFORMATION 
Name1=data from Sam 
Name2=stuff 
Name3=CDCl3 
Comment=Sample # K-47-B  
Formula=C6H10N 
Nucleus=H1 
Path=D:\NUTS\DATA\sam\$DATA 
END_INFORMATION 
PEAKLIST 
LINE HZ PPM INTENSITY REL INT XOFFSET YOFFSET HorV LABEL 
1 2307.23 7.687 120753536 10.149 0.000 0.000 V 4 
2 2097.74 6.988 111956936 9.410 0.000 0.000 V 5 
END_PEAKLIST 
INTEGRALS 
REL_VALUE = 1.589616e-009 
START_PT START_HZ END_PT END_HZ VALUE LABEL POSITION 
6394 8.432 6514 8.281 0.986642 1 
6681 8.072 6814 7.905 1.000000 1 
6912 7.782 7053 7.605 2.183908 1 
7499 7.045 7638 6.870 2.465544 1 
7243 7.366 7433 7.127 6.768002 1 
END_INTEGRALS 
END_TAILER 

T+ -- Tailer add 

A text file can be used to replace the tailer information of the currently displayed data set. 
The file needs to be in the format of the example above. This feature can be used to edit 
information already in a file tailer, by first saving the tailer (TS), then editing it with any 
text editor, saving the changes and then using T+ to read back in the modified tailer. As 
soon as T+ is executed, the modified tailer is saved on disk, using the file name of the 
currently displayed data set. 

IF -- File Information 

This command brings up a dialog box which allows entry of supplementary information 
which will be saved in the file "tailer" when the spectrum is saved. This information can 
be retrieved later with the TA command or from the File menu when the file is opened 
within Nuts. This information is also used when creating a searchable archive file. 

User, date, comment and the path to the file are entered automatically from existing 
information for the current data set.  

See also: Creating a searchable archive 
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DE -- Delete file 

Brings up a dialog box allowing the user to select a file to be deleted. It does not ask for 
confirmation before deleting the file. 

RL – Read License File 

This command reads a special encrypted text file and generates a new LICENSE.NMR 
file. This is an attempt to aid users who want to get a new LICENSE.NMR file by email, 
but who cannot handle attached binary files. Before RL is executed, any current 
LICENSE.NMR in the same directory as the NUTS.INI file must be erased or (better) 
renamed. RL will read a specially prepared file which MUST be named LICENSE.TXT 
and MUST be in the same directory as the NUTS.INI file. When NUTS is started and the 
RL command entered, a new LICENSE.NMR file will be created which will have the 
information from the encrypted LICENSE.TXT file. This operation needs to be 
performed only once. 

Command log for recording processing information 

This NUTS feature creates a record of commands used in processing each data file.   

cmdlog (or commandlog) - a non-2-letter command which controls the command 
logging operation of NUTS.  Logged commands are stored in the NUTS header (only if 
NUTS Header Type 3 is used) when the file is saved. If a file is opened that already has a 
command log, the log will be read and additional commands will be appended.  

An example of the command log section of a NUTS header is shown below.  The date 
and time are the first entry.  When the file is opened, the file name with complete path is 
listed.  The data were processed with 2 Hz of linebroadening, FT, phasing (QP auto-
phase followed by touch-up phasing using PH) and quick polynomial baseline correction, 
then the processed spectrum was saved. 

##$CMD_LOG 
Wednesday August 29, 2001 17:32:16 
ga C:\nuts\data\qeeb.fid 
lb 2.000000 
em 2.000000 
ft 
qp 3.281250 -7.031250 0.000000 
ph -0.035889 2.468750 0.000000 
qb 
sa C:\nuts\data\qeeb.nmr 
##$END_CMD_LOG 

When phase correction commands are logged, the three values listed are the zero-, first- 
and second-order corrections.  Note that the values reported are the total, cumulative 
phase correction, not the incremental adjustment applied by that one command.  So if 
multiple phasing operations are performed, as shown above for QP followed by PH 
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commands, the last reported values represent the final phase correction applied to the 
spectrum. 

The command log can be enabled or disabled by an entry in the NUTS.INI file: 

NUTS_LOG_COMMANDS = TRUE 

If this entry is commented out, set to anything other than TRUE, or is absent, then NUTS, 
by default, will not log the commands. 

The command logging can be turned on with the command 

cmdlog on 

and command logging can be turned off with the command 

cmdlog off 

The "cmdlog" command without any argument will bring up a dialog box from which the 
user selects a file, then notepad.exe will be started and the command log for the selected 
file will be displayed. 

When a command Link is executed, the commands in the Link are entered into the 
command log just once to prevent repetitious entries.  Note that when running macros 
containing a Loop, it may be advisable to turn off command logging to prevent the 
command log from getting too big, which will result in slow (potentially, VERY SLOW) 
reading of the file subsequently. 

Searching data files 
HeaderSearch (or hdrsearch) – Search files by keyword 

This is a non-2-letter command that allows searching all NUTS files in a designated 
directory for a specified value for one of the parameters in the file header. 

The command syntax is: 

hdrsearch keyword value 

where keyword is any of the keywords in the NUTS header (type 3 files only). 

A file-open dialog box is displayed, allowing the user to select which directory should be 
searched.  Select any file in that directory.  The search results are saved as a text file 
called uid_scan.txt in the default Windows temp directory.  When the search is 
complete, the search results are displayed using Notepad. 
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For example, to search for all files containing the word benzene in the title field, 

hdrsearch ##TITLE benzene 

The search is a sub-string search, so all files containing the word benzene in the title field 
will be listed. 

UID - Unique Identifier 

A new parameter has been created which can be used to identify individual data sets, or 
to group related data files together by assigning them all the same UID.  The UID is 
displayed on the Acquisition Parameters screen.  The identifier can be any text string.  A 
selected directory can be searched for a specified UID. 

The UID is stored when a file is saved (type 3 header only) and is recalled when a file is 
read, if it exists in the header.  The UID can be entered from the Acquisition Parameters 
screen or from the command line (in non-2-letter command mode), as shown here: 

uid string 

To search for all files with sub-string matched to "SearchUID" (non-2-letter command): 

uid -s SearchUID 

and select any file in the desired search directory.  The search results are saved as a text 
file called uid_scan.txt in the default Windows temp directory.  When the search is 
complete, the search results are displayed using Notepad. 

passwd - Password 

Associated with the UID is the non-2-letter command "passwd".   The idea is that the 
user can choose to restrict editing of  the UID field by requiring a password to change it. 
If a password has been set, changing the UID requires the password to be input.  The 
passwd command allows a password to be defined.   

Examples of usage:  
 
passwd <new password> <old password, if password currently exists> 
 
if no password has been defined, or if UID does not now exist, the UID can be set 
regardless of password: 
uid <UID> 
 
if UID exists and password is set 
uid <NEW_UID> <root passwd>  
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Eliminating paper 

Time and paper can be saved by the NMR facility by sending data back to its customers 
electronically.   The key to gaining customer acceptance of this is making data viewing 
easy for the customer.  A Windows computer can be set up to launch NUTS and load the 
spectrum when the user clicks on the file.  NUTS can now email a file, making this even 
easier for the NMR facility.  

NUTS must be installed on the customer's computer or on a server to which (s)he has 
access.  The file extension must be Associated with the NUTS program on the customer's 
computer.  This is done from the Windows Explorer by clicking on the file to select it, 
and then choosing Open With from the File menu.  This lets you specify the application 
which will be used to open this type of file.  The same thing can be done from most file 
managers, by selecting Associate under the File menu.  Now, when the user clicks on a 
file with this associated file extension, NUTS is launched and the data loaded.  (Of 
course, this requires that all NMR files have the same file extension.) 

NUTS can be customized to automatically display the data in different ways, depending 
on the customer's preference.   Customization can be done using the nuts.ini file and by 
creating an "auto-exec" macro, which is always run when NUTS is started.  For example, 
let's say the NMR facility processes the data, including defining integrals and picking 
peaks.  The file is saved and emailed to the customer.  The customer's copy of NUTS has 
been customized to run the following auto-exec macro: 

NUTSMacro for data display 
; read the file "tailer" 
ta 
; display integrals 
an 
; display peak labels 
^p 
; define zoom limits 
set zof1ppm 12 
set zof2ppm 0 
set displayzoom 
end 

When the customer clicks on the icon for the attached file in his email message, NUTS is 
launched, the spectrum loaded and displayed 12-0ppm with integrals and peak labels.   
(S)he is then free to examine, plot, etc. 

The NMR facility may prefer to send data directly from the spectrometer, rather than 
from a PC running NUTS.  This is complicated by the fact that most modern 
spectrometers do not save data as a single file, but rather as a directory containing 
multiple files and even multiple subdirectories.  A simple solution may be to export the 
data in JCAMP format, and email that single file to the customer.  The customer can 
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Associate the JCAMP file extension with NUTS, and the file will be automatically 
imported and displayed when the customer clicks on the file name or icon, as above. 

Basic 1D processing details 

Apodization - application of a weighting, or "window", 
function to an FID 

The time-domain signal (FID) of a lorentzian peak decays exponentially with time, due to 
relaxation.  The noise level is constant over the entire FID.  As a result, the signal-to-
noise ratio (S/N) is greater at the beginning of the FID.  The S/N of the resulting 
spectrum can be improved by "weighting" the beginning of the FID more heavily than the 
end.   This is done by multiplying the FID by a decaying exponential function. 

original 
FID 

FT 

exponential 
function     

after 
apodization 

FT 

Of course, you don't get something for nothing - the improvement in S/N comes at the 
expense of resolution.  The ability to resolve closely-spaced peaks requires "watching" 
for long enough to allow their sinusoids to diverge, so the later data points are necessary 
for resolution.  Application of an exponential function broadens peaks and can obscure 
small splittings. 

For example, the 2 sinusoids shown below differ by a few Hz.   
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If only the first 100 
data points are 
observed, they 
appear to be at 
identical 
frequencies, so are 
not resolved. 

 

They only begin to 
be distinguished at 
250 points. 

 

 

An exponential is the most common function in processing 1D spectra.  Other window 
functions are designed to enhance resolution, with some loss in S/N.   

original FID 
FT 

Lorent-
Gauss 
resolution 
enhancement 
function 

    

after 
apodization 

FT 

Applying a window function involves a trade-off between signal-to-noise and resolution, 
requiring an evaluation of the characteristics of the specific data and the information 
desired from it. 
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Applying window functions in NUTS 

This section describes the apodization options provided by NUTS.  

See also: Introduction to apodization,  Reference deconvolution, Creating custom 
window functions, interactive application of window functions 

Before applying a window function or doing an FT, the FID may need to be corrected for 
any offset from zero. 

BC -- Baseline Correction of the FID 

If the data is time domain data (FID), this command averages the last 10% of the points 
of a complex FID set and then removes that DC offset from each FID. (A different DC 
offset between the 2 channels can result in a glitch in the center of the spectrum, see 
example below.)  

Note that this command acts differently if the current data is a spectrum, rather than an 
FID.  

BA -- Baseline Average 

This is an alternative to BC for removing DC offset between the real and imaginary 
halves of the data.  Instead of calculating the average of just the last 10% of the data (as 
BC does), BA calculates the average of all data points, then subtracts this average from 
each point.  This command only makes sense for FID data. 

A quick way to see the shape of a chosen function is to open the FID to which it will be 
applied and execute the 21 command.  This sets the value of all data points to one.  Then 
apply the chosen function to see its shape. 

Note that some apodization functions are dependent on time, so the total shape applied 
depends on the acquisition time of the FID.  By contrast, the sine functions (MS) apply 
one half of a sine wave over the entire FID, regardless of the acquisition time. 

WV -- Window View 

This command allows interactive adjustment of parameters defining various window 
functions. The FID, the apodization function and the spectrum after apodization are 
shown simultaneously. Parameters can be adjusted and the new window function 
automatically applied, and the screen is updated. See details in the next section. 

LB -- Linebroadening 

This parameter defines the decay of the exponential weighting function applied to the 
FID with the EM command, to enhance signal-to-noise. The value for the linebroadening 
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(LB) must be set first. LB is set via a dialog box brought up by typing LB or selecting 
Conditions under the Process menu. The exponential multiplication is executed either by 
typing EM or by selecting it from the Window Functions menu within the Process menu.  

EM -- Exponential Multiplication 

Applies an exponential weighting function to the FID to enhance signal-to-noise. The 
value for the linebroadening (LB) must be set first. LB is set via a dialog box brought up 
by typing LB or selecting Conditions under the Process menu. The exponential 
multiplication is executed either by typing EM or by selecting it from the Window 
Functions menu within the Process menu. Note the other available window functions 
which are listed in this menu. 

The larger the value of LB, the faster the window function drops toward zero.   

         LB = 1 

  

        LB = 3 

GM -- Gaussian Multiplication 

Apodization function for Signal-to-Noise enhancement. This is similar to exponential 
multiplication (EM) but results in a Gaussian rather than Lorentzian lineshape. The 
amount of line broadening is set with LB. 

The GM command uses the following equation: 
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G(t) = exp[-(PI*LB*time)^2 / (4*ln(2)) ] 

Ref: equation [9], p543, in G.A.Pearson, "Optimization of Gaussian Resolution 
Enhancement", J.Mag.Res. 74, 541-545 (1987). 

Do not confuse this with Lorentzian/Gaussian resolution enhancement.  

As with EM, the larger the value of LB, the faster the window function drops toward 
zero.    

   

     LB = 1  

   

        LB = 3  

SG -- Shifted Gaussian  

Apodization function which is a gaussian shape centered at one-half the acquisition time.  
The shape is determined by the value of LB.  Larger LB results in faster roll-off of the 
function.  
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        LB = 1  

   

        LB = 3  

IG -- Incrementally Shifted Gaussian  

This is a gaussian function for 2D data, in which the center of the gaussian is shifted 
based on the slice number.  

LG -- Lorentzian/Gaussian resolution enhancement 

This command multiplies the FID by a function which combines a Lorentzian using a 
negative line broadening with a Gaussian. The composite function has the shape shown 
below. Two parameters must be specified before LG can be executed: LB (line 
broadening, the same parameter used by the EM command) and GF (Gaussian factor). 
LB must be negative for the Lorentzian/Gaussian function. If LB is set to a positive 
number, NUTS will use the negative of that value. GF is a number between 0 and 1 and 
defines where the maximum of the function will be, as a fraction of the acquisition time. 
(This is the same as the Bruker GB parameter). Reasonable starting values are LB = -1 
and GF = .3, and then adjust empirically.  

This command is also available from the Process menu under Window Functions. 
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Reference: A.G.Ferrige and J.C.Lindon, J. Magn. Reson., 37, 337 (1978). 

GF -- Gaussian Factor for LG command 

This is one of the 2 required parameters for Lorentzian/Gaussian resolution enhancement. 
It must be a number between 0 and 1. (If its value is set outside these limits and the LG 
command is executed, NUTS will reset the GF value.) The GF value sets position of the 
maximum of the Gaussian function, expressed as a fraction of the acquisition time. 

TF -- TRAF resolution enhancement 

Performed on a FID. The function has the shape shown below. The user must input a 
value for LB, which is an estimate of the natural linewidth. The TRAF function provides 
resolution enhancement with minimal loss of signal-to-noise.  

 

Reference: D.D.Traficante and D.Ziessow, J. Magn. Reson., 66, 182-186, (1986). 

JT -- S-TRAF resolution enhancement 

Performed on a FID.  The function has the shape below.  The user must input a value for 
LB, an estimate of the natural linewidth.  Shown below is LB = .3 
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MS -- Multiply Sine 

Multiply the reals and imaginaries by a window function which is the first half of a sine 
wave. Executing the command twice gives a sine squared window function.  These 2 
figures show the shape of sine and sine squared functions. 

     

 

The sine function may have a starting phase different from zero. This phase angle must 
be set with the S# command before MS is executed.  The next 2 figures show the shape 
of sine and sine squared functions with phase (S#) of 45. 
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The next 2 figures show the shape of cosine and cosine squared functions, which are sine 
functions with phase (S#) of 90. 
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This is also available from the Process/Window Functions menu. Note the other window 
functions which are available from this menu. 

S# -- Phase shift for sine multiplication 

Used in conjunction with the Multiply Sine (MS) apodization function. The phase shift is 
entered in degrees. This can also be set within a macro, for example, for 2D processing. 

The only valid values for S# are between 0 and 90, inclusive. Entering a value less than 0 
or greater than 90 will cause NUTS to set the value to 0 or 90, respectively. 

TM -- Trapezoidal Multiplication 

Multiplies FID by a trapezoidal shaped function defined by parameters T1 and T2. The 
first T1 number of points are scaled linearly from zero to one. The last T2 number of 
points are scaled linearly from one to zero to avoid truncation of the FID. Other points 
are unchanged. This command is available from the Process/Window Functions menu. 
Note the other available window functions which are listed in the menu, including sine 
multiplication (MS), Lorentzian/Gaussian (LG) and Traficante function (TF) for 
resolution enhancement. 

  

 

T1 -- Trapezoidal multiplication parameter 
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Defines the number of data points, starting from zero, to be scaled by the TM command.  

T2 -- Trapezoidal multiplication parameter 

Baseline correcting the FID 

Both real and imaginary parts of the FID should decay to zero by the end of the 
acquisition, but sometimes that "zero" level is not truly zero, and the offset may not be 
the same for both channels.  This mis-match creates a glitch in the center of the resulting 
spectrum. 

In the figure below, the red line is zero.  Note that the imaginary half of the FID (in 
green) decays to zero, but real half  (blue) decays to a value that is slightly above zero.    

 

 This "DC offset" appears to be small, but is large enough to create a significant "center 
glitch" after FT, as shown below. 

 

  

A BC command, issued before the FT, is used to adjust the DC level of each channel to 
real zero, and will eliminate the center glitch.  Below is the same data, processed with BC 
before FT. 
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Creating customized apodization functions 
DB -- Data to Buffer  

Copies current data to the convolution filter buffer. This is useful for creating and 
applying customized apodization functions. (Do not confuse this with the Add/Subtract 
buffer.) 

An apodization function can be created in different ways. One option is to build it within 
Nuts by first setting the current data points all equal to one with the 21 command. 
Alternatively, the ASCII import routine could be used to import a function created within 
a different application. 

Once an apodization function is created, it can be copied to the convolution buffer with 
the DB command. The function is then viewed with the Convolution View (CV) 
command and applied with the Convolution Apply (CA) command. The latter 2 
commands were created originally for use with functions created by the reference 
deconvolution operation (CF), but are also used for the general case of applying a 
function to an FID. 

The data stays in the convolution buffer until replaced by another file or until Nuts is 
closed. The data may be copied back to the current data file with the Buffer to Data (BD) 
command.  

BD -- Buffer to Data  

Copies contents of the convolution filter buffer to the current data set, replacing the 
current data. The buffer must first have been loaded with the Data to Buffer (DB) 
command. 

21 -- Convert spectrum to one 

Replaces all data points in the current spectrum by one. The current spectrum is lost. 
Note that the line may appear off scale vertically. If the line is not visible, reduce the 
vertical scale with the right scroll bar, the Page Down key or the < key. 
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This command is useful for creating customized apodization functions. Once an 
apodization function is created, it can be copied to the convolution buffer with the Data to 
Buffer (DB) command. The function is then viewed with the Convolution View (CV) 
command and applied with the Convolution Apply (CA) command. The latter 2 
commands were created originally for use with functions created by the reference 
deconvolution operation (CF), but are also used for the general case of applying a 
function to an FID. 

2L -- Convert spectrum to line 

Replaces the current spectrum with a line having a DC offset from zero. The actual value 
of the data points is 4096. The current spectrum is lost. Note that the line may appear off 
scale vertically. If the line is not visible, reduce the vertical scale with the right scroll bar, 
the Page Down key or the < key. 

This command is useful for viewing apodization functions to optimize parameters. Dual 
Display can be used to view a trial apodization function simultaneously with a FID by 
first reading in the FID, placing it in the Add/Subtract buffer with the AL command and 
typing DD. Then execute 2L, which puts a line on the screen, and apply your chosen 
apodization function. Each time you want to display a different function, first type 2L 
again to re-set the line. To apply an apodization function to a FID, you must first read in 
the FID. 

AD -- Add DC 

Adds a constant to all data points. Unlike DC, this command actually changes the data, 
not just where it is displayed on the screen. The amount added is equal to one-third of the 
difference between the largest and smallest point in the data set. 

See also window functions, reference deconvolution 

Zero-filling, shifting and shrinking data 
ZF -- Zero Fill 

This command doubles the 1D data size by adding zeros to the end of the current data set. 
If the number of data points collected is not a power of 2, ZF zero-fills to the next higher 
power of 2, rather than doubling the number of points. This is useful for resolution 
enhancement and in processing 2D experiments where few data points were collected. 
(Note that if the data size is not a power of 2, a zero-fill operation is automatically 
performed when an FT is executed.) 

If the FID has not decayed to zero, executing ZF will introduce a discontinuity, resulting 
in distortion of the spectrum. 



63 

 

When the FID shown above is zero-filled, a discontinuity is created, as seen below. 

 

After FT, the peak has "sinc wiggles" resulting from FT of the discontinuity. 
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To avoid this, a window function should be applied (usually exponential multiplication) 
to bring the end of the FID smoothly to zero before zero-filling.   

Normally, ZF is used on time-domain data.  If applied to frequency-domain data, the 
values of number of data points, sweep width and offset frequency are updated to be 
correct for the new data size. 

See also: Linear Prediction (LN)  

SH -- SHrink data 

Reduces the number of data points in a 1D data set. By default, the size is reduced by half 
the number of points, and the last half of the data is lost. This is (sort of) the reverse of 
zero-filling. The data can be reduced by a different number of points, as determined by 
the S@ parameter.  

S@ -- Shrink by 

Sets the number of data points by which the current data set will be reduced on execution 
of the SH command. If S@ is set to zero or a negative number, SH will reduce the data 
size by a factor of 2, its default operation. This default can be altered by setting the S@ 
parameter to a positive number. 

The particular situation for which this was added was 2D data consisting of a number of 
slices not equal to a power of 2, which had been automatically zero-filled out to the next 
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power of 2 by the spectrometer, introducing truncation artifacts. SH (with non-zero value 
of S@) can be used to discard the zeroed points, allowing Linear Prediction (LN) of the 
data to avoid truncation. 

  /2 -- Reduce spectrum by factor of 2  

The number of data points is halved, by discarding 25% of the points at each end of the 
spectrum.  This obviously only makes sense for frequency-domain data.  It is common to 
acquire data with a larger spectral window than needed, to reduce baseline artifacts.  This 
command allows the excess baseline to be discarded and the file size reduced.  The 
reported value for spectral width is adjusted.  The operation can be un-done with the 
following command. 

In the non-2-letter command mode, a parameter can be used to specify a different number 
of points to be discarded from each end, rather than using the default.   

The command brickwall is equivalent to /2. 

Note that the command behaves differently when applied to an FID. 

  *2 -- Expand data by factor of 2 

The number of data points is doubled by adding zeroes at each end.  This obviously only 
makes sense for frequency-domain data.  This is the inverse of the previous command. 

In the non-2-letter command mode, a parameter can be used to specify a different number 
of zeroed data points to be added to each end, rather than using the default.   

RD -- Rotate Data 

Performs a circular shift of data points a specified number of times. A circular shift 
means that a point is removed from one end of the spectrum, the data are shifted by one 
data point, and the point is added to the other end of the data. (Do not confuse RD with 
left shift (LS) and right shift (RS)). 

This is normally used for Bruker data from the Avance series of spectrometers (DnX 
models) which have been digitally filtered and "decimated" prior to saving the FID. The 
initial points of the FID are zero. A circular left shift must be performed before the FT. 
The number of points to shift is calculated from the Decimation Number found in the 
Bruker file header, but the user can change the number of points.  

When RD is executed directly, a dialog box appears allowing the user to adjust 
parameters. When RD is included in a Link or Macro, the default or last entered value is 
used, without prompting for user input. 
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Note that any zero-filling or apodization must be performed before the RD.   See details 
on how to process data with RD. 

See also: Special considerations for Bruker data 

LS -- Left Shift data 

Shifts the real and imaginary data left one point and assigns the last point the value of 
zero. 

RS -- Right Shift data 

Shifts the real and imaginary data right one point and assigns the first point the value of 
zero. 

Fourier Transform commands 

Conversion from time domain data (FID) to frequency domain data (spectrum) is 
accomplished via a forward Fourier Transform. There are 3 types of forward transforms, 
but NUTS should be able to determine which is appropriate for the current data set, and 
will apply the correct function when Fourier Transform (FT) is selected.    

FT -- Fourier Transform 

Does a forward Fourier Transform of the current data set. If the data set is real, a Real FT 
is performed. If the data set is complex, a Complex FT is performed. If the data is a 
complex interleaved data set (acquired as alternating real and imaginary points, rather 
than as simultaneous pairs), a Bruker FT is performed. 

Using the non-2-letter command mode, the type of transform can be specified by entering 
FT followed by one of the following arguments:  

complex 
complex_norotate 
complex_nosort 
hilbert 
inverse 
real 
sequential  

BT -- Bruker Transform 

Bruker data from older spectrometers (using the Aspect computer) are usually acquired 
using a single A-to-D converter, so real and imaginary points are acquired sequentially, 
rather than simultaneously. The data is sampled at twice the sampling rate and the data 
points are placed alternately into the 2 channels to achieve quadrature detection. 
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Therefore, the nth real data point and the nth imaginary data point are not acquired at the 
same time. This necessitates performing the FT differently. If the data set was converted 
properly, NUTS will correctly identify the data as "TPPI" (Time-Proportional Phase 
Incrementation) and typing FT automatically performs the appropriate transform. Typing 
BT forces NUTS to do a "Bruker Transform" regardless of how the data were acquired. 

See also: Special considerations for Bruker data  

DF -- Digital Filter and FT 

This command is an alternative to RD plus FT for digitally filtered data.   

First, some background:  Digitally filtered FIDs have zeroes at the beginning of the data, 
and FT creates a very wiggly baseline that requires very large linear phase correction 
(hundreds or more degrees).  To avoid this, the zeroes are removed by a cyclic rotation, 
performed with the RD command.  NUTS determines how many points to rotate from 
parameters found in the original data file. 

However, sometimes the information found in the data header is incorrect or insufficient 
for NUTS to determine the correct number of points.  The DF command examines the 
beginning of the FID to determine where the "real" start of the data should be, and 
calculates the linear phase correction needed, then executes an FT and applies that phase 
correction.  This will not work properly for all data, so users are advised to experiment. 

See also: Rotate Data (RD) 

TJ -- Transform JEOL 

JEOL spectrometers also have the option of acquiring data using a digital filter (see 
explanation for DF command, above).  Newer versions of the Delta software manipulate 
the data to compensate for the distorted ends of the spectrum.  The Delta software 
"knows" that 10% of the spectral window at each end will be distorted.  To avoid 
possible loss of peaks at the edge of the window, the spectral width actually acquired is 
increased automatically.  After the FT, 10% of the data points at each end are 
automatically discarded, so the resulting spectral width is the value originally input by the 
user.  However, this results in a reduction of the number of data points in the final 
spectrum from the user's settings.  For example, if the user sets a spectral width of 6000 
Hz and 16384 data points, the spectral width acquired will be (6000 / 0.8) = 7500 Hz.  
After FT, 10% of the data at each end is discarded, giving a final spectral width of 6000 
Hz, but the final number of data points is reduced to 13107.  This is a consequence of 
needing to perform the FT on data which is 2n number of points.  The digital resolution 
the user intended was 0.37 Hz/pt but the final spectrum is 0.46 Hz/pt.  Note that this may 
create problems in homonuclear 2D experiments if it is desired to perform 
symmetrization, as the number of data points is changed in the process. 
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The TJ command in NUTS performs the same operation as the Delta software does 
during processing.  As described above, the early data points are zero, but we have not 
identified a parameter in the data header that would let NUTS know how many points 
need to be cyclically rotated, using the RD command.  NUTS examines the early data 
points in the FID to determine where the "real" start of the data is.  An FT is performed, 
and then a linear phase correction is applied based on how many zeroed points were 
found at the beginning of the FID.  Lastly, 10% of the data points at each end of the 
spectrum are discarded. 

CT -- Complex Fourier Transform 

Forces NUTS to execute a complex FT, regardless of the nature of the current data set. 
Normally, it is better to use FT and let NUTS apply the type of Fourier Transform which 
is appropriate.  

RT -- Real Transform 

Performs a forward real Fourier transform of the current data set. Any data in the 
imaginary part of the current data set will be zeroed and ignored. Normally, NUTS 
correctly identifies when data are real and applies a real FT when the FT command is 
given. Typing RT will override this and apply a real FT regardless of the nature of the 
data.  

IT -- Inverse Transform 

Performs an inverse complex transform of the current frequency domain data set to 
generate an FID. 

HT -- Hilbert Transform 

Phasing 

NUTS offers several different tools for phasing, including automatic phasing routines that 
use Simplex optimization, phasing of the entire spectrum using the mouse, phasing using 
an expanded display of 2 spectral regions and applying specific numerical phase values.   

See the step-by-step instructions for the mouse-driven phasing routines, illustrated with 
screen captures.   

Summary of phasing commands:  

AP -- Auto Phase. Automatically adjusts zero- and first-order phase. 
QA -- Quick A Phase. Automatically adjusts zero- order phase only. 
QP -- Quick Phase. Automatically adjusts zero- and first-order phase. 
PA -- Phase A. Input zero-order phase correction to be applied with PC. 
PB -- Phase B. Input first-order phase correction to be applied with PC. 
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PC -- Phase Correction. Adjusts the phase of spectrum by the values in PA and 
PB. 
PI -- Incremented phase. Applies phasing equal to PA and PB multiplied by the 
slice number. 
PE -- Phasing Expanded. Mouse phasing routine using 2 expanded regions. 
PH -- Phasing using mouse. Left & right mouse buttons control A and B phase 
parameters. 
PS -- Phase Same. Applies previously determined phase correction to the current 
spectrum. 
TP -- Total Phase. Displays values of phase correction that have been applied. 
ZP -- Zero Phase. Sets both zero- and first-order phases to zero. 

See also: Phasing 2D data, Auto-phase details  

Often the best first step in phasing is to make initial phase correction using only zero-
order correction, until the phase is close to correct. This is most easily done either with 
QA (automatic phasing, zero-order only) or with PH, using only the left mouse button to 
apply zero-order correction.  Adjust phase until the spectrum has approximately the 
correct phase, then use PH or PE to make final adjustments. This avoids the possibility of 
inadvertently entering too large a value for the first order phase correction, resulting in an 
undulating baseline. (If that happens, use ZP to reset the phase and start over.) 

Spectral baselines can be improved and phasing simplified by adjusting data acquisition 
parameters so that the first-order phase correction needed is close to zero. This is done by 
adjusting the delay before the first data point is acquired (DE in Nicolet or Bruker 
software).  

Users who prefer up/down mouse movements to left/right mouse movements can select 
this in the NUTS.ini file. 

AP – Automatic Phasing 

QP – Quick Automatic Phasing 

QA – Automatic Phasing, zero-order only 

There are several ways to phase a spectrum with NUTS. The first way is to use the QP 
(Quick Phase) or AP (Auto Phase) command which adjust the zero- and first-order phase 
corrections. The 2 commands use slightly different algorithms, and one may work better 
than the other for any specific spectrum. These routines work well if there is a lot of 
baseline (no peaks) at the ends of the spectrum, if there is no DC offset for the spectrum 
and if the baseline is reasonably good. There is also an automatic phasing command 
(QA) which adjusts the zero-order phase only, which is best used to give a good starting 
point for additional phasing. If the phase obtained is not perfect using the automatic 
routines, manual phase adjustment becomes necessary. Automatic phasing does not work 
very well when the spectrum contains very narrow lines (eg., a 13C spectrum). A simple 
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way around this is to process the spectrum with 3-4 Hz of linebroadening, FT and phase. 
Then recall the spectrum, reduce the linebroadening, FT and phase using PS, which 
applies the previously determined phase parameters. 

PH - Mouse phasing  

The spectrum phase can also be adjusted using the mouse. The user can start the mouse 
phasing routine from the menu selection Process / Phasing by Mouse or with the PH 
command. This is usually applied to the entire spectrum at once, but can be used on an 
expanded region if that is the current display when the PH routine is entered. 

On entering the phasing routine a "reduced data point" display of the data will be shown 
to make screen updates faster. When the left mouse button is depressed, dragging the 
mouse left and right adjusts the zero-order (or A) phase of the spectrum. When the right 
mouse button is depressed, dragging the mouse left and right adjusts the first-order (or B) 
phase of the spectrum.  

By default, the phasing pivot point for the B correction is the left end of the spectrum 
display. However, the user can choose a different pivot point.  This can be done before 
entering the PH routine, or while in the PH routine. From the Nuts base level, hold down 
the left mouse button, place the cursor where the pivot point should be, and type P. While 
in the PH routine, place the cursor at the chosen pivot position, and (without pressing a 
mouse button) type P.   

When the phase is properly adjusted, the user types the <ENTER> key and the new phase 
adjustments for the spectrum are applied, and the PH routine is exited. Under some 
conditions there is a slight difference in the phase for the full data point spectrum and the 
"reduced data point" display. Repeating the PH command will usually correct the 
problem. 

The coarseness of the mouse adjustment of phase can be reduced by 3x by holding down 
the Control key while phasing.  A default setting can also be made in the nuts.ini file. 

See details below for to use PH. 

The PH routine was modified to allow a second-order correction to be applied.  When 
second-order phase correction is applied, the pivot point is always the far left edge of the 
spectrum, for simplicity.  To use this, type 2 on the keyboard while in the PH routine.  
Any mouse movement will result in application of second-order correction - Use 
Caution!  Pressing either mouse button returns to the normal mode of applying zero- and 
first-order correction.   

The values of zero-, first- and second-order correction are shown at the left edge of the 
screen during phasing. 

PE -Phasing expanded regions  
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The spectrum phase can also be adjusted with the Phase Expanded (PE) routine, in which 
2 regions of the spectrum are phased in turn. This is usually the best choice of phasing 
routine for larger data sets, especially to do a "touch-up" after automatic phasing, because 
it more easily allows careful examination of the phase. (Since the total phase is defined 
by 2 parameters, determining the correct phase in 2 spectral regions is sufficient to 
calculate the phase for the entire spectrum. This is similar to Bruker’s and Nicolet/GE’s 
cursor phasing process.)  

To begin, two regions of the spectrum are selected using the Zoom routine. First, display 
the entire spectrum using Ctrl-F. Then, enter Zoom, select a region by holding down the 
left mouse button and wiping across the spectrum. Type "1" to select this as region #1.  
(Don't expand the display to the selected region, just highlight the chosen region and type 
1.)  Then select another region and type "2". This defines the 2 regions to be phased.  

Now, exit Zoom and enter the Phase Expanded routine with the PE command. Region 1 
is displayed first by default. Press and hold the left mouse button and adjust the phase of 
region 1 with left and right mouse movements.  The pivot point (where linear correction 
is zero) is automatically set to the tallest peak in region 1.  Adjusting the phase with the 
left mouse button applies a zero-order correction to the entire spectrum. Then, press and 
hold the right mouse button and, likewise, adjust the phase of region 2. When both 
regions are adjusted properly, exit with an <ENTER>. The NUTS program will calculate 
and apply the proper A and B phase correction to the full spectrum. The selected regions 
will remain in effect until re-defined, they become invalid, or the NUTS program is 
exited. Typically, two regions with easy to phase peaks at opposite ends of the spectrum 
are selected for this operation. In some cases, care needs to be used to keep the B phase 
correction from getting too large (> 360 degrees) which results in an undulating baseline. 
You can check this by typing TP (Total Phase).  The B phase parameter should be small, 
and should definitely NOT exceed 360 degrees.  Should this happen, the Zero Phase (ZP) 
command can be used to reset the phases to zero so you can start over.   

The coarseness of the mouse adjustment of phase can be reduced by 3x by holding down 
the Control key while phasing.  A default setting can also be made in the nuts.ini file. 

See details below for how to use PE.  

For a series of spectra acquired with the same spectrometer conditions, the phase 
correction is usually the same for each. After the phase correction has been determined 
for one spectrum, use the PS (Phase Same) command to apply the same correction to 
subsequent spectra. Some minor adjustment may be necessary, which can be done using 
any of the above methods. 

PC -Specifying numerical phase values  

The spectrum phase can also be adjusted manually from the keyboard. The amount of 
phase correction for the A and B phasing parameters (zero- and first-order corrections, 
respectively; the pivot point is at the far left end of the spectrum) can be entered with the 



72 

PA or PB commands or from the Process / Conditions menu selection dialog box. After 
values for A and B phase correction have been entered, the PC command (or the Process 
/ Phase Correction menu selection) will apply those phase corrections each time the 
command is issued. That is, PC adds to any phasing which has already been done. The 
total amount of phase correction done to the spectrum will be noted in the Process / 
Conditions dialog box (view with the TP, Total Phase, command) and will be saved with 
the spectrum when the file is saved to disk. 

Some filters on Varian and JEOL spectrometers create spectra which cannot be phased 
with only a zero and first order phase correction. The NUTS phasing routines were 
modified to include a second-order phase correction.  In the non 2-letter command mode, 
the PC (and PhaseCorrect) command can take 3 arguments. The first argument is the zero 
order phase amount, the second argument is the first order phase amount and the third 
argument is the second order phase amount.  This takes practice! 

PI - Incremented phase  

Some solids multidimensional experiments (such as MQ-MAS) require a phase 
correction which is proportional to t1, rather than being the same for all slices. The PI 
command applies phasing equal to the values of PA and PB multiplied by the slice 
number.  PI can be used in the non-2-letter command mode to specify the phase 
correction on the command line.  If one argument is given, it is used as the A phase value 
when doing the phase incrementing. If two arguments are given they are used as the A 
and B phase values when doing the phase incrementing. If three arguments are given they 
are used as the A, B and C phase values when doing the phase incrementing.  

PI is also used in processing Bruker Sates-TPPI data.  These 2D data require inversion of 
every other slice, which can be done by setting PA to 180 and applying PI. 

The PI command was modified to implement diagonal peak suppression in COSY data 
(ref: The NMR Newsletter, August, 2000).  If the first argument is "-cosy", the command 
does a special case of phase incrementing that allows the diagonal of a 2D data set to be 
phased to the desired addition three arguments as above. 

Magnitude and Power Calculation 
MC -- Magnitude Calculation 

Computes the magnitude spectrum of the current data set so all peaks appear positive. 
Useful when data is not pure absorption phase. The magnitude spectrum is calculated as 

SQRT( Re2 + Im2 ) 

where Re and Im refer to the Real and Imaginary parts of the complex number, 
respectively. 
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Below are shown a contour plot of part of the HMQC spectrum of codeine, and the slice 
through the methoxy peak, processed with MC as the last step.  Compare to the same data 
processed with M2, below. 
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M2 -- Power spectrum 

An alternative to a Magnitude Calculation (MC). The power spectrum is calculated as  

Re2 + Im2  

where Re and Im refer to the Real and Imaginary parts of the complex number, 
respectively. 

Below are shown a contour plot of part of the HMQC spectrum of codeine, and the slice 
through the methoxy peak.  This was processed using M2 as the last step.  Compare to 
the same data processed with MC, above. 
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The M2 command actually does a calculation which converts a time domain signal 
directly to a power spectrum without the need for an FT. This will work properly only 
with standard complex data sets, not with real or Bruker TPPI data sets. This was done to 
speed up 2D processing. 

RO -- Square Root of data  

Auto-phasing 

The autophase routines (QA, QP and AP) were re-written to give faster and better 
results.  In the course of testing algorithms, several parameters for the AP command were 
created.  While in most cases, users have no need of these extended commands, they are 
available, and are described here for completeness. 

Each spectrometer generates characteristic distortions of phase and baseline, so finding 
an algorithm that works in all cases is difficult.  The user should experiment with 
commands and parameters to see what works best for his/her data. 

Part of the process involves a decision as to which data points are baseline and which are 
peaks.  One option is to ignore points at each end of the spectrum, which is useful for 
data that is digitally filtered, because these spectra commonly have badly distorted points 
at each end (see example).   
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In the descriptions below, "A" phase refers to zero-order and "B" phase refers to first-
order phase correction terms. 

QA adjusts only the zero-order phase parameter.  QP  

The AP and QP commands can take arguments, when executed in the non-2-letter 
command. mode.  They are described here for AP, but can be applied in the same manner 
with QP. 

QP is a subset of AP and therefore somewhat faster and slightly less accurate.   

AP ?  
will display possible arguments. 

AP log 
will do the AP process and log the steps the AP routine takes, written to a file in the 
current data directory. 

AP stepA # 
sets the initial step size for the zero order phase. 

AP stepB # 
sets the initial step size for the first order phase. 

AP A 
will phase only the zero order phase. 

AP look  
will exchange the current data for the automatically generated reduced data point data 
buffer used by the AP routine. 

AP enhanced # 
will set the AP routine to use advanced baseline detection when # is one. When # is zero 
the AP process will not use advanced baseline detection. This feature works better with 
spectra which having peak-free baseline at each end. 

AP IgnorePts # 
will set the number of points on each end to ignore in the phasing process to #.  By 
default (IgnorePts = -1) the AP process ignores 5% of the data points on each end of the 
spectrum. When the data set to be phased has peaks close to the ends it is better to set this 
number to the minimum allowed by the data's baseline. 

AP RMS # 
will set the number of RMS noise multiples to use in the advanced baseline peak 
detection mode. Default is 100 times. 
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AP Pts2Ave # 
will set the number of points to average when making the reduced data set for the AP 
process. The default value is zero which allows the AP process to automatically 
determine how much to reduce the data based on initial data sizes. QP reduces the data 
more than AP. If this argument is set to one, then the data is not reduced and the process 
is slightly better, but a lot slower. 

AP quality 
does not do an automatic phase process but returns the value used by the AP process for 
the quality of the current spectrum's phase. 

AP Simplex 
does the AP process using the Simplex method and creates a log to the current data 
directory. 

AP map 
sets the first order phase to -360 degrees and does a zero-order optimization.  It then 
increases the B phase in 10 degree steps and optimizes the zero order phase at each step 
until the first order phase reaches positive 360 degrees. It then corrects the current data 
set to the best phase values it found in this mapping process. This process also creates a 
log to the current data directory. 

Phasing using the mouse (PH) 

This subroutine allows the user to adjust the zero-order and first-order phase correction 
using the 2 mouse buttons. Users with a single button mouse should hold down the shift 
key, then press the mouse button when instructions call for use of the right mouse button. 
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Start with a spectrum that requires phasing. The first step is to set the pivot point, which 
is the point in the spectrum at which the first-order phase correction is zero. A peak 
located at the pivot point can be phased with only the zero-order phase.  
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To set the pivot point: 

1. Press and hold the left mouse button to display a full-window cross-hair cursor 
2. Place the cursor on a chosen peak (on the aromatics in this figure) 
3. While still holding the mouse button down, type P on the keyboard to set the 

pivot point. 

The pivot point can be set at the NUTS Base Level or from within the PH subroutine. 

  

Enter the PH routine by typing PH or from the Process/Phasing menu. Adjust the phase 
of the peak at the pivot point by holding down the left mouse button and moving the 
mouse left and right.  
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When that peak is correctly phased, phase another part of the spectrum by holding down 
the right mouse button and moving the mouse left and right. You can go back and forth as 
necessary to adjust both regions of the spectrum. Exit the PH routine and apply the 
correction by typing <ENTER>. 

Phasing with expanded display (PE) 

This routine allows adjustment of phase using an expanded display of 2 spectral regions 
to adjust the 2 phase parameters. The expanded display can provide a more detailed view 
for slight phase adjustments. 
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Starting with a spectrum which needs phasing, the first step is to define 2 regions which 
will be used for phasing. 

  

 

Enter the Zoom routine and select a region toward the downfield (left) end of the 
spectrum.  
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Select by holding down the mouse button and dragging. Do not expand to these display 
limits. 

Type 1 to assign this to be region 1. 

  

 

Choose a second region near the other end of the spectrum, again by dragging while 
holding down the left mouse button. 

Do not expand to these limits.  

Type 2 to assign this to be region 2. 
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Enter the PE routine by typing PE or from the Process/Phasing menu. The pivot point is 
automatically set to the tallest peak in this region.  (This is the point at which the linear 
correction is zero.)   

Press and hold the left mouse button. Region 1 is displayed, and its phase adjusted by 
moving the mouse left and right while holding down the mouse button.  This applies a 
zero-order correction to the entire spectrum. 
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Once Region 1 is phased, release the left mouse button and press and hold the right 
mouse button. (Users with a single-button mouse should hold down the shift key then 
press the mouse button when right mouse button operations are called for.) 

When the right mouse button is pressed, the display jumps to Region 2. Phase this region 
by holding down the right mouse button and moving the mouse left and right.  

You can go back and forth by alternating pressing left and right mouse buttons, until 
phasing looks correct for both regions. 

  



85 

 

Exit the phasing routine by typing <ENTER>. 

Baseline correction 

Linear baseline corrections 

NUTS has several commands for correcting baselines that need only DC correction 
and/or linear tilt.  (DC refers to an offset of the spectrum's baseline from true zero that is 
not dependent on frequency; in other words, the entire spectrum has the same offset.)  In 
most cases, the baseline also has curvature, so linear correction is not sufficient, and a 
polynomial correction is necessary.   

BC -- Baseline Correction of the spectrum 

If the data is frequency domain data (spectrum), this command averages the first and last 
64 points of the real half of the data and removes the DC bias and linear tilt between the 
start and end. This may or may not be sufficient to give good integration.   

Note that this command acts differently if the current data is time domain data (an FID).   

BF -- Baseline Flatten 

This removes the DC component of the baseline and any linear tilt within the Zoom 
frequency limits. This is done by averaging points at each end of the zoom region, the 
adjusting so that these average values are at zero.  The user can set the number of points 
to be averaged (with 2A) or use default values. 
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Data outside the Zoom frequency limits are adjusted, with DC correction only, to remain 
continuous with the Zoom region (see also FR).  Note that the display does not need to be 
expanded to apply BF.  The region just needs to be defined with the cursor or with Zoom 
subcommand F.  The same operation as BF can be performed within the Zoom 
subroutine using the B subcommand. 
See example of BF application below. 

FR -- Flatten Region 

This command is almost the same as BF, with one exception: 
In contrast to BF, data outside the Zoom frequency limits is not changed.  This can result 
in discontinuities in the baseline at both ends of the Zoom region.   One situation in 
which this is preferable is when baseline correcting and integrating selected regions of a 
spectrum.  The FR command can be used to correct a chosen region, without affecting 
integrals in any other part of the spectrum.  
See example of FR application below. 

2A -- Number of points to average 

Lets the user control how many points are used to by the BF and FR commands.  An 
entry of zero lets the program automatically determine the number of points to average, 
according to the following: 
If the selected region is more than 256 points then 16 points are used for averaging.  
If the selected region is less than 256 points and greater than 64 points then 8 points are 
used for averaging.  
If the selected region is less than 64 points and greater than 16 points then 2 points are 
used for averaging.  
If the selected region is less than 16 points then the end points are used directly without 
averaging.  
If the number of points set by the user is greater than the entire selected region then the 
entire selected region is averaged. 

This can be set in a macro using Set Points_to_average.  

BR -- Baseline correct Bruker digitally filtered data  

This command performs an operation similar to BC, but ignores the extreme ends of the 
spectrum when choosing points on which to base the correction.  This is needed with 
digitally filtered data, due to the distortion of the ends of the spectra.  By default, 2% of 
the data points at each end are ignored.  See details below, including description of 
additional options.  

JE -- Baseline correct JEOL digitally filtered data  

This performs the same operation as the BR command, but discards 5% of the data points 
at each end, instead of 2%, as with BR.  
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Correcting selected spectral regions 
BF and FR – Flattening a region of the spectrum 

It is important to understand the differences among the choices for baseline correction. 
The page illustrates the results of 2 similar commands, BF (Baseline Flatten) and FR 
(Flatten Region). Both remove DC and linear tilt within the current Zoom limits, but they 
differ in how the remaining parts of the spectrum are affected.  

Both commands act by adjusting the Zoom region to bring both ends of the region to 
zero. FR does not alter parts of the spectrum outside the chosen Zoom region. This can 
result in severe discontinuities at the ends of the Zoom region. BF avoids these 
discontinuities by applying a DC offset to the parts of the spectrum on each end of the 
Zoom region, such that the baseline remains continuous. It is important to understand that 
applying correction with BF will change the baseline of the entire spectrum, which will 
affect integrals. 

 

Start with a spectrum with a severely rolling baseline. 
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A small section of the spectrum is selected with Zoom. (Note that it is not necessary to 
expand display to these Zoom limits.) 

  

 

Results of applying FR. 
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Results of applying BF.  (Same spectrum and same Zoom limits.) 

See also: 

2A – To Average – This allows the user to specify how many points are averaged at each 
end of the Zoom region to determine the adjustment required to flatten the chosen region. 

FB – interactive polynomial baseline correction 

QB – quick (non-interactive) polynomial baseline correction 

BC – Baseline Correction – removes DC and tilt of the entire spectrum. 

ID - Baseline correction from within the integration subroutine.  A subcommand within 
integration allows DC and tilt to be corrected while viewing the integral trace.  If done on 
a zoom region, rather than the entire spectrum, the result is similar to BF, in that the other 
parts of the spectrum are adjusted to avoid baseline discontinuities. 

Polynomial baseline correction 

This section describes various options for correcting a curved baseline.  

Sometimes, only a linear correction is required - see options. 

In addition to linear and polynomial corrections, backwards linear prediction, which 
corrects distortions of the first few points in an FID, can be used to flatten the baseline. 
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The baseline can also be corrected from inside the integration routine, using the 
subcommand B.  See tips for correcting really bad baselines. 

FB -- Fit Baseline 

This command enters a subroutine which fits the baseline with a 5th order polynomial. 
As a starting point, NUTS selects a set of baseline points as follows: The spectrum is 
divided into 64 regions and those regions which contain just noise are selected. The data 
points within each selected region are averaged to give one point for input into the 
polynomial fit. The 64 selected regions are displayed in inverse video, usually red. The 
decision as to what constitutes noise is based on the RM multiplier value (same parameter 
as is used for peak picking). If the user finds that the regions being selected as noise are 
not appropriate, the RM value may be changed. The user can also select or un-select 
individual regions using the mouse. Place the cursor on a region of the baseline to be 
selected and click once with the left mouse button. This is a toggle process, so clicking on 
a selected region will un-select it.  The S subcommand selects all regions, and the user 
can then un-select regions containing peaks.  

By default, the FB routine divides the spectrum (or expanded region) into 64 regions (or 
fewer, if very few data points are displayed).  It is possible to override this, and specify 
the number of points in each region.  This can be used to define narrower baseline 
regions, useful when the spectrum is very crowded, with only small segments of baseline 
between peaks.  This is done in the non-2-letter command mode.  The FB command will 
accept either one argument, or 2 arguments.  The first argument specifies the number of 
data points in each region.  If there is a second argument, it is a multiplier for the RM 
parameter, used in the automatic determination of which regions contain peaks, and 
which are baseline.     

If an expanded region is displayed at the time the FB subroutine is entered, the fit will be 
confined to only that part of the spectrum. This allows a spectrum with very a distorted 
baseline to be corrected in sections. Be sure to execute a Ctrl-F first if the fit should be to 
the entire spectrum. 

For historical reasons, 2 options are available for calculating the best fit polynomial: 
Simplex and Least Squares. Results from the 2 methods appear to be indistinguishable, 
and the least squares method is more than 10 times faster.  However, sometimes the least 
squares method fails to converge, and simplex can be used instead.  

To initiate the fitting process, type C for Simplex calculation or L for Least Squares, both 
of which are available from the Edit menu. (Note that if Enter is typed before initiating a 
fit, the routine is exited without altering the baseline.) The equation used is a 7th order 
polynomial whose coefficients are adjusted to fit the spectrum. As the Simplex 
optimization proceeds, the results of each cycle are displayed. The Error is the square of 
the difference between the calculated curve and the curve formed by the set of input 
points. This is displayed so that the user can monitor the process as the Error function 



91 

converges to a minimum. The iteration can be stopped by typing Q. The coefficients of 
the calculated polynomial are printed on the screen at the end of the fitting operation. 

The calculated polynomial can be displayed by selecting Draw Polynomial from the 
Display menu or by typing P. The region selection can be changed and the fit 
recalculated by repeating the fit (C or L command).  

When satisfied with the calculated baseline, typing Enter will apply the correction and 
exit the FB subroutine. To abort the process and exit without altering the baseline, choose 
Quit from the file menu or type X.  

If the correction is made on a part of the spectrum, rather than the entire spectrum, there 
arises the question of what should be done to the rest of the spectrum.  If no adjustment is 
made to the data outside the displayed region, discontinuities may be introduced at the 
ends of the corrected region.  A logical way to address this is to apply a DC correction to 
the adjacent regions to avoid discontinuities.  However, that would result in changing the 
baseline, and therefore to the integrals, in parts of the spectrum other than the selected 
region.  The best choice in this case depends on the characteristics of the spectrum and 
the information being extracted from it, so NUTS allows the user to choose how this 
situation should be handled.   

The option to keep the baseline continuous, and avoid discontinuities, can be set in the 
nuts.ini file, with the following entry: 

CONTINUOUS_BASELINE = TRUE 

To prevent any changes to the spectrum outside of the displayed region, use the following 
entry in the nuts.ini file: 

CONTINUOUS_BASELINE = FALSE 

Changes to the nuts.ini file do not become effective until NUTS is restarted.  To change 
this option while NUTS is running, the following non-2-letter commands can be used: 

FB -c on 

enables the DC adjustment of the baseline to eliminate discontinuities. 

FB -c off 

disables the DC adjustment of baseline, so that regions outside the current display region 
are unchanged. 

These settings apply to both FB and FX. 
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It is possible to save a "mask" describing which regions of a spectrum should be used in 
calculating a polynomial baseline correction.  This would be used for automated 
processing of very similar spectra.  The user selects the regions in the usual manner, then 
saves those selections to a text file with the sub-command M or by selecting File/Save 
Mask on the menu while in the FB routine.  The mask is then applied with the FX 
command. 

If FB is used in a Link or macro, the automatically selected regions are used, the fit is 
calculated and the resulting correction applied, all without user interaction.  Normally, 
the type of fit used in this automated mode is polynomial fit using least squares.  
However, the user has the option of changing this to either Simplex polynomial fit or 
Fudge mode (equivalent to F subcommand).  This is set in the nuts.ini file. 

To perform polynomial baseline corrections in arrayed mode, use the FX command.  In 
arrayed mode, the FB command acts only on the displayed slice.  This is useful for 
correcting baselines of selected slices. 

FB also has the option of correcting the baseline by forcing each region to be flat by 
removing DC and tilt separately for each region.  This is done with the subcommand F 
(stands for "fudge").  This is useful when the baseline distortions are of too high order to 
be corrected with a polynomial.  See example.   

See details below for how to use FB. 

Subcommands:  

C -- Calculate Simplex fit to 5th order polynomial 
L -- Perform Least squares fit to 5th order polynomial 
F  -- Fudge baseline by correcting DC and tilt for each region separately  
3 -- Linear spline baseline correction 
A -- Apply default correction and exit FB 
M -- Save selected baseline regions as a "mask" to a text file 
R -- Read a previously saved "mask" file 
P -- Draw polynomial 
Q -- Quit Simplex optimization 
S -- Select all regions  
U -- Un-select all regions 
X -- Exit without applying correction 
<ENTER> -- apply correction and exit 

FX -- Fit Baseline 

Polynomial baseline correction that works in arrayed mode.   

For 1D spectra or when not in arrayed mode, FX is equivalent to QB.  It applies a 
polynomial correction to the displayed slice using default parameters. 
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When applied to a 2D spectrum while in arrayed mode, FX will execute a polynomial 
correction independently for each slice.  

When in the non-2-letter command mode, the FX command accepts an argument which is 
the file name of a "mask" file to use when calculating the polynomial fit.  The mask must 
first have been created in the FB subroutine.  The mask must be for the same 1D data size 
as the current data. If the mask was created while in a zoomed display mode, this 
command will use the same display region for the polynomial fit and NUTS will end up 
displaying that zoomed region when the command completes.  The mask can be applied 
to 1D or 2D data. 

Why use a mask?  More reproducible baseline correction can be obtained, useful in 
defining a protocol for processing QC data, to insure that the same conditions are used 
each time.  In the case of 2D data, the automatic selection of baseline regions can result 
in poor choice of baseline regions for some slices, causing serious baseline distortion.  
The recommended procedure is to examine slices using View (VW) to determine which 
regions represent "good" baseline throughout the dataset, and then use FB to select those 
regions and create a mask.  The mask is then applied with 

2f 
fx maskfile <ENTER> 
2n <ENTER> 

where maskfile is the file name supplied when the mask was saved to disk. 

By default, the "fx mask" command performs a polynomial fit.  This can be invoked with 
any of the following 3 equivalent commands:   

FX mask 
FX –p mask 
FX –1 mask 

Optionally, linear baseline “fudge” can be performed instead, identical to the FB 
routine’s F sub-command, with either of the following equivalent commands:  

FX –f mask 
FX –2 mask 

A third option is linear spline correction, identical to the FB routine’s 3 sub-command, 
with either of the following equivalent commands:  

FX –s mask 
FX –3 mask 

QB -- (or BASELINE) Quick Baseline correction  
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When executed as a 2-letter command, this performs a least squares polynomial baseline 
correction, just as would be done within the FB subroutine. There is no user interaction 
with this command. 

In the non-2-letter command mode, QB can take optional parameters and performs a 
different kind of correction.  If no parameters are given, then the routine automatically 
selects regions and corrects the baseline by a least squares fifth order polynomial.   If 
other parameters are supplied, QB performs a different type of baseline correction, 
involving "deducing" a baseline much as the user might do "by eye", and then subtracting 
that baseline from the spectrum.  To do this, the spectrum is divided into segments, and 
each segment is compared to the rms noise level to determine if it contains peaks.   

Use of QB for this type of correction takes up to 3 parameters, as follows: 

The first parameter specifies the number of data points for each segment into which the 
spectrum is divided.  (In the default QB and FB corrections, the spectrum is divided into 
64 segments).  A multiple of rms noise used to distinguish peaks from noise;  by default, 
this is the value of the RM parameter, set in the peak picking routines.  

If a second argument is entered, it is used as the multiple of rms noise, instead of using 
RM, to distinguish peaks from noise.  

The only valid value for a third argument is “show”, which displays the "deduced" 
baseline.  This action replaces the current data set with the deduced baseline. 

This correction is illustrated below. 

Illustrated example of polynomial baseline correction 

This subroutine calculates a 5th order polynomial fit to the baseline.    
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This is the most practical way to correct a baseline which needs more than simple tilt 
correction. 

Type FB or select Fit Baseline from the Process menu. 

 

On entering the subroutine, NUTS divides the spectrum into 64 regions. Those regions 
which consist of only noise are colored red.  
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The decision as to what constitutes noise is based on the RM multiplier value (same 
parameter as is used for peak picking). Regions can be selected or de-selected by clicking 
with the left mouse button. 

 

Perform a least squares fit by typing L or by choosing Calculate Fit from the Edit menu. 

The calculated polynomial can be drawn by typing P or selecting Draw Polynomial from 
the Display menu. 

If the match to the baseline is not sufficient, try selecting or de-selecting some regions, 
and repeat the fit. 
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Exit the routine with <Enter>, which applies the correction. 

Exiting the routine with X quits without applying the correction. 

See also:  QB -- Quick polynomial baseline correction.  This command performs the 
same least squares fit to a 5th order polynomial, but no user interaction is possible. 

Another option which works well in some cases is a "deduced" baseline. 

"Deduced" baseline 

Some baseline distortions arise from broad peaks due to exchangeable protons or a 
polymer component in the sample.  Even though they are "real", they can be undesirable 
and interfere with integration.  An example is shown here in the top trace. 



98 

 

A person can look at this spectrum and readily deduce where the "baseline" should be.   

The same process can be accomplished by software.  Some of the steps are similar to the 
procedure used by the FB routine.   

The process involves automatically distinguishing regions of just baseline from regions 
containing peaks, interpolating where the baseline should go underneath each peak, then 
subtracting this "deduced" baseline from the spectrum.   The process of determining the 
difference between noise and peaks requires an estimate of the noise level in the 
particular spectrum.  NUTS automatically determines the rms noise of the spectrum.  The 
spectrum is broken into segments, and a determination made as to whether or not each 
segment contains any peaks.  A segment of the spectrum is determined to contain a peak 
if its (maximum - minimum) value exceeds a defined multiple of the rms noise.  By 
default, Nuts will use as that multiplier the RM value (same as is used in peak-picking), 
but the user can specify a different value.   By default, Nuts divides the spectrum into 64 
segments, but the user can specify how many points each segment should contain. 

This correction is implemented in NUTS as a modification of the QB command.  When 
issued without parameters, QB applies a non-interactive polynomial correction, 
equivalent to that performed by FB using default parameters.   

To use the "deduced" baseline correction, the user must first place Nuts into the non-2-
letter command mode, by typing 2F.  There are 3 optional parameters: 
The first parameter specifies the number of points for each segment.  The smaller the 
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number, the more segments into which the spectrum is divided.  If no other parameter is 
specified, the current value of the RM parameter will be used to determine which 
segments contain noise. 
A second parameter can be specified, which is the value of the multiplier for the rms 
noise. 

When QB is used with 2 numerical parameters, the baseline is calculated and subtracted, 
and the current spectrum is replaced by the corrected spectrum.  (Users might want to 
enable Un-Do, to facilitate trial-and-error adjustment of parameters.) 

The lower trace in the figure above was obtained using the QB command with the 
following parameters: 

QB 32 8 

In this case, each segment contained 32 data points, and segments were determined to 
contain peaks if their (maximum - minimum) data values exceeded 8 times the rms noise. 

To examine the "deduced" baseline itself, the QB command is issued with the optional 
3rd argument of "show".  The result is shown in the lower trace.  The current spectrum 
has been replaced by this calculated baseline.  To apply the correction, the spectrum 
needs to be opened again and QB applied without the "show" parameter, or use Un-Do to 
back up one step. 
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Care in parameter selection is important to avoid distorting the low level lineshapes of 
peaks that can result in integration errors. 

Really bad baselines 

Some spectra have baselines that cannot be fit with a polynomial.  The options for 
working with such a spectrum are: 

1. Backwards linear prediction to correct the early points in the FID 
which are causing the distortion.  As many as 12 points may need 
to be corrected.  Experiment with parameters to obtain the best 
results. 

2. Divide the spectrum into multiple sections, and apply polynomial 
correction in the FB routine to each section separately.  The 
baseline curvature within each section may then be of sufficiently 
low order to be corrected.  The best procedure is to select each 
section of the spectrum using the Zoom subcommand F, specifying 
the sections by points, not by frequency limits.  For example, the 
first section would be point 1 to point n, and the second section 
would start at point n+1.  This should avoid discontinuities at the 
edges of each section. 

3. Humps can sometimes be removed by subtracting a "deduced" 
baseline.  See example in the previous section. 

4. Within FB, the F subcommand will remove DC and tilt for each 
selected region separately, forcing each region to be flat.   Note 
that this correction cannot be un-done.  This is illustrated below. 

Not all spectra can be corrected with a polynomial, such as the spectrum below.  The FB 
routine includes a "fudge" operation which can be used to improve the situation. 
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There is a "real" peak at -200ppm.   

  

 

Enter FB, use S to select all regions, then un-select the regions around -200ppm.   
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The F ("fudge") subcommand applies a DC-and-tilt correction to each region separately, 
forcing each to be flat.  The un-selected regions are corrected based on adjacent regions, 
to avoid discontinuities.  Once F is applied, it cannot be un-done.  It can be applied to 
part of a spectrum, but this will create discontinuities at the edges.  Note that the results 
of this type of correction are very sensitive to where the boundaries between selected and 
un-selected regions fall.  Integration of such a corrected spectrum should be viewed with 
skepticism!   
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Correcting baselines of digitally filtered spectra 

An artifact of digitally filtered data is an abrupt curve at the ends of the baseline.   

 

  

A tilted baseline, as seen above, is normally easily removed with the BC command, 
which removes DC offset and linear tilt by assuming that the ends of the spectrum are 
zero.  However, for spectra such as this, the ends are not zero and using BC results in a 
spectrum whose baseline is not truly at zero, as shown below:  
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The BR command performs an operation similar to BC, but disregards the ends of the 
spectrum, so that the correction is based on points that are really zero.  The result, seen 
below, is a much better correction. 
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By default, the BR command (or equivalent non-2-letter command Bruker) ignores 2% 
of the data points at each end.  A similar command, JE (for Jeol) ignores 5% of the data 
points at each end.   

The command has some additional options that can be invoked in the non-2-letter 
command mode.   

If the number of distorted points doesn't match the 2% or 5% defaults for the BR or JE 
command, it is possible to specify the number of points on each end to be ignored.   This 
requires 2 arguments: the first is "pts" and the second is the number of points to be 
ignored.  For example, to ignore 350 data points at each end, the command would be  

br pts 350  

It is also possible to replace the distorted end points with zeroes.  This requires 2 
arguments: the first is "ZeroPts" and the second is either 1 (to turn ON zeroing of the end 
points) or 0 (to turn OFF zeroing of the end points).  

To choose to zero the ends points,  

br zeropts 1  

This command does not change the spectrum, it simply selects the zeroing option for 
subsequent BR commands.  The result of the BR command with zeroing turned on is 
shown below:  
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Once zeroing of the end points is turned on, it remains on for subsequent BR (or JE) 
commands until turned off. 

Integration 
ID – Enter Integration routine 

NUTS includes a manual integration subroutine and an automatic integration function. 
This Overview is a description of the former. It is recommended that users read through 
this section, as the manual tools are often useful to supplement the automatic method. A 
summary of subcommands active in the integration subroutine is given below. Show me 
how to integrate. 

The currently displayed region can be integrated with the menu selection Process / 
Integrate, with the ID command from the NUTS base level or with the Zoom 
subcommand I. After entering the integrate subroutine, the displayed region will have the 
standard NMR integration line. The first time the integration routine is entered, the 
integral extends over the entire spectrum and is automatically scaled such that the integral 
will be full scale at the end of the display. Any changes which are made in scaling or by 
defining sub-integrals are retained when the integration routine is exited and re-entered. 
On entering the integration routine, the menu choices change to display commands which 
are active. All commands can be accessed using the menus, with the exception of those 
which involve using the mouse. The commands are also available as single-letter 
keyboard commands. 

Adjusting the integral scale -- The scroll bar on the left can be used to adjust the 
vertical scale of the displayed integral. If the integral display goes off the top of the 
display, it will wrap around to the bottom of the display.  Note that changing the vertical 
scale of the integral trace does not change the integral values. 

While in the ID routine, the Z subcommand brings up another scroll bar on the left to 
adjust the beginning level of the integral. A single <Enter> exits this offset adjustment 
routine.  

Plotting can be done from within the integration routine (P subcommand, or File/Plot 
menu selection).  Whether plotted from within the integration routine, or from the NUTS 
base level, the plotted spectrum will have the integral plotted on it as it appears on the 
screen.  

The ID routine is exited with the <Enter> key. 

Defining separate sub-integrals -- Certain of the integral routine commands are initiated 
by clicking the left mouse button to display a vertical cursor. For example, the integral 
trace can be broken into sub-integral regions of interest using this approach. Click the left 
mouse button once to produce the vertical cursor, click a second time at the beginning of 
the region to be integrated, and click a third time at the end of the region of interest to 
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complete the sub-integral. Repeat as needed. Once a single sub-integral has been defined, 
the integral is only displayed for defined sub-integrals. To toggle between this display 
and the entire integral, type F. The sub-integrals are not lost on exiting the integration 
subroutine. 

Setting integral values -- The value of a chosen sub-integral can be set to a user-defined 
value. Place the cursor on one of the sub-integrals (by clicking once with the left mouse 
button) and type V, which brings up a dialog box in which you can set the value of the 
selected sub-integral. Once a sub-integral value has been defined, each sub-integral is 
labeled with its value. The integral values remain unchanged until a sub-integral is 
explicitly set to a new value, regardless of changes in the vertical scale of either the 
integral trace or the spectrum. Setting the value of a sub-integral to zero removes all 
labels. 

The integral labels can be displayed vertically, which reduces overlap of the labels.  This 
can be set in the nuts.ini file, or while in the integration subroutine.  Integration 
subcommand V displays the labels vertically, subcommand H displays the labels 
horizontally.  Note that the V subcommand is also used to set the value of a sub-integral, 
but that command is only invoked when a vertical cursor is displayed and overlaps the 
chosen sub-integral, so there is no conflict. 

By default, the label appears just below the end of each sub-integral trace. The labels can 
be moved to the top of the screen by typing M. This is a toggle command, so typing it 
again moves the labels back to below the end of the trace.  

The integral font can be set with FI or by choosing Set Fonts from the Edit menu. (The 
user must exit the Integration subroutine to change the font.) Sometimes sub-integrals are 
so close together that the labels overlap, making them hard to read. To remedy this, the 
individual labels can be moved up or down slightly. Three positions are defined and are 
chosen with the keys 1, 2 and 3, as follows. Place the cursor on the sub-integrals whose 
label is to be moved (by clicking the left mouse button once). Typing 1 moves the label 
up slightly from its initial position. Typing 3 moves the label down slightly from its 
initial position. Typing 2 returns the label to its initial default position.  Show me how to 
adjust label positions. 

Removing sub-integrals -- Single sub-integrals can be deleted by placing the cursor on a 
sub-integral (by clicking once with the left mouse button) and typing D. At any time in 
the integral subroutine, typing C will clear the set of sub-integrals and display the entire 
integral.  Subcommand L will delete the last-created sub-integral.  

Saving integrals -- The positions of all sub-integrals and their values are saved with the 
spectrum, so that when the spectrum is recalled at a later time, these integrals can be 
displayed without having to be redefined manually. This information is saved in a file 
"tailer", meaning it is appended to the end of the file. See the description of file tailers for 
more information.  An example of the integration information contained in the tailer is: 

INTEGRALS 
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REL_VALUE = 3.755704e-006 
START_PT  START_PPM END_PT    END_PPM         VALUE   LABEL POSITION 
   809     7.560      951      6.636         5.593325    1 
  1540     2.801     1623      2.261         2.000000    1 
  1722     1.616     1767      1.323         1.923050    1 
  1769     1.310     1848      0.796         3.017987    1 
END_INTEGRALS 

The integral values listed in the VALUE column are the result of scaling all integrals by 
setting the second integral to 2.  Absolute comparison of integral values between different 
spectra is possible using the "REL_VALUE" parameter, which relates the absolute area to 
the chosen scaled value.  

Creating an integral list -- A list of all currently defined sub-integrals and their values 
can be placed into the clipboard for pasting into a document, for editing, printing or 
transfer to another application, such as a spreadsheet.  The list looks like:  

NUMBER          FROM           TO        VALUE             
   1          7.56 PPM      6.64 PPM      5.59 
   2          2.81 PPM      2.27 PPM      2.00 
   3          1.62 PPM      1.33 PPM      1.92 
   4          1.32 PPM      0.80 PPM      3.02 

This is accomplished with the Integration sub-command T. All sub-integrals are included 
in the list, whether or not they are currently visible on the screen. The T command orders 
the sub-integral regions from largest to smallest chemical shift, so the list comes out in 
order, regardless of the order in which the sub-integrals were defined. Once T has been 
typed, the list can be pasted into the Windows Notepad or any word processing program 
or text editor.  From the NUTS base program level, after exiting Integration, the IL 
command is another way to place the list of integrals into the clipboard.  Note that if 
changes are made to the integrals, the information in the clipboard is not automatically 
updated - it is necessary to do this manually.  Any text contents of the clipboard can be 
displayed on the NUTS screen by typing Ctrl-B (or CB), which is a toggle, so typing it 
again will turn off display of the text.  This can also be done from the View menu.  

The integral list can be created using either spaces or tabs to separate the columns.  With 
space-separated columns, when a fixed size font is used, the columns line up. (Best for 
pasting into Notepad).  Tab-separated columns are best for pasting into a spreadsheet 
program.  The choice is determined by a setting in the nuts.ini file, and can be toggled 
between the 2 options with the TB command. 

Flattening the integral -- If the integral is not "flat" enough, the region must have its 
baseline adjusted. NUTS provides several baseline adjustment options. Type <Enter> to 
leave the Integration routine, correct the baseline with one of the options described in the 
section on baseline correction. One more baseline correction option is available within 
the Integration routine, which lets the user correct DC offset and tilt while viewing the 
effect on the integral trace in real time. From within the integration routine, typing B 
enters this baseline correction routine. Press and hold the left mouse button. Moving the 
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mouse left and right performs a zero-order correction (DC level). The same operation 
with the right mouse button performs a first-order (tilt) correction. Type <Enter> to keep 
the correction or Q to quit, both of which exit the baseline correction routine to 
Integration. The correction is performed only on the currently displayed region. This 
function applies a correction to the spectrum, rather than just adjusting the appearance of 
the integral trace. Because the ends of the region are altered, this operation may have an 
effect on adjacent regions. Show me baseline correction within Integration. 

The easiest way to integrate an entire spectrum is to integrate expanded regions of the 
spectrum separately, in order to be able to see spectral details. Expand a region using the 
Zoom routine, enter the integrate routine and define the sub-integrals. Then either pan to 
another spectral region using the scroll bar at the bottom of the spectrum or exit the 
integration subroutine (with <Enter>) and select another expanded region. On re-entering 
the integration subroutine, the previously defined sub-integrals are still there and defining 
additional sub-integrals adds to those previously defined. After all sections are integrated, 
plot limits can be selected, the integrals displayed (using Ctrl-I) and the fully integrated 
spectrum can be plotted. 

N.B. If any of the options which involve baseline correction of only the currently 
displayed region are used, other regions of the spectrum are altered, and their integral 
values will change. It is preferable to baseline correct the entire spectrum with FB before 
beginning integration.  

The alternative is to integrate each section of the spectrum separately, copying the 
integral list to the Notepad for each section, and using the Notepad to build a complete 
integral list of the entire spectrum. While in the integration routine, copy the current 
region's integral information to the clipboard (T) and paste into the Notepad. Then clear 
the sub-integrals (C) before moving on to the next region. This is because whenever T is 
typed, all sub-integral information is copied to the clipboard, not just those in the 
currently displayed region. If baseline correction is applied to the current region, it will 
change the baseline (and therefore the integral values) in other parts of the spectrum. 
Clearing sub-integrals does not affect the integral scaling. 

Subcommands:  

Left Mouse Button Click -- Displays a vertical cursor. Used to define sub-
integrals and to select a sub-integral. 
V -- When typed while vertical cursor is displayed, brings up a dialog box 
allowing the user to sets the value of the sub-integral at the cursor location. If the 
value is set to zero, the integral values are not displayed. 
C -- Clears the sub-integrals, displaying one integral line for the entire spectrum. 
D -- Deletes the selected sub-integral in the sub-integral list at the cursor location. 
L  -- Deletes the last created sub-integral. 
Q -- Removes the cursor and aborts a sub-integral selection process. 
T -- Transfers the current sub-integral list to the clipboard for pasting into 
Notepad or other document. 
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R -- Read integral information from file "tailer". The integral information must 
have previously been saved with the file (see TA command). 
M -- Toggles location of the printed sub-integral label among the end of the 
integral line, the top of the page and the bottom of the page. Applies to both 
screen display and plot. 
1, 2 & 3 -- Moves location of the printed sub-integral label at the current cursor 
location to one of 3 vertical positions. Used to remove overlap of the labels of 
closely spaced integrals. Applies to both screen display and plot. 
V -- Displays sub-integral labels vertically 
H -- Displays sub-integral labels horizontally 
Z -- Brings up another left scroll bar to adjust the beginning level of the integral 
line. An <ENTER> removes the second left scroll bar. Another <ENTER> exits 
the Integration sub-routine. 
F -- Toggles between showing the sub-integrals and the full spectrum integral. 
B -- Starts an integral/baseline correction process to provide a zero order and first 
order correction to the integral display. A BF or FB command before entering the 
integration routine is recommended to get a flat integral. If these don't work, the B 
sub-command of the ID routine allows use of mouse movements to correct the 
integral display to make it flat. If the B sub-command is typed while displaying 
sub-integrals, the system is toggled to full integral display ( See F sub-command 
). Within this baseline correction routine, the baseline is adjusted as follows: 
Left Mouse Button Down -- Mouse movement left and right does zero order 
integral correction. 
Right Mouse Button Down -- Mouse movement left and right does first order 
integral correction. 
Q -- Aborts the process and ignores corrections made. 
<Enter> -- Applies the baseline correction and exits the B sub-command. 
See details below for how to use the B routine. 

Unlike other integral correction routines, doing baseline correction within the integration 
routine changes the baseline of the data, rather than just tilting the integral trace. The 
changes are permanent, not limited to the integral display. Because the integral is so 
sensitive to subtle baseline imperfections, this can be a very useful way to correct the 
baseline. 

AI -- Automatic Integration 

This command displays an integral of the currently displayed region of the spectrum, 
with the integral broken into integral regions, and labels each region with its relative 
value. This command is available from the Tools menu. It is advisable to correct the 
baseline (with FB) before attempting integration. 

When this command is executed while the entire spectrum is being displayed, any 
previously defined integral regions and scaling are overridden, whether they were created 
with AI or manually within the Integral Display (ID) subroutine.  If AI is executed while 
displaying an expanded region of the spectrum, only the displayed peaks are integrated.  
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The new integrals are added to any previously existing integrals, without changing the 
previously established scaling.  This allows a spectrum to be integrated piecemeal.     

NUTS determines which peaks to integrate, and where to break the integral in the 
following manner. The spectrum is divided into 256 equal segments (with the 
requirement that each segment contain at least 16 points; if not, fewer segments are 
chosen). A region must contain a peak exceeding the Minimum Height (MH) value are 
integrated.  Continuous segments with no peaks above MH are ignored.  The RM value 
can be used to change the sensitivity by which AI determines which segments have 
peaks.  

Starting from the left end of the spectrum, the first segment found to contain a peak will 
set the start of an integral region. Each subsequent segment will be included in that 
integral region if it contains a peak. When a segment is encountered which does not 
contain a peak, the integral region is ended. This procedure continues for the rest of the 
spectrum.  

The smallest integral so defined is assigned a value of 1 and all other regions scaled 
accordingly. Following automatic integration, it is possible to enter the Integral Display 
subroutine and make changes, such as deleting unwanted integral regions, defining new 
regions or rescaling by setting the value of a chosen region. See the description of the ID 
routine, above, for details.  

Display of the integral trace can be toggled on and off by typing Ctrl-I or selecting Show 
Integrals from the View menu. This works whether integral regions have been defined by 
either the automatic or manual methods. The commands AN and AF can also be used to 
turn On and Off the integral display, respectively. The latter 2 commands can be used in 
Links and macros. Ctrl-I is active at all program levels, including within subroutines. To 
use Ctrl-I in a Link or macro, use ^I. 

In the non-2-letter command mode, the AI command will accept some arguments: 

AI segments n - sets the number of segments the spectrum is divided into to look for 
segments which contain peaks. The default is 256 segments. 

AI show on - turns on a displaying mode showing segments identified as having peaks. 

AI show off - turns off the above displaying mode. 

AI show - toggles the above displaying mode. 

IL -- Integral List 

Transfers a list of sub-integral values to the clipboard, from which it can be pasted into 
the Notepad or other document for editing and printing. This is equivalent to the sub-



112 

command T within the Integration subroutine. All sub-integrals are included in the list, 
whether or not they are in the currently displayed region. 

Control-I -- Toggle on/off integral display 

This is the same as the Display Integral option under the View menu. This can also be 
accomplished with the commands AN and AF, which turn integral display on and off, 
respectively. To include this in a Link or macro, use " ^I ". 

Note that the Tab key executes a Ctrl-I, and so performs the same function. 

AN -- Turn on integral display 

Displays the integral trace. If integral regions were previously defined, either 
automatically (with AI) or manually in the ID subroutine, these regions will be displayed. 
Otherwise, the integral trace will encompass the entire spectrum. The integral trace can 
be turned off by typing AF. This operation can also be performed by selecting Show 
Integrals from the View menu or by typing Ctrl-I, both of which function as a toggle.  

AF -- Turn off integral display 

Removes display of the integral trace. The integral trace can be turned on by typing AN. 
This operation can also be performed by selecting Show Integrals from the View menu or 
by typing Ctrl-I, both of which function as a toggle.  

Illustrated example of integration 

Before attempting integration, it is usually necessary to correct the baseline, so that the 
integral trace is flat. See baseline correction commands BC, BF and FB.  

Other topics within Integration:  

Changing the position of the integral labels  
Baseline correction within the integration routine  
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Enter the Integration subroutine by typing ID or by selecting Integrate Display from the 
Process menu. 

A continuous integral trace is displayed covering the entire spectrum. If the integral goes 
off scale, it will wrap around to the bottom of the screen, as seen here at for the most 
upfield peak. 

The scroll bar on the left adjusts the vertical scale of the integral trace. 
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Defining subintegrals  

Click the left mouse button once to display a vertical red cursor. 

Place the cursor on one side of the chosen peak (either side is OK) 

Click the left mouse button again to define one end of the subintegral (green) 

Move the cursor to the other side of the peak and click the left mouse button again 

Notice that the location of the cursors is displayed at the bottom of the screen, along with 
the value of the subintegral being defined. 

 

As soon as the first subintegral has been defined, only subintegrals are displayed, not the 
full trace. (Display can be toggled between display of subintegrals and full trace by 
typing F, also available from the Edit menu.) 

Additional subintegrals are defined in the same manner. 

All subintegrals can be deleted using the C command. A selected integral can be deleted 
by placing the vertical red cursor on that integral and typing D.  
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To assign the value of a chosen subintegral 

Click the left mouse button once to display the vertical red cursor 

Place the cursor on the chosen subintegral and type V (Value) on the keyboard, which 
displays a box allowing a value for relative area to be entered. 
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Once a subintegral's value has been assigned, all defined subintegrals are labeled with 
their relative areas. These labels can be removed by setting the Value of any subintegral 
to zero. 

The displayed integral values remain unchanged, even if the vertical scale of the 
spectrum or of the integral trace is changed, until explicitly reset by the user. 

Subintegrals remain defined when the integration subroutine is exited, and even when a 
new data set is opened. 

As with all subroutines, typing <ENTER> exits the integration routine. 

Repositioning integral labels  

 

By default, numerical integral labels are placed just below the end of each integral trace.  
The labels can be repositioned to avoid overlap.   
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Each label can independently be moved vertically a small amount.  To do this, select the 
chosen integral by clicking the mouse button once to display a vertical red cursor, and 
placing that cursor on the chosen integral.   There are 3 vertical positions available, which 
are set by typing the chosen number (1, 2 or 3). 
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The above figure illustrates the 3 positions, 1,2 and 3, from left to right.  1 is just above 
the end of the integral trace.  2 (default) is just below the integral trace.  3 is slightly 
lower still.   

 

The labels can also be placed below the spectrum or at the top of the screen.  The 
subcommand M toggles among the 2 positions (end of trace, top of screen, below 
spectrum). 
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Using integral display for baseline correction 

When the integration line is not flat, it means the spectrum's baseline is not flat. This can 
be corrected using one of the NUTS baseline correction tools, but it can also be corrected 
from within the integration subroutine. The integral is very sensitive to slight tilt in the 
baseline, so viewing the integral while making the correction is often very helpful. It is 
important to understand that this operation does not just adjust the displayed integral 
trace to be flat. It actually changes the data, permanently.   

 

This spectrum clearly needs baseline correction. 
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On entering the Integration routine, the integral trace is far from flat. 

 

Enter the Integration baseline correction routine by typing B.  

The left mouse button controls zero-order correction (DC offset of the baseline, which 
appears as a tilt of the integral trace). 
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The right mouse button controls the linear correction (linear tilt of the baseline, which 
appears as a curved integral trace). 

Start by holding down the left mouse button and move the mouse left and right to try to 
make the integral trace flat in regions of the spectrum that have no peaks.  

Clearly, this baseline requires more than just zero order correction. 

 

Hold down the right mouse button and move the mouse left and right to try to make the 
tilt the same over the entire spectrum.  

The curvature that was evident above is now gone. 

Users with a single-button mouse should hold down the shift key and use the mouse 
button when the instructions call for use of the right mouse button. 

(Caution should be exercised when applying a linear correction, as large curvature can 
inadvertently be entered.) 
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The final correction is made with the left mouse button to remove the tilt seen in the 
previous screen.  

When a satisfactory integral trace is obtained, type <Enter> to exit the baseline correction 
routine and apply the correction to the spectrum. 

 

Notice how much flatter the baseline is than in the first screen. 
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It is important to understand that what this accomplishes is an interactive adjustment of 
the DC offset and linear tilt of the baseline of the spectrum.   If it is applied on a zoom 
region, rather than the entire spectrum, it will result in changes to the baseline of the 
entire spectrum, not just the displayed zoom region.  The DC and tilt correction will be 
applied to the currently displayed zoom region.  However, to avoid discontinuities in the 
baseline, the rest of the spectrum, on both sides of the current zoom region, will have its 
DC offset changed so that the baseline of the spectrum remains continuous.  As a result, 
integration values in the other parts of the spectrum will be changed.  This is similar to 
using the BF command. 

Zoom expansion routine 
ZO – Enter the Zoom subroutine 

The Zoom subroutine allows the user to expand a spectrum horizontally to view details 
more easily. That is, you can "zoom" in and out. The user can enter the Zoom routine of 
NUTS in several ways: from the menu View / Zoom selection, from the command line 
with the command "ZO" and by double clicking the left mouse button.  

Use of the Zoom routine is illustrated in the Introduction section, above. 

On entering the Zoom subroutine, the menu choices change to display commands that are 
currently active. All commands can be accessed from the menus, with the exception of 
those which involve using the mouse. 

Once in the Zoom subroutine, the mouse cursor changes into a small crosshair labeled 
ZO. While pressing and holding the left mouse button, "drag" the mouse and a region of 
the screen will be selected in inverse video. To jump to this expanded display, click the 
right mouse button or type Ctrl-E. The display window can be shifted left and right using 
the horizontal scroll bar at the bottom of the screen. The speed of this process depends on 
how many points are in the currently displayed region and on the speed of the computer. 
This may be impractical with slower computers. The horizontal scroll bar can be turned 
off in the NUTS.INI file.  

The right mouse button toggles between full and expanded display while in the Zoom 
subroutine. While viewing an expanded region, the left mouse button can be used to 
select a still smaller region, and the right mouse button will then jump to this new 
expansion (Zoom within Zoom). The user can switch the display (from the Zoom routine 
or the NUTS base level) using Ctrl-F for full display or Ctrl-E for the expanded region 
display. While in Zoom, a specific frequency range of interest can be entered from the 
keyboard by typing F, which brings up a dialog box for entry of frequency limits in 
points, Hz or ppm.  

The Zoom routine is exited with the <ENTER> keyboard key, returning the user to the 
NUTS base level. The current expanded region remains displayed on exiting Zoom.  
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Subcommands:  

B Baseline Flatten by removing the DC level and linear tilt between the zoom 
limits. See also correcting the baseline. 
F Brings up a dialog box allowing entry of specific points or frequency limits for 
the expanded display. 
I Enter the integral ( ID ) subroutine. <Enter> will return to Zoom from the ID 
routine. 
Ctrl-Z Zero the data in (reals and imaginaries) between the start of the Zoom 
region and the end of the Zoom region. See also zeroing data. 
1 Select current Zoom region for region 1 in PE phasing routine. 
2 Select current Zoom region for region 2 in PE phasing routine. 
0 - 9  Select the current Zoom region and assign it an identifying number 0-9.  
The region can be later recalled with the corresponding command Z0-Z9. 
Enter Exits the Zoom subroutine 

EZ -- Enter limits for Zoom regions 

Opens a dialog box for setting the frequency limits of the 10 Zoom regions.  This 
accomplishes the same thing as setting regions within Zoom using 0-9. 

Control E -- Expanded display 

Toggles the spectrum display to expanded display using the previously selected Zoom 
region. This is also available by selecting Type from the View menu. Control-F returns 
the display to the full spectrum. 

Control F -- Full display 

Displays the entire spectrum (all real points). To jump to an expanded display, using 
previously defined frequency limits, type Ctrl-E. These commands operate in all 
subroutines and from Base level of program. This is also available by selecting Type 
from the View menu.  

LZ -- Last Zoomed region 

Changes the left and right frequency limits to the previous values. This allows zooming 
in on a peak and then jumping back to the previous view. 

Z0 – Z9 – Display a previously defined spectral region 

Recall one of ten separate, previously defined zoom regions.  Up to 10 such regions can 
be defined, and those frequency limits saved for later recall.  The frequency limits are 
defined in one of 3 ways: 

1. with the EZ (Enter Zoom limits) command 
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2. within the Zoom subroutine using subcommands 0 - 9 
3. inside a macro with the command Set Zoom_Region 

Commands Z0-Z9 recall the corresponding region.  This is useful in designing automated 
processing. 

R0 – R9 – Register spectra 

This routine " registers" an arrayed set of 1D spectra, so that the chemical shift scale of 
all spectra is the same.  This would be used, for example, when a series of spectra are 
acquired without a field/frequency lock, resulting in the spectra not lining up properly, as 
shown here: 

 

First, choose a region of the spectrum whose largest peak will be used to align the 
spectra. The desired region is selected by setting the region while in ZOom with the # key 
where # is a digit between 0 and 9 (or, equivalently, by using the EZ command).  The 
corresponding R# command will find the tallest peak in the region, and left or right shift 
the remaining spectra to make the tallest peak in this region of each subsequent spectrum 
have the same chemical shift.  The ends of the shifted spectra are lost or set to zero.   The 
data set above now looks like:  
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This routine works in the non-arrayed mode or Complex Arrayed Mode.  

Y0 – Y9 – Sum block-averaged spectra 

These commands work in the Arrayed Mode only.  "Block averaged" data are collected 
as a series of 1D spectra and stored as slices of a 2D file.  The series of files needs to be 
summed to yield a single spectrum, but it is necessary to compensate for any field shifts 
that might have occurred during data acquisition, so that peaks line up correctly before 
being summed.    

In the Zoom routine, select a region containing a peak which can be used for chemical 
shift registration, and assign it to a numbered Zoom region using one of the Zoom 
subcommands 0 - 9.   Exit Zoom.  Execute the Y# command (# is a number with the 
same value as the chosen zoom region).  This performs the sum with appropriate 
adjustment so that the tallest peak in the chosen Zoom region lines up for each spectrum.  
The result will be a 1D spectrum, which has not yet been saved to the disk.  When the 
summing is complete, NUTS also exits the arrayed mode, because the data has been 
converted to a 1D file, and arrayed mode is no longer appropriate. 

The data set shown above results in this summed 1D spectrum: 
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Peak picking   
PP – Peak pick 

Commands and parameters that affect peak picking (details below):  

MH - Minimum Height, the threshold for selecting peaks 

RM - RMS noise parameter, to distinguish between a peak and noise 

ZL – Zero Peak Pick List, clears the list of peaks 

Ctrl-P -- Toggle on/off display of peak labels 

PN - Peak labels on, to display peak labels 

PF - Peak labels off 

CB or Ctrl-B -- Toggle on/off display of clipboard text on the screen (see also:  Notes 
subroutine)  

The Define Peaks subroutine provides more options for peak picking and labeling.  

This operation selects all peaks in the displayed region, indicating which peaks have been 
selected with vertical lines on the display. Peaks are selected if they meet 2 criteria: peak 
height must exceed the minimum height (MH) value and the peak must decrease by RM 
multiples of RMS noise after reaching a maximum. (This latter is to avoid picking 
multiple "peaks" for a broad peak in a noisy spectrum.)  

When PP is executed, a peak list is placed into the Clipboard. For example, 

Interpolated Peak Listing 
PEAK    POINT   HEIGHT    REL.HT    HZ       PPM 
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 1  1574    113459    43.49    776.17   2.586 
 2  1578    120172    46.07    768.21   2.559 
 3  1746    217882    83.52    439.81   1.465 
 4  1789    136120    52.18    356.09   1.186 
 5  1793    266988   102.35    348.20   1.160 
 6  1797    127982    49.06    340.29   1.134 

Height is peak height in absolute units, Rel. Ht is peak height relative to the tallest peak 
in the spectrum set to 100.  Peak frequency is reported in Hz and ppm. 

The peak list can be created using either spaces or tabs to separate the columns.  With 
space-separated columns, when a fixed size font is used, the columns line up. (Best for 
pasting into Notepad).  Tab-separated columns are best for pasting into a spreadsheet 
program. 

The choice is determined by a setting in the nuts.ini file, and can be toggled between the 
2 options with the TB command. 

When the file is saved, the peak list is saved in the file "tailer", so it can be recalled later. 

This information can be pasted into and edited or printed from any text editor or word 
processor, such as the Notepad. The peak list (or any other text in the Clipboard) can be 
placed on the screen (in the upper left corner, by default) using the Ctrl-B command, 
which displays the contents of the clipboard on the screen. The font for the clipboard 
display is set with FC, from the Edit menu or within the NUTS.INI file. The list will be 
easiest to read if the font is a fixed-width font, such as Courier, so that the columns line 
up. 

The PP command also displays peak labels on peaks. By default, the labels are placed at 
the top of the screen, but this can be changed in the nuts.ini file. The display of peaks is 
toggled off (an on again) using Ctrl-P. The peak labels can be edited and other parameters 
selected using the DP subroutine. The list can be removed with the Zero List (ZL) 
command. 

By default, NUTS uses interpolation to find the peak maximum, which gives a more 
accurate value for the peak frequency. The interpolation can be turned off from the dialog 
box which allows setting of the chemical shift reference. From the NUTS base level, 
press and hold the left mouse button and type O to bring up this dialog box. 

Peak frequencies or other text labels can be displayed above each peak. To do this, the 
peaks must be selected within the DP subroutine, rather than with the PP command. 

Setting the threshold (minimum height, MH) -- The Minimum Height value is 
expressed as a percentage of the tallest peak in the spectrum. The simplest way to 
determine the optimum value for MH is by using the cursor from the base level of NUTS 
(not in Zoom). Press and hold the left mouse button and place the horizontal cursor line at 
the height you want for the threshold and type M. Note that if Fixed Scaling (FS) of the 
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display has been turned on, setting Minimum Height with the cursor will not work 
properly. Minimum height may also be entered by typing MH, which brings up a dialog 
box and allows a value to be entered. If the peak selection misses peaks which have small 
splittings, try a smaller value of RM.  

As of  April, 2000, the MH command has been modified to allow use in the non-two 
letter command mode.  The command can be MH or MinHt.  If it has no arguments, then 
the standard dialog box comes up and allows the user to enter an MH value.  If it has one 
argument, that argument is converted to a number between zero and 100.0 and the MH 
value is set to that number.  If it has two arguments, and the second argument is "rms", 
then the MH value is set to the first argument times the current rms noise of the 
spectrum.    

Zeroing data 
ZE -- ZEro data set 

Replaces all data points with zeroes and the previous data are lost. A dialog box requests 
confirmation before executing. 

BZ -- Baseline Zero 

Zeros the region within the Zoom frequency limits without changing the rest of the data. 
Applies to both the reals and imaginaries. The Zoom subcommand ^Z (Control-Z) does 
the same thing.  

ZR -- Zero Reals 

Replaces the real half of the data by zeroes. Useful for some types of 2D processing. 

ZI -- Zero Imaginaries 

Replaces the imaginary half of the data by zeroes. Useful for some 2D processing. 

ZN -- Zero Negative points  

This command zeros all negative data points of both the reals and imaginaries. 

The Z subcommand of the View routine will zero all points in the displayed slice.  It does 
not ask for confirmation. 

See also:  editing 2D data 
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Miscellaneous tools 
FP – FID Play 

Creates a .wav file from the currently displayed FID and plays it through the computer's 
speakers. You may be surprised at how much you can tell about your data just listening. 
This works whether the data is an FID or a spectrum, but it only makes sense to use it 
with FIDs. This is only implemented on the Windows versions greater than version 
971106, not on the Mac or OS/2. Obviously, your computer needs to be equipped for 
sound.  

SR -- Spectrum Reverse 

Reverses spectrum right-to-left. 

RI -- Exchange Real & Imaginary data 

This can be performed on both FIDs and spectra. When performed on a FID, the 
spectrum after FT will look different, depending on whether the data were acquired by 
simultaneous acquisition of data points into the 2 quadrature channels or by sequential 
acquisition of data points alternately into the 2 channels (as is done on many Bruker 
spectrometers). In the former case, the spectrum will be reversed. In the latter case, 
artifacts will appear in the spectrum which resemble quadrature images. A flag can be set 
in the Nuts.ini file which causes RI to be executed automatically whenever data is 
imported. 

See also: Special considerations for Bruker data 

II -- Invert Imaginaries 

Performs a 180 degree phase shift on the imaginary half of complex data. This is useful if 
the sense of direction with the mouse movements while phasing seems backwards. If 
performed on an FID, this will reverse the resulting spectrum after FT. 

Ernst  -- Calculate Ernst angle 

A non-2-letter command to calculate the most efficient excitation pulse angle for a given 
total recycle time and T1 
 
ERNST <Total Recycle Time (sec)> < T1 (sec) > 

SN -- Signal to Noise 

Calculates the ratio of the tallest peak in the currently defined Zoom region to the RMS 
noise of the baseline.  The user must first define the zoom region, to be sure which peak 
is being used in the calculation.  Even if the entire spectrum is displayed (with Ctrl-F), 
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the calculation is performed on the tallest peak within the current Zoom frequency limits.  
Nuts automatically determines the RMS noise of every spectrum, so the user does not 
need to define a noise region.   

NF -- Calculate system noise figure 

Measurements must first be made as described: 

First replace the NMR spectrometer’s probe with a 50 Ohm metal film resistor. At the 
gain and frequency settings of interest for the NMR instrument take one scan of data with 
the resistor at room temperature and save the file with a file name like “HOT.NMR”. 
Cool the resistor in liquid nitrogen and take another scan and save this file with a file 
name like “COLD.NMR”.  

In NUTS, enter the NF command and follow the directions. NUTS will load the two data 
files and calculate the system noise figure. In the non-2-lettered command mode the user 
can also enter the name of the hot file as argument 1 and the name of the cold file as 
argument 2. 

More information on system noise figure can be found in the Application Notes section 

IV -- InValidate the data 

NUTS uses a sophisticated data compression algorithm to minimize the time required to 
display data on the screen. Occasionally, NUTS fails to redraw the screen following some 
operation. IV can be used to force NUTS to recalculate and redraw the screen.  

See also: UD  

XL -- Extract Line 

Extracts the real and imaginary sections of a spectrum defined by the zoom region such 
that the tallest peak in the zoom region is at the center of the NMR spectrum. Points 
outside the zoom region will be zeroed. This is useful in creating a reference 
deconvolution function. Show me how to use XL. 

XT -- Extract Spectral Region 

This command uses the currently defined frequency limits to extract a spectral sub-region 
from a spectrum. Use Zoom to set the frequency limits and type Ctrl-E to display the 
chosen region. On executing XT, this region is extracted. (Note that this may result in a 
data set whose size is not a power of 2). The values of Sweep Width, Offset and Number 
of Points are therefore modified. Show me how to use XT. 

This command was created for a specific problem, as described below, but is available 
for the user to implement for other uses as needed.  
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A set of kinetics data had been acquired over time on a spectrometer operating without 
lock. Some field drift occurred during the course of the experiment, so that successive 
spectra did not line up properly in a stacked plot. In each spectrum, the region 10ppm to 0 
ppm was selected after setting the shift reference, and XT was executed. Each resulting 
spectrum was saved under a new file name (using SB) with sequential file extensions. 
The complete data set was converted to a 2D file* and when plotted with SP, the peaks 
were displayed with the correct chemical shift and lined up nicely.  

* Viewing a series of 1D files is often best done with utilities available only for 2D files. 
(These utilities are available in both 1D and 2D versions of NUTS.) Converting a series 
of 1D spectra to a 2D file is simple, provided they have sequential file extensions (such 
as file.004, file.005, file.006, etc). Create and execute Link consisting of the command 
string  

GA SC IN  

NUTS will prompt for the file name for the first 1D file and for the file name for the 
resulting 2D file. To view the file, first read in the 2D file with GA.  

X0 – X9 – Extract pre-defined spectral region 

These 10 commands each perform an extraction (similar to XT command) of a region 
previously defined by the corresponding Zoom region (defined using 0 – 9 while inside 
Zoom, with the EZ command or by the macro command Set Zoom_Region).  To 
perform an extraction from inside a macro, use the Do Extract_PPM command. 

RE -- Resonance Elimination  

This subroutine can be used to remove a single, dominant, low-frequency resonance from 
an FID. This is done with a fitting routine, in which amplitude, frequency, phase and 
Lorentzian/Gaussian linewidth are adjusted to match the actual data. This can be useful to 
remove a residual water line in the center of a spectrum. Results depend heavily on 
having a good, symmetrical lineshape, but can reduce the water resonance by more than 
1000x in some examples.  Show me how to use RE.  

Subcommands, available from the Edit menu, are:  

D -- Delete (subtract) the calculated FID from the data  
E -- Edit the fit parameters 
F -- Perform fit 
R -- Reset parameters to default settings 
<ENTER> Exit the RE subroutine 

  
See also: Eliminate Dispersion component 

2S -- 2-Point Smooth 
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Performs a 2-point running average to reduce apparent noise in the currently displayed 
data set. This is useful, for example, to remove the "wiggles" at the base of narrow peaks 
following resolution enhancement. This command is available only as a keyboard 
command. A similar command, 3S, performs a 3-point smoothing operation. 

3S -- 3-Point Smooth 

Performs a 3-point running average to reduce apparent noise in the currently displayed 
data set. This is useful, for example, to remove the "wiggles" at the base of narrow peaks 
following resolution enhancement. This command is available only as a keyboard 
command. A similar command, 2S, performs a 2-point smoothing operation. 

SO -- Smooth 

This two letter command (non-2-letter command SMOOTH) was added to allow more 
flexibility in a smooth operation. With no arguments (or in the 2-letter command mode), 
a three point smooth is done. In the non-2-letter command mode, the first argument is 
used as the number of points to smooth.  An optional second argument is the number of 
times to repeat the smooth operation. 

CH -- Chloroform lineshape display 

Used for viewing the lineshape at the base of the peak. This command performs two 
actions: The frequency scale is adjusted to make the largest peak in the currently 
displayed region equal to zero (see SZ command) and the vertical scale is increased by a 
factor of 80. 

CL -- Chloroform lineshape 

Displays horizontal lines on the screen and plot at 0.55% and 0.11% of the largest peak in 
the currently displayed region. The command is a toggle, so entering it a second time 
turns off the displayed lines.  

With the lines displayed, the cursor can be used to read off width at each height.  

Advanced 1D Features 

Automation 

Command "links" 
LI - Linked Command Lists  

This section describes the use of "Links", a simple form of automated processing.  
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Sequences of commands can be strung together and executed with a single command. 
This can be used as a shortcut for frequently used command strings or for processing 2D 
spectra or a series of 1D spectra. The current version of NUTS provides for 10 such 
command strings, labeled L0 through L9. Typing LI or L# (where # is a number between 
0 and 9) brings up a dialog box and allows editing of the command strings. Spaces are 
ignored when the string is edited, but can be inserted to make the list more readable. The 
Linked Lists can be defined in the NUTS.INI file, in which case, their definitions are 
established each time NUTS is run. 

Note that the following description applies only for NUTS in the "2-letter command" 
mode.  Versions of NUTS newer than 5/15/99 have the option of longer commands, 
which requires that all commands be terminated with <ENTER>.  An explanation of 
modifying Links for this new command mode is given below.  See also detailed 
description of this new command mode in the Commands section at the beginning of this 
manual. 

A command string can be executed by clicking on the corresponding button in the dialog 
box and then clicking OK. Equivalently, the command string can be executed by tying 
the command A#, where # corresponds to the chosen L#. A simple example of a useful 
Link would be 

BC FT AP 

which performs baseline correction of the FID followed by an FT and then automatically 
phases the spectrum, with a single command. 

For processing 2D data or a series of 1D spectra, the Link is terminated with the IN 
command, which loops back to the first command in the Link and increments the slice 
number (for 2D data) or the file extension (for 1D spectra). By default, the link will 
continue to loop until no more files are found.   

It is possible to limit the number of times a Link is executed by setting the Link Limit. 
This can also be set for Links embedded in macros.  

Control characters in Links and Macros are input using the ^ character (shift-6). For 
example, ^I (to represent Ctrl-I) can be used to toggle integrals on and off. 

^M is used to execute a carriage return, as is needed to exit a subroutine.  

To import data in a Link, use the IM command, rather than GA. 

When using GA in a Link where File A is a 2D file, always execute a GA manually just 
before executing the Link. The reason for this is to force NUTS to read the file header so 
that all parameters will be set correctly.  

Packing 1D spectra into a "2D" file 
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The following link will create a 2D file from a series of 1D files.  The 1D files must have 
sequentially numbered file extensions. 

GA SC IN 

NUTS will prompt for the first in the series of 1D files to be read, and then will ask for a 
file name under which to save the 2D data file it will create.  It will stop when it cannot 
find the next file in the series.  The new 2D file must be opened to view the data. 

L0 - L9 -- Edit Link 

Displays the current links (command lists) for examination and editing. A chosen 
sequence is executed with the command A#. These command sequences can also be set 
in the NUTS.INI file.  

A0 - A9 -- Execute Link 

Executes the commands in the corresponding link. The links have default values which 
are set by the NUTS.INI file. If there is no NUTS.INI file or if the links are not set in the 
NUTS.INI file then all links are set to 

BC EM FT PS 

To edit one of the links, type L# (eg., L8 ). This opens up a screen showing the current 
definitions of all 10 links and allows them to be edited. Spaces make the list more 
readable and are ignored. 

IN -- INcrement slice number or file extension 

Used in Links for incrementing file names and looping back to the beginning of the Link. 
It is always the last command in a Link which is executed multiple times. IN behaves 
slightly differently depending on whether the files being read and written are 1D or 2D 
files. When the file is a 1D file, IN causes the file extension to be incremented. When the 
file is a 2D file, IN increments the slice number. When all files or slices have been 
processed, the IN command beeps and exits the link. 

By default, the Link will be repeated until NUTS fails to find the next file or slice. 
However, it is possible to limit the number of times the Link is executed by specifying a 
Link Limit in the Link dialog box. For Links embedded in macros, this is set with the 
command  

Set LinkLimit 

See also: 2D Processing  

IA -- Increment slice for file A 
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Advances the slice counter of a 2D file.  This command was created for use in processing 
interleaved hypercomplex (States type) 2D data, in which pairs of FIDs are processed, 
then combined. After the first FID of a t1 quadrature pair has been processed, the counter 
must be incremented before reading in the second FID. After the reconstructed t1 
interferogram is stored with ST, the linked command list is terminated with the IN 
command, which both increments the file counter and loops back to the start of the link.  

In Arrayed Mode, the IA command advances the slice counter and makes that the current 
slice.  

IE -- Increment file Extension 

Used in Links to increment the file extension. This operates on FileA and FileB. This 
should not be confused with the IN command, which both increments the file extension 
and loops back to the start of the Link. If all files are to be processed in the Link, the IN 
command is used. The only time one might use IE is to perform multiple increments 
within a single loop of the Link. 

For example, start with a series of 40 1D files with sequential extensions. The user 
decides he/she only wants to process every other file. The link would then look like 

GA BC EM FT SC IE IN 

The 2D file created by this Link would have 20 slices, corresponding to every other file 
from the 1D series. 

(Added 8/21/00)  When used in the non-two-letter command mode, IE (or IncrementExt) 
can now take arguments. With no argument, the command acts as described above 
(increments the file extensions of FileA, FileB and the Import File name if they have 
numerical file extensions which can be incremented).  The new functionality allows the 
use of arguments.  If IE is followed by either "A" or "B" with no second argument, then 
the extension for file A or B, respectively,  will be incremented by one.  If there is a 
second argument it will be used as the amount by which the file extension is incremented. 
If the second argument is "2" the file extension will be incremented by 2, etc. Negative 
numbers are allowed as long as the decremented (negative increment) extension will be 
greater than zero. 

IE [A or B] [amount] 
IncrementExt [A or B] [amount] 

It is important to understand the subtle distinction between the commands "IA" and "IE 
A".  IA increments the slice counter of a 2D file to the next slice.  "IE A" changes the 
current name of file A by incrementing its file extension (provided file A's name has a 
numerical file extension). 

The use of IE in this mode is illustrated in a sample macro below. 
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EI – increment extension for file export 

A separate file name can be set as the target for file exports.  The EI command is used to 
increment the numerical file extension, so exporting a series of files can be accomplished 
in a Link or Macro 

Using Links in non-2-letter command mode 

When NUTS is operating in the new command mode, which allows use of commands 
longer than 2 letters, Links must be modified to tell the program to insert <ENTER> after 
each command.  This is done by inserting a comma after each command.  Spaces 
between commands are ignored.  For example, the following link will run correctly in the 
new command mode: 

Macros 

NUTS has the capability of executing a series of commands contained in a text file.  
Sample macros can be found in the Help files and on the web site, 
http://www.AcornNMR.com/NutsHelp/sample_macros.htm 

RU – Run macro 

The macro is executed from the File menu or using the keyboard command RU. Several 
sample macros are available.  Note that these sample macros require that NUTS be 
operating in the 2-letter command mode.  The newer command mode, which allows use 
of commands longer than 2 letters, requires that each command be terminated with 
<ENTER>.  Commas must be inserted following each command, which NUTS will 
interpret as an <ENTER>. 

The text file can be created in the Windows Notepad or any word processor and saved as 
an ASCII file. To execute a macro, type RU or choose Run Macro from the file menu. 
For convenience, the macros can be mapped to Control-Fx keyboard keys. The 
assignments are made in the Nuts.ini file. A macro can also be executed automatically 
when Nuts is started. The macro to be run is set in the Nuts.ini file, with a line such as 

AutoExecMacro = C:\NUTS\MAC\GET_EB.MAC 

The first line of a NUTS macro must be  

NUTSMacro 

A line can be any valid NUTS command or command string, the same as those used in 
Links. NUTS will ignore blank lines or any line which starts with a space or semicolon. 
The last line of the macro should be END. 
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NUTS looks at the first word on each line of a macro and expects to find either a valid 
NUTS command or SET, ASK, DO, LOOP, IF (new as of 4/05), GOTO (new as of 
4/05), CALL or QUESTION, as described below. 

Set is used to set the value of some parameter. The format of the Set command is 

Set parameter [value]  

Some parameters require a value to be specified; others do not. For a list of valid 
parameters, see below. 

Ask is used to request user input. The format of the Ask command is: 

Ask parameter     where "parameter" can have one of the following 
values: 

FileA, FileB, FileC, FileImport, ExportFile, Shift, SL, LB, GF, T1, T2 and 
S# 

When a value for SL (2D slice number) is entered with the Ask operation, the slice will 
be read with the next GA command, not immediately. 
When a value is entered for Shift, the shift value is not set until a PR command is 
executed.  PR sets the largest peak in the displayed region to the value which the user has 
previously entered. 

Do is used to perform an action.  The following are valid uses of Do in a macro: 

Do DeleteFile filename    This   deletes a file with name "filename". 
Wildcards are allowed. Note that NUTS does not ask for confirmation, so 
use with caution! 

Do Extract_PPM f1 f2     This is used to perform an extraction of a 
spectral region defined by f1 and f2 (in ppm).  This is similar to the XT 
command. 

Do Sleep    This command causes the macro to pause.  The amount of 
time must first be specified with Set Sleeptime x, where x is time msec. 

Do increment_lf_get_filename    Increments file extension for file used 
by LF routine to open an existing file. 

Do increment_lf_write_filename    Increments file extension for file used 
by LF routine to write a file. 

Do increment_export_filename  Increments file extension for file used 
by export commands 
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Do Math -- performs Math functions.  There are numerous commands that 
perform automated calculations.  These are described in the Math section.  

Loop is used to execute several lines in a macro a certain number of times.  The format is 

Loop x y      where x is how many times the loop is executed, and y is how 
many macro lines comprise the loop 

IF is used to allow the macro to do a conditional branch based on the value of a specified 
parameter.  At the moment (July 2008), the only parameters that can be used with IF are 
solvent and nucleus.   

An IF statement can be used to either execute or skip the line immediately following. In 
the macro below, the first few lines place the solvent name (text string) into a text buffer. 
The IF statement tests whether that text buffer is equal to "cdcl3". (The keyword "strcmp" 
is derived from the C programming function to compare text strings.)  If it is, the macro 
executes the line after the IF statement (sets the tallest peak to 0 ppm in the example 
below). Otherwise, that line is skipped. Note that this operation is case sensitive! 

NUTSMACRO  
2f 
solvent, 
2n, 
if strcmp cdcl3  
SZ 
end 

Currently, the only other use of IF is for nucleus, as shown here. The first 3 lines put the 
current nucleus name into the text string buffer.  In this example, if the nucleus is 13C, 
the linebroadening is set to 2 Hz. 

NUTSMACRO  
2f 
nucleus, 
2n, 
if strcmp 13C  
set LB 2 
end 

GOTO can be used to jump to a specific line in a macro. The destination of a GOTO 
may be either before or after the GOTO. The label must begin with a colon (:). For 
example, in the macro below, the FT command is skipped. 

NUTSMACRO  
; the program will jump to the ":theend" label  
; and bypass the ft command 
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goto theend 
ft 
:theend 
end 

Call is used to launch an external program.  NUTS calls a .pif file, which must be 
"windowed" (no window will be shown).  When specifying the path for the .pif file, all 
backslashes must be doubled.  This is available on in the Windows version of NUTS.  
Example: 

call c:\\copyfile.pif 

Question  – It is possible to have a macro pause during execution to display a question 
and wait for user response.   
Each question needs to start with one line which is "QUESTION".   The following lines 
are for the question - up to 15 lines - then four addition lines 

First line starts with YES_BUTTON <desired action> 
Next line starts with NO_BUTTON <desired action> 
Next line starts with CANCEL_BUTTON <desired action> 
4th and LAST line needs to be END_QUESTION 

<desired action> can be one of three things 

1. ABORT 
2. CONTINUE 
3. New macro name to start 

Sample macro: 

nutsmacro  
QUESTION 
Click YES to continue the macro execution with the next line after this 
question. 
Click NO to abort the macro execution. 
Click CANCEL to abort the macro execution. 
YES_BUTTON CONTINUE 
NO_BUTTON ABORT 
CANCEL_BUTTON ABORT 
END_QUESTION 
ft 
end 

Control characters in Links and Macros are input using the ^ character (shift-6). For 
example, ^I (to represent Ctrl-I) can be used to toggle integrals on and off. 
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^M is used to execute a carriage return, as is needed to exit a subroutine.  

Sample macros are supplied which can be used as a starting point for creating customized 
macros. When writing a new macro, it is advisable to test each new part (by commenting 
out parts not needing testing) to be sure it does what the user expects. The display is not 
updated during macro execution (to save time), so it is not possible to see the results of 
each step (although commands are echoed on the command line); hence the 
recommendation for testing. 

Some of the sample macros perform operations which result in files being written at 
intermediate stages. The macro sets default names for these files so the user does not 
need to enter them. Any such macro will overwrite those files the next time it is run, so 
files which the user wishes to save must be renamed before the macro is run again. 

Adhering to two rules in writing macros will help avoid problems: 

1. Always follow "Ask FileA" (or "Ask FileB") with a line consisting of "GA" (or "GB"). 
See explanation below. 

2. When using GA (or GB) in a Link where File A (or File B) is a 2D file, always 
precede the Link with a line consisting of "Set SL 1". The obvious reason for this is to be 
sure the slice pointer is set to the beginning of the 2D file. See complete explanation 
below. 

Sample macros are included with NUTS and are in a subdirectory of the NUTS directory 
called mac.  

Rule 1: 

When using the Set command to specify a file name, the default path name is the current 
working directory. The current working directory is established each time a GA or GB 
command is completed. Therefore, executing a GA after an Ask FileA command: 

Ask FileA 

GA 

establishes the working directory, and subsequent Set File commands will use that 
directory. 

If the user wants to specify a different path for a file in a Set command, use  

Set FullFileA name 

Note that if a new path is specified for file A or B, the working directory will be changed 
when a GA or GB command is next executed. 
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Rule 2: 

The user needs to be aware that the command GA (open file A) when applied to a 2D file 
behaves slightly differently in macros or Links from when it is entered directly. The 
difference lies in whether NUTS reads just a slice of the 2D data or reads both the slice 
and the data header. While in a Link (either by itself or within a macro), NUTS reads the 
data header only once, for the first slice. This makes reading subsequent slices faster. 
When GA is used to read a 2D file in a Link, NUTS assumes that the user loaded the first 
slice manually (with GA) immediately before executing the Link. This reads in the file 
header and all is well. If the same Link is embedded in a macro, NUTS can be forced to 
read the file header by inserting the following line just before the line containing the 
Link: 

Set SL 1 

FF - Find File 

This command allows batch processing of an entire directory of NMR data files.  This 
only makes sense if used in a macro, such as the following: 

NUTSMacro batch processing 
ff ft sa in 
end 

When the macro is executed, NUTS will ask for a file to open.  By selecting a file, the 
user defines the directory whose data is to be processed in batch mode.  NUTS will 
attempt to identify and open each file in that directory.  If a file is encountered that cannot 
be opened, NUTS will display an error message, then continue.  The processed data is 
saved into a subdirectory of the chosen directory called _Target. 

Some spectrometer software (eg, Varian) does not save data as a single file, but as a 
directory which contains several files.  The FF command will open each subdirectory of 
the selected directory and look for identifiable NMR data files, and will import any it 
finds.  This does not work with Bruker XWin data, because the fid file is 2 directory 
layers down. 

The FF command can run into initialization/de-initialization problems if it does not 
complete its operation of opening every file in the directory.  A FF command line 
argument (reset) can be used to force the FindFile status to be de-initialized. 

SET parameters 

Parameters that can be set in macros with the SET command.  

File names:  

FILEA File A; current working directory will be used; See note below 
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FILEB File B; current working directory will be used; See note below 

FILEC File C; current working directory will be used; See note below 
(File C is used for 2D processing) 

ExportFile Name of file to be exported by E1, E2, E3, E4 or E5 
command. 

FILEIMPORT To set the file name of data to be imported 

FULLFILEIMPORT To specify a complete path name for data to be 
imported 

FULLFILEA To specify a complete path for File A; See note below 

FULLFILEB To specify a complete path for File B; See note below 

FULLFILEC To specify a complete path for File C; See note below 

LF_GET_FILENAME  To specify filename used by LF routine to read 
an existing Lines file 

LF_WRITE_FILENAME  To specify filename used by LF routine to 
write a Lines file 

Display:  

DC To set the DC (vertical display) offset of the data  

DISPLAYALL Display both real and imaginary points 

DISPLAYFULL Display real points 

DISPLAYIMAG Display imaginary points 

DISPLAYZOOM Expand spectrum to previously set frequency limits 

Fonts:  

FONT_AXIS +10 To change the font size of the clipboard displayed on 
screen (in this case, by one point) 

FONT_CLIP +10 To change the font size of the clipboard displayed on 
screen (in this case, by one point) 
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FONT_PEAK_HORIZONTAL +10 To change the font size of the 
horizontal peak labels (in this case, by one point) 

FONT_PEAK_VERTICAL +10 To change the font size of the vertical 
peak labels (in this case, by one point) 

FONT_INTEGRAL_HORIZONTAL +10  To change the font size of 
the vertical peak labels (in this case, by one point) 

FONT_INTEGRAL_VERTICAL +10  To change the font size of the 
vertical peak labels (in this case, by one point) 

FONT_CmdLine +10 To change the font size of the screen's command 
line (in this case, by one point) 

Axis:  

AXISHZ Set axis units to Hz 

AXISNONE No axis label 

AXISPPM Set axis units to PPM 

AXISPT Set axis units to points 

Zoom limits:  

ZOF1PT Set left hand frequency limit in units of points for Zoom region 

ZOF2PT Set right hand frequency limit in units of points for Zoom region 

ZOF1PPM Set left hand frequency limit in units of ppm for Zoom region 

ZOF2PPM Set right hand frequency limit in units of ppm for Zoom 
region 

ZOF1HZ Set left hand frequency limit in units of Hz for Zoom region 

ZOF2HZ Set right hand frequency limit in units of Hz for Zoom region 

ZOF1SL Set lower slice limit in second dimension for 2D Zoom region 

ZOF2SL Set upper slice limit in second dimension for 2D Zoom region 

ZOF12DPPM Set bottom frequency limit in ppm in second dimension for 
2D Zoom region 
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ZOF22DPPM Set top frequency limit in ppm in second dimension for 2D 
Zoom region 

ZOF12DHZ Set bottom frequency limit in Hz in second dimension for 
2D Zoom region 

ZOF22DHz Set top frequency limit in Hz in second dimension for 2D 
Zoom region 

ZOOM_REGION  Allows the user to define up to 10 Zoom regions, 
similar to Zoom sub-commands 0-9.  Syntax is  
        Set Zoom_Region n f1 f2     
where n is the region identifier (0-9) and f1 and f2 are frequency limits in 
ppm. 

Window functions: 

GF Gaussian Factor used in Lorentzian/Gaussian resolution enhancement. 

LB Linebroadening used with EM, GM, LG and TF commands  

S# Set phase shift for sine apodization (MS). 

T1 First point for trapezoidal multiplication (TM) 

T2 Second point for trapezoidal multiplication (TM) 

Linear Prediction: 

LNpts Number of points to be predicted by Linear Prediction (LN) 

LNmdim Number of points on which Linear Prediction (LN) is based 

LNnsig Maximum number of frequencies to be predicted by Linear 
Prediction (LN) 

LNdirection (FORWARD or BACKWARD) used by Linear Prediction 
(LN) 

Integration: 

INTEGRAL CLEAR clear all defined integral regions 

INTEGRAL 3.0 5.0 to define an integral region (in this case, from 3 to 5) 
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INTEGRAL 4.2 1.5 5.0 to define and integral (in this case from 4.2 to 
1.5) and also assign its value (5, in this case) 

Other: 

AC Set value for Amplitude Change (AC) command. 

AM Set value for Add/Subtract multiplier (AM) command. 

ARRAY_ON Enter Arrayed Mode for 2D (original arrayed mode only, 
does not initiate "pairwise" arrayed mode) 

ARRAY_PAIRWISECOMPLEX Enter "pairwise" arrayed mode.  Be 
sure to set the Process Type before executing this command. 

ARRAY_OFF Exit Arrayed Mode for 2D  

DP_INFO_STRING Enter text which will be entered in the Label field 
for all peaks when DP is executed. 

LINKLIMIT To specify the number of loops for a Link containing IN. 
The default is to loop until no more files can be found. 

MH Minimum height for peak picking 

OF1 Sets the o1 frequency (the frequency of the center of the spectrum) to 
the specified value, in hertz. 

OF2 Sets the o2 frequency (the frequency of the center of the spectrum in 
the second dimension) to the specified value, in hertz. 

PA Zero-order phase correction used with PC 

PB First-order phase correction used with PC 

POINTS_TO_AVERAGE  Sets the number of points to be used with 
baseline correction commands BF and FR.  This is the same as the 2A 
command. 

RDpts n  where n is the number of pts to rotate with RD command 

RDdirection left (or right) used by RD command 

RM RMS noise multiplier used in peak picking 

S@ Number of points by which SH will reduce the data set 
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SHIFT 2.5 To set the chemical shift of the largest peak in the current 
region (in this case, to 2.5 ppm). If a second value is supplied, separated 
by a space, this command can be used to set the shift in both dimensions at 
the same time. The values specified must be in ppm. 

SL  sets 2D slice number 

Sleeptime x   Sets the number of milliseconds that the macro will pause 
when Do Sleep is used. 

SPPLOTX Sets x offset for an SP plot. 

SPPLOTY Sets y offset for an SP plot. 

Note: 

When using the Set command to specify a file name, the default path name is the current 
working directory. The current working directory is established each time a GA or GB 
command is completed. Therefore, it is a good practice to execute a GA after an Ask 
FileA command: 

Ask FileA 

GA 

This establishes the working directory, and subsequent Set FileX commands will use that 
directory. 

If the user wants to specify a different path for a file in a Set command, use  

Set FullFileA name 

Note that if a new path is specified for file A or B, the working directory will be changed 
when a GA or GB command is next executed. 

Add/Subtract and Dual Display 

This section describes how to display 2 spectra on the screen simultaneously (Dual 
Display) and how to add and subtract 2 spectra.  

See details below on how to use Add/Subtract. 

DD -- Dual Display 

Toggles dual display on and off. A spectrum must have previously been placed into the 
Add/Subtract buffer using the AL command. Dual Display is also available from the 
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View menu. When DD is activated, the spectrum previously stored in the Add/Subtract 
buffer is displayed above the current spectrum. The spectra can be vertically scaled 
together in the same manner as for single spectra, and Zoom can be used for expansion. 
The spectrum in the DD buffer can be scaled by typing AM. This brings up a dialog box 
that allows a multiplying factor to be entered. Within this same dialog box, the horizontal 
and vertical offsets of the spectrum in the buffer can also be adjusted. Be careful to exit 
Zoom before executing this command, as NUTS will interpret DD as 2 baseline 
adjustment operations. 

AS -- Add/Subtract Subroutine 

This is a subroutine that allows addition and subtraction of the current spectrum and a 
second spectrum which has been loaded into the add/subtract buffer. First, a spectrum (or 
FID) is loaded into the Add/Subtract buffer with the command AL. Then a second 
spectrum is opened with GA. Note that the spectrum in the buffer remains in the buffer 
and unchanged until another spectrum is loaded into the buffer with AL. 

Typing AS or choosing Add/Subtract from the Tools menu enters the Add/Subtract 
subroutine. The menu choices change to those that are active in the subroutine. The 
spectrum in the buffer is displayed above the current spectrum. Subcommands (listed 
below) within the subroutine are single letter commands executed immediately, and are 
available either from the keyboard or from the menus. Typing <Enter> exits the 
subroutine. 

AS can be used in a link or macro, but behaves differently.  In this case, the subroutine is 
not entered.  Instead, addition of the buffer spectrum and the current spectrum is 
automatically executed without further input from the user.   The current value of the 
buffer multiplier (AM) is used.  To perform subtraction, set AM to -1 before running the 
link or macro. 

The spectra can be added or subtracted by typing + or -, respectively, or by choosing Add 
or Subtract from the Edit menu. The resulting spectrum (sum or difference) becomes the 
current spectrum. The spectrum in the buffer is unchanged. This operation can be un-
done by executing the inverse operation.  

The difference between the spectra (current spectrum minus buffer spectrum) can be 
displayed "on the fly" by typing D or by choosing Difference from the Display menu. 
With the difference spectrum displayed, parameters such as Multiplier and left/right 
offset can be adjusted and the difference spectrum is updated in real time to reflect the 
changes.  Note that Difference mode affects display of the data.   Use - (minus sign) to 
make the subtraction permanent. 

The buffer spectrum can be scaled by entering a multiplying factor. The initial value is 
one. It can be changed by typing M or choosing Change Multiplier from the Edit menu.  
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The buffer spectrum can be shifted left or right by one point using the left and right 
cursor keys. To shift it by larger steps, hold down the shift key while using the left and 
right cursor keys, which moves the buffer spectrum in steps of 10 points. The buffer 
spectrum can also be shifted by any desired amount by typing O or choosing Change 
Offset from the Edit menu, which brings up a dialog box allowing the user to set the 
offset (in points). 

The vertical offset of the buffer spectrum can be adjusted by typing V or choosing 
Change Vertical Position from the Edit menu. The offset is expressed as a percentage of 
the screen, so that 10 displays the buffer spectrum 10% above the bottom. The vertical 
offset of the current spectrum can be changed by exiting the AS subroutine, typing DC 
and adjusting the offset using the left scroll bar. When the desired adjustment has been 
made, type Enter to exit the DC routine and re-enter the AS routine. 

Subcommands  

B -- Display Both buffer spectrum and current spectrum 
D -- Display Difference between the spectra in real time (current spectrum minus 
buffer spectrum) 
M -- Change Multiplier for buffer spectrum 
O -- Change horizontal offset of buffer spectrum (in points) 
S -- Display current Spectrum only 
V -- Change Vertical offset of buffer spectrum 
+ (plus sign)-- Add spectra and make resulting sum the current spectrum 
- (minus sign) -- Subtract spectra and make resulting difference the current 
spectrum 
Ctrl-C -- Copy screen to Windows clipboard as bitmap. See copying spectra. 
Alt-C -- Copy screen to Windows clipboard as Metafile 

AL -- Load Add/Subtract buffer 

Places the current spectrum into the buffer.  

AM -- Add/Subtract Multiplier 

Enter the value by which the spectrum stored in the Add/Subtract buffer will be 
multiplied.  

Illustrated example of AS routine 

Dual Display allows 2 spectra to be displayed simultaneously. They are scaled together 
and Zoom expansion applies to both.  

The Add/Subtract subroutine allows 2 spectra to be added together or subtracted, and the 
result becomes the current spectrum. 
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To display more than 2 spectra, create a 2D data set containing the desired files, and use a 
stacked plot.  

Note that these features are not included in NUTS Lite. 

  

 

Open the first spectrum to be compared. 

Select Load AS buffer from the Tools/Add Subtract Routine menu, or type AL. 

This places a copy of the current spectrum into the Add/Subtract buffer.  
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Open the second spectrum to be compared. 

The contents of the buffer can be displayed above the current spectrum by selecting Dual 
Display from the View menu, from the Tools menu or by typing DD. The buffer is shown 
in green. 

The DD command is a toggle, so executing it again will turn off display of the buffer 
spectrum. The data remains in the buffer, however. 
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Use Zoom to expand the two spectra together. 

Use the right hand scroll bar, Page Up/Down keys or < > keys to scale the spectra 
vertically. 

Use the scroll bar at the bottom of the screen to pan both spectra. 
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Use the AM command to 

1. Enter a scaling factor for the buffer spectrum  
2. Enter a horizontal offset, for use in cases where the spectra do not line up exactly 
3. Change the vertical position of the buffer spectrum  
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The Add/Subtract subroutine provides more options than the Dual Display mode. 

Enter the subroutine from the Tools menu, or by typing AS. 

Once in the subroutine, you can change the buffer spectrum's multiplier, horizontal offset 
and vertical position from the Edit menu, (just as was done with the AM command 
above). 

  

 

It is also possible to shift the buffer spectrum horizontally using the left and right cursor 
arrow keys. Each key click moves the buffer spectrum one point. Holding down the shift 
key and using the same cursor keys moves the spectrum 10 points at a time. 
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From the Display menu, you can choose to display the difference (current spectrum 
minus buffer spectrum). This is the most convenient way to make adjustments to the 
vertical scale and horizontal offset to match the 2 spectra for good subtraction.  

Choosing Both from the Display menu reverts to display of the buffer spectrum in green, 
instead of the difference. 

Once all desired adjustments have been made, select Add or Subtract from the Edit menu 
to replace the current spectrum with the sum or difference (current minus buffer). Either 
operation can be undone while still in the AS routine by performing the opposite 
operation.  

Once addition or subtraction has been executed and the routine exited (with <Enter>), the 
current data set has been replaced by the sum or difference. 

Text annotation 
NO – Notes Subroutine 

This allows the user to define multiple text boxes, which are "tied" to a point in the 
spectrum, but can be repostioned with the mouse. NO enters the routine (also from the 
Tools menu).  
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Click with the left mouse button or type A. This brings up the dialog box below, allowing 
the user to enter desired text. 

Text can be multiple lines. Click on Choose Font to select font for this note only. The font 
does not change in this display, but will be correct on the screen. 
Click OK to close this box.  The check box allows the note to be displayed vertically. 
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Additional notes are added in the same manner. An existing note can be edited by clicking 
on it with the right mouse button. 
A chosen note can be moved by pressing and holding the left mouse button and dragging to 
a new position. The note box cannot be resized; its size is determined by its contents. 
All notes can be cleared by typing C or from the Edit menu. 
Typing P creates a special note box containing the acquisition parameters (equivalent to LP 
from the NUTS base level) 
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Notice how the text boxes are repositioned when Ctrl-F is typed. Each note is "attached" to a 
point in the spectrum, so moves when the displayed region is changed. This means it is 
possible to select a display region such that some notes are not displayed. This is different 
from the way other objects are positioned, such as the clipboard text display and objects 
created in MO. In those cases, the object is tied to a position on the screen, regardless of 
which part of the spectrum is displayed. 

Text which has been copied to the clipboard can be pasted into a Notes box with Ctrl-V 
(Windows 95/NT) or Command-V (Mac).  (This does not work under Windows 3.11). 

<Enter> exits the subroutine, leaving the notes displayed.  
All notes can be toggled on/off from outside the NO routine using Ctrl-N.  

 Subcommands:  

A -- Add new notes box 
C -- Clear all notes boxes 
P -- create new notes box containing acquisition Parameters 
S -- toggle on/off display of all notes boxes 
Ctrl-V -- Paste clipboard contents into an open text box  (Command-V on the 
Mac) 
click right mouse button on a notes box to edit 
<Enter> to exit the subroutine 
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Inset plots  
IS – Inset plots 

Note that inset plots can be created only with 1D data. 

This subroutine allows the user to define multiple inset plots, each of which is "tied" to a 
point in the spectrum, but can be repositioned with the mouse. IS enters the routine (also 
from the Tools menu). Inset plots can also be accomplished from the MetaObjects 
routine, but the IS routine is more flexible and should work better for most situations.  
Note that the IS routine does not display integrals or peak labels on the inset plot, but this 
can be done with the MO routine. 

The procedure for selecting the spectral region for the inset changed as of 7/13/05.  
Previously, the spectrum was first expanded to display the desired region, then the IS 
routine was initiated and the inset created with the A command, as described below.  For 
copies of NUTS compiled on or after 7/13/05, an alternate method is now available, using 
a "rubber band" box defined by the cursor to select the region for the inset, as shown 
below.  Either method can be used. 

 

Note that, with this change, any mouse clicks on the screen while in the IS routine will 
create a new inset (unless the mouse is within the bounds of a previously created inset). 

Once the inset is created, it can be moved and resized as previously. 

The original method of defining the inset is illustrated below: 
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Begin by selecting, with Zoom, the region that will be the inset. It works best NOT to 
expand to these limits, so type Ctrl-F before entering the IS routine. 

 

Enter the IS subroutine from the Tools menu or by typing IS. 
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Typing A (or selecting Add region from the Edit menu) creates the inset, which can be 
moved and resized with the mouse. 
Display of all defined insets can be toggled on and off with S or from the View menu. 

 

Clicking on a chosen inset with the right mouse button displays this box, allowing the 
properties of the inset to be set. The axis font can be set by clicking on Choose Font. The 
axis units can be selected independently for each inset. 
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The scale of the inset can be set to a specific Hz/cm. Since the frequency range of the 
inset has already been fixed, entering a value here will cause the size of the inset to be 
changed. This could result in the inset being displayed with an undersireable size (tiny, or 
off the screen), in which case, the scaling value needs to be reset. 
The Printer Fudge box lets you enter a correction factor so that the inset plot is correctly 
scaled on your printer. Once this fudge factor is determined, it can be set in the nuts.ini 
file.  

 

It is important to understand that each inset is "attached" to the data point corresponding 
to its left edge. Therefore, its position on the screen will change as the displayed region is 
changed. For the case shown above, if the zoom limits are changed to display from 2 to 0 
ppm, the inset will not be displayed. 

Any DC offset the displayed spectrum had when the inset was created is carried over to 
the inset. In addition, the offset (of the inset's spectrum relative to its axis) can be 
adjusted after the inset is created, using the "[" and "]" keys to increase and decrease the 
offset for the currently selected inset. 

<Enter> exits the subroutine, leaving the insets displayed.  

The insets remain defined when a new spectrum is opened. Each inset is dynamically 
created, so that it displays the data in the region selected. If the data in that region 
changes, so does the inset. For this reason, it is usually best to clear all insets before 
opening a new file.  
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The insets are saved when the file is saved, and can be recalled when the file is opened, 
using the TA command or by selecting Auto Tailer Read from the File menu.  

Arguments for inset plots have been added to allow the user to change the default 
position and size of insets when they are added. The values for the arguments are 
fractions of the screen's size. For example, "IS xpos 0.01" would change the default 
position of the insert to be 1 percent of the screen from the left. The syntax is: 

IS xpos fraction 
IS ypos fraction 
IS xscale fraction 
IS yscale fraction 

where "fraction" is entered as a number between 0 and 1.  These commands set the 
size/position;  they do not create an inset.  (0,0) is the top, left corner of the screen.   

These commands can be used in macros, for example, this section of a macro initializes 
insets to be positioned in the top, left corner of the screen and to be 50% of the screen 
size in each dimension: 

; initialize size & position for IS inset 
2f 
is xsize .5, 
is ysize .5, 
is xpos 0, 
is ypos 0, 
2n, 

Subcommands:  

A -- Add new inset 
C -- Clear all insets 
S -- toggle on/off display of all insets 
click right mouse button on an inset to edit its properties 
<Enter> to exit the subroutine 

Manual peak picking and labeling 
DP -- Define Peaks 

This subroutine allows manual peak picking using the cursor, and allows the user to place 
labels on the peaks. (Note that DP is not included in NUTS Lite.)  A summary of the DP 
subcommands is given at the bottom of this section. An example illustrated with screen 
captures is included below. 
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The DP routine operates similarly on both 1D and 2D files. For 1D files, DP is an 
alternative to the automatic peak picking (PP) command for creating a list of only 
selected peaks. Once peaks have been selected in DP, a chemical shift or other label can 
be placed above the peak by typing Ctrl-P. On entering the DP routine, the cursor 
changes to a small crosshair labeled DP and the menu selections change. Commands are 
single-letter commands which are executed immediately. With the exception of functions 
which require the mouse, all commands can be accessed via the menus. 

Position of peak labels -- By default, peak labels for 1D spectra are displayed at the top 
of the screen, with short lines drawn to show which peak corresponds to each label. The 
labels can alternatively be displayed just above the top of each peak. This can be set for 
all peaks in the nuts.ini file, or for each peak from within the DP routine by bringing up 
the parameters of a selected peak (see edit, below). NUTS now has some "smarts" to 
attempt to avoid overlap of labels on adjacent peaks. Labels can also be moved using the 
mouse (see moving labels, below). 

Selecting peaks -- When the DP routine is entered, peaks can be selected by clicking the 
left mouse button. For 1D spectra, a vertical red line is drawn showing the point that was 
selected. For a contour or intensity map of a 2D file, a small cross is placed on the peak. 
Once selected, the peak labels can be displayed by typing Ctrl-P. By default, NUTS 
chooses the nearest maximum point (positive or negative) which it can find. This "Snap 
to" feature can be turned off from the Edit menu to allow picking shoulders, etc.  

Automatic peak picking -- Automatic peak picking of 1D spectra is also available 
within DP from the Edit menu or by typing A. This uses the minimum height (MH) and 
RMS noise factor (RM), in the same way as PP.  Automatic peak picking of 2D spectra is 
only available with the new Arrayed Mode option, which allows the entire data set to be 
placed into memory.  A set of peaks from one 2D spectrum can be overlaid on the display 
of a different spectrum.  See 2D compare.  

Deleting peaks -- Any peak can be deleted by placing the cursor on or near the peak to 
be deleted and typing K (Kill). (Note: Do NOT click the mouse button to do this, just 
position the cursor.) The K command will always delete a peak, whichever one is closest 
to the cursor at the time K is typed. All peaks can be deleted by typing C or choosing 
Clear Selected Peaks from the Edit menu. 

Labels in Hz or ppm -- To display the peak position in Hz instead of ppm, type H. To 
display the text label instead of the chemical shift, type I. By default, the text label is the 
number of the peak, in the order selected. This is to allow correlation between peak labels 
and a peak list generated by PP. Both commands are also available from the Edit menu. 
Selected labels can be displayed as text even if all others are labeled with Hz or ppm. 
This is done by displaying the parameter dialog box for the selected peak (see edit, 
below) and checking the box labeled "Show Info label only". Note that this causes the 
text label even when other peak labels are toggled off with Ctrl-P or PF. This can be 
used to put multiple text labels on the screen, which need not be associated with a 
specific peak. 
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Creating a peak list -- The peaks selected are entered into a list containing shift, peak 
intensity and a peak label (eg., descriptive text) in the order the peaks were selected. The 
list can be reordered from largest to smallest chemical shift by selecting Reorder from the 
Edit menu or by typing # (number sign; shift-3 key). The list can be placed into the 
Windows clipboard for pasting into another document such as the Notepad by selecting 
Type List to Clipboard from the Edit menu or by typing T. If peaks are added, deleted or 
reordered, be sure to execute the T command again to update the clipboard contents 
before pasting the list into another document. If the clipboard display feature is enabled 
(by typing C or Ctrl-B or from the Edit menu), the T command displays the list on the 
screen. Repeat the T command as peaks are added, deleted or reordered to see the current 
list. 

The columns in the list can be separated by spaces or by tabs, according to the setting of 
the TB (Tabs) parameter.   

A peak list containing only ppm values and peak label can be copied to the clipboard 
using subcommand P.  The columns are separated by tabs. 

Editing peak labels -- The information about each peak can be viewed by placing the 
cursor on or near the peak of interest and clicking the right mouse button. The dialog box 
shown below is displayed which shows the peak frequency, relative intensity, etc.  

 

The bottom line is a label that can be edited for each peak. By default, the peak number is 
placed in the label box, but this can be edited to be any other text label. There is a check 
box which allows the user to choose to display the peak labels either horizontally or 
vertically for each peak independently. This preference can also be set in the nuts.ini file. 
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There is a check box labeled "Show first argument only". This is for situations where 
extensive information has been input in the text label box, which can be too long to 
display above each peak. If this box is checked, only the characters up to the first space 
are used to label the peak. This could be the case if the user enters extensive comments 
such as substructure codes and assignments to be saved in the file's tailer.  

This dialog box is the same whether the current spectrum is a 1D spectrum or a 2D 
contour map. (Slices from a 2D data set are treated the same as 1D spectra.) The box 
labeled "Relative Area" is used for volume integrals of 2D peaks. Enter a value for a 
chosen peak and the volume of all other peaks will be scale appropriately. See the 
description of volume integrals for details. 

Font -- The font used for peak labels can be changed by typing FV or FH (for vertical 
and horizontal fonts, respectively) or selecting Set Fonts from the Edit menu. 

Moving peak labels -- Beginning with version 5.09, it is now possible to adjust the 
position of each peak label using the mouse. Position the cursor on the label of interest, 
press and hold the left mouse button and drag the label to the desired position. The 
position of any peak label can also be changed in small steps up, down, right and left. To 
do this, place the cursor near the peak whose label will be moved and type U (up), D 
(down), L (left) or R (right). Do not click the mouse button to do this, just position the 
cursor. A label can be moved multiple steps in each direction. Note that the labels may 
look slightly different on the screen and on plots.  

The list is not lost when the DP routine is exited, so it is possible to exit DP, choose a 
different region and re-enter DP to add more peaks to the list. Note that, for this reason, it 
is a good idea to delete all peaks (with C) on entering DP to operate on a new spectrum, 
so that peaks selected in the previous spectrum aren't carried over. 

Saving peaks with the spectrum -- The list of selected peaks is saved with the file, and 
can be recalled at a later time with the TA command. The list of peaks can also be saved 
to a text file by choosing Save to File from the File menu or typing S. A peak list can be 
loaded from a previously saved file by choosing Get File from the File menu or by typing 
G. This command retrieves a set of chemical shifts from the file and applies those peak 
positions to the current spectrum, drawing red lines on the screen to indicate selected 
peaks.  

Subcommands:  

A -- Automatically pick peaks (Minimum Height must be set before entering DP) 
C -- Display contents of clipboard on screen (same as Ctrl-B command) 
G -- Get peak file. Recalls previously saved peak list and displays the 
corresponding peaks, deleting any peaks which had been selected. 
H -- Label peaks with Hz, rather than PPM 
I -- Label peaks with text label, rather than chemical shift. 
K -- Delete the selected peak closest to the cursor location 
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P - Copy ppm list to the clipboard 
S -- Save peak file. 
s -- Save peak file in format consistent with SpecMan (from Spectrum Research) 
T -- Copy peak list to the clipboard 
Z -- Zero out all selected peaks. 
# -- Re-order the peak list, from highest to lowest chemical shift 
Ctrl-C -- Copy screen to Windows clipboard as bitmap See copying spectra.  
Alt-C -- Copy screen to Windows clipboard as Metafile 

The need for the following 4 commands has been removed, now that peak labels can be 
moved with the mouse. However, at this time the commands still work. Each command 
operates on the selected peak closest to the cursor.  

D -- Move peak label Down a small amount 
L -- Move peak label Left a small amount 
R -- Move peak label Right a small amount 
U -- Move peak label Up a small amount 

Volume Integrals of 2D peaks 

The Define Peaks subroutine is used to select peaks whose information is entered into a 
list. This information includes chemical shift in both dimensions, an editable peak label 
and relative peak volumes.  

Begin by entering DP and select peaks of interest by clicking with the left mouse button. 
Choose one peak whose volume is to be assigned and click with the right mouse button 
on or near that peak. Enter a value for volume in the box labeled Relative Area. Areas 
(volumes) of other peaks will be scaled to this value. 

The Arrayed Mode allows automatic peak picking, including volume integrals. 

Several points must be kept in mind when using this feature. The limits used for 
integration are determined by the minimum height (MH) command. The integral is the 
sum of all points in the vicinity of the peak whose intensity is greater than the minimum 
height value. This is done by starting at the peak maximum and "walking" in each 
direction, summing each point until the minimum height is reached. This summation is 
performed at the time the peak is selected, and is the value shown for Absolute Area. 
Setting the value of a chosen peak merely enters a scaling factor to give "nicer" numbers 
for the peak volumes. If a new value for MH is entered, the list of selected peaks must by 
cleared (by typing Z) and peaks reselected. Care must also be taken that a chosen peak is 
resolved from neighboring peaks at the level of the minimum height.  

Control-P -- Toggle peak labels on/off 
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Peaks which have been selected in the Define Peaks subroutine can be labeled with their 
chemical shift or a text label by typing Control-P. This is a toggle, so typing it again 
removes the labels. In Links or macros, use " ^P ". 

PN -- Turn peak labels on 

Peaks which have previously been selected in the Define Peaks subroutine can be labeled 
on the screen and plots by typing PN. Display of the labels can be turned off by PF. 
These commands perform the same function as Ctrl-P, which acts as a toggle.  

PF -- Toggle peak labels off 

Peaks which have previously been selected in the Define Peaks subroutine can be labeled 
on the screen and plots by typing PN. Display of the labels can be turned off by PF. 
These commands perform the same function as Ctrl-P, which acts as a toggle. 

Automatic 2D Peak Picking (Arrayed Mode only) 

Automatic peak picking of 2D data is now available in the Arrayed Mode.  While in 
Arrayed Mode, with an intensity plot displayed, enter the DP routine and type A to 
perform automatic peak picking, shown below, including automatic volume integration. 

 

List generated by automatic peak picking: 



169 

LINE     POINT   SLICE     PPM1        PPM2    INTENSITY    AREA   
LABEL 
  1         36      15     79.876      3.401     96.783      0.77   1 
  2        101      29     68.982      3.074     79.186      1.22   2 
  3        131      13     64.077      3.439     60.209      1.02   3 
  4        146      21     61.703      3.254     79.742      0.97   4 
  5        155      35     60.209      2.920     55.281      1.21   5 
  6        156      32     60.043      2.997    112.151      2.15   6 
  7        164      46     58.733      2.666     79.937      0.82   7 
  8        175      51     56.891      2.538     92.602      1.50   8 
  9        217      33     49.866      2.977     79.109      1.17   9 
 10        223      40     48.950      2.811     78.639      1.00   10 
 11        230      33     47.787      2.982     84.700      1.26   11 

Illustrated example of DP 

This subroutine allows peaks to be selected manually with the mouse, and provides 
options for displaying peak labels. See also Peak Picking (PP).  

 (Note that DP is not included in NUTS Lite. However, peaks can still be labeled using 
the PP command.) 

 

Enter the DP routine from the Tools menu or by typing DP. 

To select peaks manually with the mouse, place the cursor at the top of the peak and click 
once with the left mouse button. By default, NUTS snaps to the closest peak maximum, 
but this can be turned off from the Edit menu. 
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Peaks can also be selected automatically by typing A or from the Edit menu. Peaks 
exceeding the Minimum Height threshold (MH) are selected in the same manner as for 
PP.  

A small, red line shows each peak which has been selected. 

All selected peaks can be cleared by typing C or from the Edit menu. A selected peak can 
be deleted by placing the cursor on the peak (don't press the mouse button) and typing K 
(kill). 

  

 

To view information for a selected peak, place the cursor near that peak and click with 
the right mouse button, which displays the box shown here. (Users with a single-button 
mouse should hold down the shift key and click the mouse button.) 

The peak's frequency in Hz and ppm is displayed in the box labeled "Horizontal". (The 
box labeled "Vertical" is for the second dimension of 2D data. The values for 
Area/Volume refer to the volume of 2D crosspeaks. These items are not relevant in this 
case.) 

By default, NUTS will label all peaks with chemical shift in ppm, but it is possible to 
display the text label instead for a chosen peak, by checking the "Show info field only" 
box. It is also possible to label all peaks with Hz or text -- see below. 
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The peak label can be displayed either vertically or horizontally using the check box 
labeled Vertical Font. The default orientation of all labels can be set in the nuts.ini file. 
Note that Macs do not have the ability to display fonts vertically on the screen. 

The list of selected peaks, including peak labels, is saved with the spectrum, in the file 
tailer. It is sometimes helpful to enter extra text in the text field for future reference, but 
not display all of that text on a plot. The check box labeled "Show first argument only" is 
used to display only the beginning of the text label, up to the first space encountered. 

  

 

Display of peak labels is toggled on and off from the Edit menu or by typing Ctrl-P 
(which is active even after leaving the DP routine). By default, NUTS displays the 
chemical shift, in ppm, as the label. The other options are peak frequency in Hz 
(subcommand H, available from the Edit menu) or text label (subcommand I, also 
available from the Edit menu as Show Peak Information Label). 

NUTS attempts to avoid overlap of peak labels, but this may not be possible for a very 
crowded spectrum. Labels can be placed either at the top of the page (shown above) or 
just above each peak, as shown below. This can be set as the default for all peaks in the 
nuts.ini file, or can be set for individual peaks by displaying the peak's information dialog 
box and selecting/unselecting "Labels at page top". 
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Individual labels can be moved by placing the cursor on the chosen label, holding down 
the left mouse button and dragging the label. Note that usually the label takes up less 
space when printed than on the screen, due to the increased resolution on the printer. 
Selecting a smaller font size, such as 6, will also help in avoiding overlap of labels.  

A peak list can be placed into the clipboard by selecting Type Peak List to Clipboard 
from the Edit menu (subcommand T) from which it can be pasted into a text editor for 
printing or displayed on the screen by typing Ctrl-B. The peak list can also be saved to a 
text file from the File menu. 
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Exit the DP routine by typing <Enter>. The red lines and boxes around the labels are no 
longer displayed. Here, 2 of the peaks have text labels displayed, using horizontal font, 
positioned above the peaks rather than at the top of the page. Each of these options was 
selected from within the peak information dialog box. 

After exiting DP, the set of peaks is still defined, and can be edited by re-entering the DP 
routine. They also still exist even if a new data file is opened, whether or not peaks exist 
at these frequencies in the new spectrum.  

Display of the labels can be toggled on and off with Ctrl-P. Labels for peaks which have 
the "Show info field only" box selected will continue to be displayed even if display of 
labels is turned off.  

Relaxation and Kinetics Analysis 

Analysis of relaxation and kinetics data are similar in that both involve changes in peak 
integrals as a function of time.  The same procedures apply to both, up to the point of 
choosing which function should be used to fit the data.  Parts of the discussion below 
refer to T1 analysis, but apply equally well to T2 or kinetics data. 

See illustrated tutorial showing analysis of T1 data. 

Relaxation and Kinetics Data 

For a T1 or T2 relaxation experiment, or for first-order kinetics, NUTS provides the 
capability of plotting the integral value of a chosen peak as a function of time, and also 
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calculates T1 or T2 or the rate constant. The time values are saved in a variable delay list 
and can be viewed and/or edited by typing D1. Be sure the time values are correctly 
entered in this list before attempting to calculate relaxation times or rate constants. If the 
list is edited, type UH to update the file header and save the corrected values. 

First, use Zoom to display just the peak of interest. Exit the Zoom subroutine and type 
GR (or choose Get Relaxation data from the Tools menu). This command measures the 
integral of the chosen region for each spectrum in the data set. Next type DR (or choose 
Data Reduction data from the Tools menu). NUTS displays a plot of integral value vs. 
time for the chosen peak. By default, Nuts assumes the data are T1 data, but this can be 
changed from the Fit menu. The curve displayed is a first guess, not a fit to the data. An 
exponential can be fit to the data by typing O. The resulting curve is displayed and the 
calculated T1value printed on the screen. Note that good phasing and flat blaselines are 
necessary to get good integration and therefore, a good T1recovery curve. The phasing 
and baseline of individual slices in a 2D data set can be corrected and the corrected slice 
saved back into the 2D data set with the S2 command. 

For details of the T1 calculation, see DR.  

A sample set of T1 data (13C spectra of sucrose) is available on the Acorn NMR web site, 
and is called Sucrose.t1. 

As an alternative to the automated approach, in which NUTS automatically integrates the 
peak for all time values, it is possible to create a table of time vs. amplitude values, saved 
as a file, and then fit these values to the T1 equation. See description of RR command for 
details. 

D1 -- Time values for arrayed experiment 

Opens a dialog box for display and entry of a list of time values (in sec) used in an 
arrayed experiment, such as a T1 experiment. If NUTS can identify a list of variable delay 
values in the data header, it will place the values in this list. Otherwise, the user can enter 
them manually. After entering a list of values, close the dialog box and type UH to update 
the file header, saving the list. Space is provided for up to 64 values. 

These values are used in calculating T1 . In the event that one or more spectra in a T1 data 
set are corrupted, and the user would like to eliminate those values from the T1 
calculation, the corresponding delay value can simply be set to a negative number. NUTS 
will ignore the corresponding spectra for its calculation, although the values are still 
displayed on the plot, in a different color. 

GR -- Get Relaxation data 

Used in calculating T1 or T2 or reaction rate from a series of spectra. This command 
integrates the chosen region for each file in the data set and creates a list of time and area 
values which will be fit to a T1 equation. (The user does not have the ability to edit this 
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list, but as an alternative, can create his/her own list of values saved as a file. To use this 
file to calculate T1 instead of the automated approach, use the RR command to read in the 
Relaxation data file.)  

To use GR, the data must first be transformed, phased and saved as slices in a 2D data 
set. The user first selects a peak using Zoom to expand the spectrum so that only the peak 
of interest is displayed. Exit the Zoom subroutine using Enter. Type GR (or choose Get 
Relaxation data from the Tools menu). NUTS measures the integral of the displayed 
region for each spectrum in the data set. Note that the baseline and phasing in the 
expanded region must be good in order to obtain a realistic value for the integral. The 
baseline may need to be corrected for each spectrum in the data set and the corrected 
spectra saved. The simplest way to do this would be to execute a link such as the 
following, having already expanded the spectrum to display the region of interest: 

GA BF SC IN 

Be sure that the slice number (SL) is set to one before executing the link, so that the 
process is performed on the whole data set. The BF command removes DC and tilt for the 
currently displayed expanded region. The SC command saves the corrected data. A 
different name must be supplied for the corrected data set. See help on each command for 
more information. 

To correct phasing or baseline of just single slices within the data set, make the changes 
and save the corrected slice with the S2 command, which saves the entire data set with 
only the currently displayed slice being changed. 

The T1 data can be displayed by typing DR (or choosing Display Relaxation data from 
the Tools menu). The entire process is repeated for each peak of interest. 

DR -- Data Reduction 

Plots integral vs. time for relaxation data on a chosen peak. The data can be fit using a 
choice of functions for T1 or T2 relaxation. 

Three steps must precede the DR command: 

1. The data must first be processed and saved as a 2D file (see Example).  
2. A peak is selected by using Zoom to expand the spectrum so that only the chosen 

peak is displayed.  
3. The GR command must be executed, which measures the integral of that peak in 

each of the spectra. (Alternatively, peak heights can be used; see below.) The GR 
command is also available from the Tools menu. 

As an alternative, the data to be fit can be read in from a file consisting of time, amplitude 
data points. See Read Relaxation data file (RR) for details.  
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Typing DR (or choosing Data Reduction data from the Tools menu) displays a plot of 
integral vs. time with each data point represented by a small square. An initial guess at an 
exponential curve is displayed, but this does NOT represent a fit to the data.  

By default, the data are assumed to be T1 data, and a 3-parameter fit is used. The fitting 
function can be changed from the Fit menu. Choosing Fit Function brings up a dialog box 
which allows the user to select the fitting function. The choices are 

T1 Inversion Recovery  
T1 Inversion Recovery fitting 3 parameters (default)  
T2  
First-order kinetics, for either reactant or product  

Equations are shown below. 

 

Also from this dialog box, the user can choose to use peak heights rather than integrals. 
Peak height can be chosen with or without interpolation. If this option is changed, it is 
necessary to exit the DR routine and re-execute GR to make the new measurement. 

To perform a fit, type O or select Optimize from the Fit menu. NUTS displays the curve 
determined by fitting the chosen equation to the data points, and also displays the values 
calculated in the fit process. A sample plot is shown below. If the integral for the longest 
delay value is set to 100, the integrals will be given as a percentage; otherwise, it is in the 
absolute integral units internal to the program. The plot can be printed by typing P or 
selecting Print from the File menu. The whole process is repeated for each peak of 
interest.  

A table of time and integral values can be placed into the Windows clipboard by typing T 
or selecting Data to Clipboard from the Edit menu. The integral values will be listed as 
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relative values if the integral has been assigned a value; otherwise it is given in the 
absolute units internal to the program. This table can then be pasted into the Notepad or 
other document. Like any other text in the clipboard, this can also be displayed on the 
screen by toggling on clipboard display by typing S or selecting Show Clipboard from the 
Edit menu (equivalent to the CB command). 

The list of delay values used in the experiment can be displayed and edited by typing D1 
from the NUTS base level or from within the DR subroutine by typing D or selecting Edit 
Time Data from the Edit menu. NUTS attempts to identify this list of values in the data 
header of the source data. If this attempt was unsuccessful, the user can simply enter the 
values. Executing a UH command (Update Header) saves the list in the header of the 2D 
data set. In the event that the user wishes to eliminate one or more spectra from the T1 
calculation, this can be done simply by changing the corresponding value in the D1 list to 
a negative number, in which case NUTS ignores that point in the fit. 

The equations used to fit the data are: 

T13IR (3-parameter T1-Inversion Recovery) 

y = A * { 1 - [ 1 + W * ( 1 - exp( -K/T ) ) ] * exp( -x/T ) } 

where 

T = T1 relaxation time  
A = peak integral at time x >> T  
K = total time between scans in the 180-t-90 sequence (equal to acquisition time 
plus relaxation delay time)  
x = delay time t in the 180-t-90 pulse sequence  
W = -(integral at time x=0 / A)  

The parameter W is determined in the fitting process, as inversion in this experiment is 
not always perfect. This gives better results than assuming that the integral at time x=0 is 
simply the negative of the integral for infinitely long x. 

ref: G.Levy and I.Peat, J.Magn.Reson., 18, 500 (1978). 

T1IR (Inversion Recovery) 

y = A * { 1 - [ 2 - exp( -K/T ) ] * exp( -x/T ) } 

where 

T = T1 relaxation time  
A = peak integral at time x >> T  
K = total time between scans in the 180-t-90 sequence (equal to acquisition time 
plus relaxation delay time)  
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x = delay time t in the 180-t-90 pulse sequence  

ref: Levy et al, J.Magn.Reson., 11, 58 (1973). 

T2 

y = A * exp( -x/T )  

where 

T = T2 relaxation time  
A = peak integral at time x >> T  
x = delay time t in the pulse sequence  

1st-Order Kinetics - for reactant (integral decreases with time) 

y = A * exp( -kx )  

where 

k = reaction rate (in units of 1/sec)  
A = peak integral at time zero  
x = reaction time  

1st-Order Kinetics - for reaction product (integral increases with time) 

y = A* {1 -  exp( -kx ) }  

where 

k = reaction rate (in units of 1/sec)  
A = peak integral at time zero  
x = reaction time  

Subcommands: 

D Display/edit list of time values  
F Choose fitting function  
K Peak pick method: integrals, peak heights or interpolated peak heights  
O Optimize fit to data points  
P Print  
S Show contents of clipboard on screen (must execute T first)  
T Copy table of time and integral values to the clipboard  
X Expand x-scale. Allows expansion to see details of early time points.  
Ctrl-C Copy screen to clipboard for pasting into other applications  
Enter Exit program  
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T1-Inversion Recovery plot of Integral vs time 

RR -- Read Relaxation data file 

Reads in a file containing time and amplitude values to be fit to the T1 equation. This is 
an alternative to the Get Relaxation data (GR) command, which automatically measures 
integrals of the selected region for each file in the data set. After reading in a file with 
RR, the fit is performed with the Data Reduction (DR) command. These commands are 
also available from the Tools menu. 

The format of the relaxation data file must be as follows: 

Relaxation Data  
time1 value1  
time2 value2  
...  
time n value n  
END  

The file can be created with any text editor and must be saved before it can be read into 
NUTS. Extra spaces are ignored, as is any line beginning with a semi-colon, allowing 
comments to be inserted to identify the source of the data. The first line must be 
Relaxation Data and the last line must be END.  

N.B. Be sure to read a spectrum into NUTS before executing RR and DR. This serves to 
initialize the display parameters. If RR and DR are executed immediately after the NUTS 
program is started, erroneous display and calculation result. 

Converting a series of 1D data to pseudo-2D data  

To use the automated relaxation data processing capability, the original 1D data files 
must have sequential file extensions to allow NUTS to process them using either a Link 
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or a macro. Most of the useful tools for displaying and analyzing a series of 1D files 
require that they first be converted to a 2D data set. 

This can be done as a 2-step process or all at once. For the 2-step process, execute a Link 
such as: 

IM BC EM FT PS SB IN 

This imports each FID, does an FT and phases the spectra, then saves them as a series of 
1D spectra. NUTS will prompt for a file name for the spectra. Remember to set LB and 
phasing on one of the files before executing this Link. The IN command increments the 
file extension and loops back to the first command in the link. It will continue until it fails 
to find the next file. The spectra can then be converted to a 2D data set with a link such 
as: 

GA SC IN 

The SC command creates a 2D file. 

To process the FIDs and save them as a 2D file all in one step, execute a link such as 

IM BC EM FT PS SC IN 

NUTS will prompt for the file name of the first file of the original data and the file name 
to save the data to, which will be a 2D file.  

Note that the above Links are not appropriate for processing in the Arrayed Mode.  In 
Arrayed Mode, each command (such as FT) is applied simultaneously to all slices, so the 
sequence of commands is executed one time, and there is no IN command.  

Use GA to read in the first slice of the 2D file, making it the current data set. The data 
can now be plotted as a stacked plot with SP or slices can be viewed with VW. This 
process is useful for any series of 1D files, such as kinetics data.  

Illustrated example of relaxation analysis 

The data must be saved as a NUTS 2D file. Data which consists of a series of 1D files 
can be converted to a 2D file using the following Link, provided the 1D file names have 
sequential file extensions (e.g., file.001, file.002, etc):  

GA SC IN 

You will be prompted for the first 1D file and for a name for the newly created 2D file. 
When the Link finishes, read in the 2D file. 

Note that this feature is not included in NUTS Lite. 
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The T1 data has been saved as a 2D data set, shown here using a stacked plot display. 

Be sure each slice is phased correctly and has a flat baseline. 
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Select the peak whose T1 is to be calculated, and use Zoom to expand so that only the 
peak is displayed with just a small amount of baseline on each side. 

It will make the numbers easier to read if the last slice in the data set has its integral set to 
a convenient number, such as 100. 

Exit the Iintegration and Zoom routines, leaving the expanded region displayed. 
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Choose Get Relaxation Data from the Tools menu (or type GR). This causes NUTS to 
read in each slice in turn and measure its integral for the expanded region. The display 
does not change when this operation is performed. 
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Choose Data Reduction from the Tools menu (or type DR). This enters the relaxation 
subroutine and displays a curve of area vs. time. The green curve does not represent a fit, 
just a quick first estimate. 

To perform a Simplex fit, choose Optimize from the Fit menu (or type O).  

See section on relaxation for equations and other options. 

  

 

The fit has been performed.  

To create a table of time vs. area, choose Data to Clipboard from the Edit menu (or type 
T). This list can be displayed on the screen by choosing Show Clipboard from the Edit 
menu (or type S or Ctrl-B). 

Meta-objects (structures and other graphics) on plots 
MO -- Meta Objects on plots 

This is a subroutine for the addition and manipulation of graphical objects on the screen. 
(In the Windows version, these objects are Windows Metafiles, hence the name Meta 
Objects.) Graphical objects can be inset plots, chemical structures, logos or others. They 
can be pasted from the clipboard or imported from files. More than one object can be 
displayed on the screen, and each can be independently moved and resized using the 
mouse. The program keeps track of them in a linked list. To select which object to 
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operate on, move through the list, forward or backward, until the desired object is 
indicated with a box with handles. See subcommands below. An example illustrated with 
screen captures is shown below. 

Another subroutine (Insets) has been added for creating inset plots.  The Insets routine 
creates the inset plots differently, and may work better.  However, only the MO 
subroutine can create insets displaying integrals and/or peak labels (which must be 
displayed at the time the inset is created). 

A different subroutine has been added to display structures from previously saved 
molfiles. 

As an experiment, MO subcommands are not presented in menus, but instead in a 
movable Helper window. The commands can be entered via the keyboard or via buttons 
in the Helper window. Display of Helper windows can be toggled on and off from the 
Help menu at the base program level, and can be set in the nuts.ini file. 

Inset plot --To create an inset plot, first expand the spectrum to display just the region 
which will comprise the plot inset. Type MO to enter the subroutine, and then A to add 
this display to a linked list of graphical objects. The chosen region can be resized and 
moved with the mouse in a manner similar to standard graphics applications. It is 
possible to display multiple insets. Exit the MO subroutine, then select and expand a new 
region, and repeat as needed.  

In the Helper window, you can set a multiplying factor for the axis font size, so that the 
numbers can be made more readable.  This must be set before the inset is captured.  Text 
such as the integral labels and peak labels may be too small to be read easily when the 
viewing area is reduced to form an inset plot.  It may be helpful to increase the size of 
such text before capturing the inset.  This can easily be done with the Windows version 
of NUTS using a macro such as the one shown below. (Changing font sizes in a macro 
does not appear to work at this time on the Mac). 

Importing -- A graphical object can be read from a file which is an enhanced, standard 
or placeable metafile. Objects can also be copied to the clipboard from another 
application and pasted into NUTS while in the MO subroutine. (Note that enhanced 
metafiles are not supported under Win3.11, and metafiles are not supported on the Mac. 
The Mac version uses PICT files.) The objects are displayed until explicitly deleted or 
until Nuts is closed, even if another data file is opened. 

When a file is saved, any objects which were pasted from the clipboard or created as inset 
plots are not saved with it, as these are memory-resident only. In the case of an object 
which was placed by reading a file, the path to that file is saved in the file's tailer, and can 
be recalled later using the TA command. 

Subcommands:  
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A - Add currently displayed region as an inset plot 
C - Paste the clipboard contents 
D - Delete currently selected Meta Object 
I - Import a graphical object from a file 
N - Move to next Meta Object in linked list 
R - Move to previous Meta Object in linked list 
Shift-F1 - brings up Help for the MO subroutine 
<Enter> - exit the MO subroutine 

There is also the option of defining one or more graphical objects in the nuts.ini file (such 
as a company logo) which will be displayed on the screen automatically. This is 
demonstrated by the display of the acorn in the upper left corner of the screen. This can 
be removed by editing the nuts.ini file or, while Nuts is running, by deleting it from 
within the MO subroutine.  

Illustrated example of MO 

This subroutine is used for placing graphical objects on the screen, moving and resizing 
them. The graphical object can be imported from a file, pasted from the clipboard or can 
be an inset plot of the currently displayed spectral region.  

There is also another subroutine for handling inset plots (IS, available from the Tools 
menu). 

A different subroutine (ML) can be used to display a structure from a molfile. 
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Enter the MO subroutine by typing MO or from the Tools menu.  

Instead of menus, the MO routine uses a Helper window. Commands can be entered by 
clicking on buttons in the Helper window or by typing the corresponding commands from 
the keyboard.  The Helper window can be moved on the screen by placing the cursor on 
the blue bar at the top and dragging.  Note that "Meta Objects" appears on the gray status 
bar at the bottom of the screen to indicate that this subroutine is currently active. 

  



189 

 

Choose I to import a graphical object (such as a chemical structure) from a file. The file 
must be a Windows Metafile (or a PICT file on the Mac). 

Choose C to paste a graphical object which has been copied to the clipboard. 

The object can be moved with the mouse by placing the mouse within the red rectangle, 
holding down the left mouse button and dragging. 

The object can be resized by placing the mouse on one of the "handles" on the edge of the 
red rectangle, holding down the left mose button and dragging 

Several objects can be placed on the screen at one time. Nuts keeps track of them by 
placing them in a Linked List in the order in which they were created. To select which 
object to adjust, move backwards and forward through the list with the N and R buttons 
or keyboard commands. 

Any selected object can be deleted with the button or keyboard command. 

Exit the MO routine by clicking on the Exit MO button or by typing <ENTER>. The 
object which was added remains on the screen. 
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Inset plots 

 

Use Zoom to display the region desired for the inset.  

Enter the MO routine and select the Add View button or type A. 
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The displayed region is captured and displayed bounded by the red rectangle, and can be 
moved and resized as above.  The Helper Window includes a mutiplier for the font size 
of the axis labels.  This can be increased to make the labels larger, but must be set before 
the inset is captured. 

Exit the MO routine. 
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The inset is displayed here after typing Ctrl-F to display the entire spectrum. 

Text, such as peak labels or integral values, may appear too small in the inset. To 
compensate for the font size being scaled down, try increasing the font size  

Molecule display from molfiles  
ML - Molecule subroutine  

This is a subroutine for displaying structures based on a previously-saved molfile.  Most 
drawing programs have the option of saving the structure as a molfile, which is a text file 
listing each atom and bond.  A brief description of the molfile format is given below. 



194 

 

Typing ML enters the Molecule subroutine.  Note that "Molecule" is displayed in the 
gray status bar, and the menus have changed.  A File/Open dialog box is displayed, 
allowing the user to select a .mol file to be displayed.  The molecule can be moved and 
resized in the usual way.  As with all subroutines, typing <ENTER> or choosing Exit 
from the File menu will exit the subroutine back to the NUTS base level. 
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More than one molfile can be displayed.  Typing G or choosing Get Molfile from the File 
menu allows additional files to be displayed.  Typing I or choosing Increment from the 
File menu allows each structure, in turn, to be selected.  The selected molecule can be 
deleted by typing D.  All molecules can be cleared by typing C or choosing Clear 
Molecule List from the Edit menu. 
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The Edit menu contains several options, which can also be entered from the keyboard.   
Commands operate on the currently selected molecule.  The + and - keys allow the bond 
line width to be changed.  The font can be changed by typing F or selecting Choose 
Molecule Font from the Edit menu.  The font can also be set from outside the molfile 
subroutine with the FJ command. 

  

  The A command displays atom 
properties 
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   The B command displays bond 
properties 

  

 

The # key toggles on/off display of the numeric atom labels. 

The preliminary steps are in place to be able to search a chemical shift database by 
clicking on a specific carbon atom.  This is done by generating a text-based code for the 
atom, and then searching a pre-existing text database for matches.  Right click on a 
carbon atom to display matches found in a small database included with NUTS.  The 
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code for the atom can be displayed by placing the cursor on the chosen atom and typing 
?  Note that this feature is incomplete. 

See also: Displaying a structure as a MetaObject, 13C chemical shift searching, 
substructure coding  

Sample molfile 

A molfile for 2-butanone          

looks like: 

ChemWindow 
  5  4  0  0  0  0  0  0  0  0  1 V2000 
    2.2994    2.0277    0.0000 O   0  0  0  0  0  0  0  0  0  0  0  0 
    3.2617    0.3611    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
    2.2994    0.9166    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
    1.3372    0.3611    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
    0.3750    0.9166    0.0000 C   0  0  0  0  0  0  0  0  0  0  0  0 
  3  1  2  0 
  3  2  1  0 
  4  3  1  0 
  5  4  1  0 
M  END 

The first 2 lines are unimportant for our purposes.  The next 5 lines are the atom table, 
one line per atom.  The first 4 columns are the atom's x, y and z coordinates and atom 
type.  Because this was generated from a 2D drawing program (ChemWindow), all z 
coordinates are zero.    

The next 4 lines comprise the bond table, 1 bond per line.  The first 2 columns list which 
2 atoms are connected by the bond.  The third column indicates whether the bond is 
single (1), double (2), triple (3) or aromatic (4). 

Details of the MolFile format 

First line of table is the "Counts Line": 

aaa bbb lll fff ccc sss xxx rrr ppp jjj mmm vvvvv 
aaa = number of atoms 
bbb = number of bonds 
lll = number of atom lists 
fff = obsolete 
ccc = chiral flag: 0=not chiral, 1=chiral 
sss = number of stext entries 
xxx = obsolete 
rrr = obsolete 
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ppp = obsolete 
jjj = obsolete 
mmm = number of lines of additional properties,including 
the M END line.  
No longer supported, the default is set to 999. 
vvvvvv is the version number - this software accepts V2000 
or V3000 

The next block of lines is the Atom Block: 

xx.xx yy.yy zz.zz aa dd cc ss hh bb vv HH rr ii mm nn ee 
x = x atom coordinate 
y = y atom coordinate 
z = z atom coordinate 
a = atom symbol ( this software supports strings less than 
10 in length 
d = mass difference 
c = charge 
s = atom stereo parity - 0=not stereo, 1=odd, 2=even, 
3=either 
h = hydrogen count 
b = stereo care box 
v = valence 
H = H0 designator - 0=not specified, 1=no H atoms allowed 
r = Not Used 
i = Not Used 
m = atom-atom mapping number 
n = inversion/retention flag 
e = exact change flag - 0=property not applied, 
1=change on atom must be exactly as shown 

The next block of lines is the Bond Block: 

11 22 tt ss xx rr cc 
1 = First atom number 
2 = Second atom number 
t = Bond type - 1=Single, 2=Double, 3=Triple, 4=Aromatic 
s = Bond Stereo - 0=Not Stereo, 1=Up, 4=Either, 6=Down 
x = Not Used 
r = Bond Topology - 0=Either, 1=Ring, 2=Chain 
c = reacting center status 

Detailed description of the molfile format can be found at 
http://www.mdli.com/downloads/public/ctfile/ctfile.jsp.   Note that not all drawing 
programs adhere strictly to the published format. 

Line-fitting (deconvolution)  
LF – Line fit 

This section describes the deconvolution subroutine. A summary of subcommands is 
given below. See example below of how to use LF. 
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Deconvolution, or line fitting, is a subroutine which adjusts parameters of a set of lines to 
fit peaks in a real spectrum. The parameters adjusted for each input peak are frequency, 
height, width at half height, and ratio of Lorentzian/Gaussian lineshape (expressed as 
percent Lorentzian). The user enters a set of initial peaks which will be varied in a 
Simplex optimization to find the best fit. Note that in more complex cases involving 
overlapping lines, this process may require an iterative approach with user input along the 
way.  

The subcommands described below are single-letter commands which are executed 
immediately. All subcommands can be accessed via the menus, except those which 
require the mouse, and most can alternatively be executed from the command line. The 
menu selections list the single-letter commands for the user's information. 

N.B. Before entering the LF subroutine, it is recommended to perform a Baseline Flatten 
(BF) operation on the displayed region of the spectrum, to be sure that the baseline in the 
region being fit is flat; otherwise, the fit will not be very good.  

To begin, use Zoom to expand the spectrum so that only the peaks of interest are 
displayed, and then exit Zoom. Type LF or select Line Fit from the Tools menu to enter 
the fitting subroutine. Note that the menu bar has changed to display commands which 
are active in this subroutine. The first step is to pick a set of peaks as a starting point. 
Hold down the left mouse button, place the crosshair cursor at the top of one of the peaks 
and then release the mouse button. A red Lorentzian line will appear superimposed on the 
spectrum. To adjust its width, place the cursor at the peak's half height at the desired 
width of the line and click the right mouse button. To view the parameters for this line, 
type I, which brings up a dialog box containing all the information about the line. Any 
parameters except the absolute intensity and area can be adjusted, and the changes 
applied by clicking the Apply button. The areas are more easily compared by setting 
Relative Area of a chosen peak to a value such as 1. To do this, display the parameters for 
the chosen peak, then using the cursor, wipe across the box labeled Relative Area and 
type in a new value. All peaks will now have values expressed relative to this value. 
Close the dialog box to return to the spectrum.  

To perform a Simplex fit to this line, type O (for Optimize). The red line will display the 
result of the fit. The new parameters can be viewed using the dialog box or they can be 
placed into the Windows clipboard by typing T. The parameters can then be pasted into 
the Windows or any other word processing program or text editor for editing, or can be 
displayed on the screen by typing Ctrl-B. Note that, to display the most recent 
parameters, not only must they be placed into the clipboard with T, but the screen display 
must be updated. This happens whenever some operation is performed which causes the 
screen to be re-drawn, but an update can be forced by typing Ctrl-B twice.  

More lines can be added in the same manner as the first. Note that the current line is in 
red and all others are in green. A quicker way to enter the starting lines is to let the 
software find the peak maximum. Instead of placing the crosshair cursor on the peak 
maximum, place it directly below the peak, below the axis, and release the mouse button. 
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NUTS find the peak maximum and positions the line at that frequency, provided the 
cursor is placed within +/- 2 data points of the position of the peak maximum. A still 
simpler method is to let the peakpicking function of NUTS find the peak positions and 
heights. Typing P performs peakpicking in the same manner as the PP command used at 
the base level of NUTS, and displays Lorentzian lines at the position of each peak. If not 
all peaks are selected, the user can adjust the parameters for minimum height (MH) and 
RMS noise factor (RM) by typing M, which brings up a dialog box for adjusting these 2 
parameters. Lines can also be added or deleted manually. 

As lines are entered, they are placed into a list. To move to the next line in the list, type F 
(for Forward) and to move to the previous line, type B (for Back). The easiest way to 
keep track of which line is which is to start with the peak farthest to the left and enter 
them in order from left to right. At any time, the peaks can be reordered from largest to 
smallest chemical shift by selecting Reorder form the Edit menu or by typing R. The 
current line (in red) can be deleted by typing D. Note that if the third line out of a list of 
5, for example, is deleted and then a new line added in its place, the new line will be fifth 
and last in the list, until the list is Reordered. When the parameter dialog box is opened 
(with I), the parameters displayed correspond to the current line, shown in red. The 
parameters for any other line can be displayed by entering its line number or by clicking 
the Previous or Next buttons.  

Starting with NUTS versions dated May, 2000, it is possible to "freeze" chosen 
parameters so they are not adjusted during the fit process.  While the parameter dialog 
box is displayed (with command I), there is a check box labeled "Iterate" next to each of 
the 4 parameters.  Removing the check mark will prevent the corresponding parameter 
from being adjusted during the fit.  

Once all lines have been initialized and adjusted to some reasonable starting parameters, 
typing A initiates the Simplex fit on all lines. This can take a minute or more if the fit 
consists of several lines, as the dimensionality of the problem is large (4 times the 
number of lines). To fit a group of overlapping peaks, it works best if the starting point is 
as close as possible. Try optimizing each line individually (with O) before starting the 
complete fitting routine (A). The Simplex routine has been implemented to perform a 
fairly quick fit so that the user gets an indication of the progress. After one iteration, 
adjustments can be made to individual lines as needed and then the optimization 
performed again. Since the starting point for the second iteration is closer, the result will 
be better. During the optimization, NUTS displays a decreasing Error value as each 
Simplex loop is completed to allow the user to monitor how the optimization is 
proceeding. 

There are several choices for viewing the calculated spectrum and comparing it to the real 
spectrum. Typing S displays the sum of the lines, which should overlay the real spectrum. 
Typing the plus sign displays both the sum and the individual lines. Typing L displays 
the individual lines. Typing the period key toggles the display of individual lines between 
a solid and a dotted line. Typing the minus sign displays the difference between the real 
and calculated spectra. To perform the fit to the real spectrum, the LF routine first 
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digitizes the theoretical line to match the real peak point-for-point. The digitized 
calculated spectrum can be viewed by typing C.  

Exiting the line fitting subroutine (with Enter) does not delete the calculated lines. 
Therefore, LF can be exited and changes made to the frequency limits and then LF re-
entered. The calculated lines will be adjusted to reflect the new display. Note that this 
could result in the fit operating on peaks which are not displayed. 

NUTS provides the option of saving the calculated spectrum and/or the list of parameters 
which define the calculated peaks (position, height and width for each line). Once a 
calculated spectrum has been saved, it can be opened and manipulated exactly as any real 
spectrum. A previously saved list of parameters can be opened and the resulting 
calculated spectrum will be displayed. This allows the user to save a "template" for 
repeated use on a series of spectra. These options are available under the File menu. 

New macro commands were added to set the file names for these operations:  

SET LF_GET_FILENAME = xxxxxxx.yyy  

SET LF_WRITE_FILENAME = xxxxxxx.yyy  

Another set of Macro Commands were added to increment any filename extensions for 
these file names (xxx.001 to xxx.002):  

DO INCREMENT_LF_GET_FILENAME  

DO INCREMENT_LF_WRITE_FILENAME 

Subcommands 

A -- simplex fit to All lines 
B -- move Back to previous line 
C -- display digitized line Calculated from current Lorentzian (displayed in grey) 
D -- Delete current line 
F -- move Forward to next line 
I -- display parameter Information dialog box 
G -- Get (open) a lines information text file 
L -- display individual Lines 
M -- display Minimum height dialog box for peakpicking 
O -- Optimize fit to current line 
P -- Pick peaks for starting point 
R -- Reorder peaks from low to high field. Remember to type T again to copy the 
new list to the clipboard. 
S -- display Sum of individual lines; this toggles between the sum and the 
individual lines 
T -- Type parameter list into the Windows clipboard 



203 

W -- Write a lines information text file 
Z -- Zero all lines 
.(period key) -- Toggle display of individual lines between dotted and solid line. 
+(Plus sign) -- Display both individual lines and sum of lines 
-(Minus sign) -- Display difference between real and calculated spectra (displayed 
in grey) 
% -- Set default percent Lorentzian lineshape (default is 1, or 100% Lorentzian). 
ENTER -- exit LF subroutine 

Illustrated example of LF 

This subroutine performs a Simplex fit to a set of peaks. The user must define a starting 
set of peaks before starting the fit process.   

The parameters adjusted are each peak's frequency, intensity, width at half height and 
ratio of Lorentzian to Gaussian lineshape. Starting with NUTS versions dated May, 2000, 
it is possible to "freeze" chosen parameters so they are not adjusted during the fit 
process.  See below. 

Note that LF is not included in NUTS Lite. 

  

 

Because these 2 peaks overlap, integrating does not give an accurate ratio of their areas. 
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Start by expanding the spectrum to show just the region of interest. Enter the 
deconvolution routine by typing LF or by selecting Line Fit from the Tools menu.  

  

 

Begin by creating a set of peaks that match the real spectrum reasonably well, as a 
starting point for the fitting routine. 

There are 3 different ways to enter a set of peaks. 

As shown above, place the cursor on the top of a peak and click once with the left mouse 
button. 
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 A red Lorentzian line is drawn at the location chosen in the previous step. 

A second way to input a peak is to place the cursor below the axis at the chosen 
frequency. NUTS will find the closest peak maximum and put a peak there.  

Notice that the second peak which was entered is red, and the first peak has changed to 
green. NUTS builds a list of peaks as they are entered, and the "current" peak is always in 
red. 

A third method, not shown here, is to let NUTS select peaks using the same criteria as 
normal peak picking. To use this method, type P or choose Peak Pick from the Fit menu. 
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It is possible to select a different peak to be the current peak by moving through the list, 
by typing F (Forward) and B (Back) commands, which are also available from the Edit 
menu. 

  

 

The broader peak has been selected as the current peak, so it is now shown in red. 
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The default peak width did not match the actual width of this peak. The fit will proceed 
better if its width is adjusted. 

Place the cursor on the peak at half height, and click the right mouse button. The width of 
the red peak changes.  

(Users with a single button mouse should hold down the shift key and use the mouse 
button when instructions call for use of the right mouse button.) 

Once all starting peaks have been created, and line widths adjusted, we are ready to start 
the fitting process.  By default, 4 parameters are adjusted during the fit for each peak:  
amplitude (intensity, or height), width, position (frequency) and ratio of Lorentzian to 
Gaussian lineshape.  Any of these parameters may be "frozen", so that it is not adjusted 
during the fitting process (see below). 

The fit is performed by typing A or selecting Optimize All Lines from the Fit menu. This 
is a Simplex optimization. The optimization can be aborted by typing Q 

The parameters for each peak can be examined by typing I or selecting Information on 
Line from the Fit menu. This brings up the box shown below. 
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Intensity and Area are reported in two ways, as absolute and relative numbers.  The 
relative intensity is relative to the tallest peak in the spectrum equal to 100, so is usually a 
more convenient number.  The absolute numbers can be used to compare different 
spectra. 

Shift is shown in both Hz and ppm.   

Each peak is fit as a combination of Lorentzian and Gaussian lineshapes, expressed as 
Fraction Lorentzian, which is always a number between 0 and 1.  

The user can change parameters by entering values in any field except Absolute Area.  
When a value is changed, and Apply or OK is clicked, related values are updated to 
reflect the change, and the peak is changed accordingly. 
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It is usually helpful to set the Relative Area of a chosen peak to a convenient number, 
which is done by entering the desired value in the box for Relative Area. All area values 
are then scaled relative to this. 

Note the 4 check boxes labeled "Iterate", next to the Intensity, Shift, Width and Fraction 
Lorentzian values.  A check mark in a box indicates that this parameter will be adjusted 
during the fit.  To "freeze" a chosen parameter, remove the corresponding check mark. 

The parameters for each peak can be placed into the clipboard by typing T or by selecting 
Type Peak List to Clipboard from the Edit menu. This can then be pasted into any text 
editor, or displayed on the screen using Ctrl-B. The resulting table looks like the 
following: 

 
LINE     HZ     PPM    HEIGHT     REL_HT   WIDTH   AREA   REL_AREA  FRACTION LORENTZIAN 
  1   2401.33   8.000  2716201    90.602   2.36  6408714      37.71   1.000 
  2   2389.61   7.961  1521459    50.750  11.17 16996376     100.00   1.000 

 

The sum of the calculated peaks can be displayed, rather than the individual peaks, by 
typing S or choosing Sum from the Display menu. The sum is shown above. 

The Display menu provides other display options, including the difference between real 
and calculated peaks. 
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Spectrum simulation   
NS – Enter spectrum simulation 

This NUTS subroutine calculates and displays a spectrum based on user-input values for 
chemical shifts and coupling constants. NUTS makes the assumption that in most cases, 
the user wants to fit a calculated spectrum to a real spectrum. Therefore, the NS routine 
uses the values of Spectrometer Frequency, Sweep Width, Spectrum Offset and Number 
of Points from the current spectrum for its calculation. (It is possible to change these 
values; see below.) Subcommands can be accessed via the menus or by typing single-
letter commands that can be found next to the corresponding operation in the menu 
displays. An example illustrated with screen captures is shown below. 

To begin, type NS or select Simulation from the Tools menu to enter the simulation 
subroutine. From the Edit menu, choose Add/Edit Simulation Data. This brings up a 
dialog box for entering data. First enter the number of spins, then enter chemical shifts (in 
either Hz or PPM; set units in lower left corner). To enter coupling constants, click on the 
button in the lower right corner. When finished, click on Accept and Recalculate, which 
closes the dialog box, performs the simulation and displays the resulting spectrum. 
Repeat this process to adjust the input parameters. 

To enter data for degenerate spins (eg., a methyl group), enter each as a separate spin 
with the same value for chemical shift and couplings to other nuclei. (The couplings 
among degenerate spins are zero.)  

Within the data input dialog box is a box labeled Nuclei. By default, all nuclei are taken 
to be H, on the assumption that this is the most common situation. The actual label is 
irrelevant; the only important point is whether or not all spins have the same label. If the 
Nuclei labels of 2 of the spins are set to be different, second order interactions between 
those 2 spins are ignored. (This can be used to compare the results obtained for a given 
set of input parameters with and without consideration of second order effects.) To 
simulate a heteronuclear case, simply make the chemical shift of the heteronucleus very 
different from the others, and the Nuclei labels need not be changed.  

To compare real and simulated spectra, choose Both from the Display menu. The vertical 
scale of both spectra can be adjusted in the usual way, with either the right-hand scroll 
bar, Page UP/Page Down keys or the < > keys. To adjust the scale of just the simulated 
spectrum, type L or choose change LB/Amplitude from the Edit menu, which brings up a 
dialog box allowing the linewidth and/or scale of the simulated spectrum to be adjusted, 
without having to re-do the entire calculation. When the simulation subroutine is exited 
(with ENTER), the input data are not lost. This means the simulation routine can be 
exited and re-entered without losing data. It may be easier to view real and calculated 
spectra if the DC offset of the real spectrum is adjusted so that the 2 spectra do not 
overlap. It is possible to exit NS, change DC and re-enter NS. To change the 
Spectrometer Frequency, exit NS, type SF, enter a new value, then re-enter NS. The input 
parameters are still active, but the spectrum is not automatically recalculated on re-
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entering NS. To recalculate the spectrum, choose Recalculate from the Edit menu or type 
R. 

While in the simulation subroutine, the cursor readout works as usual. With both real and 
simulated spectra displayed, the cursor can be used to measure shifts and coupling 
constants from the real spectrum for input in the parameter input dialog box. This can be 
repeated until all starting parameters are input before investing time to calculate the 
spectrum by selecting Accept Changes in the dialog box.  

Within the simulation subroutine, it is possible to enter Zoom to change the displayed 
region. This is done by typing Z or by choosing Enter Zoom from the Display menu. The 
cursor changes to the Zoom crosshair while in Zoom. Typing Enter exits the Zoom 
routine and returns to NS. Note that not all Zoom options are available. The calculated 
spectrum is not digitized in the way a real spectrum is, but the Zoom routine operates at 
the current digital resolution. This means that if the real spectrum being fit is poorly 
digitized, there may be limits on the ability to Zoom in on a narrow spectral region within 
NS. 

To experiment with spectrum simulations not matching a real spectrum, it may be 
desirable to change the values of Spectrometer Frequency, Sweep Width, Spectrum 
Offset and Number of Points. With the exception of Number of Points, these parameters 
can simply be changed by bringing up the parameter dialog box from the Parameters 
menu and entering new values. To change Number of Points, choose File New from the 
File menu (or type FN), which brings up a dialog box allowing parameters to be set. On 
re-entering NS, any previously calculated spectrum is displayed, but this does not reflect 
the changes in parameters. Execute Recalculate to implement changes. Note that the time 
required to calculate a spectrum is independent of the Number of Points. 

The simulation data can be saved as a text file containing both the input parameters and 
the calculated data as a list of frequencies and intensities. An example of such a text file 
is shown below. A previously saved simulation file can be opened from within the 
simulation subroutine and the resulting spectrum displayed. Note that if the current value 
for SF is different from that which was saved with the simulation file, the 2 spectra (real 
and simulated) cannot be compared until the simulation is recalculated. Regardless of 
whether the chemical shifts were entered as Hz or PPM, they are saved in the simulation 
file as PPM. This option is available from the File menu.  

The simulated spectrum can also be saved as an FID. The resulting file can be 
manipulated in the same manner as real data. The FID is created from the calculated 
transition frequencies and intensities. The time required to generate the FID depends on 
the current Number of Points. Be sure that the current digital resolution (Number of 
Points/SW) is sufficient to adequately digitize the calculated spectrum, or artifacts may 
appear in the spectrum generated this way. 

The spectrum can be printed by choosing Print from the File menu. Whatever is currently 
displayed (eg., the simulated spectrum or both real and simulated spectra) is what will 
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appear on the plot. The currently displayed screen can also be copied to the Windows 
clipboard for pasting into a document using the Copy Screen option from the Edit menu. 

The simulation subroutine includes the option of performing a Simplex optimization of 
spectral parameters to match a real spectrum. This is available from the Optimize menu 
or by typing O. Be advised that this process involves a huge number of calculations and 
so can be very time-consuming. It is best to adjust parameters manually first to be as 
close as possible before attempting optimization. Note that the optimization is not 
constrained to keeping shifts or coupling constants of degenerate spins the same, so that 
after optimization degenerate spins may have slightly different values. These can be 
adjusted manually and, if desired, the optimization repeated. 

The time required to calculate a spectrum depends on the number of spins and on the 
speed of the computer. Calculations involving up to about 8 spins take just a few seconds, 
but the time required goes up dramatically for each spin added. A 10-spin simulation 
takes about a minute on a reasonably fast Pentium.  (We have not had the patience to time 
a 12-spin calculation!)  Optimization is therefore practical only on smaller spin systems.  

For spin systems with a lot of symmetry (eg, an isopropyl group, with 6 equivalent Hs), 
the matrix diagonalization may fail.  The NS routine has 2 matrix diagonalization 
algorithms. NUTS defaults to an algorithm called QL (using Householder, if you want to 
look it up in Recipes in C) that attempts to diagonalize half of the matrix, which is faster, 
but this fails in some cases. However, there is another algorithm called Jacobi, which can 
be employed in this situation.  Selection of the Jacobi algorithm can be done from the 
Parameters dialog box in the NS routine (as of 7/10/08).  For earlier versions, selection of 
the Jacobi algorithm must be done from the Base Level of NUTS, before entering NS. 
First, exit the 2-letter command mode with 2F. Then start NS with the command "NS 
jacobi". This must be done each time NS is re-entered.   

Subcommands: 

The following subcommands are active within the NMR Simulation subroutine. They are 
single-letter commands which are executed immediately. All commands can also be 
accessed via the menus.  

A Add/Edit simulation data; opens a dialog box for setting shift and coupling 
values 
B Display Both simulated and real spectra 
C Display Calculated spectrum only 
D Display Digitized calculated spectrum 
F Generate FID from calculated transition frequencies and intensities. 
G Get simulation data from file 
Q Quit drawing spectrum. Interrupts a slow drawing operation. 
R Re-calculate spectrum based on input data 
S Save simulated data to text file 
Z Enter ZOOM subroutine to alter displayed frequency range. Not all ZOOM 
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functions are active. 
^C Copy currently displayed spectrum to Windows clipboard 
- (minus sign) Display difference between real and calculated spectra 

Sample Simulation File 

When a simulation is saved from within the NMR Simulation subroutine, a text file is 
created which looks like the example below (which is for ODCB). This file can be read 
into the Windows Notepad or any word processor for editing and printing. It includes the 
shifts and couplings from which the spectrum was calculated, and the transition 
frequencies and intensities which resulted from the calculation. Chemical shifts, labeled 
V(i) are in ppm. Coupling constants, labeled J(i,j), are in Hz. The Spectrometer 
Frequency is included for reference only. When this file is read into the NS routine, SF is 
not changed. The SF value can be changed by exiting NS, resetting SF, re-entering NS 
and executing Recalculation. 

NUTSsimulation 
Scale =  10000.00 
Spectrometer Frequency =   90.000000  MHz 
LineWidth =     0.250  Hz 
Spins = 4 
 
V(1) =    7.23  PPM 
 
V(2) =    7.23  PPM 
J(1,2) =   0.30  Hz 
 
V(3) =    6.97  PPM 
J(1,3) =   1.50  Hz 
J(2,3) =   8.10  Hz 
 
V(4) =    6.97  PPM 
J(1,4) =   8.10  Hz 
J(2,4) =   1.50  Hz 
J(3,4) =   7.50  Hz 
 
 
Number   Transitions(Hz)  Transitions(PPM)    Intensities 
 
    1       660.331          7.3370           0.121 
    2       659.535          7.3282           0.137 
    3       656.446          7.2938           1.241 
    4       656.057          7.2895           1.281 
    5       652.630          7.2514           2.886 
    6       650.680          7.2298           1.659 
    7       649.768          7.2196           1.863 
    8       646.846          7.1872           2.759 
    9       646.376          7.1820           2.978 
   10       642.961          7.1440           0.501 
   11       642.863          7.1429           0.572 
   12       635.137          7.0571           0.572 
   13       635.039          7.0560           0.501 
   14       631.624          7.0180           2.978 
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   15       631.154          7.0128           2.759 
   16       628.232          6.9804           1.863 
   17       627.320          6.9702           1.659 
   18       625.388          6.9488           2.886 
   19       621.943          6.9105           1.281 
   20       621.554          6.9062           1.241 
   21       618.465          6.8718           0.137 
   22       617.669          6.8630           0.121 
 
 
End NUTS Simulation File 

FN -- File New 

Used in conjunction with spectral simulation, this command allows the user to change the 
values of Spectrometer Frequency, Sweep Width, Spectrum Offset and Number of Points. 
Choosing File New from the File menu (or typing FN) brings up a dialog box allowing 
these parameters to be set. 

Illustrated example of NS 

This subroutine calculates a spectrum, including second-order effects, from the user's 
input values of chemical shifts and coupling constants. 

(Note that this is not included in NUTS Lite.) 
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On entering the NS routine, the calculated spectrum (which does not yet exist) is shown 
in red. 

To display the real spectrum (in blue) also, select Both Spectrum and Calculation from 
the Display menu, or type B. 

The cursor can be used to display chemical shifts and couplings, just as in the base level 
of NUTS. 

Typing A, or selecting Add/Edit Simulation Data from the Edit menu, brings up a dialog 
box allowing entry of chemical shifts and other parameters. 

 

First, enter the number of nuclei in the spin system in the upper left corner. 

You can go back and forth between this box and the spectrum by clicking on Accept 
Changes or Accept and Recalculate. Using Accept Changes does not calculate the 
spectrum, so is the quickest way to enter an initial set of values. Use Accept and 
Recalculate when you want to see the effect of newly entered values. To enter coupling 
constants, click on the button in the lower right corner.  
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Fill in coupling constants, then click OK to return to display of the calculated spectrum or 
"Accept and Return to Chemical Shifts" to return to the previous parameter input box. 

  

 

The calculated spectrum is shown in red. 



217 

The scale of the calculated spectrum can be adjusted without recalculating by typing L or 
selecting Change LB/Amplitude from the Edit menu. 

The normal scaling tools, such as the scroll bar, affect both spectra. 

  

 

Zoom can be used to view details. Enter the Zoom routine by typing Z (not ZO) or from 
the Display menu. 

Select the region to expand as usual by holding down the left mouse button and 
dragging...... 
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… and type Ctrl-E to display the expanded region. 

Values of shifts and couplings can be adjusted to optimize the match.  

A Simplex fit can be performed, but due to the huge number of calculations involved, it is 
best to get close manually before attempting a fit. 

Other options include displaying the difference between calculated and actual spectrum 
and saving the calculated spectrum as an FID. 

Buffers subroutine 
BU -- Buffers 

There are several methods within NUTS of placing data into a buffer for later use.   Each 
was created to address a specific need, but they may be useful for other purposes.  An 
effort has been made here to compare and contrast these tools to enable the user to apply 
them effectively. 

The Add/Subtract buffer (loaded with AL) is used with Dual Display as 
well as the Add/Subtract subroutine. 
The Data-to-Buffer (DB) and Buffer-to-Data (BD) commands were 
created to facilitate customized apodization functions. 
The Combine Buffers commands (B1, B2, B+ and B-) were created for 
use in processing echo-antiecho 2D data, where pairs of slices must be 
added and subtracted. 
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The Buffers subroutine allows several spectra or sections of spectra to be 
displayed on the same ppm axis even when acquisition parameters such as 
spectral width, spectrometer frequency and number of data points are not 
equal. 

Buffers subroutine 

This subroutine allows comparison of spectra in ways not permitted by the Dual Display, 
Add/Subtract and Stacked Plot routines (see comments below). Spectra can be displayed 
together even in cases where spectrometer frequency, sweep width and number of data 
points are not equal. 

The subroutine allows spectra, or sections of spectra, to be placed into a series of buffers, 
each displayed at a specified vertical position on the screen. The buffer spectra are 
displayed above the current spectrum such that the ppm scale is the same for all. NUTS 
will adjust the display of each spectrum to compensate for different parameters.  

The Buffers subroutine is entered by typing BU or from the View menu.  The status 
notation in the gray Status Bar at the bottom of the NUTS window is changed to "BUffer 
Control".  As with all subroutines, the Enter key will exit the routine. While in the 
Buffers subroutine, the displayed region of the displayed region of the current spectrum 
can be placed into a buffer using the subcommand A (or from the Edit menu).  The 
buffers are numbered in the order in which they are added.  An option in the View menu 
allows the buffer contents to be displayed after exiting the Buffers subroutine.  

A chosen buffer can be selected, and its properties can be edited with the E command.  
By default, the most recently added buffer is the selected buffer.  A different buffer can 
be selected by moving the mouse over the baseline of the buffer. When this is done, the 
buffer spectrum will blink and that buffer becomes selected. While the mouse is over that 
buffer's baseline, a right click or E command will display a dialog box showing that 
buffer's properties, such as amplitude, vertical position, color, pen width and identifying 
text. 

The selected buffer can be moved vertically by pressing and holding the left mouse 
button. When this is done a red line is displayed and can be moved with the mouse. When 
the left mouse button is released, the buffer moves to that vertical position. 

The selected buffer's vertical scale can be changed with the ">" and "<" keys.  The Page 
Up/Down keys and the right-hand scroll bar adjust vertical scaling of all buffer spectra 
and the current spectrum simultaneously.  Horizontal expansions (defined with the Zoom 
subroutine) affect the current spectrum and all buffers. 

The selected buffer can be deleted with the D command.  All buffers can be cleared with 
the C command.  Both commands are also available from the Edit menu.  
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The Math menu allows addition, subtraction and multiplication of the selected buffer 
with the current spectrum. 

The spectrum can be saved with all of the buffer spectra with command S or from the 
File menu.  When later opened, all buffer spectra will be recalled with their associated 
properties.  Saving from the NUTS base level (SA command) will not save the buffers. 

Using the Buffers subroutine 

 

When the buffers subroutine is entered by typing BU, note that the menus change and the 
gray status bar at the bottom of the NUTS window shows "Buffer Control".  The 
currently displayed spectrum or spectral region can be copied to a buffer with the A 
command, or from the Edit menu. 

The number 1 (because this is the first buffer added) is shown at the left end of the buffer 
spectrum as an identifier, along with some text.  By default, the comment line for the 
spectrum being displayed in the buffer is the displayed text, but that can be changed.  The 
text remains displayed after exiting the BU subroutine, but the buffer number does not. 

While display of buffer spectra is enabled, text is also displayed as an identifier for the 
main spectrum (the current data file) so that all displayed data are labeled.  The label for 
this spectrum takes the same properties as those of Buffer Spectrum #1. 

The font used for the text labels is the same as that used for horizontal integral labels. 
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To edit a buffer's properties, move the mouse to the buffer's baseline and click the right 
mouse button (or type E on the keyboard).  This dialog box is displayed: 

 

The vertical display (DC) offset and vertical scaling (amplitude) of the buffer can be set, 
as can the text of the comment line displayed with the buffer spectrum.  The color of the 
spectrum can be set by entering RGB numbers or by clicking the Color Editing button.  
Pen width and style can also be set.  

   

 

The vertical position of a buffer can be adjusted with the mouse.  Place the cursor on the 
chosen buffer, at the level of its baseline.  Press and hold the left mouse button.  The red 
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line indicates the position of the buffer spectrum.  Move the red line to the desired 
position, and release the mouse button.  The buffer spectrum will be re-drawn at that 
position. 

  

 

As additional spectra are added to the buffers, each is assigned a sequential number. 
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If an expanded region of the spectrum is displayed when the buffer is loaded, the buffer 
will contain only that region.   

   

Comparison of Dual Display, Add/Subtract, Stacked Plots and Buffers 

Dual Display and Add/Subtract are limited to 2 spectra.  There is no limit for the Buffers 
routine or for Stacked Plots. 

Add/Subtract is the only choice that allows one spectrum to be shifted left and right 
relative to the other. 

The Buffers routine is the only option in cases where the spectra differ in number of data 
points.  

Add/Subtract and Dual Display will display spectra that differ in spectrometer frequency 
and/or spectral width, but the frequency scale will be nonsensical. This is because the 
spectra are aligned point by point, without regard to frequency. The Buffers routine is the 
only way to display spectra differing in spectrometer frequency or spectral width with 
correct frequency axis for all spectra. 

The Stacked Plot routine does not allow independent scaling or vertical repositioning of 
individual spectra. 
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Multiple spectra can remain displayed on the screen after exiting the Buffers subroutine 
(not true of the stacked plot routine). This makes it easier to add annotations (with the 
Notes subroutine) and otherwise compose a final presentation. 

The 2 figures below show simulated spectra of ODCB at 100, 200 and 400 MHz using 
the buffers and stacked plot routines. 

 

Using Buffers, the spectra are aligned by ppm, even though spectrometer frequencies and 
sweep widths differ.  The ppm scale is correct for all. 
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Using a stacked plot, the spectra are aligned by points, not frequency, and the axis is 
correct only for the top spectrum. 

For an example of a "creative" use of the Buffers routine, see Tricks with Buffers. 

The following 4 commands are used to place data into buffers for later addition or 
subtraction. Do not confuse this with the Add/Subtract subroutine, which has its own 
buffer.  This is used in some 2D processing, where pairs of slices must be added and 
subtracted.  The following 4 commands do not work in Arrayed Mode;  see below. 

B1 -- Load Buffer 1  

Load current data set into buffer 1. Used in conjunction with commands B+ and B-, 
which add or subtract data loaded into buffers 1 and 2. These commands were added for 
use in processing gradient data.  The contents of this buffer are not visible. 

B2 -- Load Buffer 2 

Load current data set into buffer 2. Used in conjunction with commands B+ and B-, 
which add or subtract data loaded into buffers 1 and 2.  The contents of this buffer are not 
visible. 

B+ -- Add Buffers  

Adds the contents of buffers 1 and 2. Used in conjunction with commands B1 and B2, 
which load current data into buffers 1 and 2.  The sum becomes the current data. 
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B- -- Subtract Buffers  

Subtracts the contents of buffers 1 and 2 (B1 minus B2). Used in conjunction with 
commands B1 and B2, which load current data into buffers 1 and 2.  The difference 
becomes the current data. 

The next 4 commands work only in Arrayed Mode, and on data sets having an even 
number of slices.  These commands facilitate processing of echo-antiecho data which 
must be processed by adding or subtracting pairs of slices. (An example is gradient hsqc 
data, which uses the C2 command.)  Each command operates on a pair of slices, n and 
n+1.  The real halves of the 2 slices are either added or subtracted, and the sum becomes 
the real half of a single processed slice.  The imaginary halves of the 2 slices are either 
added or subtracted, and the sum becomes the imaginary half of the processed slice.  So, 
in each case, the processed data has half as many slices as it started out with.  We have 
yet to encounter data that requires C1, C3 or C4. 

C1 – Combine Mode #1  

This command adds the reals and imaginaries of even and odd slices and gives back a 
data set with half the number of slices.  

C2 – Combine Mode 2  

This command adds the reals and subtracts the imaginaries of even and odd slices and 
gives back a data set with half the number of slices.  

C3 – Combine Mode #3  

This command subtracts the reals and adds the imaginaries of even and odd slices and 
gives back a data set with half the number of slices.  

C4 – Combine Mode #4  

This command subtracts the reals and subtracts the imaginaries of even and odd slices 
and gives back a data set with half the number of slices.  

The following 2 commands were created to facilitate customized apodization functions, 
but their description is repeated here for comparison. 

DB -- Data to Buffer  

Copies current data to the convolution filter buffer. This is useful for creating and 
applying customized apodization functions. (Do not confuse this with the Add/Subtract 
buffer.) 
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An apodization function can be created in different ways. One option is to build it within 
Nuts by first setting the current data points all equal to one with the 21 command. 
Alternatively, the ASCII import routine could be used to import a function created within 
a different application. 

Once an apodization function is created, it can be copied to the convolution buffer with 
the DB command. The function is then viewed with the Convolution View (CV) 
command and applied with the Convolution Apply (CA) command. The latter 2 
commands were created originally for use with functions created by the reference 
deconvolution operation (CF), but are also used for the general case of applying a 
function to an FID. 

The data stays in the convolution buffer until replaced by another file or until Nuts is 
closed. The data may be copied back to the current data file with the Buffer to Data (BD) 
command.  

BD -- Buffer to Data  

Copies contents of the convolution filter buffer to the current data set, replacing the 
current data. The buffer must first have been loaded with the Data to Buffer (DB) 
command. 

Linear Prediction (LN) 
LN - Linear Prediction  

This command performs either forward or backward linear prediction, depending on 
parameters set by the user. Backward prediction can be used to correct corrupted early 
data points, which cause rolling baselines. Forward prediction is used to predict data out 
to twice the actual acquisition time, and is used with severely truncated data, such as in 
the indirect dimension of 2D experiments as an alternative to zero-filling. See illustration 
of backward and forward linear prediction, below.  

When the LN command is issued, a dialog box is displayed prompting for the following 
values:  

Forward or backward prediction 
Number of data points on which to base the prediction 
Number of points to be predicted for back prediction 
Maximum number of frequencies to predict. 

For backward prediction (which is the default), the user must set the number of points to 
back predict, the number of data points upon which to base the prediction and the number 
of frequencies to predict. The default value for number of points to back predict is 2 and 
should usually be a small number (4 or less). Larger values may cause failure of the 
prediction algorithm. The number of data points on which the prediction is based must be 
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less than half the total number of data points, or the algorithm fails. The larger this value, 
the longer the prediction process will take. The number of frequencies to predict is 
usually unknown, but usually a small value can be used. The larger the value, the higher 
the chances that the algorithm will fail. The option has been added of allowing the 
algorithm to determine the number of frequencies, by setting this parameter to -1.  

For forward prediction, the user must select the Forward Prediction button at the bottom 
of the dialog box. Forward linear prediction always doubles the number of data points. 
The value for number of points to back predict is ignored. 

LN can be used in Links and Macros, in which case the dialog box does not open. The 
parameters must be chosen before starting automated processing, and the last set of 
values will be used. It is advisable to experiment with parameters before initiating 
automated processing.  

The values of all linear prediction parameters can be explicitly set in a macro, using SET 
commands, as shown in the examples below: 

SET LNpts = 4 
SET LNmdim = 64 
SET LNnsig = 16 
SET Lndirection = FORWARD 
SET Lndirection = BACKWARD 

Linear prediction takes considerable time (can take 20-30 min for a 2D data set, even on 
a fast computer). 

See also: Polynomial baseline correction  

Illustration of forward linear prediction 

This is used to improve resolution in cases where the FID is badly truncated. This occurs 
most often in 2D data, where time constraints limit the number of slices which are 
acquired. Data which is truncated must be severely apodized to bring the end of the FID 
to zero to avoid truncation artifacts. This amounts to throwing away data which was 
acquired at great expense of time. As an alternative, we can use Linear Prediction to 
generate additional data points and then apply a window function which acts mostly upon 
these predicted points to bring the end of the FID to zero, preserving the real data points. 
The result is prevention of the broadening and loss of signal that would otherwise result, 
giving a net improvement in resolution and signal-to-noise. 

Note that linear prediction is not included in NUTS Lite. 
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This FID has not decayed to zero, and must be apodized to prevent truncation artifacts, 
especially if zero-filling is desired. 

  

 

The FID above has been apodized with cosine squared and zero-filled one time. 
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Note that we have thrown away good data. 

  

 

The original FID has been opened and LN typed. 

The first item, number of points for back prediction, is irrelevant for the present case of 
forward prediction.  

The prediction is based here on the last 64 points of the FID. This parameter cannot 
exceed one half of the number of data points in the FID, 512 in this case. Using larger 
numbers will make the calculation slower.  

The LN operation will double the data size to 1024. 
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This is the same FID as above after forward linear prediction to double the number of 
points and then application of a cosine squared window function.  

Note that there is much less loss of the original data points (the first half of the FID). 
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This dual display plot shows the improvement in the resulting spectrum. 

The top spectrum results from apodization and zero-filling. 

The bottom spectrum results from linear prediction followed by the same apodization 

Illustration of backward linear prediction 

The first few data points in an FID can become corrupted due to such things as probe 
ring-down. This results in an undulating baseline. While this can be corrected using 
NUTS tools such as polynomial correction of the spectrum (FB), it can also be corrected 
using backward linear prediction.  

See also: Forward Linear Prediction 

Note that linear prediction is not included in NUTS Lite. 

  

 

Looking at the sinusoidal fluctuation of this FID, it is easy to see that the first point is not 
at the "correct" position.  
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After FT of the above FID, the baseline clearly needs to be corrected. 

  

 

Taking the same FID, type LN (not available on menus) to bring up this screen for setting 
the necessary parameters. 
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The values shown here are the default values and are usually appropriate for baseline 
correction. 

We are going to correct the first 2 data points, based on the periodicity of the next 64 
points. Most linear prediction algorithms need to know how many different frequencies 
are present in the spectrum, which is usually not known. By setting this value to -1, 
NUTS will determine this value.  

We have chosen backward preciction. 

  

 

After executing the backward linear prediction, the first data point is clearly in the correct 
place. 
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After FT, the baseline is much flatter. 

Stacked Plots (SP) 
SP - Stacked plots  

A stacked plot of 2D data or "arrayed" 1D data can be displayed. The spectra must first 
exist as a 2D data file in NUTS. (This is included in 1D versions of NUTS.) See below 
for instructions on creating a 2D file from separate 1D data. 

To display just 2 spectra together, see also Dual Display.   To display multiple spectra 
with differing spectrometer frequency, spectral width and/or number of data points, see 
Buffers subroutine. 

Note that stacked plots are not included in NUTS Lite. 
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Open the 2D data file. The first slice only is displayed. 

Execute a Set Scale operation (keyboard command SS or from the 2D Process menu) 
which looks at all slices to find the tallest peak so that the display can be scaled 
appropriately. 

Now, choose Stacked Plot from the Tools menu. 
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All slices are displayed and scaled to be on screen. 

The default offsets are set in the Nuts.ini file, but can be edited by choosing Slice Offsets 
from the Display menu. The values used here are  

X-Offset = 10% 
Y-Offset = 1 (on a scale of 1 to 10) 

The vertical scale of all slices can be changed in the same way as 1D data.  
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The option of a "whitewashed" plot is available from the Display menu. In this mode, 
lines which are behind peaks are not displayed.  

Compare this to the previous figure. 

  

 



239 

It is possible to construct a stacked plot of only a part of the total data set. The plot limits 
can be set in either of 2 ways: 

For an actual 2D data set, display an intensity or contour plot and use 2D Zoom to select 
the region. Exit the contour plot and display the stacked plot. 

Alternatively, the plot limits can be set explicitly using the Zoom subcommand F. (You 
must exit from the Stacked Plot display, with <Enter>, to enter Zoom.) The critical point 
to understand is that you must explicitly set the range of slices to be displayed on the 
right hand side of the screen (Vertical Dimension). Click on OK, then execute a Ctrl-E 
command to implement the chosen range. 

  

 

The desired expanded region is displayed. 
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Failure to set the desired range of slices will result in display of only 2 slices, rather than 
the entire data set. 

  

To build a 2D file from separate 1D spectra, the individual spectra must have sequential 
file extensions. Start by opening the first of the 1D files. A 2D data set can be created by 
running the following Link:  

GA SC IN 

NUTS will first ask for the name of the first file to open, and then for a name for the 2D 
file to be created. When the link has finished, open the 2D file. 

Math functions (MA) 
MA -- Math functions in NUTS   

This is a subroutine for doing calculations.  While the routine can be used as a calculator 
from the user interface (entered with command MA), its utility is in use within macros.  
The following definitions may make more sense if you examine the Math screen by 
typing MA. 

There are 10 REGISTER, 10 MEMORY and 10 INTEGRAL locations. The REGISTERs 
act like a stack, similar to an RPN calculator.  When a math operation is done, it is 
performed between REGISTER_0 and REGISTER_1 and the answer is put in 
REGISTER_0 and REGISTERs 2 thru 9 roll down one level.  There is one comment field 
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which can be placed into a Note, along with the contents of Register 0, so results are 
displayed on the screen.  An example of a macro is shown below. 

Related commands: Multiply and Divide data by a specified constant. 

Macro commands  

Use of the ENTER function puts the value in REGISTER_0 and rolls the stack up. For 
example, 
    DO MATH ENTER 1 

Any location can be set to a specific value, such as 
    SET MATH REGISTER x value              Set Reg x to "value" 

Clear all Registers, Memory and Integral values using 
    DO MATH CLEAR 

The line below specifies the number of decimal places to show in calculations 
    SET MATH DECPLACES x                      

The math operations possible are: 

add 
subtract 
multiply 
divide 
reciprocal 
natural log 
log base 10 
exponential 
power 

The following operations are performed on Registers 0 and 1, and the result is then 
placed into Register 0. 

DO MATH +  
DO MATH -                     Register 1 - Register 0 
DO MATH * 
DO MATH /                      Register 1 / Register 0 
DO MATH POWER         Reg0**Reg1 

These operations are performed on the contents of Register 0: 

DO MATH RECIPROCAL                  1/Reg0 
DO MATH EXP 
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DO MATH LN                                     Natural Log 
DO MATH LOG                                   Log Base 10 

The value of Register and Memory locations can be set from another location, using 
    DO MATH REGISTER x REGISTER y              copy contents of Reg x to Reg y 
    DO MATH REGISTER x MEMORY y              copy contents of Reg x to Mem y 
    DO MATH MEMORY x REGISTER y              copy contents of Mem x to Reg y 
    DO MATH INTEGRAL x REGISTER y              copy contents of Integral x to Reg y 
    DO MATH INTEGRAL x MEMORY y                  copy contents of Integral x to Mem 
y 

Acquisition parameters can be set from Register 0, using 
    DO MATH SF1                              Set SF1 to the value in Register 0 
    DO MATH SF2                              Set SF2 to the value in Register 0 
    DO MATH SW1                              Set SW1 to the value in Register 0 
    DO MATH SW2                              Set SW2 to the value in Register 0 
    DO MATH OF1                               Set OF1 to the value in Register 0 
    DO MATH OF2                               Set OF2 to the value in Register 0 
    DO MATH TMS                              Set 1H TMS frequency to the value in Register 0 
(new as of 7/12/08) 
    DO MATH CHI    Set CHI to the value in Register 0 (new as of 
5/12/09; CHI is the x-nucleus frequency ratio relative to 1H, for referencing) 
    DO MATH MEMORY x CHI  Put CHI value into Memory x 
    DO MATH REGISTER x CHI  Put CHI value into Register x 

Acquisition parameters can be placed into Registers or Memory locations, using 
    DO MATH REGISTER x SF1        Put SF1 into Register x 
    DO MATH REGISTER x SF2        Put SF2 into Register x 
    DO MATH MEMORY x SF1          Put SF1 into Memory x 
    DO MATH MEMORY x SF2          Put SF2 into Memory x 
    DO MATH REGISTER x SW1          Put 1st Dimension sweep width into Register x  
    DO MATH REGISTER x SW2          Put 2nd Dimension sweep width into Register x  
    DO MATH MEMORY x SW1           Put 1st Dimension sweep width into Memory x 
    DO MATH MEMORY x SW2           Put 2nd Dimension sweep width into Memory x 
    DO MATH REGISTER x OF1             Put 1st Dim O1 into Reg x 
    DO MATH REGISTER x OF2             Put 2nd Dim O2 into Reg x 
    DO MATH MEMORY x OF1              Put 1st Dim O1 into Memory x 
    DO MATH MEMORY x OF2               Put 2nd Dim O2 into Memory x 
    DO MATH MEMORY x TMS            Put 1H TMS frequency into Memory x  (new as 
of 7/12/08) 
    DO MATH REGISTER x TMS            Put 1H TMS frequency into Register x  (new as 
of 7/12/08) 

The Zoom regions (Z0 - Z9) can be set from values in the Registers.  The line below sets 
Zoom Region i. The value in register x becomes the left end of Zoom Region i (in ppm), 
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and the value in register y becomes the right end (in ppm).  
    DO MATH ZOOM_REGION i x y               

The following creates a Note (text annotation) consisting of the COMMENT and the 
contents of Register 0, and displays it at specified screen position (x_pos, y_pos) (in 
percent of display, a number between 0 and 100).  The font used is the default Notes font, 
set in the nuts.ini file. 

    SET MATH COMMENT string              Make "string" a comment for output 
    DO MATH NOTE x_pos y_pos  

To automatically measure pre-defined integrals, the integral limits must first be defined 
using the Set Zoom Region command.  (Do not confuse this with the Set Integral macro 
commands.)  After all regions are defined, a single command, DO MATH GET_INT, 
measures all values and places them into the corresponding INTEGRAL locations.   For 
example, The following sequence defines 2 integrals (7.4 - 7 ppm and 6.2 - 6.0 ppm), 
named as regions 1 and 2, and then the Get_Int command puts the integrals of those 
regions into Integral locations 1 and 2.  It is important to understand that the DO MATH 
GET_INT command measures the integrals of all defined zoom regions. 

set zoom_region 1 7.4 7 
set zoom_region 2 6.2 6.0 
do math get_int 

It is also possible to load areas resulting from a line fit in the LF routine.  The command 

Do Math get_lf_areas 

will insert the area values of peaks 1-10 from the LF calculation into the corresponding 
INTEGRAL locations. 

These commands are used to request user to enter values at runtime.  The entered value is 
placed in the specified location. 

ASK MATH REGISTER x              Ask for a value for Reg x 
ASK MATH MEMORY x              Ask for a value for Mem x 

Example:  The following is a macro which measures the mole% of 2 impurities, relative 
to the major component. 

NutsMacro math test 
; ask name of file to open 
ask filea 
ga 
; clear any old Notes 
no 
c 
^m 
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; integrals of 1 proton each from major component 
set zoom_region 1 7.17 7.04 
set zoom_region 2 7.27 7.18 
 
; integral of impurity #1 
set zoom_region 3 6.02 5.96 
 
; integral of impurity #2 
set zoom_region 4 2.72 2.68 
 
; now get the integrals and place into Integral locations in Math 
routine 
do math get_int 
 
; average integrals of 2 protons from major component.  Move integrals 
from major component 
; into registers 0 and 1, add them, divide by 2. 
do math integral 1 register 0 
do math enter 1 
do math integral 2 register 0 
do math + 
do math enter 2 
do math / 
 
; Put result into memory location for later retrieval 
do math register 0 memory 7 
 
; impurity peak #1 is from 2 protons, so move it to register 0, enter 
value of 2, divide, then move to memory location 
 
do math enter 1 
do math integral 3 register 0 
do math enter 2 
do math / 
do math register 0 memory 1 
 
; calc mole % imp 1.  Divide previous result by integral of main 
component, mult by 100 
do math enter 1 
do math memory 7 register 0 
do math / 
do math enter 100 
do math * 
 
; Set comment, output result at specified screen location 
set math comment Mole % Impurity #1 
do math note 35 10 
 
; now do same for impurity #2 
do math integral 4 register 1 
do math memory 7 register 0 
do math / 
do math enter 100 
do math * 
set math comment Mole % Impurity #2 
do math note 35 20 
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end 

See also: sample macro for X-nucleus chemical shift referencing based on the proton 
TMS frequency. 

Multiply  

Multiply the current 1D data set or the currently displayed slice by a constant.  This takes 
one argument, the factor by which the data is to be multiplied.  In Arrayed Mode, only 
the current slice is multiplied, not the entire data set. 

Divide  

Divide the current 1D data set or the currently displayed slice by a constant.  This takes 
one argument, the factor by which the data is to be divided.  This can be helpful in 
cleaning up 2D data which has t1 noise "stripes", which consist of a few data slices with 
high noise level.  Display each slice and divide it to reduce the noise amplitude.  This 
command is not array-aware, meaning that even in arrayed mode, it acts only on the 
displayed slice. 

Copying spectra to other applications 

NUTS provides multiple options for copying spectra into other applications, either via the 
clipboard or by writing to a file.  The Enhanced Metafile usually works best, but other 
choices are available to allow the user to experiment and choose. 

The commands described below are  

Control-C -- Copy to clipboard as bitmap 
(Also, copy bitmap as black and white) 
Alt-Shift-C -- Copy to clipboard as a standard metafile 
Alt-Shift-E -- Copy to clipboard as an enhanced metafile 
Alt-Shift-P -- Copy to clipboard as an enhanced metafile using the printer device 
context 
Ctrl+Alt+C -- Copy to file as standard metafile 
Ctrl+Alt+L -- Copy to file as placeable metafile 
Ctrl+Alt+E -- Copy to file as enhanced metafile 
Ctrl+Alt+P -- Copy to file as enhanced metafile using the printer device context 
metafile -- Copy to clipboard as an enhanced metafile 
metafile enhanced_standard_clipboard -- Copy to clipboard as an enhanced 
metafile 
metafile enhanced_printer_clipboard -- Copy to clipboard as an enhanced 
metafile using the printer device context 
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The last 3 commands listed above were created to allow copying from within a macro, 
because the special (control, alt, shift) keys cannot be used in a macro.  These commands 
operate in the non-2-letter command mode. 

Choosing Copy Bitmap from the Edit menu (or typing Control-C) copies the currently 
displayed screen to the clipboard, from which it can be pasted into other programs, such 
as word processing programs. The "picture" created this way is a bitmap, and can be 
edited with a Paint program. This is the quickest way to place spectra into reports and is 
often sufficient. The drawback to a bitmap is that the picture is created pixel by pixel and 
so is limited to screen resolution, whereas NMR data usually has much better inherent 
digital resolution. The spectra can end up looking coarse, similar to a FAXed image. 
Distortions can also result when the bitmap is re-sized. The quality of the final image will 
be affected by the size of the NUTS window before executing Copy.  A large window 
will contain more pixels, so the resolution will be better.  However, if the image is then 
reduced in size, some pixels can be "lost", and the image can have gaps.  It may work 
better to set the NUTS window to the size of the final image desired, then Copy, and 
don't resize after pasting. 

The second method for placing a spectrum into a report is to copy it as a Windows 
Metafile, rather than a bitmap.  A Metafile is a vector drawing and can be edited with 
Draw programs. This type of drawing preserves the digital resolution inherent in the data, 
so the spectrum looks as good as when printed directly out of NUTS. The disadvantage is 
that it is slow and the resulting picture when pasted into other programs can be very 
large. The more data points you have displayed, the slower the operation is.  

The appearance of the image after pasting is affected not only by NUTS, but also by the 
target application (see comments below).  NUTS offers multiple Metafile variants to give 
the user the ability to experiment with what works best with his/her preferences and other 
applications.  Some trial and error is needed to determine the best way to paste spectra 
into a particular application.  

The Enhanced Metafile seems to avoid some of the reported problems with printing from 
the target application, and seems to handle fonts somewhat better. Also, any inset plots 
which have been created (with MO) are copied along with the main plot, which is not 
true of standard metafiles. There are 2 types of Enhanced metafiles available from the 
Edit menu, one of which requires a printer "device context".  Using a printer DC means 
that the image is generated with properties pertaining to a specific printer.  If this is 
chosen, and a printer has not been defined in the current Nuts session, a print setup box 
will appear when a metafile is copied. 

Why use a Printer Device Context? 

When a metafile is copied to the clipboard, the coordinates are expressed as integers 
(because you can't have a fraction of a pixel) and this can cause roundoff errors if the 
number of points in the spectrum being copied exceeds the number of pixels.  When the 
resulting metafile is pasted into the target application and stretched, distortion can result.   
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The logical solution is to create the metafile at higher digital resolution.   This is done by 
using a "Printer Device Context" which means that the metafile is composed at the digital 
resolution of the printer rather than the lower screen resolution.  Most common printers 
are 300 or 600 dpi, but you can install a printer driver that has much higher resolution (> 
2000 dpi), even though you don't actually have such a printer.  Add a "printer" (such as a 
Linotronic) on your computer whose designated destination is FILE rather than a printer 
port, and select this printer from inside NUTS (File/Printer setup).  Then choose "Copy 
Printer DC Enhanced Metafile to Clipboard" from the Edit menu.   When pasted, the 
image should be essentially free of distortion.  Note that many applications, such as 
Word, allow you to edit a pasted metafile, but to do this, the application converts it to its 
own internal graphics object, and this may re-create the very roundoff problem we had 
avoided.  

We have recently (September, 2003) noticed that the procedure described above no 
longer yields high quality spectra in Word or PowerPoint.  If you display the resulting 
spectrum at 500% scale, the distortion is obvious.  We assume changes in newer versions 
of Office or perhaps Windows are responsible.  There is a work-around.  NUTS allows 
copy the metafile to a file, rather than to the clipboard.  Save the spectrum to a file, then 
use Insert/Picture from file to place the spectrum into the document.   

The added complication is that the target application into which the spectrum is pasted 
also affects the final image quality.  Using the higher resolution printer device context 
solves the roundoff problem when pasting into Word or PageMaker.  But pasting the very 
same copied spectrum into Publisher or PowerPoint still gives a spectrum distorted by 
roundoff.  

A few additional points need to be noted regarding metafiles. Any text displayed on the 
screen (with Ctrl-B command) is not copied when copying as a standard metafile or as a 
PICT file, because placing the spectrum into the clipboard replaces the text that was 
there. Text on the screen is preserved when copying as an enhanced metafile or bitmap. 
Font sizes chosen in NUTS assume a full-page plot. If the spectrum is reduced when 
pasted into another application, the fonts are reduced proportionately, and may become 
too small. The font can first be changed in NUTS from the Edit/Fonts menu. This can 
easily be done with a macro which resets the font sizes. Whether or not the font can be 
changed after pasting into the target application depends on the specific application. 
  PowerPoint, Publisher and Word have the ability to break the image down into its 
component parts, which allows you to edit parts of the spectrum (eg., change the font of 
the axis labels, remove a specific integral trace, change colors of any single item).  
However, this involves a conversion which can result in loss of image quality. 

For documents which will ultimately be printed on a black and white printer, you may 
want to set all colors in NUTS to black (from the File / Page Setup menu, choose 
monochrome display). Otherwise, from some applications (such as Microsoft Word), the 
laser printer will "dither" the colors and the lines will come out dashed, not solid.  Figures 
for slides or posters may be more visible if the line thickness is increased before copying, 
which is also done from the NUTS File/Page Setup menu.  Depending on the graphcis 



248 

capabilities of the target application, annotations may be made after pasting.  However, it 
may be simpler to add a structure or text annotations in NUTS before copying. 

A Metafile can also be written directly to a file, rather than placed into the Windows 
clipboard, by typing Ctrl+Alt+C (for a Standard Metafile), Ctrl+Alt+L (for a Placeable 
Metafile) Ctrl+Alt+E (for Enhanced Metafile) Ctrl+Alt+P (for Enhanced Metafile with 
printer device context). These commands are also available from the Edit menu. The 
Metafile will consist of the currently displayed region. NUTS will prompt for a file name 
for the Metafile. (The file extension .WMF is suggested, as this will be recognized by 
many other Windows applications.)  

Another method of incorporating spectra into reports is to print to a file.  Many 
applications, such asWord, have import filters for these files which can be used to insert a 
graphics object into the target application. Depending on the type of printer available and 
the import filters in the target application, it is possible to print to a file in either HPGL 
format or postscript format. To do this, choose Print Setup from the file menu and select 
"HPGL Plotter to File" or "Postscript Plotter to File" as the printer. (If this is not one of 
the printer options, the corresponding printer driver must first be installed. Then connect 
that printer to file using the Windows Control Panel.) Use Page Setup from the NUTS 
File menu to choose whether or not a box drawn will be drawn around the plot and 
whether or not parameters should be listed. Then choose Print from the File menu and 
supply a file name. The file can then be imported from within a word processing program 
or other application. How well this works is dependent on the import filter of the program 
into which the file is imported. 

Window view  for interactive apodization 
WV - Window View 

This subroutine allows experimentation with window functions while simultaneously 
viewing the apodization function, the FID and the resulting spectrum. The spectrum can 
be expanded with zoom so that the effects on lineshape can be more easily seen. 

This subroutine is not included in NUTS Lite. 
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Start by processing the data with no apodization, FT and phase.  

Before entering the WV subroutine, this has been expanded to view the region of interest. 

Type WV to enter the subroutine. 
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The grey line at the top is the apodization function.  

The green trace is the entire FID, even when the spectrum is expanded. This allows 
adjustment of the apodization to match the shape of the FID. 

Most Nuts commands are active while in the WV subroutine, allowing the user to set 
parameter values such as linebroadening (LB), gaussian factor (GF) and phase for sine 
function (S#). 

No changes are made until the chosen window function is applied. (EM, LG, TF, MS or 
TM) 
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 Here, LB was set to 1 and EM executed.  

The grey line shows the shape of the resulting function. The FID does not change. 

The spectrum has changed to reflect application of 1 Hz linebroadening. 

This operation can be undone by typing Ctrl-Z, causing the apodization function and 
spectrum to be reset so that a different function can be applied. 
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Here, LB was set to -1, GF was set to 0.1 and LG was executed (Lorentz-Gauss 
resolution enhancement). 

Exiting the routine with <ENTER> applies the current window function and displays the 
resulting spectrum. 

Exiting the routine with <ESCAPE> aborts the operation, and reverts to the spectrum that 
was displayed before the WV routine was entered. 

Note that commands ZF and SH cannot be executed while in the WV routine. 

WV can be especially useful when optimizing window functions for 2D data.   

Reference Deconvolution 

We were intrigued by a poster presented at the 1994 ENC by Ken Metz (Poster # WP111) 
entitled "Simple Technique for Improving Resolution in Heteronuclear NMR Spectra by 
Deconvolution with the Measured B0 Field Distribution". The poster demonstrated a 
processing technique for removing lineshape distortions, based on an earlier paper by 
Morris (J.Magn.Reson., 80, 547, 1988 ) and showed some impressive improvements in 
lineshape.  
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The basic idea is that if you know the shape of the distortion, you should be able to 
correct for it. To measure the distortion, you need a "reference" spectrum of a single, 
isolated peak whose ideal lineshape is known, eg., chloroform or water. A comparison of 
the reference spectrum and the ideal lineshape characterizes the shape of the distortion. 
Both ideal and reference peaks are mathematically adjusted to be at zero frequency and 
inverse FTed. An apodization function is created by dividing the ideal time-domain 
function by the reference FID. This apodization function is then applied to a real FID. 
The resulting lineshapes are substantially improved. The whole approach, of course, 
relies on the assumption that all peaks have the same distortion. 

To implement Reference Deconvolution with NUTS: 
The first step in creating the function is to have a spectrum containing an isolated singlet 
peak. This serves as a reference peak which characterizes the distorted lineshape. Use 
Zoom to expand the spectrum to a small region with only this singlet displayed. Estimate 
the real linewidth, in the absence of distortions, and set LB to this value (Type LB and 
enter the chosen value in the highlighted box.) Suggested values are 0.3 to 1 Hz. Typing 
CF creates the convolution function in 3 steps: It creates an FID from the displayed 
singlet via an inverse FT (removing all other peaks that were in the spectrum). It also 
creates an ideal FID corresponding to a Lorentzian line with width equal to LB. Finally, it 
creates the convolution function as the result of dividing the ideal FID by the "reference" 
FID created from the singlet peak in the real spectrum.  

To apply this function, read in (with File/Open or GA) the FID to be corrected, and type 
CA (Convolution function Apply), then FT and proceed as usual. If the base of the peak 
appears distorted, it may help to repeat the entire process and use a larger value for LB. 
The convolution function has a shape somewhat like other resolution enhancement 
functions. It can be viewed (after being created by CF) by typing CV. The function can 
be saved by selecting the Save Convolution Filter option under the Tools/Convolution 
option. Similarly, a previously saved function can be recalled from the same menu. 

Refs: K.Metz, Poster # WP111 presented at the 35th ENC, 1994 
G.A.Morris, J.Magn.Reson., 80, 547 (1988). 
A.Gibbs and G.A.Morris, J.Magn.Reson., 91, 71-83 (1991). 

NUTS implementation of reference deconvolution 
CF -- Create Convolution Function 

Creates a convolution function relating observed lineshape to an ideal Lorentzian 
lineshape. When applied to an FID , the resulting lineshape is improved. Commands 
related to this operation can be found in the menus under Tools/Convolution.  

Ref: K.Metz, Poster # WP111 presented at the 35th ENC, 1994 
G.A.Morris, J.Magn.Reson., 80, 547 (1988). 
A.Gibbs and G.A.Morris, J.Magn.Reson., 91, 71-83 (1991). 
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The basic idea is that if you know the shape of the distortion, you should be able to 
correct for it. To measure the distortion, you need a "reference" spectrum of a single, 
isolated peak whose ideal lineshape is known, eg., chloroform or water. A comparison of 
the reference spectrum and the ideal lineshape characterizes the shape of the distortion. 
Both ideal and reference peaks are mathematically adjusted to be at zero frequency and 
inverse FTed. An apodization function is created by dividing the ideal time-domain 
function by the reference FID. This apodization function is then applied to a real FID. 
The resulting lineshapes are substantially improved. The whole approach, of course, 
relies on the assumption that all peaks have the same distortion. 
See step-by-step example below. 

The first step in creating the function is to have a spectrum containing an isolated singlet 
peak. This serves as a reference peak which characterizes the distorted lineshape. Use 
Zoom to expand the spectrum to a small region with only this singlet displayed. Estimate 
the real linewidth, in the absence of distortions, and set LB to this value (Type LB and 
enter the chosen value in the highlighted box.) Suggested values are 0.3 to 1 Hz. Typing 
CF creates the convolution function in 3 steps: It creates an FID from the displayed 
singlet via an inverse FT (removing all other peaks that were in the spectrum). It also 
creates an ideal FID corresponding to a Lorentzian line with width equal to LB. Finally, it 
creates the convolution function as the result of dividing the ideal FID by the "reference" 
FID created from the singlet peak in the real spectrum.  

To apply this function, read in (with File/Open or GA) the FID to be corrected, and type 
CA (Convolution function Apply), then FT and proceed as usual. If the base of the peak 
appears distorted, it may help to repeat the entire process and use a larger value for LB. 

The convolution function has a shape somewhat like other resolution enhancement 
functions. It can be viewed (after being created by CF) by typing CV.  

The function can be saved by selecting the Save Convolution Filter option under the 
Tools/Convolution option. Similarly, a previously saved function can be recalled from 
the same menu. 

CV -- View Convolution function 

Replaces the current spectrum with the calculated convolution function created with CF. 
This command is also available from the Tools/Convolution menu. A previously saved 
function can be recalled from the same menu. 

CA -- Apply Convolution function 

Illustrated example of reference deconvolution 

This is a technique for correcting distorted lineshapes without loss of signal-to-noise. To 
do this, we need to be able to characterize the nature of the distortion, which is done 
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using a reference spectrum. See description of reference deconvolution for details and 
references. 

Note that this feature is not included in NUTS Lite. 

  

 

Start with a spectrum with poor lineshape. 
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Expand to display just the isolated singlet. Enter a value for LB, the estimated linewidth 
in the absence of distortion. LB used here is 1 Hz. 

Typing CF (also available from the Tools/Convolution menu) performs three steps: 

• Creates a zero-frequency "reference" FID from the peak in the Zoom region 
• Creates a zero-frequency FID from an ideal Lorentzian line with linewidth equal 

to LB. 
• Creates a customized apodization function by dividing the ideal FID by the 

reference FID 
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The resulting function can be viewed with CV (or from the Tools/Convolution menu). 
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Read in the original FID again and apply the function with CA (or from the 
Tools/Convolution menu). 

Resonance Elimination (RE) 
RE -- Resonance Elimination  

This subroutine can be used to remove a single, dominant, low-frequency resonance from 
an FID. This is done with a fitting routine, in which amplitude, frequency, phase and 
Lorentzian/Gaussian linewidth are adjusted to match the actual data. This can be useful to 
remove a residual water line in the center of a spectrum. Results depend heavily on 
having a good, symmetrical lineshape, but can reduce the water resonance by more than 
1000x in some examples.   See details below on how to use RE.  

Subcommands, available from the Edit menu, are:  

D Delete (subtract) the calculated FID from the data  
E Edit the fit parameters 
F Perform fit 
R Reset parameters to default settings 
<ENTER> Exit the RE subroutine 

  
See also: Eliminate Dispersion component 

This subroutine fits an FID with a single frequency and then subtracts the calculated FID 
from the data. The FID must be dominated by a single resonant frequency near zero. 
Because the calculated FID will have ideal Lorentzian lineshape, the quality of the fit is 
critically dependent on the lineshape of the data. 

Note that RE is not included in NUTS Lite. 
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This spectrum has a very large peak at the center (0 frequency) and some small peaks 
very close to it. The goal is to remove the large peak without affecting the smaller ones. 

(This is actually simulated data, with ideal lineshape.) 
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On entering the RE subroutine, a first guess at a matching FID is displayed 

  

 

These parameters can be adjusted to give a closer starting point by selecting Edit 
Parameters from the Edit menu, or typing E. 

This dialog box shows the parameters which are adjusted during the fit. 

  



261 

 

To initiate the fit, select Fit to Data from the Edit menu, or type F. The Simplex fit may 
take a couple of minutes. 

When the fit is completed, select Delete Calculated Resonance from the Edit menu, or 
type D. 
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After FT, the major peak is removed. A small negative peak remains, because the fit was 
not perfect. 

  

 

Comparison of spectra without (top) and with RE, using the Dual Display utility. 
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Eliminate Dispersion   
ED - Eliminate Dispersion 

A routine to reduce residual dispersion lines at the center of a water suppressed spectrum 
was added at the request of Jerry Dallas and Marc Alder at Berlex per the reference: 

Adler M., and Wagner, G. "A New Technique for the Removal of Baseline Distortions 
Caused  
by Strong Water Signals." (1991) J. Magn. Reson. 91, 450. 

Often, 2D spectra acquired in H2O using water suppression have a large dispersion 
component to the residual water peak.  The dispersion line has large "wings" that extend 
on each side of the peak, and this can create substantial baseline distortions.  This cannot 
be removed by digital filtering.  By subtracting out the dispersion component, these broad 
wings are eliminated, giving a much flatter baseline and contour plots with less 
pronounced "zipper" appearance. 

Compare the 2 pairs of plots below (single slice and stacked plots).  The first plot shows 
the broad wings caused by the dispersion component of the residual water peak.  The 
second one shows the much flatter baseline obtained after removing the dispersion 
component.  In the stacked plot, notice also the modulation in the amplitude of the peak 
at 4.3 ppm caused by the variation in phase of the dispersion component of the water 
peak, which is eliminated when the dispersion component is removed. 
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To use this command, zoom in on the residual water peak.  That expanded region will be 
used to fit a dispersion line: 

I(w) = a*(wo-w) / { (1/T2)2 + (wo-w)2 } 

using three parameters:  

wo - frequency of the center of the water peak.  The peak must be close to 
zero frequency (center of the spectrum), as this parameter is adjusted over 
only a small range. 

T2 of the water peak 

a - amplitude 

This fitted calculated dispersion line is subtracted from the entire spectrum (all real data 
points). 

The fit can be made faster by using default values of T2 and/or wo.   

When ED is executed in the 2-lettered command mode, or in the non-2-lettered command 
mode with no arguments specified, NUTS uses the displayed zoom region to do a 1 
parameter fit to amplitude using a fixed T2 = 10.0 and wo = 0.0 
 
The command will take arguments when operating in the non-2-lettered command mode. 
Examples are: 
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ED 1         // same as default mode above 
ED 1 20         // 1 parameter fit to amplitude using T2 = 20.0 and wo= zero.  
ED 2         // 2 parameter fit to amplitude and T2 with wo= zero.  
ED 3         // 3 parameter fit to amplitude, T2 and wo. 

This can be used in Arrayed Mode to perform the fit on each slice with the single 
command. 

Digital Filters 
DH -- Digital High pass filter 

This routine allows the user to define a frequency limit and apply it to an FID. Signals 
above that frequency limit will remain unchanged and signals at lower frequencies will 
be filtered out from the currently displayed FID. 

This is done by creating a function in the frequency domain which is equal to one for all 
frequencies greater than the cut-off value and equal to zero for all frequencies less than 
the cut-off. The function is converted to the time domain using a Hilbert transform. This 
time domain function is then correlated with the FID to remove high frequency 
components. 

The user can adjust the order of the function, which is the number of pts in the correlation 
function. The more points, the sharper the cutoff, but the operation also becomes slower. 
As the order approaches the number of points in the FID, the filter approaches being 
perfectly square. 

If the number of data points is not equal to a power of 2, it is important to execute a zero-
fill to next higher power of 2 before executing the digital filter. Failure to do this will 
hang the program. 

DL -- Digital Low pass filter 

This routine allows the user to define a frequency limit and apply it to an FID. Signals 
below that frequency limit will remain unchanged and signals at higher frequencies 
(measured from the center of the spectrum) will be filtered out from the currently 
displayed FID. 

This is done by creating a function in the frequency domain which is equal to one for all 
frequencies less than the cut-off value and equal to zero for all frequencies greater than 
the cut-off. The function is converted to the time domain using a Hilbert transform. This 
time domain function is then correlated with the FID to remove high frequency 
components. 

The user can adjust the order of the function, which is the number of points in the 
correlation function. The more points, the sharper the cutoff, but the operation also 
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becomes slower. As the order approaches the number of points in the FID, the filter 
approaches being perfectly square. 

If the number of data points is not equal to a power of 2, it is important to execute a zero-
fill to next higher power of 2 before executing the digital filter. Failure to do this will 
hang the program. 

D2 -- Decimate data by 2  

This command is intended for use on an FID in conjunction with a digital low-pass filter. 
The D2 command "decimates" the data by a factor of 2, meaning that every other point is 
discarded. This reduces the data size by half and also reduces the spectral width by half 
(by effectively digitizing the data a factor of 2 slower). This only makes sense for use 
following application of a low pass filter set equal to half the spectral width.  

See also: Extracting a spectral region (XT)  

/2 -- Decimate FID  

This command operates differently on time and frequency domain data. 

When applied to an FID (time domain), this command reduces the data by half, similar to 
D2, but instead of simply deleting every other point, pairs of points are averaged.  So 
each pair of points is replaced by their average. 

When applied to a spectrum (frequency domain), one quarter of the spectral window on 
each end of the spectrum is discarded.  Number of data points and SW are both reduced 
by a factor of 2. 

Histograms (binning) (HI) 
HI - Histogram 

This is a new tool for reducing or digesting (also referred to as "binning" or "bucketing") 
a complicated spectrum for input into software that performs principal component 
analysis. 

Background 

Spectra such as 1H spectra of biofluids are so complex that it is not possible to assign all 
peaks, yet they still contain valuable information.  The spectra must be reduced to a 
simpler form that is more tractable to enable comparison of spectra and identification of 
correlations.   

This is done by segmenting the spectrum into narrow frequency regions, usually 0.04 
ppm wide, and summing all points in each region.  Each region is thereby reduced to a 
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single number, called a descriptor.  This not only reduces the number of data points to a 
more manageable number, but also allows for small differences in chemical shifts, such 
as might be caused by variations in pH.   

It may be desirable to eliminate some descriptors (such as the residual water peak, which 
varies from spectrum to spectrum).   The values are normalized, to allow comparison of 
different spectra.  The resulting data are output as an ascii text file consisting of 2 
columns of numbers, chemical shift and intensity.  This data can then be analyzed by 
other software. 

Using the HI command in NUTS 

The HI command generates a text file which is a list of intensity descriptors. The first 
item in each line of the descriptor file is the PPM value of the start of the descriptor.  The 
second item is a relative sum of the intensity in the descriptor PPM range, which by 
default is 0.04 PPM wide. The descriptor file has the following characteristics: 

All negative sums are zeroed 
The sum of all descriptors is 1.0 

By default, the size of each descriptor is 0.04 PPM. By default the total spectrum is used 
for the descriptor file and all data points in the file are used.  It is possible to customize 
this by having NUTS read a file containing the relevant information.  This is done with 
NUTS in the non-2-letter command mode.  The command will take an argument which is 
the file name for this descriptor properties template file. A sample file is shown here: 

Histogram_Template 
Descriptor_Size 0.1 
Include 10.0 0.0 
Eliminate 9.50 9.0 
Eliminate 5.00 4.00 

The ends of the spectrum can be ignored by specifying a region to be digested, with the 
"Include" line.  The regions specified by "Eliminate" are excluded from the descriptor 
file. 

References 

Metabolic profiling of chronic cadmium exposure in the rat, Griffin JL, Walker LA, 
Shore RF, Nicholson JK, CHEMICAL RESEARCH IN TOXICOLOGY, 14 (10): 1428-
1434, Oct 2001 

An NMR-based metabonomic approach to the investigation of coelomic fluid 
biochemistry in earthworms under toxic stress, Bundy JG, Osborn D, Weeks JM, Lindon 
JC, Nicholson JK, FEBS LETTERS, 500 (1-2): 31-35, Jun 29, 2001 
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Metabonomics: Metabolic processes studied by NMR spectroscopy of biofluids, Lindon 
JC, Nicholson JK, Holmes E, Everett JR, CONCEPTS IN MAGNETIC RESONANCE, 
12 (5): 289-320, 2000 

Extracting part of a spectrum 

There are two different tools available in NUTS for extracting part of a spectrum. 

XL -- Extract Line  

This command extracts just the displayed Zoom region, places the biggest peak in that 
region at the center of the extracted spectrum, and adds zeros to both ends of the 
spectrum so that the final size of the extracted spectrum is the same as the original 
spectrum. This was initially created for use with reference deconvolution. 

XT -- Extract Region  

This command extracts just the displayed Zoom region. The resulting spectrum has a data 
size equal to the number of points in the zoom region. This can be useful for overlaying 
spectra that were acquired with different offsets. 

  

 

Begin with a spectrum of ethyl benzene. 
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Use Zoom to expand so that just one peak is shown, in this case the water peak. 

Exit zoom with <Enter>. 
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After executing XL, the spectrum consists of just the water peak, shifted to be in the 
center of the spectrum (zero frequency), and zeros are added to both ends so that the final 
data size is the same as the initial spectrum. 

  

 

This is a kinetics experiment run on a spectrometer without a field/frequency lock, so the 
field moved during the course of the experiment. 

The task was to create a display with the peaks correctly lined up. 
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Expand each spectrum to the same frequency limits, being sure that each spectrum is 
correctly referenced. 

Execute a XT operation on each spectrum, saving the resulting files.  
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The extracted spectra were converted to a 2D file and now the peaks line up. 

(To create a 2D file from a series of 1D spectra, run this Link:  

GA SC IN 

and supply the name of the 1D files and an name for the 2D file to be created.) 

See also:  X0 - X9 to extract pre-set spectral regions.  

Searchable Archive 

This NUTS tool allows the user to create and search an archive file containing 
information about a collection of Nuts spectra. The file is a text file consisting of several 
fields, identified by keywords.  

The information placed into the archive file is taken from the "tailer" of each file in a 
directory or folder. When a spectrum is processed with Nuts and then saved, several 
pieces of information are automatically saved in the file tailer. This can include:  

a list of peaks defined by PP or within the DP subroutine  
a list of integral regions defined via automatic integration (AI) or in the 
integration subroutine (ID) 
a pointer to a metafile (or PICT file on the Mac) containing a molecular structure, 
imported into the MO routine 
items such as multiple names, molecular formula and nucleus which are input via 
the IF command 

Creation of an archive file involves first processing each spectrum and saving the 
processed data, all in the same directory or folder. The archive file is created within Nuts 
using the Database Make (DM) command, which reads the tailers of all files in the 
chosen directory and enters the information into a text file with appropriate keywords. 
This file could be searched with any search tool, but is most easily searched from within 
Nuts using the Database Search (DS) command. A dialog box is displayed allowing 
search criteria to be entered in several fields. With the exception of the chemical shifts, 
all searches are sub-string searches. For chemical shifts, a value is entered as well as a 
range. When an entry is made in the Name field, the search operation looks for matches 
in any of the 3 Name fields defined in the IF routine. Entries can be made in more than 
one field, which causes the search to find entries which meet all specified criteria (logical 
AND). Multiple entries can be made in the Name field, separated by a space, to search 
for a name containing multiple sub-strings. For example, entering "methyl phenyl" would 
search for occurrence of both methyl and phenyl in the name fields, and select only those 
containing both. 

After the Search button is clicked, a box displays the number of hits found, and clicking 
on OK displays information about each file, in turn, that matched the search criteria. 
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When the desired file is located, the corresponding spectrum is loaded into Nuts by 
clicking on the Load button. The information from the file tailer is automatically read, 
and peak labels, integrals and structures (if any) are displayed. To select another file from 
that search, use the View Search (VS) command. To perform another search, enter the 
DS command again. 

These commands are available from the Tools menu. 

DM -- Database Make 

This command is active only with the optional Searchable Archive accessory, which 
allows the user to create and search a database composed of his own files.  

This command takes all the NUTS files in the selected directory and constructs a text file 
from information saved in each file's tailer. This file can then be searched. This file 
includes pointers to the NUTS spectra, so that files matching search criteria can be loaded 
into Nuts. When the DM command is executed, a File Open dialog box is displayed. The 
user selects any file in the directory containing the Nuts data. All files to be included in 
the database must reside in that directory. The archive file has the default name 
_master.ndb, which can be renamed only after it is created. 

DS -- Database Search  

This command is active only with the optional Searchable Archive accessory, which 
allows the user to create and search a database composed of his own files. The archive 
file is first created within Nuts using the Database Make (DM) command. Once the 
archive file has been created, it can be searched using DS. Show me how to search. 

The DS command brings up a dialog box in which the user selects the database file 
created with the DM command. Then a screen is displayed in which the user can enter 
search criteria for searching that database file. It is possible to search by user name, date, 
compound name, comment line, molecular formula, nucleus, file name or chemical shift. 
With the exception of the chemical shifts, all searches are sub-string searches. For 
chemical shifts, a value is entered as well as a range. When an entry is made in the Name 
field, the search operation looks for matches in any of the 3 Name fields defined in the IF 
routine. Entries can be made in more than one field, which causes the search to find 
entries which meet all specified criteria (logical AND). Multiple entries can be made in 
the Name field, separated by a space, to search for a name containing multiple sub-
strings. For example, entering "methyl phenyl" would search for occurrence of both 
methyl and phenyl in the name fields, and select only those containing both. 

After the Search button is clicked, a box displays the number of hits found, and clicking 
on OK displays information about each file, in turn, that matched the search criteria. 
When the desired file is located, the corresponding spectrum is loaded into Nuts by 
clicking on the Load button. The information from the file tailer is automatically read, 
and peak labels, integrals and structures (if any) are displayed. To select another file 
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meeting the search criteria, enter VS (View Search). To perform another search, enter the 
DS command again. 

VS -- View Database Search  

This command is active only with the optional Searchable Archive accessory, which 
allows the user to create and search a database composed of his own files. The archive 
file is first created within Nuts using the Database Make (DM) command. Once the 
archive file has been created, it can be searched using DS. VS is used to return to the list 
of files created by DS, without performing the search again. 

Other Nuts commands which affect operation of the Searchable Archive include 

Information Entry (IF) -- allows alternate sample or compound names and molecular 
formula to be entered, and subsequently saved in the file's tailer. This information is 
collected into the archive file by the DM command, and is searchable using the DS 
command. 

MetaObjects subroutine (MO) -- This subroutine allows one or more graphical objects, 
such as a molecular structure, to be imported from a file that is a Windows metafile. A 
pointer to this file is subsequently saved in the file's tailer, and is incorporated into the 
archive file so that it is displayed when the spectrum is loaded following a search 
operation. 

Define Peaks (DP) -- A list of peaks selected within the DP subroutine are saved in the 
file's tailer and is incorporated into the archive file. This allows searching by chemical 
shift. Note that peaks selected with the PP command are not saved in the file's tailer. 
Peaks must be selected using the DP subroutine. 

Searching by chemical shift or substructure 
JJ - 13C Chemical Shift Searching 

This feature allows the user to search a small collection of 13C spectral data based on 
substructure, chemical shift range, name (or part of a name) or reference number.  The 
database resides in encrypted files installed with NUTS.  The user can also create his/her 
own database which will also be searched with this command.  See details below. 

Typing JJ displays the following dialog box, allowing one of 4 different types of search 
criteria to be entered.  The "pattern" option refers to a text-based system for describing 
substructure.  The search is initiated by clicking on the corresponding button to the right.  
Only one criterion is searched, even if information is entered in other boxes.  In the 
sample shown, we are searching for carbon peaks between 190 and 192 ppm, inclusive. 
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The following response is displayed, showing that the database contains 6 carbon peaks 
in this range: 

 

Clicking on OK launches the web browser (Windows only) and displays the following 
report.  (See below for how to configure NUTS to launch your browser.) 

Carbon Chemical Shift Search Range Report 
Carbon Shift Range is:  190.0 PPM -  192.0 PPM 
SHIFT    MOLECULAR FORMULA         REF #  NAME                                     
PATTERN 
 191.4   C5H8O2                    115    acetylacetone                            
5-APHJa 
 191.4   C5H8O2                    115    acetylacetone                            
9-ALhl 
 190.0   C13H16O                   454    2,2,3,3-tetramethyl-1-
indanone           (9)-(D)aadVhd 
 191.3   C8H8O3                    292    vanillin                                 
9-HVhh 
 191.6   C9H10O3                   346    3,5-dimethoxybenzaldehyde                
9-HUhh 
 192.0   C7H6O                     229    benzaldehyde                             
9-HVhh 

Suppose we now want to know more about vanillin.  We can perform another search, this 
time by reference number 292.  The following report is generated. 

Reference # Report 
Reference # is: 292 
  56.0   C8H8O3                    292    vanillin            1-Ov 
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 191.3   C8H8O3                    292    vanillin            9-HVhh 
 127.4   C8H8O3                    292    vanillin           10-HJaOa 
 109.4   C8H8O3                    292    vanillin           10-HHPH 
 114.8   C8H8O3                    292    vanillin           10-HHPH 
 109.4   C8H8O3                    292    vanillin          10-HJhOaH 
 114.8   C8H8O3                    292    vanillin          10-HJhOaH 
 129.5   C8H8O3                    292    vanillin          10-JhHHP 
 147.5   C8H8O3                    292    vanillin           10-OaHPH 
 152.3   C8H8O3                    292    vanillin           10-PHOaJh 

Vanillin has 8 carbons, but notice that the report has 10 entries.  This is due to an 
ambiguity in the assignment of 2 of the peaks. 

As an example of a substructure search, 3-AABc is entered and the Pattern Search button 
clicked.  (3-AABc represents a methine carbon bearing 2 methyls and a CH2-CH- group.  
See coding explanation.)  The following response is displayed: 

 

In this case, the database contains 5 examples of this substructure.  NUTS displays the 
average shift of those 5 values, as well as the minimum and maximum values, giving the 
user an estimate of the possible shift range for this carbon.  Clicking on OK displays the 
following report in the browser: 

Carbon Pattern Report 
Carbon Pattern is: 3-AABc 
SHIFT      MF             REF #  NAME                   PATTERN 
  24.8   C6H13NO2         204    leucine (acidic)           3-AABc 
  24.8   C6H14O           214    4-methyl-2-pentanol        3-AABc 
  25.2   C6H13NO2         203    leucine (basic)            3-AABc 
  25.8   C60H92N12O10     499    gramicidin S               3-AABc 
  30.6   C12H24           445    7,9-dimethyl-1-decene      3-AABc 

Searching by substructure can be done automatically if a molfile is displayed. 

Configuring NUTS to work with a web browser (Windows only) 

NUTS must first know where to find your computer's web browser.  This is set in the 
nuts.ini file, in the [DIRECTORIES] section.  Here are the default paths for WinNT and 
Win98.  You must un-comment (remove semicolon from) the line corresponding to your 
OS, and verify that the path and file name are correct for your system. 

; Default Directory for Window NT 4 
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BROWSER = C:\\Program Files\\Plus!\\Microsoft Internet\\iexplore.exe 
; Default Directory for Windows 98 
; BROWSER = C:\\Program Files\\Internet Explorer\\iexplore.exe 

Creating a database of your spectral data 

NUTS searches both the supplied, encrypted spectral data and also some user-editable 
files (with file names !myshift.txt and !mynames.txt).  NUTS is supplied with sample 
files (shown here) that can be edited with any text editor.  Simply follow the syntax 
shown.  These files must be in the data subdirectory of the NUTS program. 

MyShiftTable 
 
; Users Carbon Pattern code and reference number list 
 
;Code Shift Reference # 
;1-Ban 23.8 515 ;This is a sample entry, remove seicolon 

The syntax for the !myshifts.txt file is  

substructure_code shift reference#        
with each item separated by a space.  The syntax for the !mynames.txt file is  
reference# molecular_formula name 

with each item separated by a space. 

MyNamesTable 
 
; User Reference Number and names list 
 

Substructure codes 
13C chemical shift searching is initiated with the command JJ.  Searching from a 
displayed molfile is in development. 

The substructure code is a simple, text-based system for classifying carbons by their type, 
nearest neighbors and next nearest neighbors.   Each different type of carbon (methyl, 
carbonyl, phenyl, etc) is assigned a number.  Its substituents are indicated by upper case 
letters, usually alphabetically.  For each substituent, its substituents are, in turn, indicated 
by lower case letters, usually listed alphabetically. 

For main groups and their substituents that are part of a ring, the number or upper-case 
letter is enclosed in parentheses.  This does not apply to the ring systems designated 
explicitly (numbers 10-15).  See examples below. 

The following 2 tables show the numbers for each type of carbon, and the letters for each 
substituent.  
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Partial codes can be entered for searching.  For example, 2-B will return all CH2s which 
have at least one CH2 substituent. 

For olefin, phenyl and pyridine (types 5, 10 and 11, respectively), it is necessary to use * 
as a "wildcard".  For example, 10-E*** will return all chloro-substituted phenyl carbons. 

Try doing a Ref # or Range search first, and look at the codes returned to get a better idea 
of how the coding works. 

Main Groups 

Group Example Code and Comments 

1.  CH3--R1 CH3-CH2-OH 1-Bp 

 2.  CH2--R1,2 CH3-CH2-OH 2-AP    list substituents 
alphabetically 

3.  CH--R1,2,3 (CH3-CH2)2-CH-OH 3-BaBaP  list substituents 
alphabetically 

4.  C--R1,2,3,4 (CH3)3-C-OH 4-AAAP   list substituents 
alphabetically 

5.    

List substituents starting with 
directly bonded groups, 
alphabetically, then gem, cis 
and trans to the first group, in 
that order  

*5-ABaEH   and   5-EHABa 

6.   

List directly bonded 
substituents first, 
alphabetically, then N 
substituent  

6-ABaH   for C=N carbon 

methyl:  1-Mb 
ethyl:   1-Bm and 2-AMa 

7.  
 

List directly bonded 
substituent first  

*7-AH    and    7-HA 

methyl:  1-Th 
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8.    R--CN CH3-CH2-CN 
8-Ba   for the cyano C  

ethyl:  1-Bm   and   2-AM 

9.      

9-ABa  for the carbonyl  

methyl:  1-Jb 

ethyl:   1-Bj   and    2-AJa 

10.    

 
 

List directly bonded 
substituent, then ortho 
substituents, alphabetically, 
then para substituent  

*10-EAPF  

The other ring carbons are, 
clockwise: 
10-PEHH 
10-HFPA 
10-FHHE 
10-HAFP 
10-AEHH 

11.    
 

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  (The report 
will include a lower case 
letter (a, b or g) following the 
number indicating alpha, beta 
or gamma.  Don't use this a, b 
or g in searching.)  

11-AH    for C alpha to N 
11-HAE  for C beta to N   
11-EHH  for C gamma to N 

report will show 11-a-AH, 
11-b-HAE and 11-g-EHH 
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12.    
 

*12-JhH  

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta  (12-
a-JhH in this case). 

13.     
 

*13-AHH  

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta (13-
b-AHH in this case). 

14.      

*14-HEH  

List directly bonded 
substituent first, followed by 
ortho substituents, 
alphabetically.  The report 
will include lower case letter 
(a or b) following the number 
indicating alpha or beta (14-
b-HEH in this case). 

15.  Miscellaneous aromatic 

*15-(quinolyl-4)-H  

List directly bonded 
substituent only.  Indicate 
ring system and position after 
number, in parentheses. 

Substituent Groups 

A.  --CH3 

J.      

S.   --S-- 
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B.  --CH2--R1 
K.     T.      

C.  --CH--R1,2 L.    --C= U.  --CN 
D.  --C--R1,2,3 M.   --C=N V.  phenyl 
E.  --Cl N.   --N= W.  Misc. aromatic 
F.  --F O.  --O--  or  --O--> X.   P 
G.  --Br P.  --OH Y.   Si 

H.  --H 
Q.    

Z.   Misc. atom 

I.   --I R.   --NO2   

For a phenyl substituent, V, list its two ortho substituents in lower case letters, 
alphabetically. 

Note that K and Q are different, as illustrated below: 

 

Ethyl group codes are    1-Bk   and   2-AKa
Carbonyl code is     9-BaOa 
Methyl code is    1-Qb 

 

Ethyl group codes are    1-Bq   and   2-AQa
Carbonyl code is     9-AOb 
Methyl code is    1-Kb 

Cyclic structures 

Some rings are encoded explicitly (groups 10-15, above).  Other rings are indicated using 
the codes described above, but using parentheses to indicate that the atom is part of a 
ring.  Only main group numbers and nearest neighbors (upper case letters) are so 
indicated.    

    
The CH is coded as 3-ABaBa  (A for methly, Ba for each CH2-CH3) 
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The indicated CH has the similar substituents as above (one methyl, 2 methylenes) but 
they are now in a ring.  The CH is encoded as   (3)-A(B)b(B)b     Note that lower case 
letters are not in parentheses. 

If a methylene is in a ring, by definition, both of its substituents are in the ring.  Methyls 
can never be part of a ring. 

Another example: 

   

The indicated carbon is coded as   5-(C)bbHHH   because the attached CH is part of a 
ring.  The olefinic CH2 is    5-HHH(C)bb 

The other carbons in this molecule are coded as: 

methyl    1-(L)bl  

Ring carbons, starting with C bearing methyl and proceeding clockwise: 

(5)-A(B)bH(B)c    olefinic Cs are coded with attached, gem, cis and trans, respectively  

(2)-(B)c(L)al  

(2)-(B)l(C)bl  

(3)-(B)b(B)lLhl    C bearing the olefinic substituent  

(2)-(C)bl(L)hl  

(5)-(B)cH(B)bA  
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Shimming Simulation  
SM - Shimming Simulation  

This command enters a subroutine that allows the user to practice adjusting the on-axis 
(Z) shims under ideal conditions.  The "sample" consists of a single peak.  By default, the 
peak is exactly on resonance, but this can be changed by adjusting the Z0 shim.  The 
value of each shim gradient is displayed in the upper right portion of the screen.  A value 
for the current lock level is displayed at the upper left, along with the lock level 
corresponding to the previous set of shims, so the user can easily gauge the effect of a 
shim adjustment.  Perfect shims will give a lock level of 1000.   

 

Each shim value is changed using the number keys on the keyboard -- each time a 
number between 0 and 8 is pressed, the corresponding shim is changed by a set 
increment.  By default, the increment is 5 units.  To change to larger step sizes, use the 
greater than key (>) to increase the Sensitivity, which applies a factor to the increment 
size.   (It is also possible to change the increment; see below).  The number keys apply a 
positive increment.  Holding down the shift key while typing a number applies a negative 
increment.  These and other subcommands are described below. 

Several parameters can be adjusted by selecting Edit Parameters from the Edit menu, 
which displays the screen shown below.   
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The lineshape is calculated as the superposition of "mini-samples" located along the 
length of the detector coil.  In the case of a very broad resonance due to poor shims, the 
peak shape can become distorted because of this "discrete" approximation.  A series of 
small, individual peaks can be seen when the signal should really be a continuous curve.  
This can be corrected by ssing a larger number of minisamples, but this will slow the 
calculation. 

Number of points refers to the number of data points used in the Fourier Transform. 

Randomize level refers to the highest order magnet gradient which is randomized by the ? 
command for practice shimming.  By default, all gradients up to and including Z6 are 
randomized, but this can be changed to make the shimming problem easier (lower value) 
or harder (higher value). 

A specific value for any shim can be entered directly, as an alternative to adjustment by 
increments.  Choosing Set Gradients from the Set menu displays the screen below. 
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Test yourself with the Shimming Game 

To simulate an imperfect magnet, whose gradients must be corrected using shims, select 
Randomize from the Set menu (or type ?).  The resulting lineshape will be poor, and the 
lock level will be low.  The goal is to obtain a narrow, symmetrical peak and a lock level 
of 1000, corresponding to a perfectly shimmed magnet.  The values of the magnet 
gradients can be displayed by selecting Toggle Answer from the Display menu (or type 
:).  The value for each shim  needed to compensate perfectly for these gradients is the 
same absolute value as the corresponding magnet gradient, but the opposite sign.  When 
the answer is displayed, a score is also shown, calculated from the elapsed time and 
percent lock level recovery, which are also displayed.  Maximum possible score is 
100,000.   

A very useful tool for shimming under these conditions is the Z1 profile – see 
http://www.AcornNMR.com/Sam/shimintro.htm. 

Subcommands:  

# (0-8) Increment corresponding shim, Z0 - Z8 
shift-# Decrement corresponding shim, Z0 - Z8 
? Randomize magnet gradients 
: Display magnet gradient values 
F Display FID 
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S Display spectrum 
E Edit parameters 
G Set shim gradients 
I Set increments for each shim adjustment 
Z Zero magnet gradients 
[ Apply negative Z1 gradient 
] Apply positive Z1 gradient 
= Remove Z1 gradient 
> Increase sensitivity -- increases multiplication factor for shim increments  
< Decrease sensitivity -- decreases multiplication factor for shim increments 
<ENTER> Exit shimming subroutine 

Virtual Spectrometer 

The Virtual Spectrometer module in NUTS consists of a set of commands which simulate 
an FT-NMR spectrometer, producing realistic data corresponding to acquisition 
parameters set by the user. It is designed to mimic a "vanilla" NMR spectrometer, rather 
than imitating any actual manufacturer's instrument. In addition to the functions which 
are specific to the Virtual Spectrometer, all of the processing capabilities of NUTS are 
also available. Commands specific to the Virtual Spectrometer are available from the 
vSpec menu. 

As with the rest of the NUTS program, most commands can be executed either from the 
menu or as keyboard commands,  which are 2-letter commands executed without typing 
<Enter>. 

The virtual NMR "sample" is a text file containing some parameters and a list of NMR 
frequencies and their intensities. Several sample files are provided (as a zip file for 
Windows and .sea file for Mac), and a sample file is shown below which includes an 
explanation of the different items in these files. The file must contain certain keywords 
which allow the Virtual Spectrometer to interpret correctly the data being read from the 
file. The file is most easily created from within the NUTS NMR simulation subroutine, 
but can also be created from scratch or edited using any text editor.  

The user must set values for several NMR acquisition parameters as well as select the 
sample whose spectrum will be acquired. The sample is chosen using the GS command 
or by selecting Get Sample from the vSpec menu. This opens a standard dialog box for 
specifying the name of a file to be opened. The file itself is not opened or shown at this 
time; this is simply the process used to retrieve the name of the file which will be read 
when acquisition is started. To set acquisition parameters, type VP or select Parameters 
from the vSpec menu. This opens a dialog box for input of parameters.  

Once parameters are entered, the dialog box is closed and data acquisition initiated by 
typing ZG or selecting Zero and Go from the vSpec menu. Messages are displayed on the 
screen as acquisition proceeds, and the accumulating FID is displayed. If the user's PC is 
equipped for sound, the FID will be "played" through the PC's speakers (Windows only). 
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Upon completion of data acquisition, the data can be processed using the NUTS 
processing capabilities.  

A Tutorial is available as a Word document, and illustrates use of the Virtual 
Spectrometer. 

Commands for the Virtual Spectrometer 

GS - Get Sample 
Specifies the file from which frequencies will be read 

ZG -  Zero & GO 
Reads file containing freqencies and generates the NMR data. 

VP -  Virtual Parameters  
Opens a dialog box to set acquisition parameters. 

Acquisition parameters are input using the dialog box shown below, which is activated by 
typing VP or by selecting Parameters from the vSpec menu. A brief explanation of each 
item is shown below.  

 

Descriptions below explain how the setting of each parameter will affect the spectrum. 

User:    Enter user's name or initials (for information only; does not affect data 
acquisition) 
Date:    for information only; does not affect data acquisition 
Experiment:    Select from the list of available experiments. Currently the only option is 
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Single Pulse. 
Scans to do:    Enter the number of scans (acquisitions) which will be collected and 
added to form the final spectrum. 
Pulse Width:    The excitation pulse width in microseconds. 
Recycle Delay:    Delay between repeat scans to allow relaxation, in sec. 
Receiver Gain:    Adjusts the amplitude of the signal going into the receiver. 
Spectral Width:     Frequency range for the spectrum. 
Spectrum Offset:     Frequency of the "carrier", or center of the spectrum.  
Data Size:         Number of data points to be acquired. 
Delay for first point:     In microseconds.  

The following values are displayed for information only, and cannot be changed directly. 

Virtual Spectrometer Parameters 

Pulse Width 

Maximum signal is obtained when the excitation pulse is turned on for exactly the length 
of time necessary to rotate the net magnetization vector 90 degrees, referred to as a 90-
degree pulse. This rotates the magnetization from its initial position aligned along the 
magnetic field (designated as the z-axis) to a position perpendicular to the z-axis, in the 
x-y plane. The pulse length necessary to do this is dependent on the each instrument's 
hardware, such as the transmitter power and the efficiency of the detector coil in the 
NMR probe. It must therefore be determined empirically and will vary slightly from day 
to day. Typical values are 5-15us. 

The NMR operator must decide what fraction of the 90-degree pulse, commonly referred 
to as the "tip angle", will be used to generate the NMR signal. For a single-pulse 
experiment, as is used to acquire a basic spectrum, there is no value in exceeding a 90-
degree pulse. So the choice for values of pulse width are from zero up to the 90-degree 
pulse.  
The obvious question is: Why not always use a full 90-degree pulse? More is better, 
right? The answer is, not always. For a concentrated sample, a smaller pulse angle might 
be necessary to keep the signal from overloading the receiver, which leads to artifacts in 
the spectrum. In addition, some of the most valuable information which can be obtained 
from NMR is quantitative. For this data to be reliable, the spectrum must be obtained 
under conditions which result in peaks whose integrated area is proportional to the 
number of nuclei which each peak represents. The complication is that different nuclei 
relax at different rates. Any nuclei which have not fully relaxed by the time the next 
excitation pulse is applied will give a signal with somewhat reduced intensity. The result 
is a spectrum with distorted integration. Therefore, the factors which must be considered 
are the concentration of the sample and the relaxation time of the nuclei under 
observation. A relaxation delay and/or smaller pulse angle may be necessary to ensure 
complete relaxation between scans. As with many aspects of NMR, the choice is a 
tradeoff and requires consideration of which factors are most important for the case at 
hand. 
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The easiest way to determine the 90 degree pulse length is to determine a 180 degree 
pulse length and divide by 2. A 180 pulse will give zero signal, and is very sensitive to 
small offsets from the exact value. It is much easier to determine zero signal than to 
determine the maximum, as it is a fairly broad maximum, making it difficult to 
distinguish among values that are close to the maximum. So, start with a small pulse 
length and increase it, viewing the signal. The signal amplitude will go through a 
maximum and back to zero as the pulse length is increased from 0 degrees to 180 
degrees. 

Carrier frequency 

The center of the spectrum is determined by the carrier frequency, which is the sum of 
the Spectrometer Frequency (in MHz) and the Spectrum Offset (in Hz). On many 
spectrometers, the Spectrum Offset varies depending on the deuterated solvent being used 
for the Field-Frequency lock, and therefore changes from sample to sample. If the 
Spectrum Offset is set incorrectly, some peaks of interest may fall outside the the 
Spectral Window, which then appear "folded".  
As the Offset value is increased, the spectral window is moved to lower field, which is to 
the left as the spectrum is normally viewed. Therefore, peaks will appear to move to the 
right.  

Data Size 

The number of data points which will be acquired. The algorithm used to perform a 
Fourier transform requires the number of data points in the time domain function (FID) to 
be a power of 2. For this reason, most spectrometers, including the Virtual Spectrometer, 
limit the choices for data size to be a power of 2. If a value is entered which is not a 
power of two, the value will be changed to the next higher power of 2.  
To accomplish quadrature detection (which provides the ability to distinguish positive 
and negative frequencies), data are acquired in 2 channels, related by a 90 degree phase 
shift. Therefore, the data exist as 2 halves, usually referred to as real (in-phase) and 
imaginary (90 degree phase shifted) parts. Because these 2 halves are really complex 
pairs of data points, the NUTS program expresses the number of data points as the 
number of complex pairs, but that is not true of all spectrometers. Some spectrometers 
give the data size as the total number of points (the sum of the number of points in the 2 
channels). In that case, the number of points which will define the final spectrum will be 
half of the total data size. For example, starting with 4K (4096) total points (2K real and 
2K imaginary) yields 2K points in the final spectrum. By contrast, NUTS considers this 
size of data to be 2K complex. This is of concern when calculating the data size required 
to yield the desired digital resolution. 

DE delay 

The digitizer, or Analog-to-Digital Converter (ADC), digitizes the signal coming from 
the NMR probe at a rate determined by the user's chosen value of Spectral Width. The 
time between data points is called the Dwell Time, equal to the reciprocal of the spectral 
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width.  However, signal acquisition is not started immediately after the excitation pulse, 
but after a small delay, necessary to allow the circuitry to recover from the effects of the 
intense excitation pulse.  By default, most spectrometers (including the Virtual 
Spectrometer) set the DE value equal to the dwell time, meaning that a delay of 1 data 
point is used.   
However, this is not usually the optimum DE setting.  This is because the filters used to 
eliminate frequencies outside the chosen range cause a finite delay in the signal reaching 
the ADC.  DE must be empirically chosen to match the delay introduced by the filters.  
When the DE value does not match the filter delay, baseline distortions (baseline "roll") 
are seen in the spectrum which make phasing and integration more difficult. If the DE 
value is too low, the baseline will have a hump ("frown") and the first-order phase value 
required to phase the spectrum will be negative. If the DE value is too high, the opposite 
is true: the baseline will have a dip ("smile") and the first-order phase value required to 
phase the spectrum will be positive. At the optimum DE value, the baseline will be flat 
and the first-order phase value required to phase the spectrum will be zero. 

Number of Scans 

The signal to noise ratio of a spectrum can be increased by repeating scans and adding the 
data. Signal from the sample will add with each repeat scan. Noise, which is random in 
phase, will add at a slower rate. Therefore the signal to noise ratio increases as the square 
root of the number of scans; eg, four times the number of scans is required to double the 
signal to noise ratio. 

Receiver Gain 

This controls an amplifier through which the signal passes just before it reaches the 
receiver (analog-to-digital converter, or ADC). This should be adjusted to the maximum 
amplitude that the ADC can handle without overloading it. If the signal amplitude is too 
low, small signals will not be discernible. If the ADC is overloaded, the signal will be 
truncated, or "clipped", resulting in distortion of the resulting spectrum. This can have the 
appearance of an undulating baseline, in the case of a small degree of clipping, or 
spurious signals in the case of more severe clipping. The optimum setting can be 
determined by increasing the gain until clipping is observed and then reducing it from 
that value. In the case of NUTS, the cutoff occurs at about +/- half of full screen.  
Note that receiver gain affects signal and noise equivalently, so will not affect the 
signal/noise ratio. 

Relaxation Delay 

This is the delay between the end of acquisition of each scan and the next excitation 
pulse. For nuclei with long relaxation times, more time must be allowed between 
successive excitations to permit the magnetization to return to equilibrium. Distortions of 
the spectrum, including distorted integration, results from too short a relaxation delay. On 
the other hand, one does not want to waste time in acquiring data. Another trade-off. 



292 

Spectral Width 

This sets the range of frequencies which will be observed. In the case of NUTS, this is 
the size of the entire range, from one end to the other. (Note that some instruments set 
this parameter to be +/- on either side of center.) It must be set large enough to include all 
peaks of interest, but too large a setting reduces digital resolution and results in "wasting" 
data by acquiring regions which include only noise. Peaks which fall outside the spectral 
width, or "window", will be partially filtered out by the spectrometers filters, but not 
totally. They will appear "folded" or "aliased" into the spectrum, meaning that they 
appear at a frequency which is not their correct value. This can be detected by the 
appearance of peaks at anomalous frequencies and by the fact that folded peaks are often 
out of phase when all other peaks are phased correctly. The most foolproof way to 
determine the correct spectral width is to start with a value that is much larger than 
estimated, to determine where the peaks are, then reduce the value to encompass all 
peaks. 
The spectral window is centered at the frequency of the NMR transmitter, commonly 
referred to as the "carrier" frequency.  

Digital Resolution 

This is the quotient: Spectral width / number of data points, expressed as Hz/pt. The 
digital resolution must be great enough (Hz/pt value small enough) compared to the 
width of the lines being observed, to define and resolve narrow peaks. Usually, the 
spectral width is fixed by the range of frequencies being observed. Therefore, the only 
parameter which can be varied is the number of data points. Acquiring more data points 
requires more time. We again have a trade-off between enough points to adequately 
digitize the NMR signal, but not so many points that time and disk space are wasted. 

FID - Free Induction Decay 

FT-NMR data is collected as a function of time following an excitation pulse. This time-
domain data is referred to as a Free Induction Decay, or FID. It consists of a sum of 
sinusoids oscillating at different frequencies, one for each peak in the spectrum. The 
signal decays to zero as a function of time, as the excited spins relax back to equilibrium. 

Acquisition Time 

Virtual Spectrometer sample file 

The following is an example of a text file which is a "virtual NMR sample", which is read 
by Virtual Spectrometer when acquisition is initiated. It specifies several parameters of 
the sample and contains a list of NMR frequencies and their intensities. 

Sample files for input into the Virtual Spectrometer are most easily created from within 
the NUTS simulation subroutine. This subroutine allows input of chemical shifts and 
coupling constants corresponding to real NMR data and calculates the NMR spectrum. 
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The result of the calculation is a list of frequency and intensity values. This list can be 
saved as a text file which also includes several parameters which define characteristics of 
the sample and the spectrometer, specified with keywords, which the Virtual 
Spectrometer reads. 

The components of the file that the Virtual Spectrometer reads are Spectrometer 
Frequency, PW90, Concentration, EBsensitivity, Intensity_Per_Spin (used to adjust for 
the arbitrary intensities created by the NS routine), plus frequency (in Hz) and intensity 
for each peak. If the parameter values are not present in the file, the program will use 
default settings.  

NUTSsimulation 
Sample Name = Unknown #1 
Spectrometer Frequency = 300.149994 MHz 
Concentration = 5.0 
EBsensitivity = 120.0 
 
PW90 = 10.0     
Intensity_per_spin = 31.9870 
 
Number Transitions(Hz) Transitions(PPM) Intensities 
1  2101.0503  7.0000   32.000 
2  786.4559  2.6202   3.779 
3  786.2332  2.6195   3.785 
4  778.6384  2.5942   3.918 
5  778.5466  2.5939   3.921 
6  778.4114  2.5934   7.773 
7  778.3357  2.5932   7.852 
8  770.7247  2.5678   4.067 
9  770.6700  2.5676   4.069 
10  770.5101  2.5671   8.147 
11  770.4384  2.5668   8.151 
12  762.7601  2.5413   4.227 
13  762.5414  2.5405   4.234 
14  359.1456  1.1966   6.234 
15  359.0011  1.1961   12.454 
16  358.8564  1.1956   6.221 
17  351.1756  1.1700   23.999 
18  351.0389  1.1695   23.974 
19  343.3527  1.1439   5.785 
20  343.2066  1.1435   11.558 
21  343.0524  1.1429   5.773 
End NUTS Simulation File 

Importing data 

Data translation 

Before a FID or spectrum can be processed by NUTS, it must be translated into the 
NUTS file format, called the Common Data File format. Most files can be translated from 
within NUTS with the Import command (IM). IM automatically detects the origin of the 
file and applies the appropriate translation. Import is also available from the File menu.  
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The What's New text file supplied with NUTS will list new and modified imports.  

Nicolet 1180 and 1280 Dexter NT spectrometer data files 
Nicolet/GE TMON data files from NT, QE and GN spectrometers 
GE Omega spectrometer files exported with the GE Export command 
Bruker Aspect 3000 data files 
Bruker X32 and UNIX data files, including digitally filtered data 
Varian VXR 5000, Unity and INOVA data 
JEOL Delta, GX, EX, FX, Lambda, ALS and Alpha data files  
Chemagnetics files 
WinNMR files 
Tecmag MacFID, MacNMR and NT-NMRfiles 
ATI ASCII and binary files 
SMIS data files 
Analogic files 
PC-NMR files in Lybrics format 
Process Control Technology data files 
Felix new format 
NMRi format 
ASCII format -- data should be in the form of (real, imaginary) pairs 
JCAMP format 
Galactic (Grams-32) files 
AZARA  
Elcint  
Philips MRi Spectroscopy Data - Type II 
Siemens   

It is possible to bypass the automatic translation process and "force" a specific type of 
translation.  This is not generally recommended because it is easy to select the wrong 
type, which can cause NUTS to hang or crash.  In all but rare cases, it is best to do IM 
and let NUTS do its own auto identification process. 

If you MUST force a type, the user can enter the non-2-letter command mode and enter a 
command like: 

IM -type "force_type" 

where allow words for "force_type" are: 

NTDEXTER 
NTTMON 
GN 
QE 
NTDEXTER_NICNET 
NTTMON_NICNET 
GN_NICNET 
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QE_NICNET 
OMEGA_ONE_FILE 
OMEGA_TWO_FILE 
BRUKERASPECT 
FELIXNEW 
ASC 
CDFFDOS 
CDFFUNIX 
JEOL 
JEOL_GENERIC 
ATI 
BRUKERASPECTBS 
BRUKERETHERNET 
SMIS 
VARUNIX 
BRUKERUNIX1 
BRUKERUNIX2 
BRUKERUNIXSGI1 
BRUKERUNIXSGI2 
BRUKERX32_1D 
BRUKERX32_2D 
BRUKNET 
PCT 
FXQ 
ANALOGIC 
LYBRICS 
CHEMAGNETICS1 
CHEMAGNETICS2 
CHEMAGNETICS3 
GALACTIC 
IRIS_FELIX 
CDFFINT 
MACFID1 
MACFID2 
MACNMR1 
MACNMR2 
GEMS 
FLXAII 
NMRI 
PHILIP_MR 
JEOL_LAMBDA 
WINNMR1DOF     (Bruker WinNMR 1D Old Conversion FID) 
WINNMR1DOS     (Bruker WinNMR 1D Old Conversion Spectrum) 
WINNMR2DOF     (Bruker WinNMR 2D Old Conversion FID) 
WINNMR2DOS     (Bruker WinNMR 2D Old Conversion Spectrum) 
WINNMR1DNF     (Bruker WinNMR 1D New Conversion FID) 
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WINNMR1DNS     (Bruker WinNMR 1D New Conversion Spectrum) 
WINNMR2DNF     (Bruker WinNMR 1D New Conversion) 
WINNMR2DNS     (Bruker WinNMR 1D New Conversion) 
WINNMRAQS_FID     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_R     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_I     (Bruker WinNMR using *.aqs file) 
WINNMRAQS_SER     (Bruker WinNMR using *.aqs file) 
WINNMR1D97     (Bruker WinNMR 1D year 1997) 
WINNMR2D97     (Bruker WinNMR 2D year 1997) 
BRUKER_24_to_32     (Bruker Aspect transfers with LightNet to X32) 
BRUKER_1R     (Bruker Real Only data) 
JEOL_ALS  
JEOL_ALPHA  
JEOL_DELTA  
JCAMP  
XWINNMR  
TECMAG_NT  
AZARA  
ELCINT  
PHILIPS2     (Philips MRi Spectroscopy Data - Type II) 
SIEMENS  

Varian data from XL and older Gemini spectrometers, based on the older computer, is 
translated into the NUTS format using a separate translation program called V_Helper, 
written by Steve Silber at Texas A&M.  This program allows a PC to read a Varian 
floppy despite its foreign format. 

It is usually best to use the auto-detect capability of the IM command and let NUTS 
identify the file type. It is possible to force NUTS to apply a specific translation, 
regardless of the file's origin, by selecting the desired file type from the File / Import 
menu. However, this can result in errors, including termination of the NUTS program, if 
the chosen format does not match the actual file type. 

See details about how NUTS identifies different file types. Some spectrometers create 
multiple files for one data set, and the user must be careful to transfer all relevant files to 
the PC. In some cases, this involves creation of multiple layers of subdirectories, and it is 
important to create the subdirectories correctly on the PC, or NUTS may fail to locate 
part of the data.  

For detailed information about the file format, see CDFF.  

Fortran code to write data in NUTS format (contributed by Todd Alam) 

Data files can be displayed using the look (LO) command, useful for "hacking" apart data 
files. 
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IM -- Import File 

Performs data translation "on the fly" and opens the translated file. NUTS automatically 
detects the source of the file and applies the appropriate translation.  

For data from Unix computers, in most cases, multiple files are created when the 
spectrum is acquired. A directory is created bearing the file name entered by the user, 
into which all relevant files are placed. NUTS expects this file structure when it searches 
for the necessary files, so when files are transferred to the PC, the directory structure 
created on the PC must match that of the original data.  

There are also some issues specific to Bruker data which may be important.  

If a File Open (GA) command is attempted on a file which has not been translated into 
the NUTS format, a message appears asking if an auto-detect import should be attempted. 
If an import operation is to be included in a Link, use the GA command and not IM. The 
reason for this is when the GA command is used in a Link, the user is prompted for the 
file name only once. NUTS is smart enough to perform an import if necessary. 

When IM is used, the original file remains unchanged with its original name. The 
translated file is given a file name consisting of a dollar sign ( $ ) appended to the 
beginning of the original file name. This file is then loaded into NUTS and becomes File 
A. For 2D data, the translated file is always saved to the disk. For 1D files, whether or not 
the translated file is automatically saved to the disk depends on which version of NUTS 
is being used. It is saved in the Win95/NT version only. This file name is printed at the 
top of the NUTS screen and is printed on all plots. Because DOS can only handle files 
with file names up to 8 letters, appending an extra character to the file name can create 
problems for file names of greater than 7 letters (not including the extension). The user 
can always save the file under a new name with SB or chose Save As under the File 
menu. 

The default directories for file importing (with IM) and for the file Open and Save 
operations (eg, GA and SA) can be different and can also be set in the NUTS.INI file. 
(Note that this does not work correctly on the Mac.) The translated file is saved in the 
directory currently being used for Open and Save operations. The current settings for 
these directories can be viewed with the WP command. 

ZZ - Auto importing 

This command imports a file with a default file name, as defined in the NUTS.ini file. 
This is useful in cases where the file to be opened always has the same file name and path 
name, as might be the case with some file transfer programs. The file name, with full path 
name, and the file type are defined in the NUTS.ini file. The relevant lines in the 
NUTS.ini file are shown in the examples below: 

ZZ_FILE_PATH = C:\NUTS\DATA\FILE.QE 
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ZZ_FILE_TYPE = Lybrics 

The path name must be the full path name. If ZZ_FILE_TYPE = Auto is used the 
imported file will be auto identified using NUTS standard file detection scheme. 

BS -- Byte Swap 

Used mainly for debugging data import operations. Reverses the byte order of floating 
point data. Data from some spectrometers requires this operation. 

BV -- Byte Swap to VAX byte order 

Used mainly for debugging data import operations. Reverses the byte order of floating 
point data. Data from some spectrometers requires this operation. 

CX -- Convert data 

Used mostly in the course of identifying and debugging data import problems. Allows 
selection of one of 3 options for imported data:  

Byte swap for floating point data 
Convert data from integer to floating point 
Convert data from integer to floating point with byte swap 

These can be useful to try when data does not appear to have imported correctly. 

LO -- Look at data file 

This is a keyboard command that displays the contents of a specified file, useful for 
"hacking" apart data file formats. The user specifies a format from the following choices, 
which controls how the file's contents will be displayed. These choices are available from 
the Display menu or by typing T.  

Binary 
CDFF (the format for NUTS files) 
Unix 
Macintosh 
Aspect 
1280 

The default starting position for displaying the file is at zero, the beginning of the file. 
This can be changed from the Edit or Display menu, or by typing P. Scrolling up and 
down through the file is possible using the Page Up, Page Down and arrow keys. The 
currently displayed information can be copied to the Windows clipboard using Control-C 
or from the Edit menu. A new file can be opened from the File menu or by typing F. To 
exit this subroutine, type<Enter> or choose Exit from the File menu. 
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SE -- Visually inspect data file 

This command was created to aid in the visual inspection of unknown data files.  In the 2-
lettered command mode, the command SE first brings up a dialog box and allows the 
user to select the file to look at. After this selection, another dialog box comes up which 
allows the user to specify how he wants to view the data. After selecting all the options 
and clicking OK, the data is imported without translation in that manner as a 1D file 
thereby allowing the user to visually "see". This can aid if finding actual NMR data in 
unknown files. Hint – It is often useful to first load an NMR file with NMR data of about 
the vertical scale size the user expects and then do an FS to fix the scale. This allows all 
the "junk" to be imported and go off-scale without shrinking smaller NMR data so small 
as not to be seen. 

In the non-2-lettered command mode, the SEE command with no arguments behaves as 
above. The user can give arguments as shown below to directly import the specified file 
as instructed in the arguments: 

SEE [Bytes2Skip] [WordType] [Complex] [Endian] [FileName] 

Importing details 

Identifying foreign data files 

The criteria by which NUTS identifies the origin of NMR data are as follows, although 
the list is not complete, because new import types are added frequently.  See also the 
section on data importing. 

ATI Reads first line of an ASC header file. All characters are read in an ASCII text line 
until "\n" is found or the first 80 characters are read. If the first two words are FILE and 
VERSION (case insensitive) the file is identified as ATI. 

Analogic data usually comes as two separate files, one with a base name and an 
extension of "SPC" and another with the same base name with the extension "ANM". The 
SPC file contains a 256 header and the binary data. This header contains some file 
information. If the second byte of the selected file (usually *.SPC) is 4D hex AND the 
second file (*.ANM) is present then identified as an Analogic file. Some additional 
parameters are obtained from the *.AMN file. 

ASCII data is assumed to be in the format of (real, imaginary), with one pair of data 
points per line.  A few basic parameters will be read if correct keywords are found.   To 
import ASCII data, it is necessary to specify that the data is ascii, because there are no 
unique features in the file that NUTS can use to identify the data as ascii.  This is done in 
the non-2-letter command mode with this series of commands:  
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2f 
im -type asc <ENTER> 
2n <ENTER>  

NUTS expects the data to be in the form of (real, imaginary) pairs, one pair of numbers 
per line, but can handle other formats, as follows.  If 3 numbers are found per line, NUTS 
will ignore the first number, and will import the second and third numbers as real and 
imaginary values, respectively.  If only 1 number is found per line, NUTS assumes these 
are real data points and sets the imaginary points to zero.  

Note that if your data is (x, y) pairs (in other words, (frequency, intensity) values), Nuts 
will "think" that the series of frequency values are the real data points, and the display 
will appear as a straight diagonal line.  The actual data points are interpreted as being the 
imaginary data points.  Execute an RI command to swap real and imaginary points, and 
you should see the data as expected.  

NUTS can read a few basic parameters from the beginning of the file, provided the 
correct keyword is found.  This is equivalent to the Full ASCII export format (E1) shown 
above.  The allowed keywords are:  

Spectrometer_Frequency or SF    (in MHz) 
domain    (values are time or frequency) 
comment:    (note that colon must be included to be recognized) 
user:    (note that colon must be included to be recognized) 
date:    (note that colon must be included to be recognized) 
scans 
offset 
SW or Sweep_Width    (in Hz)  

If no parameters are found, Nuts will import the data, but values for SF and SW must be 
entered manually. 

Bruker ASPECT 3000 The first 3 bytes of the file are converted to a long word. If the 
word is 4687093 the file type is Bruker Aspect 3000. If the word is -687033 the file type 
is Bruker Aspect 3000 with the three bytes swapped. If the word is -4061952 the file type 
is Bruker Aspect 3000 transferred by BrukNet with packet information to be stripped. See 
also: Bruker data.  

Bruker UNIX Bruker saves multiple files for each FID/spectrum, saved under a 
directory whose name is the name supplied by the user when the data were acquired. 
Within that directory is another directory whose name is an experiment number (usually 
1). Within THAT directory are several files, including one called "fid" for 1D data or 
"ser" for 2D data which contain the actual data. Select "fid" or "ser" (as appropriate) for 
importing into NUTS. NUTS retrieves parameters from the "acqus" and "acqus2" files, 
which must be present. It is important to recreate the directories on the PC and that the 
file names remain unchanged, as this is how Nuts identifies the data as Bruker. The 
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translated file is given a name corresponding to the top directory name with an extension 
of fid or ser, as appropriate. NB: During the import process a NUTS file will be created 
in the current NUTS data directory with the name of the directory two levels above the 
"fid" or "ser" file. If for some reason this is not a valid name the file will be given the 
name $BRUKER.IMP. 

Bruker SGI -- Files from some Bruker systems with SGI computers create files which 
have 3 bytes of Aspect data stuffed into an SGI 4-byte word. The other byte is zeros with 
no attempt at sign extension. This type of translation can be forced with the File / Import / 
Bruker Unix SGI menu selections. 

To attempt an autodetection on these files, the examples to date seem to have line 4 of the 
ACQUS file set to: 

##ORIGIN=UXNMR/P, SPECTROSPIN AG 

NUTS will search for the line starting ##ORIGIN and see if it contains the string 
UXNMR/P. If it does it will do a 24 bits stuffed into a 32 bit word type translation. 
Otherwise the auto-identification process is the same as the process for Bruker UNIX. 

Chemagnetics -- If the file name is "d" with no extension and the same directory 
contains a file with the name "pg", then the file is identified as a Chemagnetics file. The 
imported file will be given the file name of the selected file's parent directory with a "$" 
appended to the front of the file name. Resulting file names with a base name greater than 
eight characters will truncated to eight characters.  

Felix New Format If the first word in the file is in hexadecimal 0x01020304 the file is 
detected as Felix New UNIX format. 

GE OMEGA If the file is a power of 2 in size, the current directory is examined for a file 
with the same base name but with the extension "HED". If found the file is identified as 
GE OMEGA. These are the files created by the Omega's Export routine. The data can 
also be exported as a single file, which can also be detected and imported by NUTS. 

Hitachi files created on the Hitachi NMR systems and read into Labcalc GRAMS/386 
DOS software for saving are detected by the second byte in the file header. If the second 
byte is 4D hex then the file is translated as "old style" GRAMS/386. If the second byte is 
4B hex it is translated as "new style" GRAMS/386 with LSB 1st. If the second byte is 4C 
hex it is translated as "new style" GRAMS/386 with the MSB first. Files from an Hitachi 
instrument have some parameters like SF, SW and OF1 in the header area region 
identified as spare. All files identified as above are considered to be real (not complex). 

JCAMP data is assumed to be in the format XYDATA= (X++(Y..Y)). Only real data can 
be imported at this time. Parameters are imported as desccribed in Davies & Lampen, 
Applied Spectroscopy, 47 (8), 1093-1099, 1993. 
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JEOL Delta (exported as JEOL Generic) These files are identified by their "BIN" 
extension. A second file should be present with the same name, but with a file extension 
"HDR", which contains parameters. These files are 64 bit IEEE double precision Floats. 
These are converted to 32 bit PC type floats in the CDFF file format. 

JEOL GX and EX files -- If the file name extension is "GXD" the file is detected as 
JEOL GX or EX. A second file with the same name, but with the extension "GXP" 
contains parameter information. The parameter names are not the same for the 2 file 
types, so Nuts looks for and reads multiple key words for each parameter. 

JEOL Lambda files -- If the first item in the file is "JEOLUSF001", the file is identified 
as JEOL Lambda format. 

LYBRICS (PCNMR) files are detected by reading the beginning of the selected file and 
looking for the string "KEYS". If found, the file is assumed to be in the LYBRICS file 
format. 

Nicolet 1280 The file is read as a packed 1280 word and the first Nicolet 20 bit word is 
read. If it is 11378 the Nicolet header size is subtracted from the filesize and the number 
of Nicolet 20 bit words is calculated. If this is a power of 2 then the file is an NT TMON 
file. If it is not a power of 2 the file is an NT Dexter file. If the first word is 12818, the 
file is a QE file. If the first word is 57923, the file is a GN file. If the first word is 11378, 
the file is a NT TMON file transferred by NicNet. If the first word is 12818, the file is a 
QE file transferred by NicNet. If the first word is 57923, the file is a GN file transferred 
by NicNet. 

NMRi data is identified by detecting reasonably valid values at the expected locations 
corresponding to quadrature flag, FT flag and SF. Nuts will check for these values using 
byte order for either VAX or Unix systems. 

SMIS If the file name extension is MRD the file is detected as SMIS type. 

Tecmag MacFID and MacNMR files are identified by looking at the resource fork for 
valid values for Type and Creator, and also looks for a Version number in the range 9001 
to 9712 at the appropriate location. 

Varian UNIX Varian saves multiple files for each FID/spectrum. The files are in a 
directory whose name is the name supplied when the data were acquired. One of the files 
in that directory is called "fid" and is the actual data. If there is also a file with the name 
"procpar", Nuts identifies the file type as Varian Unix. To import the data, the user 
should select "fid". NUTS retrieves parameters from the other files. NUTS will save the 
translated data as a file whose name is the name of the directory and whose extension is 
fid.  

Varian data from Gemini, XL and VXR 4000 spectrometers can be translated into the 
Common Data File format using a utility called V_Helper written by Steve Silber at 
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Texas A&M University. This allows the PC to read Varian floppies and translates the 
data into various fomats. A version of V_Helper for use with NUTS is available through 
Acorn NMR for a small fee.  

Troubleshooting import problems 

The safest approach to importing data is to use the NUTS "auto-detect" function (IM 
command) to import all data.  If you use the File/Import menu and select a specific file 
type, you may apply an incorrect data translation, with unpredictable (and probably 
undesirable!) results. 

When data is transferred between computers via ftp, remember to explicitly set the 
transfer type to binary. 

For spectrometer models that create multiple files, rather than a single file (e.g., Varian, 
Bruker), all files must be transferred and the file names must be unchanged.  Failure to 
adhere to these guidelines will prevent NUTS from being able to locate the required 
information, and the import process will fail. 

For Varian data, the data consists of 4 files (called fid, procpar, text and log).  Use IM 
and select the file called fid.  Data which has already been FT'd is saved with the name 
"phasefile". 

For Bruker data (not including Aspect-based systems), the situation is much more 
complicated.  Time-domain (fid) data is contained in the file called fid (1D) or ser (2D), 
and most parameters are contained in the files acqu and acqus (and acqu2 and acqu2s for 
2D data).  But additional files are needed - files called proc and procs (and proc2 and 
proc2s for 2D data) are saved  

 

Debugging tools 

See also: Look and See utilities for examining files. 

NB - Nuts Bug flag 

Used to provide additional information useful in determining the origin of problems in 
program operation. Turning this option on causes some status messages to be displayed in 
the course of normal program operation. This command is a toggle, so that typing it a 
second time turns the debugging option back off.  

WP - Which Path 
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Processing digitally filtered data 

An extra processing step is required before FT for digitally filtered data (Bruker data 
from the Avance series of spectrometers such as DRX and ARX, Tecmag NT-NMR data 
and some JEOL data).  This is necessary because the data have been digitally filtered and 
"decimated" prior to saving the FID. The initial points of the FID are zero. A circular left 
shift must be performed before the FT. The number of points to shift is calculated from 
parameters found in the file header (the Decimation Number and the DSP firmware 
version found in the Bruker file header), but the user can change the number of points.  
(In a circular left shift, points are removed from the left end of the data and added to the 
right end.)  

** Note:  NUTS attempts to perform the RD operation automatically when FT is 
executed.  NUTS will use its calculated value for number of points to rotate.  The value 
can be changed by typing RD.  There are 2 ways to avoid having NUTS do automatically 
apply RD:  Type RD and enter 0 for points to rotate, or use the command CT (complex 
FT) or BT (Bruker FT) instead of FT.  The choice of CT or BT depends on whether your 
data was acquired using simultaneous or sequential acquisition. 

 

This FID is typical of digitally filtered data. Note the odd appearance of the beginning of 
the FID. 
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The FID above has been expanded to show the first 400 points, making it easier to see the 
beginning of the FID. 
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If an FT is performed on the above FID, a seriously distorted spectrum results. The 
"wiggles" can be removed with very large linear phase correction (many 100s of 
degrees) which is not very convenient. 

The first 70 points at the beginning of the FID need to be removed, which is done as a 
circular left shift, so that the points removed from the beginning of the FID are added 
onto the end.  This is performed with the NUTS command RD.   

  

 

When RD is typed, this screen is displayed. NUTS determines the number of points to 
shift (Number of Rotations) from the Decimation Number and Firmware Version, which 
are imported with the data.  

If NUTS has been able to determine a default value from parameters in the data header, a 
non-zero value will be displayed in the Number of Rotations box.  Usually the user 
should just click on OK.  If NUTS has not been able to determine the correct number, this 
value will be zero, and the user must input the appropriate number.  This can be 
determined by examining the beginning of the FID.  

The user can experiment with different values for Number of Rotations.  After FT and 
phasing, look at the value for linear phase correction (TP command).  When the correct 
value is used, the linear correction should be fairly small (less than 360 degrees).  
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The resulting FID now has its maximum at the beginning of the FID.  Note the non-zero 
points at the end of the FID.  
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FT of the FID after RD gives a reasonable looking spectrum. In some cases, as here, there 
is some roll-off at the ends of the spectrum. The normal BC command (to remove DC 
offset and tilt) does not work properly in this case.  To compensate, either expand the 
spectrum so that the curved ends are not displayed and apply baseline correction, or use 
the BR command to ignore the ends of the spectrum while applying DC and tilt 
correction. 

Any apodization should be applied before RD is executed.  Below is a comparison of 
spectra resulting from exponential multiplication applied after (top) RD and before 
(bottom) RD.  Note that the tailing off of the baseline is worse when the apodization is 
applied after RD.   Retaining the non-zero points at the end of the FID is important for 
minimizing baseline distortion. 

 

  

If the acquisition time was short enough that the FID has not decayed to zero, then doing 
an RD can result in a discontinuity, and the resulting spectrum will be distorted.  (See 
description of zero-filling for an illustration.)  Applying a window function before the RD 
operation, to bring the end of the FID smoothly to zero, will avoid this. 

For Bruker data, NUTS determines how many points should be shifted by examining the 
parameters DSPFVS and DECIM found in the acqus file.  Allowed DSPFVS values are 
10, 11 and 12.  DECIM can have any of several values.  Milo Westler and coworkers at 
the University of Wisconsin generated a look-up table for the correct number of points to 
rotate, based on these 2 parameters.  If either of these values is zero, NUTS concludes 
this is not digitally filtered data, and so zero points should be rotated. 
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However, sometimes the information found in the data header is incorrect or insufficient 
for NUTS to determine the correct number of points, so NUTS has an alternative 
approach.  The DF command examines the beginning of the FID to determine where the 
"real" start of the data should be, and how may zeroed points precede it.  It executes an 
FT, then attempts to undo the large linear phase correction by applying linear phase of -
360 degrees for every zeroed point.   This will not work properly for all data, so users are 
advised to experiment. 

RD can be used for other purposes than just to correct digitally filtered data.  See 
example in the previous section. 

Special considerations for Bruker data 

There are some peculiarities associated with Bruker data.  Topics are  

sequential data acquisition 
byte swapping 
directory structure 
digitally filtered data 
data transferred via Bruknet  
2D Aspect data  

See also:  2D processing, baseline correcting digitally filtered data 

True quadruature (complex) detection is accomplished by splitting the signal from the 
probe into 2 channels, related by a 90-degree phase shift of the reference frequency.  
Bruker data is often acquired using "sequential" data acquisition, rather than true 
complex, or "simultaneous" data acquisition.  To accomplish quadrature detection using 
this scheme, the data is digitized at twice the rate and points are placed into the 2 
channels alternately.  In other words, the nth point placed into each channel are not 
acquired the same time.  This requires that a special type of FT be performed (BT). Nuts 
should correctly identify sequential data, which is identified by setting the Domain 
parameter to TPPI, and executing an FT should automatically perform the appropriate 
type of FT.  If a complex FT is performed on sequential data, artifacts are created which 
resemble severe quadrature images - every peak has an out-of-phase mirror image. See 
example below. 

Sequential detection can cause a different artifact with similar appearance.  If the 2 
channels are switched, the data points become out of order in time, and following FT, 
each peak will have a large, out-of-phase mirror image.   See example below.  If the data 
is complex, switching the channels simply reverses the spectrum.   We have been unable 
to identify any header information to detect which channel is real and which is 
imaginary.  In addition, we have some information that it depends on the method used to 
transfer the data from the Aspect to the PC.  Executing an RI command (switching Real 
and Imaginary points) before the FT will fix the problem.  An entry has been added to the 
NUTS.INI file which allows the user to automatically perform an RI on Bruker Aspect 
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data at the time it is imported into NUTS, so that the user does not have to do this 
explicitly. The relevant entry in the NUTS.INI file is: 

BRUKER_ASPECT_RI = TRUE  

If the line is not present in the INI file then add it, left justified as typed above.  There is 
also an entry in the nuts.ini file which is: 

RI_ON_IMPORT = FALSE 

This will apply an RI operation on all imported data, so will solve the problem only in 
cases where all data being imported into NUTS comes from an instrument that has this 
problem. 

Some file transfer processes from Bruker Unix systems to the PC incorporate a "byte 
swap" in the file transfer process. The NUTS importing process wants the file to be an 
exact image of the Bruker Unix system fid and will get these files wrong on importing. 
This results in a corrupted file which does not resemble a normal FID. If the parameters 
of these files are imported correctly but the fid is wrong, set this parameter in the 
NUTS.INI file to TRUE. 

BRUKER_UNIX_BS = TRUE  

Note that changes made in the NUTS.INI file are not implemented until the next time the 
NUTS program is started. 

The directory structure for Bruker Unix files must be exactly reproduced on the PC (or 
Mac) for NUTS to import the data successfully. The file name supplied by the user when 
the data are collected becomes the name of a directory. Within that is a subdirectory 
whose name is a number (1, 2, 3, etc.). The files associated with the data are in this 
subdirectory. This directory structure must be created on the PC (or Mac) and files placed 
in the correct directory. File names must be unchanged in moving data from the 
spectrometer, or NUTS will not be able to find the required information.  When NUTS 
translates the data, it creates a file whose name is the name of the parent directory with a 
$ appended to the front. 

Digital Filtering  

Bruker data from Avance series spectrometers (DnX models) require special processing. 
The data have been digitally filtered and "decimated" prior to saving the FID. The FID, 
when first imported into NUTS, appears distorted because the initial points of the FID are 
zero. Before an FT can be performed, an RD (Rotate Data) operation must be performed. 
This is a circular left shift of a specified number of points. NUTS calculates the 
appropriate number of points for the shift, or number of rotations, from the Decimation 
Number found in the Bruker header. Any apodization or zero-filling must be performed 
before the RD.  See section above on how to process digitally filtered data. 
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Digitally filtered data have distorted baselines at the ends of the spectra, which can 
complicate baseline correction.  This is illustrated in the section on baselines, above. 

The FT command was recently modified to perform the RD operation automatically, 
using the values of DECIM and DSPFVS found in the Bruker header.  If an RD is done 
manually, the FT will not perform the RD again.  This is not fool-proof, but works in 
most cases.    

Data transferred from the spectrometer to PC via Bruknet 

This transfer process splits the data file into 2 parts.  For an original file called file.001, 
the 2 resulting files are file.001 and p_file.001.  In this form, the data will not import 
correctly into NUTS.  The solution is to re-combine the 2 files into a single file that 
NUTS will recognize and import.  This is done on a PC with a simple batch file which is 

copy p_%1 #%1 
type %1 >> #%1 

This batch file is placed into the directory containing the data files.  Then execute the file 
with a single argument which is the name of the data file (e.g., file.001).  The 2 files are 
combined and given the name #file.001, which can then be imported into NUTS. 

2D data acquired on an Aspect-based spectrometer 

The Aspect computer predates development of routine 2D spectroscopy.  As a result, the 
Aspect data file format contains no provision for essential parameters for the indirect 
dimension.  The missing parameters are essential to displaying a correct axis in the 
indirect dimension. 

It is simple to enter values for the missing SF, SW and offset parameters, provided you 
know the correct values.  It is suggested that SW and chemical shift information be 
placed into the Bruker TITLE when data are acquired, so they stay with the data. 

Exporting data 

NUTS allows data to be exported as ASCII and as JCAMP-DX5. Both options are 
available from the File menu. The ASCII export has some options, as described below.  

Data can be exported in a macro using the following macro commands to set the filename 
to be used, and to increment the file extension of that file for subsequent exports:  

Set ExportFile filename 

Do increment_export_filename   

See also criteria for ascii files to be imported.    
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EJ -- Export as JCAMP-DX (Real data points only) 

This command exports only the real part of the data in the "XYDATA= (X++(Y..Y))" 
format, and does not use any of the compressed JCAMP formats. Only the displayed 
region of the spectrum is exported. See Davies & Lampen, Applied Spectroscopy, 47 
(8), 1093-1099, 1993. 

E6 -- Export as JCAMP-DX using NTUPLES format 

The NTUPLES data format supports RI pairs. Bruker software can import and export 
data in this format using extensions which are Bruker specific. NUTS follows this 
technique by using extensions to the JCAMP-DX standard which are specific to NUTS. 
Efforts have been made to make these extensions the same as the Bruker extensions 
whenever possible. This means that NUTS can import Bruker exported JCAMP-DX 
spectra and, hopefully, Bruker can import NUTS exported JCAMP-DX spectra. 

NUTS can also export 2D spectra in the JCAMP-DX style. This is outside the JCAMP-
DX standard definitions and is not supported by Bruker. If we become aware of any 
further definitions to the JCAMP-DX standard, we will make efforts to keep our exports 
faithful to the defined standard. 

Even though NUTS does export values for TD and TD_2D in the parameters for the 
number of points in both dimensions of a data set, they are ignored on import, with the 
actual number of points being determined as the data is being imported. 

E1, E2, E3, E4 and E5 - Exporting Data 

NUTS provides the capability of exporting data to a file in ASCII format. This is 
available from the File menu, as Export File, or via keyboard commands E1, E2, E3, E4 
and E5, which output the data in different formats. A list of options is provided which 
includes exporting header plus data points (Full; equivlaent to E1), just the header (E2), 
just the real points (E3), real and imaginary points (E4) or as PPM and Intensity (E5). 
The latter could then be imported into another application for line fitting or other 
analysis.  

The output of the Full ASCII export (and the E1 command) looks like the following:  

COMMENT: Ethyl Benzene on a QE 300 
DATE: 12/31/92 
USER: WWC 
Complex_Points = 2048  
Spectrometer_Frequency = 300.152374 MHz 
Sweep_Width = 4000.00 Hz  
Offset = 1850.00 Hz  
Domain = Time 
Scans = 1 
DATA Reals,Imaginaries 
1528.104614,735.299377 
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425.757690,927.761475 
76.757011,-2591.717285 etc. 

The Header only option (E2) gives the following:  

COMMENT: Ethyl Benzene on a QE 300 
DATE: 12/31/92 
USER: WWC 
Complex_Points = 2048  
Spectrometer_Frequency = 300.152374 MHz 
Sweep_Width = 4000.00 Hz  
Offset = 1850.00 Hz  
Domain = Time 
Scans = 1 

The output of the Real Data Only ASCII export (E3) looks like the following:  

DATA Reals Only 
1528.104614 
425.757690 
76.757011 
1459.461060 
-1165.192627 
-725.373047 
-1354.193359 etc. 

The output of the R&I Data Only ASCII export (E4) looks like the following:  

DATA Reals,Imaginaries 
1528.104614,735.299377 
425.757690,927.761475 
76.757011,-2591.717285 
1459.461060,-1324.713379 
-1165.192627,-843.652344 
-725.373047,-1660.726563 etc. 

The output of the PPM, Intensity ASCII Data Pairs export (E5) looks like the following:  

12.826818,1528.104614 
12.820312,425.757690 
12.813805,76.757011 
12.807298,1459.461060 
12.800791,-1165.192627 etc. 

See also: Importing ascii data, Data Translation. 

NUTS file format 

Common Data File Format 

Header – Select which of 3 file formats to use 
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There are now 3 different NUTS file formats, referred to as Type 1 (original), Type 2 and 
Type 3.  The changes have been made to add flexibility for future program 
modifications.  The default format can be set in the NUTS.ini file, and can also be set 
while NUTS is running.  To do this, enter the "non-2-letter" command mode (by typing 
2F), and type, for example,   

header 2  

which would set the header type to 2.  

This command can also be used to determine the length of the header, in bytes:  

header length  

Type 1 

The translated files have a 258 32bit word header which contains several pieces of 
information.  

A list of file types which can be identified and imported into NUTS with the import (IM) 
command can be found in the section on data translation. 

The general description of the created file is given below: 

See also:  

C structure definitions for NUTS file format 
C code which defines the structure of the NUTS data file and includes routine for 
writing out a NUTS Type 1 data file 
Looking at data files 
FORTRAN program for converting data to CDFF Type 1 

NOTE Word numbering starts at zero since that is the way computer addressing schemes 
would start. 

  

Word              Variable                      Description  
Number          Type 
0        int   Byte Key 04030201 Hexadecimal 
1        int   Number of words in header     ( Usually has 256 
here ) 
 
Start of general header information 
2        int   Number of Dimensions in data ( 1D, 2D, 3D etc. 
data ) 
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NOTE - If data is written as integer NUTS will "import" the data as 
floats  
 
3        int   Data Format    0=IEEE float, 1=32 bit integer 
4        int   Empty             ( Usually a 1 here ) 
5        int   Frame Size         ( Usually 32 ) 
6        int   100 * Program Version Number 
7        int   Number of points in second dimension 
8   int      No Tailer = 0, Tailer present = 1 
 
18       float   SW Sweep Width - NOT used by NUTS         
19       float   SF Spectrometer Freq - Not used by NUTS 
     
20 to 83   float        64 time values from an arrayed experiment  
 
84-95      --           unassigned    (95 is last word of general 
header information) 
 
First Dimension Parameters 
96        int   pts1d - Data Points 
97        int   complex1 - Data Type: 0 = Real; 1 = Complex; 2 = 
Bruker Interleaved 
98        int   domain1 - Domain Type: 0 = Time; 1 = Frequency 
99        int   axis1 - Axis Type: 0 = None; 1 = Points; 2 = Hz; 
3 = PPM 
100       long   decimation - Bruker decimation no. for digitally 
filtered data  
101-111    --    unassigned  
112       float  sw1 - Sweep Width 
113       float  sf1 - Spectrometer Frequency 
114       float  of1 - Reference Shift 
115       float  Reference Point (unused by NUTS) 
116       float  Phase Pivot (unused by NUTS) 
117       float  tpa1 - Zero Order Phase 
118       float  tpb1 - First Order Phase 
119       float  tlb1 - LB -- Line Broadening by EM command 
120-135    --           unassigned 
 
Second Dimension Parameters. 
136        int  pts2d - Data Points 
137        int   complex2 - Data Type: 0 = Real; 1 = Complex; 2 = 
Bruker Interleaved (TPPI) 
138        int   domain2 - Domain Type: 0 = Time; 1 = Frequency 
139        int   axis2 - Axis Type: 0 = None; 1 = Points; 2 = Hz 3 
= PPM 
140-151          unassigned  
152        float  sw2 - Sweep Width 
153        float  sf2 - Spectrometer Frequency 
154        float  of2 - Reference Shift 
155        float  Reference Point (unused by NUTS) 
156        float  Phase Pivot (unused by NUTS) 
157        float  tpa2 - Zero Order Phase 
158        float  tpb2 - First Order Phase 
159        float  tlb2 - LB -- Line Broadening by EM command 
160-201     --          unassigned 
 
General Parameters 
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204        float  Temperature 
205-214    chars  EXperiment description string 
215        float  90 Degree pulse length in usec 
216        float  Recycle delay in seconds 
217        long int  Number of Acquisitions 
218 - 227    chars  USER name string 
228 - 235    chars  DATE string 
236 - 256    chars  COMMENT string 
 
After the header comes the data as complex pairs. 
If the data is real only then every other word must be 
zero. 
 
The first word of each slice of data is the size of that slice  
in words. Therefore a 4096 Complex Pair data set would be 
8192 words long. 
NOTE: While NUTS writes this word into the data format it never 
reads or uses this information.  
 
The word numbers below assume the header is 256 Words long. 
258        int   Data size of slice 1 in words 
259...    float  Data 
 
If multi-D then the next dimension. 
... int   Data Size of slice 2 in words 
... float   Data 
 
As many slices as needed. 

  

Type 2 

In addition to a larger header block (1026 rather than 258), the new format also 
eliminates the "spacer" between slices.  In Type 1 format, the first word of each slice is 
an integer equal to the size of that slice.  NUTS never used that value, it was included to 
make the format consistent with the Felix format from which it derived.  To make things 
simpler, this spacer was eliminated in the Type 2 format. 

  

Word              Variable                      Description  
Number          Type 
0     int   04030201 Hexadecimal 
1     int   Number of words in header, Usually 1024 
2     int   1=1D, 2=2D, 3=3D etc 
3    int   0 = float, 1 = integer 
4     int   1 = NUTS 1st Header, 2 = NUTS 2nd Header,  
5      int   Usually 32 
6     int   Version Number of Program times 100 
8     int   0 = No Tailer, 1 = Tailer 
20-83     float  64 time values from an  
 
1st Dimension Parameters 
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96        int   pts1d - Data Points 
97        int   complex1 - Data Type: 0 = Real; 1 = Complex; 2 = 
Bruker Interleaved 
98        int   domain1 - Domain Type: 0 = Time; 1 = Frequency 
99        int   axis1 - Axis Type: 0 = None; 1 = Points; 2 = Hz; 
3 = PPM 
100       long   decimation - Bruker decimation no. for digitally 
filtered data  
101-111    --    unassigned  
112       float  sw1 - Sweep Width 
113       float  sf1 - Spectrometer Frequency 
114       float  of1 - Reference Shift 
115       float  Reference Point (unused by NUTS) 
116       float  Phase Pivot (unused by NUTS) 
117       float  tpa1 - Zero Order Phase 
118       float  tpb1 - First Order Phase 
119       float  tlb1 - LB -- Line Broadening by EM command 
120-135    --           unassigned 
2nd Dimension Parameters 
136        int  pts2d - Data Points 
137        int   complex2 - Data Type: 0 = Real; 1 = Complex; 2 = 
Bruker Interleaved (TPPI) 
138        int   domain2 - Domain Type: 0 = Time; 1 = Frequency 
139        int   axis2 - Axis Type: 0 = None; 1 = Points; 2 = Hz 3 
= PPM 
140-151     --   unassigned  
152        float  sw2 - Sweep Width 
153        float  sf2 - Spectrometer Frequency 
154        float  of2 - Reference Shift 
155        float  Reference Point (unused by NUTS) 
156        float  Phase Pivot (unused by NUTS) 
157        float  tpa2 - Zero Order Phase 
158        float  tpb2 - First Order Phase 
159        float  tlb2 - LB -- Line Broadening by EM command 
160-201     --          unassigned 
 
176-215 -- reserved for 3rd Dimension Parameters 
216-255 -- reserved for 4th Dimension Parameters 
 
General Parameters 
256     float  Temperature for experiment  
257     float  90 degree pulse length in usec  
258     float  Recycle delay in seconds  
259     int   Number of acquisitions  
260-267    char  Name of pulse program  
268-275    char  Name of nucleus 
276-283    char  solvent  
284-291    char  USER name string  
292-299    char  DATE string  
300-331    char  COMMENT string  
332-1025    --  unassigned 
After the header comes the data as complex pairs  
(alternating real and imaginary pts). 
If the data is real only then every other word must  
be zero.  Subsequent slices follow immediately after the 
preceeding slice. 
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Type 3 

This format is based on the JCAMP specifications, but is not identical to JCAMP.  The 
header is ASCII, with a keyword at the beginning of each line.  This offers much more 
flexibility for future additions to information stored in the header, because the exact 
location of any item in the header and the order of items is not fixed.  Some of the lines 
conform to the JCAMP-DX specification, others are NUTS-specific items and are in a 
proprietary section.  Another advantage of this format is that the header can be viewed in 
any text editor.  

The data is not stored as ASCII, as is the case for JCAMP files, because the file size 
would be much larger.  The header is terminated with Ctrl-Z, and is followed by the data 
points, stored as 32-bit floating point numbers in Intel (little endian) byte order.   The 
data are organized as Real, Imag, Real, Imag, etc.  This is essentially the format proposed 
as JCAMP-DXB, which was not approved as a JCAMP standard.  

An example is shown below, for a small 1H spectrum.  

##TITLE= Ethyl Benzene on a QE 300 
##JCAMP-DXB $$JCAMPDX Header and Binary Data 
##DATA TYPE= NMR SPECTRUM 
##DATA Class= NTUPLES 
##ORIGIN= NUTS NATIVE (RI) 
##OWNER= 
##SPECTROMETER/DATA SYSTEM= NUTS NATIVE (RI) 
##INSTRUMENTAL PARAMETERS= H1 
##.OBSERVE FREQUENCY= 300.152374 
##.OBSERVE NUCLEUS= H1 
##.DELAY= 0.000000 
##.AVERAGES= 1 
$$ NUTS specific parameters 
##$AXIS_TYPE=3, 3, 0, 0 
##$AQ_mod=1, 0, 0, 0 
##$DATE= 12/31/92 
##$USER= WWC 
##$NAME1=ethylbenzene 
##$NAME2= 
##$NAME3= 
##$FORMULA=C8H10 
##$Nucleus1= H1 
##$Nucleus2= 
##$Nucleus3= 
##$Nucleus4= 
##$PATH= c:\nuts\data\test.nmr 
##$DECIM=0 
##$DOMAIN=1, 0, 0, 0 
##$DSPFVS=0 



319 

##$POINTS=2048, 1, 1, 1 
##$FREQUENCY=300.152374, 1.000000, 1.000000, 1.000000 
##$SWEEP_WIDTH=4000.000000, 1.000000, 1.000000, 1.000000 
##$FREQ_OFFSET=1850.000000, 0.000000, 0.000000, 0.000000 
##$PULPROG= One Pulse 
##$PULSE_LENGTH= 0.000000 
$$ End of NUTS specific parameters 
##NTUPLES=NMR SPECTRUM 
##VAR_NAME= PPM, SPECTRUM/REAL, SPECTRUM/IMAG, PAGE NUMBER 
##SYMBOL= X, R, I, N 
##SYMBOL= INDEPENDENT, DEPENDENT, DEPENDENT, PAGE 
##VAR_FORM= AFFN, ASDF, ASDF, AFFN 
##VAR_DIM= 2048, 2048, 2048, 2 
##UNITS= HZ, ARBITRARY UNITS, ARBITRARY UNITS 
##FIRST= 3850.0000 , -1406.669434, -465.478027 
##LAST= -150.0000 , -557.505615, -853.042786 
##MIN= 3850.000 , -3443.531006, -100636.140625 
##MAX= -150.000 , 257425.500000, 96545.257813 
##FACTOR= 1.0, 1.000000, 1.000000 
##YDATA=(Y..Y) 
$$ Binary Data follows Control Z 
$$ Binary( Total # Points) = Total # Bytes, Intel Little 
Endian floats 
$$ Complex Pairs packed RIRIRIRI... 
##BINARY(2048)=16384,IEEE32L 

Customizing NUTS 

Configuration: The NUTS.INI file 

When the NUTS program is run, it automatically sets internal operational parameters to 
some default values. After setting these default values, the NUTS program looks for a 
configuration file called nuts.ini. If it finds the file, NUTS looks through the file for 
keywords followed by a value. For every keyword found, the default value of the 
keyword parameter is changed to the value specified in the configuration file. This allows 
each user to customize NUTS to his/her own preferences. Use any text editor to make 
changes in the nuts.ini file which is supplied with the NUTS program. There are 
extensive comments included in the file, and it is suggested that users read through the 
file supplied with Nuts, to acquaint themselves with the options it provides. 

Some of the parameters set by the nuts.ini file can be overridden after the program is 
started. The reason for setting these parameters using the nuts.ini file is that they remain 
set to the user's choice every time NUTS is run. These include the axis label, minimum 
height for peak picking, page setup for plots (whether or not to print parameters or draw a 
box around the plot, plot margins) and choice of font for the different types of text used 
in the program. 
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While NUTS is running, it is possible to reset default parameters to those specified in the 
nuts.ini file using the non-2-letter command NUTSINI.   

It is possible to use a different nuts.ini file when NUTS starts, which would allow users 
sharing a computer to have personalized nuts.ini files.  This is done by adding an 
argument to the command line when Nuts is started.  For example, the following 
command would use a file called fred.ini in  

nuts.exe -i fred.ini 

A full path to the nuts.ini file can be specified using double or single quotes. 

See also: other startup options 

A sample configuration file is shown below.  It is divided into the following sections: 

General Configuration - header version, UnDo, scrollbars 
Directories - set defaults for working data directory, import directory, 
macro directory 
Import - invoke automatic spectrum reverse on import of specific file 
types 
Help - choices for Help files 
Routines - set some initial values  
Axis Labels  
Phase - set mouse direction, sensitivity 
FB - default baseline correction mode for FB command 
Print - set pen width, choices for parameters on plots, box around plots, 
color, margins 
Color - set colors for spectrum, axis, integrals, contour levels 
Stacked Plot - X and Y offsets 
Peak Picking - appearance of peak labels and peak lists 
Offset Information - interpolation and snap-to-peak settings 
Line Broadening 
Line Fit - default lineshape for deconvolution 
Macro - map function keys to specific macros 
Links - define linked command lists 
Font - set fonts for axis, peak labels, integral labels, etc. 

;   NUTS.INI 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[GENERAL CONFIGURATION] 
 
 
;  All blank lines and lines starting with a ";" are ignored. 
;  The first word on other lines becomes the keyword. 
;  The remaining part of the line in the value for the keyword 
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;  The keyword and values are case insensitive 
 
 
; Over time, the file format for the NUTS header has changed 
; to accommodate new features and capabilities.  The 3 versions 
; are referred to as header types 1, 2 and 3.  All are described 
; in the Help files.   
NUTS_HEADER_VERSION = 3 
 
;  Flag used to reduce the level of questions NUTS asks 
;  is areas where the data could be destroyed if the program 
;  continues.  Tends to make the command level operation 
;  directly from the keyboard more like a Link or Macro was  
;  controling NUTS operation.   
;  If this term is not going to be used then leave a semicolon in front 
;  of it so that the initialization part of NUTS will ignore it and  
;  use its own internal default of EXPERT_MODE = FALSE. 
;EXPERT_MODE = TRUE 
 
; Nonsub-routine commands can have an undo buffer of 10. 
; If the flag below is set to TRUE the undo buffers 
; will save buffers to the disk with each two letter 
; command.  This can take time depending on the size 
; of the file and speed of the disk.  This is especially 
; true of 2D files. 
;UNDO = TRUE 
 
; Nonsub-routine commands were originally two letter 
; commands which automatically executed after entering 
; the second character on the keyboard. 
; If the flag below is set to TRUE then an <ENTER> is 
; required before the command is executed by default when 
; NUTS is started.  In this non two letter command mode 
; commands can be longer than two letters.  This mode can 
; be toggled on and off while NUTS is running with the 
: 2N (2 letter command mode oN) and 2F (2 letter command  
; mode oFf). 
;CR_FOR_COMMANDS = TRUE 
 
;  By default NUTS has a toolbar at the top of the window 
;  below the menu.  If the semicoln is removed on the next  
;  line, this feature will be disabled. 
;Toolbar = FALSE 
 
;  By default NUTS does not display Gridlines on the 
;  display or plots.  If the parameter below is set to TRUE  
;  Then gridlines will be displayed on NUTS startup. 
;  This gridline display can be toggled on and off with ^G. 
;GRIDLINES = TRUE 
 
;  If a line is "MetaObjectFile" the next line is read  
;  as a filename of a Windows Enhanced MetaFile on the 
;  disk to be added to the MetaObjects for display and 
;  printing.  The first item in the line is the file name. 
;  The next 2 numbers define the x,y position of the upper 
;  left corner of the object.  They are expressed as a  
;  fraction of the total width and height of the screen 
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;  or plot.  The last 2 numbers define the object's 
;  height and width, expressed as a fraction of the 
;  height and width of the screen or plot. 
; 
;   
; 
;  NOTE: 
;  If the MetaFile is not in the same directory as the NUTS 
;  program, then a full path must be included.  If a full  
;  path is not included, then the display can come as go as 
;  working directories are changed inside NUTS. 
; 
;  NOTE there can be more than one of these "MetaObjectFile" 
;  line pairs in the INI file. 
; 
;  NOTE %NutsRoot% indicates the directory where the NUTS.INI 
;  file is at 
;MetaObjectFile 
;%NutsRoot%acorn.emf 0.01 0.01 0.06 0.10 
 
 
;  AXIS keyword has legal values of HEADER, NONE, HZ PPM, and POINTS 
;  The keyword header means the file header value should be used. 
;  Other keywords override the file header values. 
AXIS = ppm 
 
;  The default label for the main menu View / Spectral Parameters 
;  and the 2D axis display can be set with the lines below. 
DIMLABEL1 = Direct Dimension 
DIMLABEL2 = Indirect Dimension 1 
DIMLABEL3 = Indirect Dimension 2 
DIMLABEL4 = Indirect Dimension 3 
 
;  If this line contains a valid macro, the macro will 
;  be executed when NUTS starts. 
;AutoExecMacro = C:\NUTS\MACS\GET_EB.MAC 
 
 
;  The default for NUTS is to NOT read a file tailer when 
;  reading a file.  This is so information such as integral regions 
;  and DP lists can be carried over from one spectrum to another. 
;  The NUTS behavior can be modified by checking the option 
;  under the FILE menu. 
;  Setting the keyword below to TRUE makes the default behavior in 
;  NUTS to be to read the tailer with each new file read. 
AUTOTAILER = FALSE 
 
 
;  When the HORIZONTAL_SCROLL_BARS flag is set to TRUE the 
;  ZO and ID subroutines of the NUTS program will have 
;  a bottom horizontal scroll bar for moving the displayed 
;  region left and right. 
HORIZONTAL_SCROLL_BARS = TRUE 
 
 
;  When this flag is set to TRUE the NUTS program will 
;  close Windows when NUTS is exited. 
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Exit_Windows = FALSE 
 
;  By default NUTS will set the initial windows position and size 
;  to defalut sizes as determined by the operating system. 
;  The values below can be set to override the default behavior 
;  and set the X and Y upper left corner of the starting screen 
;  and the X width and Y width of the starting screen. 
;  All units are in screen pixels. 
;  All four values must be set or this entry is ignored. 
;X0_START = 3; 
;Y0_START = 3; 
;XW_START = 900; 
;YW_START = 700; 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[DIRECTORIES] 
 
 
; NUTS can be configured to not overwite existing files.  
; This requires all file saves to be to a non-exiting file name. 
;NO_FILE_OVERWRITE = TRUE 
 
;  DATADIR is the default path name for NUTS file open command. 
;  If this term is used, it must be a full path name like 
;  "C:\NUTS\DATA\" 
;  If this term is not going to be used then leave a semicolon in front 
;  of it so that the initialization part of NUTS will ignore it and  
;  use its own internal defaults. 
;DATADIR = C:\NUTS\DATA\ 
 
;  IMPORTDIR is the default path name for NUTS file import command. 
;  If this term is used, it must be a full path name like 
;  "C:\NUTS\DATA\" 
;  If this term is not going to be used then leave a semicolon in front 
;  of it so that the initialization part of NUTS will ignore it and  
;  use its own internal defaults. 
;IMPORTDIR = C:\NUTS\DATA\ 
 
;  If DEFAULT_IMPORT_OUT_DIR is set to a value below then that 
directory 
;  will be the default path where NUTS will put all imported files. 
;  The default data directory will also be reset to this directory with 
each import. 
;  If DEFAULT_IMPORT_OUT_DIR is not set, then all imported files will 
go 
;  to the current Data Directory which is updated with each GA or GB 
operation. 
;DEFAULT_IMPORT_OUT_DIR = C:\NUTS\DATA\ 
 
 
;  MACRODIR is the default path name where NUTS will first look for 
;  macros when using the run macro (RU) command. 
;  If this term is used, it must be a full path name like 
;  "C:\NUTS\DATA\" 
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;  If this term is not going to be used then leave a semicolon in front 
;  of it so that the initialization part of NUTS will ignore it and  
;  use its own internal defaults. 
;MACRODIR = C:\NUTS\MAC\ 
 
;  ZZ_FILE_PATH is the default path name for NUTS ZZ auto-import 
command. 
;  ZZ_FILE_TYPE is the default import type for NUTS ZZ auto-import 
command. 
;  If these terms are used, it must be a full path and file name like 
;     "C:\NUTS\DATA\FILE.QE" 
;  and a legal import type like: 
;     "ZZ_FILE_TYPE = LYBRICS" 
;  If ZZ_FILE_TYPE = Auto  is used the imported file will be auto 
;  identified using NUTS standard file detection scheme. 
;  If these terms is not going to be used then put a semicolon in front 
;  of it so that the initialization part of NUTS will ignore it and  
;  bring a File Open Dialog inquiry the first time ZZ is used each 
;  NUTS sesion. 
ZZ_FILE_PATH = D:\PG\CODE\NUTS\DATA\QEEB.FID 
ZZ_FILE_TYPE = Auto 
 
 
;  Some reports and functions created or used by NUTS use 
;  the system browser.  NUTS needs the full path name to 
;  the desired browser to do this. 
;  If the browser is "NONE" these the browser launch and report 
;  are skipped. 
;BROWSER = NONE 
;  If the path has spaces the path needs to be enclosed in quotes. 
;  If you prefer a different browser then prvide the full path to that 
;  browser. 
;  Default Directory for Window NT 4 
;BROWSER = C:\Program Files\Plus!\Microsoft Internet\iexplore.exe 
;  Default Directory for Windows 98 and Windows 2000 
BROWSER = C:\Program Files\Internet Explorer\iexplore.exe 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[IMPORT] 
;  Some file transfer processes from Bruker unix systems 
;  to the PC world incorporate a "byte swap" in the file 
;  transfer process. The NUTS importing process wants the 
;  file to be an exact image of the Bruker Unix system fid 
;  and will get these files wrong on importing.  If the  
;  parameters of these files are imported correctly but 
;  the fid is wrong, set the parameter below to TRUE. 
BRUKER_UNIX_BS = false 
 
;  Some file transfer processes result in the "real" fid and 
;  "imaginary" fids being in either the opposite order or  
;  the wrong relative phase direction.  NUTS makes a best 
;  guess from the header information to correctly determine 
;  this. The result of importing this kind of data is that 
;  after FT the spectrum is backwards and requires an SR. 
;  However, if with the data you use most this is consistently 
;  required the flag below can be set to TRUE and NUTS will 
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;  swap the FIDs on all importing processes. 
RI_ON_IMPORT = FALSE 
 
;  Some file transfer processes from Bruker Aspect systems 
;  have the "real" fid and "imaginary" fid in the  
;  opposite order.  We have been unable to identify 
;  any header information to detect this. In addition, we 
;  have some information that it depends on the method the  
;  data is transferred from the Aspect to the PC. 
;  If Bruker Aspect data requires an RI to process without 
; bad "Quadrature" images set the parameter below to TRUE; 
BRUKER_ASPECT_RI = FALSE 
 
;  Some file transfer processes from Bruker XWinNMR systems 
;  have the "real" fid and "imaginary" fid in the  
;  opposite order.  We have been unable to identify 
;  any header information to detect this, but this flag 
;  will allow the default operation to be reversed. 
BRUKER_XWIN_RI = false 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[HELP] 
 
 
;  WinHelp development has stopped for NUTS.  The new help is  
;  HTML help.  For the time being both help files are being 
distributed. 
;  The flag below can be used to set the default help file type to 
HTML. 
;  The HTML help is more up to date and complete and is the recommended 
;  help method for NUTS.  To use the HTML help on Win9x/NT IE 4.0 MUST 
be 
;  loaded on the computer.  It does NOT have to be the default browser.   
;  To use HTML help on Windows 3.1 or Macintosh you must use browser  
;  software such as IE 4.0 or Netscape 4.0 
HTMLHELP = TRUE 
 
;  The default for NUTS is to use helper dialog boxes where they  
;  exist.  
;  Setting the keyword below to FALSE configures NUTS to NOT use  
;  helpers by default. 
HELPERS = TRUE 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[ROUTINES] 
 
 
;  Intial values for the AS (Add/Subtract) routine 
;  AS_Mult is the initial multiplier  
;  AS_DC  is the initial percent vertical screen offset 
AS_Mult = 1.0 
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AS_DC = 33.0 
 
;  Flag used to set certain debug messages during NUTS operation. 
;  This is used to help analyze problems remotely which cannot 
;  be reproduced at Acorn NMR. 
;  0 (zero) is off and 1 (one) is on. 
NUTSBUG = 0 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[AXIS LABELS] 
;  The axis has different labels depending on how the data has been  
;  processed and the users settings. By default these are: 
;    PPM, Hz, sec, pts, slice 
;  The user can change them here if desired. 
AXIS_LABEL_PPM = PPM 
AXIS_LABEL_HZ =  Hz 
AXIS_LABEL_SEC = sec 
AXIS_LABEL_PTS = pts 
AXIS_LABEL_SLICE = slice 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[PHASE] 
;  For the phasing operations PH and PE the mouse movement is 
;  used to determine the amount of phasing to do.  By default 
;  NUTS uses left and right mouse movement for these operations. 
;  However, NUTS can be configured to use up and down mouse  
;  movements for this operation or the sum of left and right 
;  and up and down. 
;  Left and Right  = 0 
;  Up and Down     = 1 
;  Sum L&R and U&D = 2 
MOUSE_DIRECTION = 0; 
 
;  Mouse movement step is scaled (multiplied by) the scaling number 
;  below during PH and PE.  
MOUSE_SCALING_PE = 10 
MOUSE_SCALING_PH = 500 
 
; DEFAULT_PA keyword sets the initial PA value used by the PC command 
 
DEFAULT_PA = 0.0 
 
; DEFAULT_PB keyword sets the initial PB value used by the PC command 
DEFAULT_PB = 0.0 
 
; DEFAULT_PC keyword sets the initial PB value used by the PC command 
DEFAULT_PC = 0.0 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[FB] 
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;  The baseline correction command "FB" fits a polynomial 
;  to the baseline for the purpose of "straighting" the 
;  baseline.  The Symplex method seems to work the best 
;  in most cases, however the Least Squares method is  
;  50 to 100 times faster and gives better than 90% of the   
;  bang for the buck.  Both methods are available from the 
;  command line by user choice.  However, when FB is used  
;  in a Link or Macro, the flag below will set the method 
;  used without user interaction.  The allowed values are 
;  TRUE or 0 (for Simplex), FALSE or 1 (for least squares) and 
;  2 for "fudge" method.  The latter is not a polynomial fit, 
;  but rather removes DC and tilt separately for each segment of 
;  the spectrum.  See Baselines in Nuts Help for details. 
FB_SYMPLEX = FALSE 
 
; FB and FX baseline correcting routines can be used while in a zoomed  
;  display mode. When so used the baselines of the regions 
;  outside the zoomed display region can be adjusted in DC value 
;  to prevent a discontinuity in the total spectral baseline  
;  by setting CONTINUOUS_BASELINE to TRUE.  
;  Sometimes, the user would rather have the baseline become  
;  discontinuous. One reason being to keep integral values 
;  outside of the zoomed display region from being changed by 
;  a DC baseline adjustment. To not do these DC baseline adjustments 
;  outside of the displayed region set CONTINUOUS_BASELINE to FALSE.  
CONTINUOUS_BASELINE = FALSE 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[PRINT] 
;  The default pen width is 1 (one).  If the line below in uncommented 
;  it can be used to set the initial pen width to another value. 
PEN_WIDTH_SCREEN  = 1; 
PEN_WIDTH_PRINTER = 2; 
 
 
;  PRINT_BOX keyword sets the default presentation of plots. 
; If TRUE then a box will be printed around the plot. 
; Otherwise no box will be printed. 
PRINT_BOX = TRUE  
 
 
;  PRINT_PARAMETERS keyword sets whether the spectral parameters 
;  will be printed on each plot. 
; If TRUE then the parameters will be printed on each plot. 
; Otherwise they will not be printed. 
PRINT_PARAMETERS = TRUE 
 
 
;  SQUARE_2D keyword sets whether 2D contour and intensity plots 
;  are forced to be square in the X and Y dimensions. 
; If TRUE then the 2D plots will be square. 
; Otherwise they will not be forced to be square. 
SQUARE_2D = FALSE 
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;  PRINT_COLOR keyword sets whether the display colors will be  
;  sent to the printer as displayed or remapped to black and white. 
; If TRUE then the colors will be printed as displayed. 
; Otherwise they will be converted to black and white. 
PRINT_COLOR = FALSE 
 
 
;  TOP_MARGIN keyword sets the printer's top margin in millimeters. 
;  Devices such as laser printers often have a "dead" area 
; on the edges of the paper.  This margin is in addition 
; to the devices "dead" area. 
TOP_MARGIN = 7 
 
 
;  BOTTOM_MARGIN keyword sets the printer's bottom margin in 
millimeters. 
;  Devices such as laser printers often have a "dead" area 
; on the edges of the paper.  This margin is in addition 
; to the devices "dead" area. 
BOTTOM_MARGIN = 7 
 
 
;  LEFT_MARGIN keyword sets the printer's left margin in millimeters. 
;  Devices such as laser printers often have a "dead" area 
; on the edges of the paper.  This margin is in addition 
; to the devices "dead" area. 
LEFT_MARGIN = 1 
 
 
;  RIGHT_MARGIN keyword sets the printer's right margin in millimeters. 
;  Devices such as laser printers often have a "dead" area 
; on the edges of the paper.  This margin is in addition 
; to the devices "dead" area. 
RIGHT_MARGIN = 1 
 
 
;  ???_2D_MARGIN keyword sets the specified margin of a 2D IP or CP 
;  display as a fraction of the current windows width. 
TOP_2D_MARGIN = 0.10; 
BOTTOM_2D_MARGIN = 0.10; 
LEFT_2D_MARGIN = 0.10; 
RIGHT_2D_MARGIN = 0.10; 
 
 
 
;  DISPLAY_MONO keyword sets whether the display will be  
;  in color or monochrome. 
; If FALSE then the display will be in color, 
; otherwise, the display will be monochrome. 
DISPLAY_MONO = FALSE 
 
 
;  When doing inserts (inset plots) the user can specify the  
;  hertz per centimeter for the lenth of the insert when  
;  plotted.  The device drivers for the printer devices sometimes 
;  hav an error of a certain reproducible percentage.  The user 



329 

;  can enter that error here so it can be automatically set when 
;  adding inserts. 
INSERT_PRINTER_FUDGE = 1.000 
 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[COLOR] 
 
 
; Colors will vary with different types of Windows graphics drivers. 
; They are defined here as the scale of the red, green and blue parts 
; of the color spectrum on a scale between 0 and 255 intensity; 
; Zero is no color such that if all three colors were a level 0 the  
; color would be black.  If all three colors were defined to be 255  
; the color would be white. 
; Color of the Axis line 
AXIS_COLOR = 255_0_0 
; Color of the axis font 
AXIS_FONT_COLOR   = 0_0_0 
 
; Color of the real points 
REAL_COLOR   = 0_0_255 
 
; Color of the imaginary points 
IMAG_COLOR   = 0_255_0 
 
; Color of the integral lines 
INTEGRAL_COLOR = 128_128_128 
INTEGRAL_FONT_COLOR = 0_0_0 
 
; Color of the peak picking label fonts 
PEAKPICK_FONT_COLOR = 0_0_0 
 
; Color of the Command Line fonts 
CMDLINE_FONT_COLOR = 0_0_0 
 
; Color of the clipboard fonts 
CLIPBOARD_FONT_COLOR = 0_0_255 
 
; Color of the parameter fonts used when 
; printing the parameters on a plot 
PARAMETER_FONT_COLOR = 0_255_0 
 
; Color of the screen background 
BACKGROUND_COLOR = 255_255_255 
 
; The Zoom and DP cursors are black by default. 
; The flag below set whether they are black or white 
; and can be used to make them more visable on a dark backgroung 
LIGHT_COLOR_CURSORS = FALSE 
 
; The Contour Displays(CP) and Intensity Displays (IP) can be set to 
use 
; different number of levels (between 1 and 10) and each level can be 
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; displayed in a different color. 
 
IP_LEVELS = 10 
 
; Each level will be at the value set by MH times the values below. 
; Care needs to be taken that the values always increase. 
IP_LEVEL_1 = 1.0 
IP_LEVEL_2 = 1.5 
IP_LEVEL_3 = 2.3 
IP_LEVEL_4 = 3.5 
IP_LEVEL_5 = 5.2 
IP_LEVEL_6 = 7.8 
IP_LEVEL_7 = 11.6 
IP_LEVEL_8 = 17.5 
IP_LEVEL_9 = 26.2 
IP_LEVEL_10 = 40.0 
 
 
; The color will vary with different types of Windows graphics drivers. 
; They are defined here as the scale of the red, green and blue parts 
; of the color spectrum on a scale between 0 and 255 intensity; 
; Zero is no color such that if all three colors were a level 0 the  
; color would be black.  If all three colors were defined to be 255  
; the color would be white. 
IP_RED_1 = 150 
IP_RED_2 = 150 
IP_RED_3 = 150 
IP_RED_4 = 150 
IP_RED_5 = 125 
IP_RED_6 = 100 
IP_RED_7 = 75 
IP_RED_8 = 50 
IP_RED_9 = 25 
IP_RED_10 = 0 
 
IP_GREEN_1 = 150 
IP_GREEN_2 = 150 
IP_GREEN_3 = 150 
IP_GREEN_4 = 150 
IP_GREEN_5 = 125 
IP_GREEN_6 = 100 
IP_GREEN_7 = 75 
IP_GREEN_8 = 50 
IP_GREEN_9 = 25 
IP_GREEN_10 =0 
 
IP_BLUE_1 = 150 
IP_BLUE_2 = 150 
IP_BLUE_3 = 150 
IP_BLUE_4 = 150 
IP_BLUE_5 = 125 
IP_BLUE_6 = 100 
IP_BLUE_7 = 75 
IP_BLUE_8 = 50 
IP_BLUE_9 = 25 
IP_BLUE_10 = 0 
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;  Now for the negative contour levels 
IP_RED_MINUS_1 = 25 
IP_RED_MINUS_2 = 50 
IP_RED_MINUS_3 = 75 
IP_RED_MINUS_4 = 100 
IP_RED_MINUS_5 = 125 
IP_RED_MINUS_6 = 150 
IP_RED_MINUS_7 = 175 
IP_RED_MINUS_8 = 200 
IP_RED_MINUS_9 = 225 
IP_RED_MINUS_10 = 255 
 
IP_GREEN_MINUS_1 = 0 
IP_GREEN_MINUS_2 = 0 
IP_GREEN_MINUS_3 = 0 
IP_GREEN_MINUS_4 = 0 
IP_GREEN_MINUS_5 = 0 
IP_GREEN_MINUS_6 = 0 
IP_GREEN_MINUS_7 = 0 
IP_GREEN_MINUS_8 = 0 
IP_GREEN_MINUS_9 = 0 
IP_GREEN_MINUS_10 = 0 
 
IP_BLUE_MINUS_1 = 0 
IP_BLUE_MINUS_2 = 0 
IP_BLUE_MINUS_3 = 0 
IP_BLUE_MINUS_4 = 0 
IP_BLUE_MINUS_5 = 0 
IP_BLUE_MINUS_6 = 0 
IP_BLUE_MINUS_7 = 0 
IP_BLUE_MINUS_8 = 0 
IP_BLUE_MINUS_9 = 0 
IP_BLUE_MINUS_10 = 0 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[STACKED PLOT] 
 
 
;  The keyword X_OFFSET allows the operator to set the default 
;  stacked plot X offset values,  a typical value is 10.0 and 
represents 
;  the % the x width will be reduced on the first plot. 
X_OFFSET = 10.0; 
 
;  The keyword Y_OFFSET allows the operator to set the default 
;  stacked plot Y offset values,  a typical value is 1.0 and represents 
;  the Y offset which will put all the plots in the display. 
;  A larger number will make the plots farther apart in the vertical  
;  direction, while a smaller number moves them closer together. 
Y_OFFSET = 1.0 
 
;  The keyword DC_OFFSET allows the operator to make the default 
;  screen and plot Y offset other than zero. 
;  Start with numbers like 10 and 20 then adjust to desired value; 
DC_OFFSET = 0 
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;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[PEAK PICKING] 
 
 
; When the peakpicking operation is done, a copy of the peak pick table 
; is placed into the clipboard. This table is done in two possible 
ways: 
; 1) space separated columns such that, when a fixed size font is used,  
;    the columns line up. Best for pasting into Notepad. Set UseTabs to 
FALSE. 
; 2) tab separated columns. Best for pasting into a spreadsheet 
program. 
;    Set UseTabs to TRUE 
; This column separation is also used for the Integral Tables. 
UseTabs = TRUE 
 
; MH keyword sets the initial Minimum Height for the Peakpicking 
command 
MH = 10.0 
 
 
; RM keyword sets the multiple of the RMS noise level 
; a peak must change after a maximum before it will be declared a real 
; peak in the peakpicking command 
RM = 3 
 
;When NUTS is in its base level of operation and  
;the right mouse button is pressed then a target crosshair is  
;displayed on the screen. While the crosshair is being displayed,  
;the "M" sub-command resets the MH value to the level of the  
;horizontal crosshair. It is sometimes convenient to have NUTS  
;automatically do a new PP command when the M sub-command is given.  
;The default action can be set in the NUTS.INI with the line: 
DO_PP_WITH_M = TRUE 
 
; DP_PREVENT_OVERLAP keyword sets the initial mode for whether the DP 
labels  
; try to automatically avoid overlap 
DP_PREVENT_OVERLAP = TRUE 
 
 
; DP_ONTOP keyword sets the initial mode for the DP labels to be at the 
; top of the display 
;DP_ONTOP = TRUE 
DP_ONTOP = TRUE 
 
 
; DP_WITHLINE keyword sets the initial mode for the DP labels to have a 
line 
; drawn from label to indicate where the peak is at for that label 
;DP_WITHLINE = TRUE 
DP_WITHLINE = FALSE 
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; DP_ALWAYSINFO keyword sets the initial mode for the DP labels to be 
showing 
; the information field always even when peak labels are off 
DP_ALWAYSINFO = FALSE 
 
 
; DP_FIRSTARG keyword sets the initial mode for the DP labels to show 
only 
; the first argument (to a space) instead of the entire info field.  
This is 
; most useful in the searchable archive accessory 
DP_FIRSTARG = FALSE 
 
 
; default 1D DP peak label orientations are vertical. 
; One of the following lines can be uncommented (remove the semicolon) 
; to change this default. 
1D_DP_LABELS = vertical 
;1D_DP_LABELS = horizontal 
 
 
; default 2D DP peak label orientations are horizontal. 
; One of the following lines can be uncommented (remove the semicolon) 
; to change this default. 
;2D_DP_LABELS = vertical 
;2D_DP_LABELS = horizontal 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[OFFSET INFORMATION] 
; When in the target display mode (crosshair on the screen) pressing 
; "V" brings up the Offset Information dialog box. The user then enters 
; the chemical shift information for the current crosshair position. 
; By default the system uses a three point Peak Interpolation for 
setting  
; the chemical shift. Also by default the system will "snap to tallest 
; nearby peak" mode when setting the chemical shift. The user can set 
; the set the default modes below by removing the comment semi-colon 
; and setting the argument to either TRUE or FALSE. The Peak 
Interpolation 
; is also used by the peak picking routine when reporting peak 
positions. 
;INTERPOLATE_PEAKS=FALSE 
;SNAP_TO_PEAK=FALSE 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[LINE BROADENING] 
 
; LB keyword sets the default value for LB when the program is started. 
LB = 0.2 
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;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[LINE FIT] 
 
;  Fraction_Lorenztian keyword sets the default fraction for Lorenztian 
lineshape 
;  used by routines lile LF.  The fraction Gaussian lineshape id 1 
minus this value. 
Fraction_Lorentzian = 1.0 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[INTEGRAL] 
;  ID_DISPLAY sets the sub-integral value display to the 
;  end of the sub-integral if it is set to END, 
;  top of the display if it is TOP and 
;  at the bottom just above the axis if it is BOTTOM 
ID_DISPLAY = END  
 
The default orientation for the integral labels can be set  
by setting the following line to TRUE or FALSE 
ID_HORIZONTAL_FONT=TRUE 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[MACRO] 
;  Specified macros can be run with the Ctrl-Fxx function keys. 
;  To enable this feature enter the full path to the desired 
;  macro and remove the semi-colon from the front of one of the 
;  lines below. 
;Macro_1 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_2 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_3 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_4 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_5 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_6 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_7 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_8 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_9 =  C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_10 = C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_11 = C:\NUTS\MAC\MAG_COSY.MAC 
;Macro_12 = C:\NUTS\MAC\MAG_COSY.MAC 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[LINKS] 
;  LINKS can be set with the keyword LINK# 
LINK1 IM BC EM FT PS 
LINK2 BC EM FT AP 
LINK3 EM FT IN 
LINK4 EM FT MC IN 
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LINK5 GA BC EM FT PS TR IA GA BC EM FT PS TR ST IN 
LINK6 GA EM FT SR SC IN 
LINK7 BC EM FT PS 
LINK8 GA BC EM FT IN 
LINK9 GA MS FT SR MC SC IN 
LINK0 GA BC EM FT PS SC IN 
 
 
 
 
 
;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;
;; 
[FONT] 
; The keyword "AxisFont" allows the default font for the axis to be 
reset 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and  
;    use its own internal defaults. 
AxisFont 
Arial 
100 
400 
0 
 
; The keyword "CmdLine" allows the default font for the Command Line to 
be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and  
;    use its own internal defaults. 
CmdLine 
SYSTEM_FIXED_FONT 
90 
400 
0 
 
; The keyword "IntegralFont" allows the default font for the integrals 
to be reset 
; Its use is slightly different from other INI entries. 
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; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and  
;    use its own internal defaults. 
IntegralFont 
Arial 
100 
400 
0 
 
; The keyword "NoteFont" allows the default font for the Notes to be 
set. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;    If these terms are not going to be used then put a semicolon in 
front of the 
;    lines so that the initialization part of NUTS will ignore them and  
;    use its own internal defaults. 
NoteFont 
Arial 
100 
400 
0 
 
; The keyword "ParmFont" allows the default font for the plots 
parameter to be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;  If these term is not going to be used then put a semicolon in front 
of the 
;  lines so that the initialization part of NUTS will ignore them and  
;  use its own internal defaults. 
ParmFont 
Times New Roman 
100 
400 
0 
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; The keyword "PeakFont" allows the default font for the peak values on 
the screen 
; to be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;  If these term is not going to be used then put a semicolon in front 
of the 
;  lines so that the initialization part of NUTS will ignore them and  
;  use its own internal defaults. 
PeakFont 
Arial 
90 
400 
0 
 
; The keyword "ClipFont" allows the default font for the clipboard font 
to be reset. 
; Its use is slightly different from other INI entries. 
; The keyword alone appears on the first line. 
; The next line MUST be the Font Name 
; The third line MUST be 10 times the desired point size. 
; The fourth line MUST be the weight of the font. 
;      0 to 400 is normal weight. 
;      401 to 900 is bold weight. 
; The fifth line is a 1 for italic and 0 for normal. 
;  If these term is not going to be used then put a semicolon in front 
of the 
;  lines so that the initialization part of NUTS will ignore them and  
;  use its own internal defaults. 
ClipFont 
Courier New 
100 
400 
0 
 
 
;end INI file 

Setting colors in NUTS 

Colors for the spectrum, axis, integrals, cursor, screen background and various fonts can 
be set in the nuts.ini file.   

The color of the spectrum can be changed while NUTS is running using the WC (which 
color) command.  The non-2-letter command colors can be used to set the color for the 
spectrum, screen background, axis and integral trace.  Command syntax is 

colors background 
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which displays a color pallette for selecting background color.  Valid arguments for the 
colors command are  

real (this is the default if no argument is supplied)  
imag 
axis 
integral 
background 

The display can be changed from color to black and white either from the File/Page Setup 
menu selection, or with the commands BW (changes all colors to black) and CD (color 
display on).   Note that CD not only enables display of colors on the screen, but also sets 
the Print in Color option to TRUE.    

The option to print in color is set in the nuts.ini file or from the File/Page Setup menu.  
The command MP (monochrome plot) can be used to turn off color printing.  

The color of each spectrum in the Buffers subroutine can be set from the Edit menu in 
that subroutine. 

The colors for each level of a contour plot are set in the nuts.ini file or can be entered 
while NUTS is running using the CR command.  Colors are set by entering numerical 
values for Red, Green and Blue. 

In the dialog boxes to set fonts, there is an option for choosing the font color. 

Included in the NUTS installation files for the Windows version is a useful program 
called colors.exe, which lets the user experiment with setting RGB values by showing the 
resulting colors, as shown below.   
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Setting fonts 

The fonts used within NUTS can be set by the user either within the NUTS program or in 
the NUTS.INI file. If set in the NUTS.INI file, the selected fonts will be implemented 
each time NUTS is run. The font can be set independently for each use of text within 
NUTS: the axis label, the command line at the bottom of the screen, the parameters 
printed on the bottom of plots, the clipboard display on the screen, integral values and 
peak labels. 

Within NUTS, fonts can be set by choosing Set Fonts from the Edit menu. A sub-menu 
allows selection of the text whose font is to be changed, and a typical Windows font 
dialog box is displayed. The font choices are all scalable fonts which are available on 
both the screen and printer, to make the operation as WYSIWYG (What You See Is What 
You Get) as possible. In practice, font sizes of 8-10 are recommended for best visibility. 
For the clipboard display (see CB command) of peak lists or integral lists, a fixed-space 
font such as Courier is recommended so that the columns line up. Note that the amount of 
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space taken up by the clipboard display is not the same on the screen and on plots, so it is 
best to test the font choice by printing. 

The font for each type of text can also be set using the following 2-letter commands from 
the keyboard, by-passing the menus: 

FA -- Select font parameters for axis.  
FC -- Select font parameters for clipboard display using CB.  
FI -- Select font parameters for integral labels.  
FJ -- Select font parameters for the molefile subroutine and the 2D compare 
utility. 
FL -- Select font parameters for command line.  
FM -- Select font parameters for parameters printed on plots.  
FH -- Select font parameters for horizontal peak labels.  
FV -- Select font parameters for vertical peak labels.  

FA -- Set axis font 

Brings up a Windows font dialog box allowing selection of font parameters for the axis 
label. This command is also available by choosing Set Fonts from the Edit menu. The 
font choices are all scalable fonts which are available on both the screen and printer, to 
make the operation as WYSIWYG (What You See Is What You Get) as possible. In 
practice, font sizes of 8-10 are suggested for best visibility. The text may look slightly 
different when printed, so it is best to test the choice of font by printing.  

FM -- Set font for parameter list on plots 

Brings up a Windows font dialog box allowing selection of font parameters for the list of 
spectral parameters printed on the bottom of plots. This command is also available by 
choosing Set Fonts from the Edit menu. In practice, font sizes of 8-10 are suggested for 
best visibility. It is best to test the choice of font by printing.  

The user can choose whether or not spectral parameters should be printed on plots by 
choosing Page Setup from the File menu. This can also be set in the NUTS.INI file. An 
alternative to printing the parameters on the bottom of plots is to use the LP command to 
place the parameters into the Windows clipboard and then use CB to display the contents 
of the clipboard on the plot. 

FC -- Set font for clipboard display 

Brings up a Windows font dialog box allowing selection of font parameters for text 
display using the CB command. This command is also available by choosing Set Fonts 
from the Edit menu. The font choices are all scalable fonts which are available on both 
the screen and printer, to make the operation as WYSIWYG (What You See Is What You 
Get) as possible. In practice, font sizes of 8-10 are suggested for best visibility. For 
display of peak lists or integral lists, a fixed-space font such as Courier is recommended 
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so that the columns line up. Note that the amount of space taken up by the clipboard 
display is not the same on the screen and on plots, so it is best to test the font choice by 
printing. 

FI -- Set font for Integral labels 

Brings up a Windows font dialog box allowing selection of font parameters for labels on 
integral segments.  This command is also available by choosing Set Fonts from the Edit 
menu. The font choices are all scalable fonts which are available on both the screen and 
printer, to make the operation as WYSIWYG (What You See Is What You Get) as 
possible. In practice, font sizes of 8-10 are suggested for best visibility. The text may 
look slightly different when printed, so it is best to test the choice of font by printing. 

With addition of the option to display integral labels vertically (Dec 2002), the fonts for 
horizontal and vertical integral labels are set independently.  This means the FI command 
displays the font dialog box twice, for the 2 different orientations. 

FL -- Set font for command line 

Brings up a Windows font dialog box allowing selection of font parameters for the 
command line at the bottom of the screen. This command is also available by choosing 
Set Fonts from the Edit menu. In practice, a font size of about 10 is suggested for best 
visibility.  

FH -- Set font for horizontal peak labels 

Brings up a Windows font dialog box allowing selection of font parameters for the 
chemical shift labels displayed above peaks. Each label can be oriented either 
horizontally or vertically. The labels are toggled on and off by typing Ctrl-P. This 
command is also available by choosing Set Fonts from the Edit menu. A font size of 8 is 
suggested. It is best to test the choice of font by printing because appearance on the 
screen and plots will usually differ.  

FV -- Set font for vertical peak labels 

Brings up a Windows font dialog box allowing selection of font parameters for the 
chemical shift labels displayed above peaks. Each label can be oriented either 
horizontally or vertically. The labels are toggled on and off by typing Ctrl-P. This 
command is also available by choosing Set Fonts from the Edit menu. A font size of 8 is 
suggested. It is best to test the choice of font by printing because appearance on the 
screen and plots will usually differ.  
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Page setup 

There are several options which can be set from the File/Page Setup menu. Some can also 
be set in the NUTS.INI file, so that they are established each time the program is run. 

Square 2D plots -- Check this box to force 2D plots to be square. Does not affect 1D 
plots. 

Border box -- Refers to a border drawn around the entire plot.  

Parameters on page -- 3 lines of acquisition and processing parameters printed below 
the spectrum. 

Print in color -- By default, Nuts converts all colors to black when printing. Check this 
box to print colors as shown on the screen. Note that colors of different objects can be set 
in the Nuts.ini file. 

Monochrome display -- Turns all colors on the screen to black. This is most useful when 
copying spectra for pasting into other applications, which will then be printed on a black-
and-white printer. In that situation, some applications "dither" the colors, and they end up 
as dotted lines.  This can also be set with the BW command, and unset with CD. 

Pen width on screen and on printer -- These 2 parameters allow independent 
adjustment of thickness of lines on the screen and on plots. In some cases, such as 
making transparencies, the thin lines printed on high resolution printers do not show up 
well, which can be solved by drawing the lines thicker. Starting with version 971106, this 
can also be set in the nuts.ini file. 

Axis tick density -- Nuts makes its own decisions about the number of axis tick marks 
that will fit comfortably on a page. This allows the user to override the default settings, 
and draw more or fewer tick marks. 

Margins -- The margins on all 4 sides of a plot can be set independently in millimeters. 
Note that this is in addition to the default, which is very narrow margins. 
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Startup options 

NUTS can executed with various options by including arguments on the command line.  
The choices are indicated by a switch that tells NUTS what to do with the file name that 
follows.  The switches are: 

-f    open file 
-m    run macro 
-i    start NUTS using a different nuts.ini file 

A single argument is assumed to be a file that should be opened automatically as soon as 
NUTS starts, equivalent to the -f switch.  The complete path can be specified using single 
or double quotes.  These 2 commands are equivalent, and will open the file called file.fid 
as when NUTS starts: 

nuts.exe "c:\data\file.fid" 
nuts.exe -f "c:\data\file.fid" 

A macro can be run immediately on startup in two different ways.  If the same macro 
should be run every time, it can be specified in the nuts.ini file with the keyword 
AutoExecMacro.   If different macros should be run, the macro can be specified on the 
command line with the -m switch.  For example: 
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nuts.exe -m "c:\macro\file.mac" 

By default, when NUTS is started, it reads a file called nuts.ini, which must be in the 
same folder as the NUTS program.  The nuts.ini file contains the user's preferences for 
many different parameters.  If the user wants to use a different nuts.ini file when NUTS 
starts, it is signaled by a "-i" switch, where the next argument must be the path to the 
nuts.ini file, enclosed in double or single quotes.  For example, 

nuts.exe -i "c:\fred\nuts.ini" 

2D data processing and display 

This section describes the processing and display of 2D data.   Topics and commands 
covered: 

Quick intensity plots and contour plots 
Setting the chemical shift reference 
Setting contour levels 
Setting colors for contour levels 
Turning on/off gridlines 
Selecting individual slices for display 
Viewing slices 
Summing slices 
Creating projections 
Placing projections or 1D spectra along the edges of a contour plot 
Making 2D plots come out square  
Stacked plots 
Symmetrize  
Tilt 
Transpose data 
Save 
Substitute one slice for another 
Zero diagonal 
Processing TPPI, hypercomplex and echo-antiecho data 

See also: 

Arrayed Mode processing with NUTS Professional version 
Processing 2D data -- step-by-step processing descriptions for different 
types of 2D data 
Examples of 2D spectra using codeine 
Sample macros  
Sample data files 
Displaying 2D data 
Displaying horizontal and vertical lines on a contour plot, to aid in 
interpretation 
Setting chemical shift reference 
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Editing 2D data 
comparing multiple 2D spectra 
2D nomenclature 

Macros have been supplied which perform the basic types of 2D processing (magnitude, 
TPPI and hypercomplex).  These macros simply string together linked command 
sequences (Links) so that the entire processing can be performed with a single command. 
The user should have a basic understanding of the commands in the Links and the macros 
because some parameters vary from experiment to experiment or with different 
spectrometers. The macros have comments and, combined with the explanation below, 
should contain sufficient information. 

IP -- Intensity Plot 

If the currently displayed data is a 2D data set, this command displays the data as a two 
dimensional intensity map. NUTS can also draw contour plots (CP), which look nicer, 
but take longer to display. The intensity plot is faster because its speed is limited by the 
graphics display process, while the contour plot is calculation-limited. The intensity map 
is recommended for initial viewing of the data, determining the levels to be displayed, 
setting shift references and Zoom frequency limits, etc., leaving the contour plot for the 
final display, for viewing details and plotting. Show me how to display 2D data. 

The SS (set 2D scale) command should be executed before IP or CP so that the scale is 
reasonable for an initial display.  

The levels of data represented by the different contour levels are determined as multiples 
of the MH parameter.  For versions compiled after Dec, 2001, the contour threshold can 
be changed interactively in several ways.  The coarsest adjustment is made using the 
scroll bar along the right edge of the screen.  Page Up and Page Down keys, Arrow Up 
and Arrow Down keys and the "<" and ">" keys apply finer adjustments. 

The MH value can also be set explicitly.  To lower the first contour level to be displayed, 
type MH and set it to a smaller value.  

The number of levels, the MH multiplier for each level and the color for each level are set 
in the NUTS.INI file.  The maximum number of levels is 10.  The multiplier for each 
level can be set while NUTS is running using the LV command.   Contour level colors 
can be changed from within NUTS using the CR command.  Changes made using LV 
and CR are not saved for future NUTS sessions.  To make the changes persistent, edit the 
nuts.ini file. 

NUTS provides the option of displaying horizontal and/or vertical projections or a 1D 
spectrum along each axis.  These options are available from the Borders menu or by 
using the proj command.   See illustration.   
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By default, both positive and negative contour levels are displayed. The user can switch 
to just positive by typing C+ (plus) or to just negative levels by typing C- (minus). To 
display both, type C0 (zero).  (In versions of NUTS older than Sept, 2001, this is done 
with the single-letter commands +, - and 0, respectively.)  The colors for each level are 
set separately in the NUTS.INI file, or can be set within NUTS with the CR command. 

The intensity map or contour plot can be interrupted before finishing drawing by typing 
<escape>. This command halts the Windows screen paint operation, allowing the user to 
change parameters such as frequency limits or minimum height, or to plot the spectrum, 
without having to wait for the 2D display to be completed. The mouse can be used to 
define a Zoom region even though the screen paint operation is incomplete, because 
NUTS "knows" where the peaks are. Once the parameter change is completed, the screen 
paint is re-started.  

CP -- Contour Plot 

If data set A is a 2D data set, this command displays the current data as a two 
dimensional contour plot. This is a nicer display than the intensity plot, but takes longer 
to draw. The intensity plot is recommended for initial viewing of the data, determining 
the levels to be displayed, setting shift references and Zoom frequency limits, etc., 
leaving the contour plot for the final display for viewing details and plotting. The colors 
and contour level spacing are set in the NUTS.INI file and cannot be changed after NUTS 
is started. See description of the NUTS.INI file for explanation of how these parameters 
are set.  

C+, C- and C0 -- Display positive, negative or all contour levels 

By default, both positive and negative contour levels are displayed. The user can switch 
to just positive by typing C+ (plus) or to just negative levels by typing C- (minus). To 
display both, type C0 (zero).  

Setting the chemical shift reference 

The coordinates of a peak in the 2D plot can be displayed by holding down the left mouse 
button, just as for 1D spectra. The cursor location is given in the lower right corner of the 
screen. The slice number and shift value in Hz and PPM is given for the vertical (2nd) 
dimension. The point number and shift value in Hz and PPM is given for the horizontal 
(1st) dimension. While holding down the left mouse button, typing O brings up a dialog 
box allowing the user to set the offset (chemical shift reference) in both dimensions.   
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Note that the 2 checkboxes on the right should not be checked when working with 2D 
plots. 

Because of the poor digital resolution of most 2D data, and the fact that NUTS will read 
the cursor location as the nearest actual data point, setting chemical shift reference with 
the cursor will often result in the crosspeaks not lining up with the high resolution 1D 
spectra placed along the edges of the contour plot.  The easiest way to fix this is to adjust 
the Offset parameters explicitly.  The "offset" in each dimension is defined as the number 
of Hz from the center of the spectrum to 0 ppm.  Using the cursor, you can determine the 
frequency difference, in Hz, between the crosspeak and the corresponding peak in the 1D 
"border" spectrum, best measured using an expanded display.  Bring up the parameters 
dialog box by typing O1 (for horizontal dimension) or O2 (for vertical dimension).  
Change the appropriate offset parameter by the measured difference.  If it is determined 
that the values of these corrections are always the same, this process can be automated 
using a macro.  See example. 

After 2D parameters have been changed, use the UH (Update Header) command to save 
the changes.  (Caution:  When processing in Arrayed Mode, the UH command should 
NOT be used if any processing has been performed since the data set was saved, as the 
updated header will be written to the original file, and parameters may not be 
compatible.) 

While holding down the left mouse button, press and hold the right mouse button. The 
slice corresponding to the cursor location is displayed. As the mouse is moved vertically, 
the slice is updated in real time. The Page Up and Page Down keys can be used to scale 
the slices. Users with a single-button mouse can press the period key in place of the right 
mouse button. 

Two dimensional Zoom works in the same way as for 1D spectra. Typing ZO or double 
clicking the left mouse button enters the Zoom routine, indicated by the cursor changing 
to a small crosshair labeled "ZO". Hold down the left mouse button and drag the mouse 
to highlight a region for expansion. Typing control-E or clicking the right mouse button 
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jumps to expanded display of this region. Control-F and control-E toggle between fill 
and expanded display, as does clicking the right mouse button. Typing <Enter> exits the 
Zoom routine.  

Exit the 2D display mode by typing 1D.  (In versions older than Sept, 2001, 2D display is 
exited by typing <ENTER>.)    

Outside of the 2D display mode, individual slices can be displayed by specifying the slice 
number with SL, and the View (VW) command allows stepping through slices. To view 
slices in the second dimension requires that the data set first be transposed with the TD 
command so that the dimension of interest becomes the horizontal dimension.  

2D Peak Picking and 2D Volume Integration are performed within the Define Peaks (DP) 
subroutine. 

LV -- Set contour levels 

This command allows the multiplier for each level to be set while NUTS is running.   
These changes are not saved when NUTS is closed.  Permanent changes must be made in 
the nuts.ini file, along with the number of levels and the color for each level.  Note that 
the maximum number of levels is 10.   See also 2D display.  

CR -- Set contour colors 

This command allows the color for each level to be set while NUTS is running.   Colors 
are set as numerical Red, Green and Blue values.  See Setting Colors.  Changes made 
with CR are not saved when NUTS is closed.  Permanent changes must be made in the 
nuts.ini file, along with the level multipliers for each level.      

Ctrl-G -- Toggle on/off display of grid lines 

This command will display gridlines on an intensity or contour plot.  The command is a 
toggle, so entering it a second time will remove the gridlines.  The lines are drawn at the 
position of the major tick marks on the axis, and cannot be moved or their spacing 
changed by the user.  Users who want gridlines displayed always can add a line to the 
nuts.ini file which is  
GRIDLINES = TRUE 
which makes display of gridlines the default condition.  (Gridlines are shown on 1D data 
as well, but this is probably not very useful.) 

SS -- Set 2D data Scale 

Examines all slices of a 2D data set and sets the automatic scaling factor which is used in 
commands such as View data (VW), stacked plots (SP), intensity plots (IP) and contour 
plots (CP). SS should be performed before attempting to display 2D data to get 
reasonable scaling. This command also identifies the largest positive and negative peaks 
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in the data set and sets their difference to 100%. This value is then the basis for the 
Minimum Height (MH) parameter, which is used to set the scale for 2D Intensity Plots 
(IP). 

SL -- Set Slice 

This commands allows the user to select which slice of a 2D data set will be available for 
processing. When a 2D data set is read by NUTS, the first slice is displayed and is 
available for data processing. The user should avoid saving a slice as a file under the 
same name as the 2D file (Save command from menu or SA command ) as the 1D file 
will replace the 2D data set. Use the Save As menu command or SB keyboard command 
to save the processed 1D file under a different name. 

VW -- View 2D data slices 

Steps through slices of a 2D data set. Set starting slice with SL.  While in Arrayed Mode 
and in the View routine, subcommand Z will zero all data points in the currently 
displayed slice. 

To view a series of 1D files, they must first be converted to a 2D file.   See description 
under Stacked Plot command.   

Subcommands:  

I or N - Increment to next slice 
D or R- Decrement to previous slice 
Z - Zero the displayed slice. 
<Enter> - exit VW 

SU or sum -- Sum slices 

Sums a specified range of slices of a 2D data set.  By default, all slices are summed.  If 
executed in the "non-2-letter" command mode, it is possible to specify a subset of slices.  
The command takes 2 arguments, which are the first and last slices to be included in the 
sum.  For example, this command would sum slices 5 through 20, inclusive: 

sum 5 20 

Note that the sum becomes the current data (1D) set.  If in arrayed mode, save the data 
before performing the sum.  See sample macros. 

It is possible to add two 2D files by running a link such as 

ga b1 gb b2 b+ sc in 
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Note this is NOT done in the arrayed mode.  The link will ask for the names of the 2 data 
sets to be added, and for a name to use for the resulting sum.  See commands b1, b2 and 
b+ for details. 

Similarly, one 2D data set could be subtracted from the other - just change the b+ 
command in this link to b-.   

SUM -- Sum planes 

The sum command can also be used for summing of planes in a 3D data set in a manner 
analogous to summing slices of 2D data. When the second argument of the "sum" 
command is "planes", all planes of a 3D data set are summed into a single 2D data set. 
The command also takes additional optional arguments allowing the user to specify the 
starting and ending planes to sum. The original 3D data set is destroyed and replaced by a 
new 3D data set which has only one plane. The command must be used in the 3D arrayed 
mode.  

sum planes <start> <end> 

PJ -- Projection 

Calculate the "skyline" projection of the current 2D data set along the horizontal axis. 
The projection consists of the largest value in the 2D data set at each data point. When 
the procedure is complete, the projection is displayed as a 1D file which can be saved 
with SA. To return to the 2D data set, it must be reopened with GA.  

A projection can be created from a subset of the entire data set by first expanding the 
displayed region using Zoom. The desired limits can be entered using the F subcommand 
within Zoom or using the mouse. Use Ctrl-E to display the expanded region. PJ will 
create a projection of the displayed region. 

Placing projections on contour plots 

NUTS provides the option of displaying a horizontal and/or vertical projection along any 
side of a 2D intensity or contour map. These projections are automatically scaled such 
that the tallest peak in the displayed region is set to a height of one-tenth of the total 
display size. Display of projections along the Top, Right, Bottom and Left sides of the 
plot are toggled on/off with the  commands P1, P2, P3 and P4, respectively. (Note that in 
versions of NUTS older than Sept, 2001, this is done with the single-letter commands 1, 
2, 3 and 4.)  These commands are also available from the Borders menu, or from the 
command line (see below).  

The projections can be scaled independently with the EP command or by choosing Edit 
Display Parameters from the Edit menu, which allows a scaling factor to be entered for 
each projection.  (Note that this same dialog box allows margins to be set for each side of 
the 2D plot.  Values are entered as fraction of total display.)  Each projection can also be 
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clipped, allowing the vertical scale to be increased to show small peaks while limiting the 
height of larger peaks.  This option is available from the Display menu. As always, what 
is displayed on the screen is what will be plotted. 

Using high resolution spectra as projections 

It is often preferable to use a high resolution 1D spectrum instead of the actual 
projections due to the better digital resolution.  The 1D spectrum must already exist, 
saved to disk, and must have been processed.  The file is selected from the Borders 
menu.  The 1D file need not have exactly the same spectral window as the 2D plot. The 
appropriate region will be displayed, based on the chemical shift scale. 

Scaling and clipping are performed in the same manner as for actual projections, 
described above. 

Once a 1D file has been selected in this manner for use as a projection, the commands 
P1, P2, P3 and P4, respectively will toggle on/off display of the projection on top, right, 
bottom and left sides of the plot. (Note that in versions of NUTS older than Sept, 2001, 
this is done with the single-letter commands 1, 2, 3 and 4.)  If it is desired to display 
instead the actual projection, rather than a separate spectrum, the file must be removed 
from this projection "buffer" with the XC command. 

These can also be defined from the command line or in a macro.   

PROJ (or PROJECTION) - specify projection file and position 

This non-2-letter command allows display of projections on the edges of contour plots to 
be turned on and off, and also allows a file to be specified for use as each projection.  The 
command takes 2 or 3 arguments. The first argument defines which side projection is the 
focus of the command.  Allowed 1st arguments are: 

Top Projection 

-1 
-top 
-t  

Right projection 

-2 
-right 
-r  

Bottom projection 
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-3 
-bottom 
-b  

Left projection 

-4 
-left 
-l  

The second required argument determines whether or not the specified projection is 
shown: 

-on 
-off 

A third optional argument defines a file name to use for the specified side projection 
spectrum. 

XC -- Clear projections 

Removes any file which has been defined for use as a projection on the edges of a 2D 
plot. 

SQUARE2D -- Force plots to be square 

This command allows the user or a macro to turn on the forcing of square 2D plots. When 
used without arguments, it toggles the current value of the variable to force printing of 
square 2D plots. 
The command also accepts two possible arguments: 
square2d on 
square2d off 

SP -- Stacked Plot 

Plots slices of a 2D data set on the screen. A series of 1D spectra can be plotted if they 
are first stored as a 2D file (see instructions).   

Before executing SP, read in the first slice of the 2D file with GA and use SS to set the 
scaling. The entire plot can be scaled vertically in the same ways as 1D spectra. The 
vertical scale can also be set by typing A or from the Display menu, which brings up the 
Amplitude Change dialog box (same as AC command). Press Enter to exit from the 
stacked plot.  

Show me how to use SP. 
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When SP is executed, a new set of menu choices is displayed. Under the Display menu is 
an option to whitewash the stacked plot. The command is a toggle, so executing it a 
second time undoes the whitewash. Equivalently, whitewash can be toggled by typing W. 
Depending on the type of data, whitewashing may or may not be desirable. The 
whitewashed spectrum contains many more "draw" operations, so will take longer to 
draw on the screen and to plot. In most cases, a whitewashed plot is too large to copy as a 
metafile to other applications, and it must be copied as a bitmap instead. (See copying 
spectra for further information).  

The offsets in both x and y dimensions can be changed by typing O or choosing Offset 
from the Display menu. The X-offset can be changed from 0 to 100% and the Y-offset 
from 1 to 10. These offsets can also be set in the Nuts.ini file, so that the user's preference 
is always set as the default. 

Because drawing the stacked plot can be slow, the draw operation can be terminated by 
typing Q. 

A subset of the entire data set can be plotted by using 2D Zoom from an intensity plot 
(IP) or contour plot (CP) to select a region to be plotted. From the 1D display of a slice, 
type ZO to enter Zoom, then F to bring up the dialog which allows setting of frequency 
limits for expansion. The limits must be set in both dimensions by points, Hz or PPM. 
Failure to set the limits in the vertical dimension will result in only 2 slices being 
displayed. Click OK to close the dialog box. Type Ctrl-E to expand to the limits you 
have set. Now typing SP will display a stacked plot of the selected region. To plot the 
entire spectrum, first type Ctrl-F to select the full display.  

Note that it is necessary to explicitly set values for the first and last slice to be displayed, 
followed by Ctrl-E, and that this operation needs to be repeated if the horizontal 
expansion is changed. Failure to do this will cause NUTS to display only 2 slices.  

Once the stacked plot is displayed on the screen, it can be plotted with PL. 

SY -- Symmetrize 2D data set 

This is applied to symmetrical homonuclear 2D data, such as COSY experiments, in 
which the data are ideally symmetrical about the diagonal, f1=f2. Symmetrization is used 
to remove artifacts from the 2D spectrum to improve its appearance. Noise and other 
artifacts which do not occur symmetrically on both sides of the diagonal are eliminated. 
The data set must be square (that is, the same number of points in both dimensions). 

The SY command examines the entire 2D data set, comparing each point to its 
symmetrically related partner across the diagonal. Then both of these points are replaced 
by the smaller (absolute value) of the 2 points.  
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This process can take a minute or more, depending on the size of the data set. It also 
involves multiple TD operations, saving temporary files in the process, so there must be 
sufficient disk space available. 

The SY command can be used to symmetrize J-resolved data about the horizontal axis, 
with the command 

SY tilted 

This should be done after tilting. 

Ref: R.Bauman, G.Wider, R.R.Ernst and K.Wuthrich, J.Magn.Reson., 44, 402-406, 
1981. 

TD -- Transpose Data 

This command is available only in the 2D and Pro versions of NUTS. The TD command 
swaps the 1st and 2nd dimensions and their associated parameters.   See also: processing 
3D data. 

SC -- Save dataset C 

Used in macros or links.  This command asks for a new file name for File C and saves the 
current data to File C as the first slice of a 2D data set. Subsequent SC commands save 
the current data set to File C as successive slices of a 2D data set. When this command is 
used in a Link (the preferable method), File C is closed when the link finishes. When this 
command is used manually, the operator must use the Close File C ( CC ) command 
when finished writing to file C. An opened File C will be closed automatically when the 
NUTS program is exited.  

When used in a Link, the SC command asks for the name for File C on the first pass only. 
On each additional pass through the link, the SC command saves the current data set to 
the already opened File C as the next slice.  

UH -- Update Header 

Writes parameters into the header of a 2D file. This should be executed after parameters 
have been changed to insure the changes are saved with the file. For example, after 
setting the chemical shift reference or after editing the variable delay list for relaxation 
data, UH will save the changes. 

Caution:  When processing in Arrayed Mode, the UH command should NOT be used if 
any processing has been performed since the data set was saved, as the updated header 
will be written to the original file, and parameters may not be compatible. 

S2 -- Save 2D data set   
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(Used in non-arrayed mode only) 

This command can only be executed when the current data file A is a 2D data set. A 
dialog box prompts for a file name. The command functions differently depending on 
whether a new file name is supplied or the current file name is chosen. If a file name 
different from the current file A name is entered, the entire 2D data set is copied into the 
new file exactly as it currently exists on disk and the new file becomes data file A. If the 
file name supplied is the same as the current file name, the entire 2D data set is saved as 
it currently exists on disk EXCEPT for the currently displayed slice, which is saved as it 
is currently displayed. This allows modifications on individual slices to be saved 
permanently. 

One situation for which this is useful is for touch-up phasing of a series of kinetics or 
relaxation data following automated processing. The 1D spectra must first be converted 
into a 2D data set. 

Another use is when one slice of a 2D data set gets corrupted. A simple way to "fudge" 
the data so that it can be displayed without artifacts is to overwrite the corrupted slice 
with its neighboring slice, since adjacent slices should be similar. Let's assume that slice 
10 is corrupted and we will replace it with a copy of slice 11. To do this, display slice 11 
and place it in the Add / Subtract buffer by typing AL. Be sure that the Add / Subtract 
multiplier (AM) is set to 1, its default value. Next, display slice 10 and zero the entire 
slice by typing ZE. Then type AS, + and <Enter> to add the contents of the Add / 
Subtract buffer ( which is slice 11 ). Slices 10 and 11 are now identical. With the 
modified slice 10 displayed, use the S2 command to save the modification, specifying the 
file name to be the same as the current file name. This entire procedure must be repeated 
for each slice which needs to be modified, because the S2 command updates only the 
currently displayed slice. 

In arrayed mode, simply use SA (or File/Save) to save the file. 

Substitute -- Slice substitution  

(Arrayed Mode only) 

This command allows one slice of data to be copied over (replace) another slice.  This is 
useful when a slice has been corrupted.  Note that this requires NUTS to be placed into 
the "non-2-letter" command mode (with 2F). 

For 2D data,   

substitute  target_slice   source_slice 

For 3D data, it is possible to perform this slice substitution either for a single plane of the 
3D data, or for all planes.  To operate on a single plane, the plane is specified as the first 
argument: 
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substitute  plane   target_slice   source_slice 

If the substitute command has just two arguments, then all planes of a 3D data set will 
have the source_slice copied to the target_slice.   

ZeroDiagonal  

A non-two-letter command which takes either one or two arguments.  This is used with 
homonuclear 2D data to eliminate (zero out) all data points including and around the 
large diagonal peak. 

If only one argument is given, then the command takes a 2D data set and zeros the 
diagonal over a range which is plus and minus the number of points specified by the 
argument.  If two arguments are given, then the 2D data set's diagonal is zeroed plus the 
first argument number of points and minus the second argument number of points. Usage: 

ZeroDiagonal [+ points] [-points] 

See also: Removing the dispersion component of a residual solvent peak. 

TL (or Tilt) -- Tilt of 2D data 

(arrayed mode only) 

TL (or Tilt) is used to rotate a 2D data set, such as J-resolved data.   

The default rotation is a counter-clockwise rotation of 45 degrees, based on Hz, so NUTS 
first calculates the Hz/point in both dimensions. 

In the non-2-letter command mode, arguments can be supplied to apply the tilt 
differently.   

An argument of C or CC is used to define the direction of the tilt to be clockwise or 
counter-clockwise, respectively.   

An second argument is taken as the number of points to tilt per slice (fractional points 
allowed).  

If the TILT command is given with an argument which is not C or CC then the argument 
is taken as the number of points to tilt per slice (fractional points allowed) and the tilt will 
by default be in the counter-clockwise direction.  

For example, 

tilt c 0.1      
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would rotate clockwise 1 data point every 10th slice. 

An invalid first argument is used as the number of points to shift and any second 
argument is ignored. The center slice (slice number_of_slices divided by 2) is taken as 
the center and is left unshifted. 

The SY command can be used to symmetrize J-resolved data about the horizontal axis, 
with the command 

SY tilted 

This should be done after tilting. 

TPPI -- Time Proportional Phase Incrementation 

TPPI is a method for achieving quadrature detection (distinguishing positive and negative 
frequencies) in the indirect dimension of a 2D experiment. This allows data to be 
acquired as phase sensitive. 

Processing TPPI data requires a Real Fourier transform (as opposed to the normal 
complex FT). 

A detailed explanation of a macro for processing TPPI data is available. 

Hypercomplex 2D data 

(method of States, et. al. ) 

An example of processing hypercomplex data is available, including step-by-step 
explanation, and sample macros. 

The alternative to TPPI for obtaining phase-sensitive 2D data is to acquire 2 FIDs (with a 
90 degree phase shift; ie., a quadrature pair) for each t1 point. After FT of each FID in the 
first (t2) dimension, the imaginary part of each is discarded and the real parts are 
combined to form real and imaginary halves, and a complex FT is performed in the 
second (t1) dimension. 

NUTS-Pro users – skip this section, as it is for processing with the older method, before 
Arrayed Mode. 

NUTS uses the commands TR and TI ("tag" real and imaginary halves, respectively) to 
select which half of the data will be saved. (Usually, only TR will be used to save the real 
half of each spectrum. However, the TI command is provided in case the need arises to 
save the imaginary half. This could be the case depending on how the phase cycling was 
done in the experiment.) These commands are followed by the command ST ( save 
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"tagged" data) instead of the usual SC command. This is done in processing the first (t2) 
dimension only. The Link for the first dimension processing then looks like  

GA BC EM FT PS TR IA GA BC EM FT PS TR ST IN 

The first time TR (or TI) is encountered, the selected part becomes the real half of the 
final complex pair. The second time one of these commands is encountered, the selected 
part becomes the imaginary half of the complex pair. The ST command then saves the 
data as a complex interferogram in t1. The IA ( Increment counter for file A ) command 
must be included before reading in the second FID. 

The above Link is appropriate for data which have been saved as a single file, with the 
pairs of FIDs occurring sequentially. Some spectrometers save the 2 halves of the data as 
2 separate files. For this case, the Link for processing in the first dimension must be 
modified as follows:  

GA BC EM FT PS BC TR GB BC EM FT PS BC TR ST IN 

so that slices are read alternately from the 2 different files, designated as A and B.  Or, 
use the interleave command to form a single file. 

The second dimension processing is normal, using FT to perform a complex transform. If 
phasing is needed in the second dimension, PS can be included in the link or performed 
after, using a link such as  

GA PS SC IN 

performed after the appropriate phasing parameters are determined. 

Interleave  

 (Arrayed Mode only) 

This is a non-2-letter command which interleaves two data sets into a new data set. This 
is used for hypercomplex data that was saved on the spectrometer as 2 separate files, 
creating a single file containing all the data.  This command works only for the Complex 
Arrayed Mode. The two data sets must have the same number of points and slices. The 
resulting data set is not automatically saved.  Syntax: 

Interleave FileName1 FileName2 

TR -- Tag Reals 

Used in processing hypercomplex (States type) 2D data. 
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The TR command is used to discard the imaginary half of each pair of spectra acquired 
for a given t1 value. The real halves are then used to construct a complex t1 
interferogram. The ST command then stores the interferogram as complex data ready to 
be processed with a complex FT in the t1 dimension.  

For complete description and examples of use, see hypercomplex (States type) 2D data. 

TI -- Tag Imaginaries 

Selects the Imaginary half of the data to be saved and discards the Real half. Intended for 
use in processing hypercomplex ( States type ) 2D data. (N.B. Normally, the TR (Tag 
Reals) command is used, but TI is provided to give the user maximum flexibility in data 
processing.) 

ST -- Store Tagged data 

Used in conjunction with the TR (tag reals) (or TI (tag imaginaries)) command to process 
hypercomplex (States type) 2D data. The TR command is used to construct a complex t1 
interferogram. The ST command then stores the interferogram as complex data ready to 
be processed with a complex FT in the t1 dimension. 

For a complete description and example of use, see hypercomplex (States type) 2D data. 

The next 4 commands work only in Arrayed Mode, and on data sets having an even 
number of slices.  These commands facilitate processing of echo-antiecho gradient data 
which must be processed by adding or subtracting pairs of slices. (An example is Varian 
g_hsqc data, which uses the C2 command.)  Each command operates on a pair of slices, n 
and n+1.  The real halves of the 2 slices are either added or subtracted, and the sum 
becomes the real half of a single processed slice.  The imaginary halves of the 2 slices are 
either added or subtracted, and the sum becomes the imaginary half of the processed 
slice.  So, in each case, the processed data has half as many slices as it started out with. 

Echo-antiecho 2D data 

These phase-sensitive gradient experiments are run such that each slice contains both sine 
and cosine terms in t1.  To process these data, we FT and phase slice 1 and slice 2, then 
calculate the sum and the difference of them. Because the 2 slices are, respectively, (cos 
t1 + isin t1) and (cos t1- isin t1), the sum gives you just cosine, and the difference gives 
you just sine.  Together, they comprise a complex "FID" in the indirect dimension. 

This add/subtract process is handled with command C2 which works in Arrayed Mode 
only, but can be accomplished in non-arrayed mode using a combination of commands.  
See details.  

C1 – Combine Mode #1 
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This command adds the reals and imaginaries of even and odd slices and gives back a 
data set with half the number of slices. 

C2 – Combine Mode #2 

This command adds the reals and subtracts the imaginaries of even and odd slices and 
gives back a data set with half the number of slices.  Used in processing echo-antiecho 
data. 

C3 – Combine Mode #3 

This command subtracts the reals and adds the imaginaries of even and odd slices and 
gives back a data set with half the number of slices. 

C4 – Combine Mode #4 

This command subtracts the reals and subtracts the imaginaries of even and odd slices 
and gives back a data set with half the number of slices. 

GC -- Get data set C 

Opens the dialog box for loading a file. The last name used for File C, if any, will be the 
default selected name. Data set C is used in 2D processing.  This is rarely used, as GA is 
"smart" enough to detect when the file is 2D.  

OC -- Open file C 

(rarely used)  This command allows the user to open a 2D file and move to the last slice 
of data. Further Save to file C ( SC ) commands add the currently displayed data set to 
the end of file C. When finished the user should close file C with the CC command. 

The better way to accomplish the same thing is with a Link which contains SC and IN 
commands, and automatically takes care of opening and closing the 2D file. 

CC -- Close file C 

(rarely used)  If a File C has been opened for writing data into, this command closes File 
C. This could be used to manually combine 1D files into a 2D data set, but this is more 
easily performed with a Link such as GA SC IN. When using such a Link, the IN 
command takes care of closing File C when the complete 2D data set has been processed.  

Contour plot display 

When a 2D file is opened (with GA or from the File/Open menu), the first slice is 
displayed.  An intensity plot (IP) or contour plot (CP) can be displayed.  IP is much faster 
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and should be used for an overview of the data, and to set frequency limits and contour 
levels.  CP is used to view the data in detail.    

In versions of NUTS newer than Sept, 2001, the command 2D is used to enter the 2D 
display mode, and displays an intensity plot.  Exit back to 1D display by typing 1D.  

Contour levels are set as multiples of the Minimum Height (MH). The levels are set in 
the Nuts.ini file, but can be changed after starting Nuts using the LV (levels) command. 
The minimum height is expressed as a percentage of the tallest peak in the entire data set. 
So, the first step is to find the intensity of the largest peak and from that to set the display 
scale. This is done with SS (or Set Scale from the 2D menu).  

Contour level colors are set in the nuts.ini file or can be set from within NUTS using the 
CR command.  

By default, the first contour level is at the minimum height, which the user can change by 
typing MH. The choice of this setting depends on the type of data being displayed. For 
HETCOR data, where all peaks are approximately the same intensity, a value of 10% is 
reasonable. For NOESY data, in which the crosspeaks are much smaller than the 
diagonal, the MH value can be as small as 0.1%.    

Starting with December 2001, the MH value can be changed while the intensity or 
contour plot is displayed.  This is done using a scroll bar displayed on the right edge of 
the screen,  or with the PageUp, PageDown, Arrow Up, Arrow Down, "<" key and ">" 
keys.  Due to the speed of contour plot recalculation, especially on older PCs or with 
large 2D data sets, this is best done in the intensity display mode or in a zoomed region if 
in the contour display mode.    

Text labels for the axes can be entered from the View/Spectral Parameters menu in the 
NUTS base level (not in the 2D display routine).  
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Display an intensity plot with the 2D or IP command (or from the 2D menu). Intensity 
plots are much faster than contour plots, so it makes sense to use that display mode for an 
initial look at the data.  The size of the plot is adjusted by choosing Edit Display 
Parameters from the Edit menu, and entering a value for the margin on each side. 
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The chemical shifts in both dimensions can be displayed by pressing and holding the left 
mouse button. 

  

 

The Zoom expansion routine can be used to display chosen regions. Type ZO to enter the 
Zoom routine, then press and hold the left mouse button and drag across the region of 
interest. Type Ctrl-E to expand to the chosen limits, or click the right mouse button. 
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Change to contour plot, instead of intensity plot, by typing CP.  Note the other options 
available from this menu. 
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Slices can be displayed overlaid on the contour plot. Press and hold the left mouse button, 
place the cursor on a peak of interest and then press and hold the right mouse button also.  

(Users with a single button mouse should press the period key on the keyboard instead of 
the right mouse button.) 

 

Projections can be displayed along each axis from the Borders menu or using the 
commands P1, P2, P3 and P4 which toggle on/off display of projections along the top, 
right, bottom and/or left edges, respectively.  The vertical scale for each projection is set 
independently by choosing Edit Display Parameters from the Edit menu, and entering a 
multiplying factor for the chosen projection.  If the projection contains both large and 
small peaks, it is possible to scale up the projection to see the small peaks, and then clip 
(truncate) the taller peaks.  Clipping is turned on and off from the Display menu.  

If high resolution 1D spectra exist, they can be displayed instead of the actual projection 
by selecting Pick the Bottom/Top/Left/Right Spectrum from the Borders menu.   If such 
spectra have been defined, their display is automatically toggled on.   As with the 
calculated projections, the vertical scale of high resolution "projection" can be adjusted 
by choosing Edit Display Parameters from the Edit menu.  Either projection can be 
clipped, allowing small peaks to be seen while limiting the height of larger peaks.  This is 
available from the Display menu.   
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The 2D plot can be resized by typing EP or selecting Edit Display Parameters from the 
Edit menu.  The Margin for each side is set independently, entered as fraction of total 
display. 

Related topics: Stacked plots, Arrayed Mode, detailed explanation of processing for 2D 
processing, comparing multiple 2D spectra. 

Line list routine  
LL - Line List 

This is a subroutine within 2D display that allows vertical and horizontal lines to be 
drawn on the spectrum to aid in spectral interpretation.  The lines are "attached" to the 
spectrum by ppm value, so the lines remain in place as the spectrum is zoomed in/out. 

Lines can be placed on a 2D plot without entering the subroutine, but the subroutine 
allows the appearance of the line to be edited. 

To add a line to a 2D plot, first press and hold the left mouse button to display a large red 
cross-hair cursor (referred to as the "target" cursor).  While the target cursor is displayed, 
typing a V places a vertical line at the current target position, and typing an H places a 
horizontal line at the target position. L clears the last entered line and C clears all entered 
lines. 
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When the command ppmlines or LL is given from the 2D base level, the Edit Line List 
routine is entered. If the cursor is moved over a line, it will blink and that line becomes 
the selected as the current line.  At this position, a right click or the key E will enter the 
mode to edit the properties of the current line.  Typing the D key will delete the current 
line and typing C will clear all current lines.  To add more lines while in the LL 
subroutine, holding down the mouse button is optional, but the target cursor is helpful in 
choosing the desired line position.  Place the cursor at the desired position, and type 
either V for a vertical line or H for a horizontal line.   

 

On entering the LL routine, note that the status bar shows Edit PPM Line List and the 
menus have changed.  As with all subroutines, typing <ENTER> or choosing Exit from 
the File menu will exit the LL subroutine. 
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Use the "target" cursor to display a large cross-hair, to aid in positioning the line. 

  

 

Typing H draws a horizontal line at the cursor position. 
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Selecting the line (by moving the mouse cursor across the line, causing the line to blink) 
and typing E displays a dialog box that allows the line's width, style and color to be set.  
Color is set using RGB values or by clicking the GUI Color button to select color. 
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The lines remain after exiting the LL routine, and continue to be displayed at the same 
ppm value even if the displayed region is changed. 

As of 12/8/06, new commands have been added that work with the data table and the 
Line List feature for contour plots.  Highlight a cell containing a chemical shift, and type 
either HL or VL.  A horizontal or vertical line is drawn on the contour plot at the 
corresponding chemical shift. 

Examples of 2D processing 

The user must have a basic understanding of how the data was collected to select the 
correct processing method.  For example, just knowing that the experiment is COSY is 
not enough, because the data may or may not be phase-sensitive.  The data types that can 
be processed with NUTS are magnitude, hypercomplex (method of States, et al), echo-
antiecho, States-TPPI and  TPPI.  Each type must be processed differently.   

Sample macros with detailed explanation is provided for those experiments for which we 
have sample data.  We will create macros for the others if sample files can be supplied.  
Contact us for help in creating customized macros. 

A recommended reference is T.D.W.Claridge, "High-Resolution NMR Techniques in 
Organic Chemistry", 1999. 

Step-by-step instructions for: 
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Magnitude data - COSY or HETCOR  
Hypercomplex data 
TPPI data 
Echo-antiecho data 
States-TPPI data 

** NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for 
improved processing of phase-sensitive data.  See description of PT command. 

See also:  

arrayed mode processing (NUTS-Pro users only)  
macros - commands used in macros for automated processing 
2D processing - commands related to 2D 
displaying 2D data - options for contour plots 
phasing 2D data 
symmetrizing 
editing 2D data 
sample data for downloading 
Varian DEPT data - macros for processing and creating edited DEPT plots 
comparing multiple 2D spectra 

Varian 2D data 

Processing description and macros are provided for the following Varian experiments.  
The same procedures are applicable to data from other spectrometers. 

NOESY - nuclear Overhauser spectroscopy;  hypercomplex, phase-
sensitive using States method 
The same processing procedure applies to tntocsy, tocsy, roesy, and 
hypercomplex cosy data. 

g_hsqc - gradient heteronuclear single-quantum correlation; echo-
antiecho, phase-sensitive  

hsqc - heteronuclear single-quantum correlation; hypercomplex, phase-
sensitive  

hmbc - heteronuclear multiple bond correlation; hypercomplex, not phase-
sensitive  

g_hmbc - gradient heteronuclear multiple bond correlation; magnitude  

cosy - magnitude COSY, not phase-sensitive  
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2dexch - 2D exchange experiment for solids; hypercomplex data in which 
the 2 halves of the data are scaled differently  

Bruker 2D data 

magnitude -- no phasing, a magnitude calculation is done at the end of processing;  This 
is appropriate for experiments such as cosy, cosygs, cosygsmf, cosy45gs, inv4gs, 
invgslrlp.  See also hetcor processing. 

phase-sensitive experiments: 

TPPI -- requires REAL ft in the indirect dimension 

States (hypercomplex) -- pairs of slices are combined to generate complex 
"fids" in the indirect dimension 

echo-antiecho -- gradient experiment, pairs of slices are added and 
subtracted to generate complex "fids" in the indirect dimension 

states-tppi data -- experiments such as noesygpst and roesyprst 

For Avance-series spectrometers, you can tell which kind of data you have by opening 
the file called pulseprogram using a text editor such as Word or WordPad (notepad 
doesn't work well, due to the absence of carriage returns).  Toward the end of this file is a 
parameter called MC2, which indicates the type of processing required.   

MC2 values: 

QF indicates magnitude data 
QSEQ or TPPI indicates TPPI data 
States indicates States-type hypercomplex data 
States-TPPI indicates States-TPPI data 
Echo-antiecho indicates echo-antiecho data 

The name of the pulse program also indicates the data type.  The names are concatenation 
of a base name (usually 4 letters) plus a series of 2-letter codes that are shorthand 
notation for various properties of the experiment.  Codes of interest here are: 

ea -- echo-antiecho 
gs -- gradient selection (use magnitude processing) 
sh -- use States-type processing 
tp -- use TPPI processing 
st -- use states-tppi processing 

For Aspect-based spectrometers, data is most likely magnitude or TPPI, depending on 
whether or not it is phase-sensitive.  Reading the .aur file on the spectrometer will usually 
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tell you which.  Or, process the first slice of the data and try to phase it; if it can't be 
phased, assume it's magnitude.  If it can be phased, assume it's TPPI. 

How to tell if something is wrong 

If the wrong type of processing is done, a set of mirror image peaks is often seen.  
Compare the plots shown below for an HMQC spectrum of strychnine.  The top spectrum 
is correct.  The bottom spectrum was obtained by failing to process the data as 
hypercomplex.  
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Because there are so many variations in spectrometer models and pulse sequences, it is 
not possible to provide users with macros that will work correctly on 2D data from all 
spectrometers.  It is recommended that users process a known data set first, for each 2D 
experiment commonly used on their spectrometers, to determine the correct processing 
commands under conditions where the correct final result is known. 

Another, less serious, problem is that sometimes the final spectrum appears to have the 
diagonal going the wrong way, as shown below. 
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This is easily fixed by including a spectrum reverse (SR) in the processing for the second 
(indirect) dimension.  Or, if there is already a SR in the processing list, remove it and re-
process. 

If the data is homonuclear and "square" (same number of data points in both dimensions), 
the spectrum can be symmetrized using the SY command.  Choose Spectral Parameters 
from the View menu and check the Number of Points in the 2 dimensions.  Additional 
zero-filling can be done during processing to make the data end up square, if 
symmetrizing is desired.  Attempting to execute SY if the data set is not square will 
generate an error message. 

Magnitude experiments 
Processing magnitude COSY data 

COSY data can be acquired in any of several "flavors" and each must be processed 
differently.  This example applies to a magnitude COSY spectrum (not hypercomplex, 
not phase-sensitive).  Any magnitude data is processed in the same manner;  see hetcor 
processing below. 
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Varian COSY spectrum of strychnine. 
This data set can be downloaded, along with processing macros. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.   

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing commands, displaying 2D data, sample data, processing 
2D data 

Arrayed Mode processing from the command line 

IM import file called fid 
AR enter arrayed mode 
S# set phase shift for sine multiplication to 0 
MS  MS apply sine squared window function 
FT no phasing is done 
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TD transpose data 
MS MS apply sine squared window function 
ZF zero-fill (may be repeated if needed) 
FT   
SR this spectrum needs spectrum reverse (may or may not be needed) 
MC magnitude calculation 
BC remove any DC offset and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 1 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

If the data is "square" (same number of data points in both dimensions), the spectrum can 
be symmetrized using the SY command.  Choose Spectral Parameters from the View 
menu and check the Number of Points in the 2 dimensions.  Additional zero-filling can be 
done during processing to make the data end up square, if symmetrizing is desired.   

Be sure to save the processed data (with SA). 

Macro using Arrayed Mode 

NUTSMACRO Varian magnitude cosy data for NUTS-Professional 
ask filea 
ga 
set array_on 
set s# 0 
bc ms ms ft  
;transpose data 
td 
ms ms zf ft sr mc bc 
;transpose data 
td 
set mh 1 
ss 
ip 
end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  The data can be 
symmetrized, if desired, provided it has the same number of data points in both 
dimensions.  Be sure to save the final data. 

Macro without Arrayed Mode 

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $. 
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Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

 Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result, or it will be overwritten the next 
time the macro is run. 

NUTSMacro Varian  magnitude cosy  
ask filea 
ga Macro asks for FID to open 

set sl 1 
set s# 0 

window function used here is sine squared, 
applied with ms ms after setting s#=0 

set filec ft1.2d set name for temp file 

ga bc ms ms ft bc sc in 

1st dimension processing  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies sine squared   
BC after FT removes DC and tilt in baseline
SC saves the data 
IN increments the slice counter 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d 
set sl 1 
set lb 5 

reset file names 

ga ms ms zf ft mc sr bc sc in 
2nd dimension processing 
this data requires spectrum reverse (SR) and 
magnitude calculation (MC) 

set filea ft2.2d 
set filec final.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

  
set filea final.2d 
ga 
ss 
set mh 1 

open file data set  

set contour threshold (MH = 1) 
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ip 
end 

set scale, display intensity plot 

The data can be symmetrized, if desired, provided it has the same number of data points 
in both dimensions. 

Processing magnitude HETCOR data 

This is among the simplest 2D experiments, as it requires no phasing. A sample 
HETCOR data file called small.2d (a 13C-1H spectrum of sucrose) can be downloaded.  
The resulting 2D plot is shown below. 

This page shows how to process this data set with step-by-step explanation.  2 macros are 
described, one for NUTS-Professional users and one for NUTS-2D users.  The goal with 
these examples is to describe the basic functions to allow users to customize them.  

See also descriptions of Links and Macros, magnitude COSY processing, processing 
Varian and Bruker 2D data. 

Users with the Professional version of NUTS can process the data using the following 
keyboard commands. 

Arrayed Mode processing from the command line 

IM import file called fid (Varian) or ser (Bruker) 
AR enter arrayed mode 
LB set line broadening to 5 
EM apply exponential window function 
FT no phasing is done 
BC remove DC and tilt of baseline 
TD transpose data 
MS apply sine window function  (could use EM here, if preferred) 
ZF zero-fill (may be repeated if needed) 
FT   

SR small.2d sample spectrum needs spectrum reverse;  other data may or may 
not need this 

MC magnitude calculation 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 10 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 
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Be sure to save the processed data. 

Macro using Arrayed Mode 

NUTSMACRO   Magnitude HETCOR processing using NUTS-Professional 
;macro prompts for name of data set 
ask FileA 
ga 
set array_on 
; 5 Hz linebroadening in 1st dimension 
set LB 5 
;link to process in 1st dimension 
bc em ft bc  
;transpose data 
td 
;link to process in 2nd dimension 
;uses sine window function, spectrum reverse and magnitude calculation 
ms ft sr mc bc 
; transpose data 
td 
set mh 10 
ss 
ip 
end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  Be sure to save the 
final data. 

Macro without Arrayed Mode 

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $. 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result. 

NUTSMACRO for 
magnitude HETCOR 
ask FileA 
ga 
set SL 1 

The macro first asks for the name of the file to be processed, 
so that the macro does not need to be edited each time it is 
run.  
GA opens the file. 
The pointer is set to the first slice (just to be safe). 

set FileC ft1.2d 

The macro writes several temporary files during processing. A 
file created as output in one step becomes the starting point 
for the following step, which is why FileA and FileC keep 
being reset. The output of the first step will be a 2D file called 
ft1.2d. 
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set LB 5 
ga bc em ft bc sc in 

The linebroadening for the first (carbon) dimension is set to 5 
Hz. 
The Link reads in each slice, baseline corrects to remove any 
DC offset of the 2 halves of the FID, applies the exponential 
multiplication and FT 
BC applied to the spectrum removes any DC and tilt in the 
baseline 
The resulting spectrum is saved as FileC with SC; the IN 
command increments the file pointers and loops to the 
beginning of the Link. 

set FileA ft1.2d 
set FileC td.2d 
set SL 1 

Now ft1.2d, the result of the first dimension FT, becomes the 
starting point for the next processing step, so is set to be 
FileA.  
The output of the next step will be a file called td.2d 
Again, to be safe, the file pointer is set to the first slice. 

td TD rotates the matrix so that slices in the other dimension can 
be read 

set FileA td.2d 
set FileC ft2.2d 
set SL 1 

The next step will operate on td.2d, which is now set to be 
FileA 
The result of the second dimension processing, FileC, will be 
called ft2.2d 
Again, to be safe, the file pointer is set to the first slice. 

 
ga em ft sr mc bc sc in 

This Link processes in the second (proton) dimension. 
Because the digital resolution is poor, we will use the same 5 
Hz. linebroadening. Hetcor data from this particular 
instrument requires a spectrum reverse (SR) command in this 
dimension. That may need to be removed for data from other 
sources. 
MC performs a magnitude calculation and BC removes DC 
and tilt from the baseline. 

set FileA ft2.2d 
ga 
set SL 1 
set FileC final.2d 

The data is best viewed with the 13C dimension horizontally, 
as this is customary and is also the dimension with better 
digital resolution. So we again reset file names and set the 
slice pointer. 

td Transpose the data 
set FileA final.2d 
ga 
set SL 1 

Load the first slice of the final data set 

ss 
set MH 10 
ip 
end 

SS normalizes the display scale. It looks through the entire 
data set to find the largest peak and sets it equal to 100%. 
Contour levels are defined in the nuts.ini file as mulitples of 
the Minimum Height (MH) which is expressed as a percent of 
the largest peak. So SS is needed to get the display correct.
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MH of 10 means that the first contour is drawn at 10% of the 
largest peak, appropriate for hetcor data, in which most peaks 
are similar in height. 
IP displays a quick intensity plot 

The result should look like this: 

 

This data set can be downloaded, along with macros for processing it. 

Processing Bruker HMQC data 

Macro using Arrayed Mode 

NUTSMACRO B_inv4gs_pro  
; Bruker Magnitude HMQC and HMBC data, 
; applicable for inv4gs, invgslrlp 
; arrayed mode processing - requires NUTS-Professional version 
; this is magnitude data, no phasing done 
 
; turn on arrayed mode 
set array_on 
 
; request name of file to open, and open it 
ask FileA 
ga 
 
; set phase for sine mult to 0 
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set s# 0 
 
; 1st dimension processing (F2 or t2) 
; uses sine window function 
; no Spectrum Reverse for ptype data 
ga bc ms ft  
 
;transpose data 
td 
 
; 2nd dimension processing (F1 or t1) 
; uses sine window function and zero-fill 
; Spectrum reverse (SR) included for Bruker-SGI-data 
ms zf ft mc td sr  
 
; set minimum height for intensity plot to 3% 
set mh 3 
ss 
ip 
end 

Macro without Arrayed Mode 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Before running the macro, import the data, FT and phase.  When the macro starts, it will 
ask for a file to open - select the translated file.  Temporary files are written at each stage 
of processing, so the macro must reset the file names at each stage.  Be sure to save the 
final result. 

NUTSMACRO B_inv4gs_pro  
; Bruker Magnitude HMQC and HMBC data, 
; applicable for inv4gs, invgslrlp 
; does not use arrayed mode processing  
; this is magnitude data, no phasing done 
 
 
; request name of file to open, and open it 
ask FileA 
ga 
 
; set phase for sine mult to 0 
set s# 0 
 
set filec ft1.2d 
 
; 1st dimension processing (F2 or t2) 
; uses sine window function 
; no Spectrum Reverse for ptype data 
ga bc ms ft sc in 
 
; reset file names 
set filea ft1.2d 



384 

set filec td.2d 
set sl 1 
ga 
;transpose data 
td 
 
set filea td.2d 
set filec ft2.2d 
set sl 1 
; 2nd dimension processing (F1 or t1) 
; uses sine window function and zero-fill 
; Spectrum reverse (SR) included for Bruker-SGI-data 
ga ms zf ft mc td sr sc in 
 
set filea ft2.2d 
set sl 1 
ga 
 
; set minimum height for intensity plot to 3% 
set mh 3 
ss 
ip 
end 
 

Processing Varian HMBC data 

Varian acquires HMBC data as hypercomplex, even though the data is not phase-
sensitive, and a magnitude calculation is done at the end of processing.  In a 
hypercomplex experiment, 2 FIDs are acquired for each t1 time point, with a phase shift 
of one pulse.  After FT in the direct dimension, the real halves of each pair of spectra are 
combined to create complex interferograms in the indirect dimension. 
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Varian HMBC spectrum of strychnine. 
This data set can be downloaded, along with processing macros. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.   

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing, displaying 2D data 

Arrayed Mode processing from the command line 

AR enter arrayed mode 
IM import file called fid 
S# set phase shift for sine multiplication to 45 
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MS  MS apply cosine squared window function 
FT   
TR  TR  ST "tag" real half of each slice and store  
TD transpose data 
MS MS   

ZF ZF zero-fill (experience has shown there is benefit from doing several ZFs, 
even 4 times) 

FT   
MC magnitude calculation 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 5 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Macro using Arrayed Mode 

NUTSMACRO Varian hmbc data (hypercomplex and magnitude) for NUTS-
Professional 
set array_on 
ask filea 
ga 
set s# 45 
;window fcn is sine-squared 
bc ms ms ft  
; combine slices for hypercomplex data 
tr tr st 
;transpose data 
td 
;2nd dimension processing 
;window fcn is sine-squared and we do one zero-fill 
; magnitude calculation 
ms ms zf ft mc bc 
;transpose data 
td 
set mh 5 
ss 
ip 
end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  Be sure to save the 
final data. 

Macro without Arrayed Mode 
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Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

 Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result. 

NUTSMacro Varian HMBC, hypercomplex 
and magnitude  

ask filea 
ga Macro asks for FID to open 

set sl 1 
set s# 45 

window function used here is sine squared, 
applied with ms ms after setting s#=45 

set filec ft1.2d   

ga bc ms ms ft bc tr ia ga bc ms ms ft bc tr 
st in 

1st dimension processing  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies cosine squared   
BC after FT removes DC and tilt in baseline
TR "tags" this to be the real half of the 
complex FID in t1 
IA increments slice counter for File A 
GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 
of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d 
set sl 1 

reset file names 

ga ms ms zf ft mc bc sc in 2nd dimension processing 
set filea ft2.2d 
set filec final.2d 
set sl 1 
ga 

reset file names  

transpose data 
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td   
set filea final.2d 
ga 
ss 
set mh 5 
ip 
end 

open file data set  

set contour threshold (MH = 5) 

set scale, display intensity plot 

 

 
Processing Varian gHMBC data 

Varian g_hmbc data is a simple magnitude experiment, not phase sensitive and not 
hypercomplex. 
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Varian g_hmbc spectrum of sucrose. 
This data set can be downloaded, along with processing macros. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.   

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing, displaying 2D data, sample data, processing Varian 2D 
data 

Arrayed Mode processing from the command line 

AR enter arrayed mode 
IM import file called fid 
S# set phase shift for sine multiplication to 0 
MS  MS apply sine squared window function 
FT   
TD transpose data 
LB 
EM 

set line broadening to an appropriate value, apply EM (alternatively, sine 
squared can be used). 

ZF ZF zero-fill (experience has shown there is benefit from doing several ZFs, 
even 4 times) 

FT   
MC magnitude calculation (alternatively, use M2) 
BC remove any DC and tilt in baseline 
TD to view data with direct dimension horizontal 
MH set minimum height to 5 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Macro using Arrayed Mode 

NUTSMACRO Varian g_hmbc data (magnitude) for NUTS-Professional 
set array_on 
ask filea 
ga 
set s# 0 
set LB 5 
bc ms ms ft  
;transpose data 
td 
em zf ft mc bc 
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;transpose data 
td 
set mh 5 
ss 
ip 
end 

Note that NUTS remains in Arrayed Mode at the end of the macro.  Be sure to save the 
final data. 

Macro without Arrayed Mode 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

 Temporary files are written at each stage of processing, so the macro must reset the file 
names at each stage.  Be sure to save the final result. 

NUTSMacro Varian g_hmbc, magnitude  
ask filea 
ga Macro asks for FID to open 

set sl 1 
set s# 0 

window function used here is sine squared, 
applied with ms ms after setting s#=0 

set filec ft1.2d   

ga bc ms ms ft bc sc in 

1st dimension processing  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies sine squared   
BC after FT removes DC and tilt in baseline
SC saves the data 
IN increments the slice counter 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d 
set sl 1 
set lb 5 

reset file names 

ga em zf ft mc bc sc in 2nd dimension processing 
set filea ft2.2d reset file names  
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set filec final.2d 
set sl 1 
ga 
td 

transpose data 

  
set filea final.2d 
ga 
ss 
set mh 5 
ip 
end 

open file data set  

set contour threshold (MH = 5) 

set scale, display intensity plot 

 

 

Processing Hypercomplex data (method of States,et al) 

Data in a single file – Varian HSQC 

Varian acquires phase-sensitive HSQC data as hypercomplex, meaning that 2 FIDs are 
acquired for each t1 time point, with a phase shift of one pulse.  After FT in the direct 
dimension, the pairs of spectra are combined to create complex interferograms in the 
indirect dimension. 

Note that Varian's g-hsqc experiment is echo-antiecho, not hypercomplex, and must be 
processed differently. 
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Varian phase-sensitive HSQC of strychnine. 
This data set can be downloaded, along with processing macros. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.   

NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for 
improved processing of hypercomplex data.  See description of Arrayed Mode below. 

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing, displaying 2D data, phasing 2D data 

Arrayed Mode processing from the command line 
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AR enter arrayed mode 
IM import file called fid 
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TR  TR  ST "tag" real half of each slice and store  
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
TD to view data with direct dimension horizontal 
MH set minimum height to 5 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Arrayed Mode processing using new PT feature (May, 2002) 

Be sure you are not in arrayed mode, and open the data to be processed. 

PT set processing type to 2D_HyperComplex 

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
TD to view data with direct dimension horizontal 
MH set minimum height to 3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 
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All quadrants of the data are saved, allowing phasing in both dimensions.  Be sure to save 
the processed data.  To open the processed data at a later date, enter AR first, so that the 
data is sorted correctly when opened. 

Macro using Arrayed Mode (does not use the new modified arrayed mode) 

NUTSMACRO Varian hypercomplex HSQC processing for Arrayed Mode 
;macro prompts for name of data set 
; first, import, process and phase 1st slice 
 
set array_on 
ask FileA 
ga 
set s# 90 
bc ms ms ft ps bc 
; combine hypercomplex slices 
tr tr st 
;transpose data 
td 
ms ms zf ft  
td 
set mh 4 
ss 
ip 
end 
Macro without Arrayed Mode  

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Before running the macro, import the data, FT and phase.  When the macro starts, it will 
ask for a file to open - select the translated file.  Temporary files are written at each stage 
of processing, so the macro must reset the file names at each stage.  Be sure to save the 
final result. 

NUTSMacro Varian Hypercomplex HSQC 
ask filea 
ga 
set sl 1 

Before running macro, open data set, FT 
and phase 1st slice   

Macro asks for name of data set to open - 
supply translated file name 

set filec ft1.2d 
set s# 90 

window fcn will be cosine squared;  phase 
is set with S# 

ga bc ms ms ft ps bc tr ia ga bc ms ms ft ps 
bc tr st in 

Link to process 1st dimension  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies cosine squared   
BC after FT removes DC and tilt in baseline
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IA increments slice counter for File A 
TR "tags" this to be the real half of the 
complex FID in t1 
GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 
of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d reset file names 

set sl 1 
ga ms ms zf ft sc in 2nd dimension processing 

set filea ft2.2d 
set filec final.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea final.2d 
ga 
ss 
set mh 4 
ip 
end 

open final file  

set scale, set contour threshold (MH = 4) 

 

Processing Varian NOESY data 

Varian (and JEOL) acquires some phase-sensitive data (such as NOESY) as 
hypercomplex, meaning that 2 FIDs are acquired for each t1 time point, with a phase shift 
of one pulse in the sequence.  After FT in the direct dimension, the pairs of spectra are 
combined to create complex interferograms in the indirect dimension. 
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Varian phase-sensitive NOESY of strychnine. 
This data set can be downloaded, along with processing macros. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering commands using the command line, shown below.   

NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for that 
allows phasing in both dimensions after processing.  Commands for processing are listed 
below.   

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing, displaying 2D data, phasing 2D data 
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Arrayed Mode processing from the command line 

Import the fid, then process using the following series of commands:  

PT set processing type to 2D_HyperComplex 

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 

SR may or may not be needed to make diagonal run in the conventional 
direction 

TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

All quadrants of the data are retained, allowing phasing in both dimensions.  See details.  
Be sure to save the processed data.   

Macro using Arrayed Mode   

NUTSMACRO Varian noesy in arrayed mode 
; for hypercomplex data 
ask fileimport 
im 
2f 
pt 2D_hypercomplex, 
2n, 
set ARRAY_PAIRWISECOMPLEX 
set s# 90 
ms ms ft 
; transpose 
td 
; process using zero-fill 
ms ms zf ft 
td 
set mh 2 
ss 
ip 
end 



398 

Note that the processed data have not been saved.  Phasing in one or both dimensions 
may be needed.  See 2D phasing.  

Macro without Arrayed Mode 

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $.  

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.   

Before running the macro, import the data, FT and phase.  When the macro starts, it will 
ask for a file to open - select the translated file.  Temporary files are written at each stage 
of processing, so the macro must reset the file names at each stage.  Be sure to save the 
final result.  

NUTSMacro Hypercomplex  
ask filea 
ga 
set sl 1 

Before running macro, open data set, FT 
and phase 1st slice   

Macro asks for name of data set to open - 
supply translated file name 

set filec ft1.2d 
set s# 90 

window fcn will be cosine squared;  phase 
is set with S# 

ga bc ms ms ft ps bc tr ia ga bc ms ms ft ps 
bc tr st in 

Link to process 1st dimension  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID  
MS MS applies cosine squared   
BC after FT removes DC and tilt in baseline
TR "tags" this to be the real half of the 
complex FID in t1 
IA increments slice counter for File A 
GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 
of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 
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set filea td.2d 
set filec ft2.2d reset file names 

set sl 1 
ga ms ms zf ft sc in  2nd dimension processing 

set filea ft2.2d 
set sl 1 
ga 
set mh .3 
ip 
end 

reset file names  

set contour threshold (MH = 0.3), set scale, 
display intensity plot 

This macro ends displaying data with the indirect dimension on the horizontal axis.  This 
is because usually some phasing is needed.  See 2D phasing. 

Data in a pair of files 

The first section presents a pair of macros appropriate for data which are saved with the 2 
halves contained in separate files. Processing has been split into 2 parts. The first part 
processes in the first dimension and performs a TD. This allows the user to examine the 
data and determine the phasing required in the second dimension. The second part 
processes the second dimension using that phasing.  

Following this are macros appropriate for data which are saved with the 2 halves 
interleaved (Varian). 

It is recommended that users begin by examining the explanation of HETCOR processing 
first, as many steps are the same and HETCOR is a simpler case. 

Because this is a phase-sensitive experiment, begin by reading in the first slice of the 
data, apply window function, FT and phase. These phase parameters will be applied to 
the rest of the data with the PS command. Customization of the macros may be desirable 
to use different window functions or to incoporate a spectrum reverse (SR) if needed. 

See also description of commands for processing hypercomplex data.  

NUTSMacro Hypercomplex 2D, 
part I 
ask FileA  
ask FileB  
ga  
set SL 1  
set FileC ft1.2d  

The macro prompts for the names of the files 
containing the 2 halves of the complex data, called 
Files A and B.  
GA sets the data directory, and setting Slice to 1 
makes sure the file pointer is set to the beginning of 
the file. 
File C, ft1.2d, will be the result of the first 
dimension FT. 

set LB 1 Processing in the first dimension:
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ga bc em ft ps bc tr gb bc em ft ps 
bc tr st in  

The first slice is read from File A, apodized, FT'd 
and phased. The real half of the resulting spectrum is 
"tagged" with TR to become half of the complex 
"FID" in t1. 
The first slice from File B is treated similarly. 
The real halves from the 2 files are saved as a 
complex FT in t1 with ST. 

set FileC td.2d  
set FileA ft1.2d  
set SL 1  
ga  
td  

The file created in the first step becomes the input 
file (File A) for the next step.The file pointer is set to 
1, just to be safe. 
The TD operation rotates the matrix so that slices in 
the 2nd dimension can be accessed. 

set FileA td.2d  
set SL 1  
ga 
end 

Reset file name, set Slice pointer to 1 and read in the 
first slice. 

We stop the processing at this point, to examine the t1 interferograms to determine the 
appropriate window function and phase parameters. This requires selecting slices that 
contain signal, most easily accomplished by viewing an intensity plot. Type SS to 
normalize the display scale, set MH to 5-10 and type IP to display an intensity plot. The 
cursor can be used to determine the slice numbers of slices that contain signal. Slices can 
be displayed overlaid on the intensity plot, which is the easiest way to scan through the 
data. Hold down left mouse button to display a horizontal cursor, then press the right 
mouse button simultaneously to display slices as the cursor is moved up and down 
through the data set. (Users with a single-button mouse should press the period key on the 
keyboard instead of the right mouse button.) Note slice numbers of slices with good 
signal-to-noise, then exit the IP routine with ENTER.  

To determine phase parameters in the second dimension, we need a spectrum with peaks 
near both ends of the spectrum, which can be accomplished by adding together 2 slices 
with peaks at opposite ends of the spectrum. Read in the first slice of interest (with SL), 
apply an apppropriate window function and FT. Place this slice into the Add/Subtract 
buffer (with AL). Read in and process the second slice. Enter the Add/Subtract routine 
(AS), add the 2 spectra (with plus sign) and exit the subroutine with ENTER. Now phase 
this spectrum, then note the phasing applied (TP). Enter the values of zero- and first-order 
phasing into the PA and PB parameters. This phase correction will then be applied (with 
PC) to each slice. 

NUTSMacro Hypercomplex 2D, 
part II 
set FileA td.2d  
set SL 1  
ga  
set FileC ft2.2d 

The second half of the processing begins by reading 
in the first slice of td.2d 
After processing, the file created is called ft2.2d. 
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set S# 90 
ga bc ms ms zf ft pc bc sc in 

Set the phase for sine multiplication to 90 degrees 
(cosine). 
Link to process in the second dimension includes a 
cosine squared apodization (MS MS) and one zero-
fill, followed by FT and phasing using the PA and 
PB parameters determined above. 

ss  
end  

SS normalizes the display scale. It looks through the 
entire data set to find the largest peak and sets it 
equal to 100%. Contour levels are defined in the 
nuts.ini file as mulitples of the Minimum Height 
(MH) which is expressed as a percent of the largest 
peak. So SS is needed to get the display correct. 

This macro ends with the second dimension displayed horizontally. It may be desirable to 
perform another TD operation to view the data from the better digitized dimension. It has 
not been done as part of the macro in case additional phasing is required. If additional 
phasing is required in the second dimension, determine the phase correction needed and 
set values for PA and PB. Phasing is accomplished with a Link such as  

ga pc sc in 

Interleaved hypercomplex data 

This section describes processing which is appropriate for data which are saved with the 
2 halves interleaved. As above, begin by reading in the first slice of the data, apply 
window function, FT and phase. These phase parameters will be applied to the rest of the 
data with the PS command. Customization of the macros may be desirable to use 
different window functions or to incoporate a spectrum reverse (SR) if needed. 

NUTSMacro Hypercomplex 2D, 
part I 
ask FileA  
ga  
set SL 1  
set FileC ft1.2d  

The macro prompts for the file name of the FID, 
called File A.  
GA sets the data directory, and setting Slice to 1 
makes sure the file pointer is set to the beginning of 
the file. 
File C, ft1.2d, will be the result of the first 
dimension FT. 

set S# 90 
ga bc ms ms ft ps bc tr ia ga bc ms 
ms ft ps bc tr st in  

Processing in the first dimension: 
The window function used here is cosine squared, 
applied with ms ms after setting the phase S# = 90  
The first slice is read from File A, apodized, FT'd 
and phased. The real half of the resulting spectrum is 
"tagged" with TR to become half of the complex 
"FID" in t1. 
The slice pointer for File A is incremented (IA), so 
that the next slice is read and processed in the same 
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manner. The real halves from the 2 files are saved as 
a complex FT in t1 with ST. The IN command 
increments the slice pointer for both File A and File 
C. 

set FileA ft1.2d 
set SL 1  
ga  
set FileC td.2d  
td  

The file created in the first step becomes the input 
file (File A) for the next step.The file pointer is set to 
1, just to be safe. 
The TD operation rotates the matrix so that slices in 
the 2nd dimension can be accessed. 

set FileA td.2d  
set SL 1  
ga 
end 

Reset file name, set Slice pointer to 1 and read in the 
first slice. 

As before, we stop the macro at this point to determine phase parameters for the second 
dimension. From this point, processing is the same as for the case above. 

Processing TPPI data 

TPPI (Time Proportional Phase Incrementation) is one method for accomplishing phase-
sensitive "quadrature detection" in the indirect dimension, most often used in Bruker 
experiments.  The only "trick" to processing is that a real FT is required in the indirect 
dimension.   

This should not be confused with States-TPPI data, which must be processed differently. 

A recommended reference is T.D.W.Claridge, "High-Resolution NMR Techniques in 
Organic Chemistry", 1999. 

Customization of the macros may be desirable to use different window functions or to 
incorporate a spectrum reverse (SR) if needed. 

See also: 

• Arrayed Mode (NUTS-Pro users only) 
• Commands for processing 2D data   
• 2D Processing details 
• Processing States-TPPI data 
• Processing hypercomplex data 
• Processing echo-antiecho data 
• Processing magnitude hetcor or COSY 2D data 
• Displaying 2D data 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.  NUTS-Pro users with NUTS 
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versions newer than Nov 2002 can process data using the modified arrayed mode, such 
that both dimensions can be phased after processing.  See below. 

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

Arrayed Mode processing from the command line 

IM import file called ser 
AR enter arrayed mode 
S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 

RT Performs a real FT.  This is critical! 
may require phasing;  see 2D phasing 

TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

NUTS-Pro users with copies newer than Nov 2002 can process using the modified 
arrayed mode, allowing phasing in both dimensions after processing.  Processing is as 
above, except that instead of the AR command, execute the following command (in non-
2-letter command mode): 

ar tppi2pairwise 

This creates the required additional 2 quadrants of data, filled with zeroes, and enters the 
pairwise arrayed mode.  See description of PT command. 

With NUTS versions dated May 2002 to Nov 2002, you must enter the pairwise arrayed 
mode before re-opening the processed data, so that the data is sorted correctly when 
opened.  Versions newer than Nov 2002 will read the PT parameter and automatically 
start the pairwise arrayed mode when the file is opened. 

Macro using Arrayed Mode 
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NUTSMacro TPPI 2D for NUTS Professional 
; process and phase on 1st slice before starting macro 
ask filea 
ga 
; turn on arrayed mode 
set array_on 
;window fcn is cosine squared, applied with ms ms 
set s# 90 
process 1st dimension, phase with previously determined values 
bc ms ms ft ps 
; transpose data 
td 
; 2nd dimension processing with cosine sq, zero-fill and real FT 
ms ms zf rt bc 
; set scale, set contour threshold (MH = .3) and display intensity plot 
ss 
set mh .3 
ip 
end 

This macro ends displaying data with the indirect dimension on the horizontal axis.  This 
is because usually some phasing is needed.  See 2D phasing.  Note that the processed data 
has not been saved. 

Macro without Arrayed Mode 

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $. 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Before running the macro, import the data, FT and phase.  When the macro starts, it will 
ask for a file to open - select the translated file.  Temporary files are written at each stage 
of processing, so the macro must reset the file names at each stage.  Be sure to save the 
final result. 

NUTSMacro  phase-
sensitive TPPI  
ask FileA 
ga  
set SL 1 
set FileC ft1.2d  

The macro prompts the user for the name of the data file to be 
read, designated File A. Temporary file names are used for 
intermediate stages of processing. The file after the first 
dimension FT is called ft1.2d. 

set S# 90  
ga ms ms ft ps sc in  

The window function used here is cosine squared, 
accomplished with MS MS after setting the phase for sine 
multiplication to 90 degrees. 
The processing Link applies the window function, FT and 
phases with phase parameters determined on the first slice, 
before the macro was started. The FT'd data is saved as File 
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C.  
set FileA ft1.2d  
set FileC td.2d  
set SL 1  
ga  

The file created in the previous step becomes the input for the 
next step.  
File C, which will be the output of the next step, is defined as 
td.2d. 

td  Transpose the data to access slices in the second dimension. 
set fileA td.2d  
set fileC ft2.2d  
set SL 1  
ga  

The input data for the next processing step is td.2d.  
The slice pointer is set to slice 1 and the file opened. The file 
to be created in the next step is ft2.2d. 

Set S# 90  
ga ms ms zf rt sc in  

Link to process in 2nd dimension uses cosine squared window 
function and one zero-fill. 
A real transform (RT) is used instead of a "normal" FT. No 
phase correction is applied. 

set FileA ft2.2d  
ga  
set SL 1  

The processed data, ft2.2d, is read in and the slice pointer set 
to 1. 

ss  
end  

SS normalizes the display scale. It looks through the entire 
data set to find the largest peak and sets it equal to 100%. 
Contour levels are defined in the nuts.ini file as multiples of 
the Minimum Height (MH) which is expressed as a percent of 
the largest peak. So SS is needed to get the display correct. 

This macro ends with the second dimension displayed horizontally. It may be desirable to 
perform another TD operation to view the data from the better digitized dimension. It has 
not been done as part of the macro in case additional phasing is required. Phasing can be 
done as described in the section on 2D phasing.  

Forward linear prediction (LN) can be used in the second dimension processing instead 
of zero-filling. After the first dimension processing, determine the appropriate Linear 
Prediction parameters by testing on one or more slices. The most recent values for each 
parameter will be used when LN is used in a Link or macro. Then modify the macro for 
processing in the second dimension by replacing ZF with LN. Processing will require 
significantly more time when LN is included (For a 1K complex by 256 NOESY data set, 
processed on a Pentium 100, this macro takes about 20 min.) 

Processing States-TPPI data 

The terms are confusing, as phase-sensitive data can be acquired as States (also called 
hypercomplex), as TPPI (Time Proportional Phase Incrementation) or as States-TPPI (in 
addition to other methods), each of which must be processed differently. 
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For States-TPPI, you need to invert every other data point in the indirect dimension "fid", 
or equivalently, every other slice in the direct dimension AFTER you have combined 
pairs of spectra to form the complex "fids" in the direct dimension. 

With States (hypercomplex) data, 2 FIDs are acquired for each t1 time point, with a phase 
shift of one pulse in the sequence.  After FT in the direct dimension, the real halves of 
each pair of spectra are combined to create complex interferograms in the indirect 
dimension.  So you end up with half as many slices as you had to start with. 

For States-TPPI, after this data shuffling operation, you must also invert every other slice. 

A new command, invert, has been added to NUTS for processing States-TPPI data, 
which works only in the Arrayed Mode, so requires NUTS-Professional version.  See 
below for processing in non-arrayed mode. 

NUTS-Pro versions newer than May, 2002, include a modified arrayed mode for 
improved processing of States-TPPI data.  This mode allows phasing in both dimensions 
after processing.  See details. 

invert – This command inverts either the even or odd slices of a 2 or 3D dataset.  This 
command works only in the non-two-letter command mode and only during arrayed 
mode operation.  

Examples: 

invert even - used for States-TPPI processing 
The above command would invert every even numbered slice of the current dataset 

Related commands: 

invert odd 
The above command would invert every odd numbered slice of the current dataset. 

invert real 
The above command would invert all reals for every slice of the current dataset. 

invert imag 
The above command would invert all imaginaries for every slice of the current  
dataset. 

Arrayed Mode processing from the command line 

AR enter arrayed mode 
IM import data  
S# set phase shift for sine multiplication to 90 
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MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

TR  TR  ST "tag" real half of each slice and store  
2F turn off 2-letter command mode 
INVERT 
EVEN 
<enter> 

invert command must be terminated with <ENTER> 

2N <enter> return to 2-letter command mode 
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

Be sure to save the processed data. 

Arrayed Mode processing using new PT feature (May, 2002) 

Be sure you are not in arrayed mode, and open the data to be processed. 

PT set processing type to 2D_StatesTPPI 

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased 

2F turn off 2-letter command mode 
INVERT 
EVEN 
<enter> 

invert command must be terminated with <ENTER> 

2N <enter> return to 2-letter command mode 
TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
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FT may require phasing;  see 2D phasing 
(SR) may be needed to make diagonal run in the conventional direction 
PH phase as described here 
TD to view data with direct dimension horizontal 
MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

All quadrants of the data are saved, allowing phasing in both dimensions.  Be sure to save 
the processed data.  To open the processed data at a later date, enter AR first, so that the 
data is sorted correctly when opened. 

Processing in non-arrayed mode 

This can be done using the NUTS "phase incremented" (PI) command by setting PA = 
180 and PB = 0. 

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $. 

Processing is done one 1 slice at a time, so the sequence of commands is done in a Link, 
which is repeated for each slice.  

Before running the macro, import the data, FT and phase.  When the macro starts, it will 
ask for a file to open - select the translated file.  Temporary files are written at each stage 
of processing, so the macro must reset the file names at each stage.  Be sure to save the 
final result. 

NUTSMacro States-TPPI  
ask filea 
ga 
set sl 1 

Before running macro, open data set, FT 
and phase 1st slice   

Macro asks for name of data set to open - 
supply translated file name 

set filec ft1.2d 
set s# 90 

window fcn will be cosine squared;  phase 
is set with S# 

ga bc ms ms ft ps tr ia ga bc ms ms ft ps tr st 
in 

Link to process 1st dimension  

GA reads in the first slice 
BC removes DC offset of the 2 halves of 
the FID 
MS MS applies cosine squared   
TR "tags" this to be the real half of the 
complex FID in t1 
IA increments slice counter for File A
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GA  reads in the next slice, which is 
processed same way 
TR "tags" this to be the imaginary half of 
the complex FID in t1 
ST saves the 2 halves, and IN increments 
the file pointers and loops to the beginning 
of the Link 

set filea ft1.2d 
set filec invert.2d 
set sl 1 
ga 
set pa 180 
ga pi sc in 

reset file names  

PI  (Phase Incremented) inverts every other 
slice 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

reset file names  

transpose data 

set filea td.2d 
set filec ft2.2d reset file names 

set sl 1 
ga ms ms zf ft sc in 2nd dimension processing 

set filea ft2.2d 
set sl 1 
ga 
set mh .3 
ip 
end 

reset file names  

set contour threshold (MH = 0.3), set scale, 
display intensity plot 

This macro ends displaying data with the indirect dimension on the horizontal axis.  This 
is because usually some phasing is needed.  See 2D phasing. 

Processing Echo-antiecho data 

These phase-sensitive gradient experiments are run such that each slice contains both sine 
and cosine terms in t1. This means that the data must be handled differently from 
hypercomplex data, in which odd numbered slices contain only cos t1 terms, and even 
numbered slices contain only sin t1 terms.   
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Varian g-hsqc spectrum of sucrose. 
This data set can be downloaded, along with processing macros.  

The data are processed differently depending on whether or not Arrayed Mode (NUTS-
Professional version only) is used.  

To process this data, we FT and phase slice 1 and slice 2, then calculate the sum and the 
difference of them. Because the 2 slices are, respectively, (cos t1 + isin t1) and (cos t1- isin 
t1), the sum gives you just cosine, and the difference gives you just sine.  Together, they 
comprise a complex "FID" in the indirect dimension.  

This add/subtract process is handled with command C2 which works in Arrayed Mode 
only, but can be accomplished in non-arrayed mode using a combination of commands.  
See below.  
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Phase correction in the direct dimension can be difficult, because the first slice may have 
little signal.  If a 1D spectrum was acquired when the 2D experiment was done, the phase 
correction can be determined using the 1D spectrum, and then applied to the 2D data 
using PS.  If not, phasing can be determined after processing.  See details. 

Using Arrayed Mode, processing can be done using a macro (below) or simply by 
entering the following commands using the command line.  NUTS-Pro versions newer 
than May, 2002, include a modified arrayed mode which allows processing in both 
dimensions after FT.  See details. 

Users with the standard 2D version cannot use Arrayed Mode, and can process with a 
different macro (below). 

See also: macros, 2D processing, displaying 2D data, phasing 2D data 

Arrayed Mode processing  

PT set processing type to 2D_EchoAntiecho 

AR enter arrayed mode (note that status bar says "pairwise complex arrayed 
mode" 

S# set phase shift for sine multiplication to 90 
MS  MS apply cosine squared window function 
FT   
C2 add/subtract pairs of spectra to create complex "fids" in indirect dimension

PH phase while viewing the first slice;  on exiting phase routine, the entire 
data set is phased.  If S/N is insufficient, skip phasing for now 

TD transpose data 
MS MS   
ZF zero-fill (may be repeated if needed) 
FT may require phasing;  see 2D phasing 

SR may or may not be needed to make diagonal run in the conventional 
direction 

PH phase as described here 

TD to view data with direct dimension horizontal; touch up phasing if needed 
(see 2D phasing) 

MH set minimum height to 0.3 (good starting guess for contour threshold) 
SS set scale 
IP intensity plot 

All quadrants of the data are retained, allowing phasing in both dimensions.  Be sure to 
save the processed data.   

Macro for processing using Arrayed Mode   
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NUTSMACRO Varian g-hsqc in arrayed mode 
; for echo-antiecho data 
ask fileimport 
im 
2f 
pt 2D_echoantiecho, 
2n, 
set ARRAY_PAIRWISECOMPLEX 
set s# 90 
ms ms ft 
; combine data 
c2 
; transpose 
td 
; process using zero-fill 
ms ms zf ft 
td 
set mh 2 
ss 
ip 
end 

Phasing in one or both dimensions may be needed after processing.  See 2D phasing.  
Note that data has not been saved.  

Macro for processing without Arrayed Mode  

Commands have been added to facilitate the addition/subtraction process. Two buffers, 
called B1 and B2, have been created. Typing B1 (or B2) copies the current data into 
Buffer 1 (or 2). Then typing B+ sums B1 + B2 and places the sum into the current data 
set. Similarly, B- does the same with the difference. However, by being a bit clever, it 
can be done without these commands.  

Before running the macro, import the data with IM.  The macro start by prompting for a 
data file to open - select the translated NUTS file, which always starts with $.  

It is recommended that users unfamiliar with 2D processing in NUTS begin by 
examining the explanation of HETCOR processing first, as many steps are the same and 
HETCOR is a simpler case. The processing required here differs from "normal" 
hypercomplex data only in the Link to process in the first dimension. It is recommended 
that users also read through the description of hypercomplex phase-sensitive 2D data. 

NUTSMacro Varian echo-
antiecho g_hsqc   determine phase correction before beginning 

set s# 90  
ask filea 
ga 
set filec ft1.2d 

window function used here is cosine squared, applied 
with ms ms after setting s#=90  

macro requests name of data set to be processed 
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data are saved as Ixcos(wt1)+Iysin(wt1) and Ixcos(wt1)-
Iysin(wt1) 
We form the real half of the t1 complex pair from (slice 
1 + slice 2) and the imaginary half from (slice 1 - slice 2) 

ga zf b1 ia ga zf b2 b+ ms ms 
ft ps tr b- ms ms ft ps ti st in 

(Note that this Link appears in the macro all on one line) 

GA reads in the first slice 
ZF will zero-fill to the next higher power of 2  
B1 loads it into buffer 1 
IA increments the extension for fileA 
GA ZF B2 reads in the next slice, zerofills and loads it 
into buffer 2 
B+ adds the slices, then we apply window function, FT 
and phase 
TR "tags" this to be the real half of the complex FID in 
t1 
B- subtracts the contents of the buffers, then we apply 
window function, FT and phase 

TI "tags" this to be the imaginary half of the complex 
FID in t1 
ST saves the 2 halves, and IN increments the file 
pointers and loops to the beginning of the Link 

set filec td.2d 
set filea ft1.2d 
set sl 1 
ga 
td 

set new file names and transpose data for processing in 
the second dimension 

set filea td.2d 
set sl 1 
ga 
set filec ft2.2d  

read in transposed data, set file names 

  

ga bc ms ms zf ft sr bc sc in  process 2nd dimension with cosine squared, 1x zerofill 
and spectrum reverse  

set filea ft2.2d 
set sl 1 
ga 
set mh 4 
ss 
ip 
end  

reset file name, read in transformed data  

set minimum height to 4 (good first guess) 

set scale, draw intensity plot  
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Phasing can be done after running the macro.   

 

2D Exchange experiments 

This is a hypercomplex experiment in which the 2 halves of the data are scaled 
differently.  See description of noesy processing for detailed description of hypercomplex 
data and how to process it in NUTS. 

After the first dimension FT, the real half of each odd-numbered slice is combined with 
the real half of the following even-numbered slice, but the even numbered slices must 
first be scaled by a factor of -0.3.  Except for this scaling, processing is essentially the 
same as other hypercomplex experiments. 

Because the NUTS Arrayed Mode applies the same processing to all slices, Arrayed 
Mode cannot be used in processing this data. 

The scaling is most simply accomplished by placing the data to be scaled into the 
add/subtract buffer with an appropriate factor, then adding the buffer to the current data.   

To accomplish a scaling factor of -0.3, the multiplier (AM) is set to -1.3, and then the 
buffer is added to the current data ( -1.3 + 1 = -.3 )   This is accomplished in a Link with 
the   al as   commands.  AL loads the buffer, using the value of AM as a multiplier, and 
AS adds the buffer to the data. 

The Link for processing in the first dimension is: 

ga ls ls ls ls bc em ft ps bc tr ia          ga ls ls ls ls bc em ft ps al as bc tr st in 

Each cycle through the Link processes a pair of slices.  Four left shifts (LS) are 
performed before the FT, because this is an echo experiment and data acquisition starts a 
bit before the echo.   

The complete macro is shown here.  Before beginning, open the data, set LB, FT and 
phase the first slice.  At the end of the macro, phasing must be done in the indirect 
dimension.  See phasing 2D data for description. 

NutsMacro 2dexch 
ask filea 
set filec ft1.2d 
set am -1.3 
ga bc ls ls ls ls em ft ps bc tr ia ga bc ls ls ls ls em ft ps al as bc 
tr st in 
 
; reset file names and transpose data 
set filea ft1.2d 
set sl 1 
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ga 
set filec td.2d 
td 
 
; reset file names and process 2nd dimension 
set filea td.2d 
set sl 1 
ga 
set filec ft2.2d 
ga bc em ft sc in 
 
; read in final data set and display stacked plot 
set filea ft2.2d 
set sl 1 
ga 
ss  
sp 
end 

This is illustrated using a 2H spectrum of d6-dimethylsulfone (courtesy of Dr. Detlef 
Reichert, University of Halle, Germany). 
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For this spectrum, the direct dimension was processed using 100 Hz linebroadening and 
zero-order phase correction of 247.5 degrees.   Phase correction in the indirect dimension 
was zero-order =  -45.3 and 1st order = 89.2  

Note the low-intensity, elliptical exchange features.   Dr. Reichert points out that ideally, 
the scaling eliminates the anti-diagonal, but some anti-diagonal remains, due to the 
anisotropy of the relaxation times T1Z and T1Q, preventing complete cancellation of the 
mirror images.   

Reference: J.Magn.Reson, 79, 269-290 (1988) 
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Editing 2D spectra 

The data shown here is a phase-sensitive NOESY spectrum of codeine, displayed with 
the direct dimension horizontal. 

Note the "t1 noise" at the positions of the 2 methyls.   

 

  

The noise causing the streaks exists in only 2 slices per methyl peak.  The offending 
slices can be edited to give a much nicer plot. 
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Because NUTS displays only horizontal slices, first transpose the data (TD) so the slices 
containing streaks can be accessed. 

A stacked plot shows why we see streaks in the contour plot.   The noise level in 2 slices 
is much greater than in the rest of the data.  We don't want to zero out these slices, as they 
contain useful crosspeaks. 
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Use the View routine (VW) to step through slices and the Slice command (SL) to display 
a selected slice.  Editing of selected slices is simpler to do in arrayed mode, because it is 
not necessary to save the data after editing each slice.  (If not in arrayed mode, the S2 
command is used to save after each modification - if you don't save, when you display a 
different slice, your changes will be lost.)  As you look through the data, there may be 
slices with distorted baselines, which can be corrected with FB or QB. 

To remove the streaks, we reduce the amplitude of all points in the 2 offending slices, and 
the noise level becomes more comparable to that of the rest of the data.  This was done 
using the NUTS divide command, reducing the amplitude of all data points in the 2 
selected slices by a factor of 4.  This is sufficient to eliminate the streak from the contour 
plot without affecting the crosspeak. 

 

  

In some cases, a single slice of a 2D data set may be corrupted.  It may be possible to 
salvage the data by removing the offending slice.  This can be done by zeroing all points 
in that slice (with ZE or, more conveniently, the View subcommand Z) or, usually better, 
substituting the adjacent slice for the one that is corrupted.   

Arrayed Mode for 2D processing  

This is included in NUTS Professional version only.    

The entire 2D data set is placed into memory, resulting in much faster 2D processing (a 
factor of ~12 in our tests on Windows, and a factor of ~40 on Macs).  The "normal" way 
of processing 2D data is by looping through a command string, applying the commands 
to each slice in turn.  With the Arrayed Mode, the entire data set is placed into memory, 
and each command operates on the entire 2D data set; i.e., typing FT one time transforms 
the all slices. 
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The amount of available memory needed is ~2.5 times size of the 2D data set being 
processed.  If sufficient memory is not available, NUTS will use virtual memory, which 
is very slow. 

As new 2D processing features are added to NUTS, many function only in the arrayed 
mode. 

See step-by-step processing instructions for different types of 2D data, including sample 
macros. 

Using Arrayed Mode 

The AR command (not yet in menus) is a toggle, and turns on/off arrayed mode.  In a 
macro, you can also use 

Set array_on  
Set array_off 
Set array_pairwisecomplex 

The only indication you will have that Arrayed Mode has successfully been entered is the 
appearance of the words "Complex Arrayed" or "Pairwise Complex Arrayed" on the gray 
status bar.  On exiting the Arrayed Mode, this will change to say "Non-Arrayed". 
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Most commands are "array-aware", meaning that if in arrayed mode, NUTS will apply 
the command to all slices.  However, some commands apply only to the displayed slice.  
It is important to keep track of when NUTS is in the arrayed mode, and understand 
whether a given operation affects the entire data set or a single slice. 

Type AR to enter Arrayed Mode.  Process in the first dimension with commands such as 

GA BC MS FT 

These commands can be typed directly, or can be executed as a Link or a Macro.  Note 
that there is no SC command and no IN command.   

Phasing using any of the phasing commands will display just one slice while phasing, but 
on exiting the phasing subroutine (PE or PH), the correction is applied to all slices. See 
phasing details.  

Next, execute TD to rotate the matrix in preparation for processing in the second 
dimension.  Execute an appropriate series of commands, such as 

MS FT MC 

Typing AR exits Arrayed Mode.  You will be asked if you want to save the data before 
exiting Arrayed Mode, which you should do, or you will lose the processing just 
completed.  

Note that you cannot go back to the previous step, as the data is not saved at each step, as 
is the case when processing in the "regular" mode.  Of course, the original data is 
unchanged, so it is always possible to go back and start over.  If UnDo is turned on, 
typing Ctrl-Z will undo the last command.  However, it is not recommended to use UnDo 
in arrayed mode because of the large amount of memory required. 

After processing the second dimension, you can execute another TD command to view 
the data with the first dimension displayed horizontally. 

** Starting in May, 2002, the Arrayed Mode can be configured for different Processing 
Types, depending on what kind of 2D data is to be processed.  This allows phase-
sensitive data acquired as TPPI,  hypercomplex, echo-antiecho or States-TPPI to be 
processed while maintaining complex data correctly in both dimensions, so that the data 
can be phased in both dimensions after processing. 

In the past, NUTS discarded the imaginary half of the data following FT in the direct 
dimension.  This made it impossible to phase the data in the direct dimension after further 
processing.   Ability to phase the frequency-domain data requires that the imaginary 
half of the data be carried through the entire processing operation, and that the Transpose 
operation correctly sort the data to maintain complex data pairs in each dimension. 
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For hypercomplex, echo-antiecho and States-TPPI data, before entering Arrayed Mode, 
type PT (Processing Type), which displays this dialog box: 

 
 

The important changes involve setting Processing Type to either 2D_HyperComplex or 
2D_EchoAntiecho, for processing the corresponding type of phase-sensitive data.    

2D_HyperComplex is for processing hypercomplex data (method of States, et al). 

2D_EchoAntiecho is for processing gradient data acquired as echo-antiecho (also referred 
to as pn data). 

2D_StatesTPPI functions the same as 2D_HyperComplex. 

By default, 1D is chosen if the data set consists of only 1 slice, or 2D_Magnitude if the 
data contains more than 1 slice.  2D Magnitude is identical to the Arrayed Mode in 
previous versions. 

For 2D_TPPI mode, it is not necessary to set the Processing Type from this screen, 
because additional manipulations are needed.If one of the 3 modes, 2D_HyperComplex, 
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2D_EchoAntiecho or 2D_StatesTPPI, is selected, then when arrayed mode is entered, the 
data is sorted and displayed in "Pairwise Complex" arrayed mode.     

If PT is not set, entering arrayed mode with the AR command will treat the data as 
magnitude data, and phasing after processing will not be possible. 

Previously, the value NUTS displayed for data size in the indirect dimension (number of 
slices) was the total number of slices, not number of complex slices.  Hypercomplex, 
echo-antiecho and States-TPPI data consist of pairs of FIDs (2 FIDs acquired for each t1 
value).  For example, if 128 t1 values were collected, NUTS would display the total 
number of slices as 256 (2 FIDs for each of the 128 values).   In "Pairwise Complex" 
arrayed mode, NUTS reports the data size in the indirect dimension as 128 complex 
points, and would display only 128 points (the first of each pair of FIDs). 

Important: As of Nov, 2002, Nuts will look at the PT value when a file is opened, and 
enter/exit arrayed mode, as appropriate.   

With previous versions, to open a data set that had been saved while in the "Pairwise 
Complex" arrayed mode, you must first re-enter arrayed mode.  This is because of the 
data sorting required to display the data properly.  Similarly, you must exit "Pairwise 
Complex" arrayed mode before importing or opening data that has not been saved from 
within that routine.  Exit AR, open the data set, choose the correct processing type using 
PT, then type AR to enter the correct arrayed mode. 

The details of the data sorting that is performed in Pairwise Complex arrayed mode, and 
some additional commands, can be found here.  

In macros, the Processing Type can be set to any of the values shown in the figure above.  
This must be done in the non-2-letter command mode.  For example,  

2f 
pt 2D_hypercomplex, 
2n,  

The comma at the end of lines while in non-2-letter command mode are interpreted as an 
<ENTER>, and are required. 

Processing instructions (see also: Processing 2D data) 

Hypercomplex data  

Import or open the 2D data file, type TP and select 2D_Hypercomplex.  Click on OK to 
close this box.  Type AR to enter the "Pairwise Complex" arrayed mode.  Apply an 
appropriate window function, FT and phase.  Type TD to transpose the data.  Apply an 
appropriate window function, zerofill if desired, FT and phase.  You can go back and 
forth between the dimensions with TD, and phase in each.   
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Note that the "tr tr st" series of commands is not used in this mode. 

States-TPPI data 

Import or open the 2D data file, type TP and select 2D_StatesTPPI.  Click on OK to 
close this box.  Type AR to enter the "Pairwise Complex" arrayed mode.  Apply an 
appropriate window function, FT and phase.   

Before transposing, it is necessary to invert every other slice.  To do this, type 2f to exit 
the 2-letter command mode, and type invert even <ENTER>.  Then return to 2-letter 
command mode by typing 2n <ENTER>. 

Type TD to transpose the data.  Apply an appropriate window function, zerofill if 
desired, FT and phase.  You can go back and forth between the dimensions with TD, and 
phase in each. 

Note that the "tr tr st" series of commands is not used in this mode. 

Echo-antiecho data 

Import or open the 2D data file, type TP and select 2D_EchoAntiecho.  Click on OK to 
close this box.  Type AR to enter the "Pairwise Complex" arrayed mode.  Apply an 
appropriate window function, FT and phase.   
Type C2 to add and subtract each pair of spectra. 
Type TD to transpose the data.  Apply an appropriate window function, zerofill if 
desired, FT and phase.  You can go back and forth between the dimensions with TD, and 
phase in each.  

TPPI data 

First be sure you are in non-arrayed mode, and open the unprocessed data.  Then type (in 
the non-2-letter command mode): 

ar tppi2pairwise 

This does 2 things.  The pairwise arrayed mode is entered, and zeroes are loaded into the 
"B" half of the data.  The process type is automatically set to "2D_TPPI", and the TD will 
do no swapping of data pairs.    

Be sure to use RT (real transform) in the indirect dimension! 

See also:  

Examples of 2D data processing.  Sample macros are available for 
processing common types of 2D data, with detailed explanation. 
Comparing multiple 2D data sets 
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Phase-sensitive arrayed mode  
(NUTS-Pro only) 

New commands created in association with modified arrayed mode, May 2002 

These are non-2-letter commands that give the user control over data sorting and allow 
viewing of data quadrants not normally displayed.  None of these commands is necessary 
for correct processing of data, but may be useful in some situations. 

Hypercomplex, echo-antiecho and States-TPPI experiments all acquire 2 FIDs for each t1 
value, and hence are referred to here as "pairwise" data.   A new command, array 2 (also 
referred to as "Pairwise Complex Arrayed Mode") was created to work with data so as to 
preserve all data quadrants during processing, which is necessary to allow phasing in both 
dimensions after processing. 

For the purposes of the following descriptions, a notation has been devised.  The first FID 
of each pair is labeled as the A data set, the second is labeled as the B data set.  Each has 
both real and imaginary halves, referred to as A.r, A.i, B.r and B.i.  (The conventional 
notation of RR, IR, RI and II can become confusing when considering operations such as 
the pairwise adding and subtracting done when processing echo-antiecho data, and this 
notation seems easier to follow.) 

When the Processing Type (PT) is set to 2D_Hypercomplex, 2D_EchoAntiecho or 
2D_StatesTPPI, when arrayed mode is entered (AR command), NUTS actually enters the 
array 2 mode.  Data is sorted such that odd-numbered slices become A and even-
numbered slices become B.  Only the real half of the A data set is displayed (A.r). 

Note that this means that, in Pairwise Complex arrayed mode, NUTS counts the data size 
in the indirect dimension (number of FIDs) as complex points, and not as total number of 
slices, as it has previously done.   

The RI command can be used to swap the real and imaginary halves of the data, allowing 
A.i to be displayed.   

AB – Swap quadrants in phase-sensitive arrayed mode 

To view the B half of the data, it must first be swapped with the A half, as only the A half 
can be displayed.  A new command called AB has been created.  AB takes 2 arguments 
which are the labels of the 2 quadrants to be swapped.  The labels are ar, ai, br and bi, 
corresponding to A.r, A.i, B.r and B.i, respectively.    For example, to display the B.r 
data, type 

ab arbr <enter>     (note no space between ar and br) 

It is important to keep track of what you've moved where! 
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The TD command (Transpose Data) can take one of 3 arguments to specify how the 
quadrants are sorted during the transpose.  If the Processing Type has been set correctly, 
the argument is not needed;  TD without any argument will execute the appropriate 
sorting. 

TD hyper - for hypercomplex and States-TPPI data.  This swaps A.i and B.r during the 
transpose. 

TD echo - for echo-antiecho data.  This swaps A.i and B.i during the transpose. 

TD noswap - does no swapping, just transposes each quadrant separately. 

Extension of the new arrayed mode to handle TPPI data was done in Nov, 2002.   

TPPI data is phase-sensitive, but it is not "pairwise" data - only one FID is acquired per t1 
value - so we don't want to split the data into A and B halves.  The FIDs comprise the A 
half of the data, and we want all zeroes in the B half.   Nuts has been modified to do this 
with the command 

ar tppi2pairwise 

This fills out the B half of the data with zeroes, enters the pairwise arrayed mode, and 
sets process type to 2D_TPPI. 

Process as usual (window fcn, FT, phase, BC).  The transpose needs to be done without 
data sorting, which is handled automatically, based on the PT setting. 

Process in the indirect dimension as usual for TPPI data (using Real FT !!).   

2D phasing 

Phasing is done differently depending on whether or not NUTS is in the Arrayed Mode.  
In Arrayed Mode, the entire data set is in memory, and commands are applied to all slices 
simultaneously.  Arrayed Mode is available in NUTS Professional version. 

Arrayed mode 

Manual phasing in the first dimension can be done with either the PH or PE command.  
Autophase can also be used.  This is done while viewing the first slice.  When the phase 
has been adjusted, exiting the phase routine applies that correction to all slices. 

Phasing in the indirect dimension is a bit different, because usually any given slice has 
only one peak of significant intensity, so is not sufficient to determine 2 phase correction 
parameters.  Start by choosing a slice that has a peak with good signal-to-noise near one 
end of the spectrum.   
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(This is most simply done by displaying an intensity plot and viewing slices in real time.  
Hold down left mouse button to display a horizontal cursor, then press the right mouse 
button  simultaneously (or type period key on keyboard) to display slices at the cursor 
position).    

Once a slice is selected, exit the IP routine so that the chosen slice is displayed as a 1D 
spectrum.  *Place the pivot point on the large peak in this slice.*  (See PH for setting 
pivot point).  Now enter PH and phase this peak using only zero-order (left mouse button) 
correction.   Hit <Enter> to exit and apply this zero-order correction to the entire data set. 

Now repeat the slice selection process, this time choosing a slice with a large peak near 
the opposite end of the spectrum.  Enter PH and phase using only first-order (right mouse 
button) correction.   Hit <Enter> to exit and apply this first-order correction to the entire 
data set.  Now the whole data set should be correctly phased. 

"Pairwise" Arrayed mode 

NUTS-Pro versions dated May 2002 and newer allow processing of phase-sensitive data 
such that all quadrants of data are retained, and the data can be phased in both dimensions 
after processing.  This is done as described above for the indirect dimension.  See details 
of the pairwise arrayed mode. 

Non-arrayed mode 

Direct dimension - The first step in processing is to import the data and process the first 
slice, including phase correction.  Then a macro (or link) is run that executes a series of 
commands on each slice, and the PS (phase same) command is used to apply this phase 
correction to all slices.   

To determine phase parameters in the second dimension, we need a spectrum with peaks 
near both ends of the spectrum.  This is usually accomplished by adding together 2 slices 
from opposite ends of the spectrum. To find which slices contain signal, display an 
intensity plot (IP), and view slices in real time (hold down left mouse button to display a 
horizontal cursor, then press the right mouse button simultaneously to display slices). 
Note slice numbers of slices with good signal-to-noise, then exit the IP routine with 
ENTER. Read in the first slice of interest (with SL) and place this slice into the 
Add/Subtract buffer (with AL). Read in the second slice. Enter the Add/Subtract routine 
(AS), add the 2 spectra (with plus sign) and exit the subroutine with ENTER. Now phase 
this spectrum, then note the phasing applied (TP). Enter the values of zero- and first-order 
phasing into the PA and PB parameters. Then execute this Link     ga pc sc in    to apply 
this phase correction.  

Phasing the direct dimension after FT of both dimensions  

Sometimes it is necessary or desirable to adjust phasing of the direct dimension after FT 
of both dimensions.    
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For NUTS-Pro versions older than May 2002, (Nov 2002 for TPPI data) and for NUTS-
2D versions, phasing after processing poses a problem, because NUTS discards the 
imaginary half of the direct dimension spectra after processing.  However, there is a 
procedure to accomplish this.    

Make sure the data is displayed with the direct dimension on the horizontal axis.  Use a 
Hilbert transform (HT) to generate a "FID" that has both real and imaginary parts.  Then 
use FT to recreate a spectrum that has complementary real and complex parts, and can be 
phased in the usual way (as described above). 

Comparing 2D spectra 

Starting in Sept, 2001, NUTS has the ability to display a "mask" of peak positions 
overlaid on a 2D plot. 

This is a "non-2-letter" command and requires NUTS-Pro operating in the arrayed mode. 

The "mask" is created by opening a dataset and picking peaks using the DP subroutine.  
After all peaks are picked, the file is saved.  The peak list is automatically saved in the 
file. 

Then the second file is opened, and 2D mode entered.  Compare is used to display the 
peaks from the first dataset overlaid on the contour plot of the second dataset.  This is 
illustrated below for HMQC and HMBC spectra of codeine.  The HMQC data file was 
opened, peak-picked, and saved.  Then the HMBC file was opened, the contour plot 
displayed, and compare -m X typed.  The previously saved HMQC file was selected, and 
its peaks are indicated with X.  The font is set with FJ. 
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The compare command can take one or more arguments, which are specified in a unix-
like syntax. 

compare   ask for a filename for 2D comparison 
compare <filename>   compare to specified file  
compare -on  or  compare -n   turns on compare display when doing 2D display 
compare -off  or  compare -f    turns off compare display when doing 2D display  
compare -clear   or   compare -c   clears the 2D comparison list 
compare -marker X   or    compare -m X     set marker letter for this file to "X" and ask 
for a filename 
compare -m X <filename>    compare to filename using marker "X"  

If no filenames are given in the command line, a dialog box will be presented to the user 
allowing selection of a filename for the compare operation. This is true regardless of 
whether a -m letter assignment is given. If a -m letter assignment is not given by the user, 
then the first comparison file uses the letter "A", the second comparison file uses letter 
"B" and so on. 

3D Processing 

We have tested this only on a single 3D data set from a Bruker spectrometer.  Users with 
data from other systems are encouraged to supply sample data sets for us to test.   
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Processing of 3D data is done in a new 3D Arrayed Mode.  Many of the commands 
necessary for 3D processing are non-2-letter commands, so the user must enter this mode 
with the 2F command.  In this mode, commands are not executed until <Enter> is typed. 

Because the import routines do not recognize 3D data (yet), the data is imported as 
though it were 2D data.  Thus it is necessary to change parameters to define the number 
of data points in each dimension.  This is done with the new dims command.  Typing just 
dims <enter> will print out the number of data points in each dimension.  To change the 
values, type 

dims i j k l 

where i=number of (complex) points in the first dimension, j=number of (complex) 
points in the second dimension, k=number of (complex) points in the third dimension and 
l=number of (complex) points in the fourth dimension (which for now is 1). 

The total number of points (i x j x j x l) must remain unchanged, or the process will abort. 

Acquisition parameters can be viewed for all 3 dimensions by selecting Spectral 
parameters from the View menu.   

Processing is done in a manner very similar to 2D.  The main difference is that when data 
are transposed for processing and display along a different dimension, it is now necessary 
to specify which dimension will be transposed.  A general procedure is described below, 
and specific steps for one particular data set are described here. 

Processing normally begins by opening the data file and examining the first slice, setting 
parameters for window functions, doing FT and phasing.  Then the 3D arrayed mode can 
be entered.  To do this, first execute 2F to change to non-2-letter command mode, then 
type  

AR 3D <enter> 

This will load the entire 3D data set, so will take several seconds.  Now, each command 
will be executed on the entire data set, not just a single slice.  For example, 

MS 
FT 
PS 

will apply sine apodization, FT and phase with previously determined phase correction.  
The appropriate steps needed will depend on the particular experiment, as it does with 
2D. 
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Next, we need to transpose the data to process in the second dimension.  The TD 
command now requires an argument to specify which of the other 2 dimensions will be 
transposed with the current dimension.  So 

TD 2 

will display interferograms along the second dimension, and processing proceeds in 
essentially the same manner as 2D data. 

As the different dimensions are transposed, it is necessary to keep track of which is 
which.  View/Spectral Parameters will display 3 columns of parameters, one for each 
dimension.  The user can change the label for each to something more meaningful.  The 
first (left-hand) column always corresponds to the currently "active" dimension, whose 
points are displayed from left to right.  The second (middle) column is dimension 2, 
which are the different slices.  A contour plot or stacked plot will display dimension 1 
horizontally and dimension 2 vertically on the screen.  The third column of parameters is 
for dimension 3, which can be visualized as a stack of 2D planes.   

At the moment, Nuts has no way to display the third dimension.  Instead, a particular 
plane is chosen and a 2D plot (contour or stacked plot) of dimensions 1 and 2 is 
displayed.  While in the contour or stacked plot display mode, the sequence of planes can 
be stepped through using the [ and ] commands, which (like all commands in 
subroutines) are executed immediately, not requiring <enter>.   A particular plane can 
also be specified with the plane command, for example: 

plane 7 

Another new command is acqorder, which has a syntax similar to the dims command, 
allows the user to rearrange the order of the different dimensions. 

SUM -- Sum planes 

The sum command can be used for summing of planes in a 3D data set in a manner 
analogous to summing slices of 2D data. When the second argument of the "sum" 
command is "planes", all planes of a 3D data set are summed into a single 2D data set. 
The command also takes additional optional arguments allowing the user to specify the 
starting and ending planes to sum. The original 3D data set is destroyed and replaced by a 
new 3D data set which has only one plane. The command must be used in the 3D arrayed 
mode.  

sum planes <start> <end> 

Example of 3D processing (ubiquitin) 

The sample was 13C,15N-ubiquitin run on a Bruker 600.  (Data kindly supplied by DuPont 
Pharmaceuticals.)  The experiment was 3D CBCA(CO)NH. 



432 

The data set is 1H-detected (512 complex points), with 13C in the second dimension (110 
total slices, hypercomplex) and 15N in the third dimension (96 total slices, hypercomplex) 
for a total size of 43 MBytes.  It was acquired with digital filtering, so needs to be 
processed with RD.  There is also a residual water signal which needs to be removed to 
avoid some truncation artifacts, so we use a digital high-pass filter (DH).  An illustration 
of the truncation artifacts is shown below. 

See macro for complete processing with a single command, but this can also be done 
from the keyboard, as described below. 

  Using a macro, processing took 42 seconds on a Pentium II/400, including RD and 
DH operations.  

The data was imported with IM, which finishes by displaying the first slice.   

 

  

Processing parameters are determined by processing the first slice.  The parameters used 
were cosine multiplication (set S# to 90, them MS), RD to correct for artifacts of the 
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digital filter, DH (filter width of 250 Hz) to remove the residual water signal, FT and 
phase.  It is important to examine the FIDs and tailor processing to avoid artifacts such as 
truncation.  (See example below.) 

 

  

The data was nominally a 2D data set, with 512 complex points and 10,560 slices (110 x 
96) in a Bruker ser file.  Nuts imported this as a 2D file, so the dimension sizes must be 
set correctly.  To do this, enter non-2-letter command mode by typing 2F, and then use 
the dims command. 

dims <enter> 

will print out the number of points in each dimension, which for this data set is 

dims - Points 1D = 512  2D = 10560  3D = 1  4D = 1 

To set these correctly, use dims and enter the 4 values, all on one line, separated by 
spaces: 
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dims 512 110 96 1 

Once a value greater than 1 is entered for dimension 3, the View/Spectral Parameters 
menu will display parameters for all 3 dimensions: 

 

Note that the 3rd dimension did not contain correct values for SF and SW.  This is 
because the raw data did not include any 3D parameters.  The correct values were entered 
using this screen. 

We are now ready to process.  The first step is to enter "3D arrayed mode", by typing 

ar 3d <enter> 

The following series of commands is executed.  While not specified, each command is 
terminated by <enter>.  See Nuts Help for explanation of each command.  (Remember 
that the data is hypercomplex in both indirect dimensions.) 

ms 
rd 
dh 
ft 
ps 
tr 
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tr 
st 

Now we are done with the proton dimension, and need to transpose the data to process 
the carbon dimension.  Because we will need to "build" complex interferograms in the 
nitrogen dimension (using tr tr st commands), we need the carbon dimension to be 
dimension 1 and the nitrogen dimension to be dimension 2.  This is accomplished by 2 
successive TD commands.  The TD command, when working with 3D data, takes an 
argument to specify which dimension will be transposed with the current dimension 1. 

td 3 

This puts the proton as dimension 3 and nitrogen as dimension 1. 

td 2 

This puts the carbon as dimension 1 and nitrogen as dimension 2.  Now process with 

ms 
ft 
tr 
tr 
st 

This data was collected to require no phasing in the carbon and nitrogen dimensions.  We 
have constructed our complex interferograms in the nitrogen dimension, so we transpose 
to process the nitrogen dimension. 

td 2 

And process with 

ms 
ft 

And a final TD to put the nitrogen back to dimension 3 and display protons as dimension 
1: 

td 3 

Now we are ready to view the data.  IP will display the intensity plot, and the commands 

plane + 
plane - 
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will step through 15N planes.  The number of the currently displayed plane is shown in 
the upper left corner of the screen.   

 

  

The zoom subroutine works just as for 2D data to expand the display.   
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Exit from the IP routine and use SP to view stacked plots.  The ] and [ keys will step 
through planes.   
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Truncation problems 

This 3D data set has only 512 complex points in the direct (1H) dimension, and the data is 
digitally filtered, so the first ~70 points are zero.  It is a good idea to step through the 
slices (with VW) and examine the data before beginning processing.  This allows 
experimentation with processing parameters to determine which will give the best results. 

Here is a slice from the 3D data 
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The FID does not approach zero at the end of the acquisition time due to the large, low-
frequency water signal. 
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Following the RD operation, we have a large discontinuity. 
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After FT, this gives large "wiggles". 

Here is the same slice, processed with cosine multiplication before RD, and then DH. 
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3D processing macro 
nutsmacro 3D processing 
; Bruker data from DuPont Pharmaceuticals 
; data is States-type hypercomplex in both indirect dimensions 
; macro uses long command mode 
; data size is 512 x 55 x 48 (complex) (43 MByte file) 
; with RD, DH and phasing in proton dimension 
; total time, after data loaded into 3D mode, 42 sec (PII-400) 
; without RD and DH, total time 18 sec 
 
; before starting, open file, MS (S#=90) RD, DH (to set parameters) 
; FT 1st slice and determing phasing 
 
; note that spaces are *not ignored* in non-2-letter command mode! 
 
2f, 
ga, 
set s# 90 
 
; enter 3D arrayed mode 
ar 3d, 
 
; cosine mult, RD (this is Bruker digitally filtered data) and 
; digital high-pass filter (this has residual water peak) 
ms, 
rd, 
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dh, 
 
; ft and phase, then combine Real parts to form complex FT in 
; second dimension (see Help on States) 
ft, 
ps, 
tr,tr,st, 
 
; transpose data to exchange 1st and 3rd dimensions 
td 3, 
 
; transpose data to exchange 2nd and 3rd dimensions, so 
; we are ready to process 2nd dimension, similar to 1st 
td 2, 
ms, 
ft, 
tr,tr,st, 
 
; transpose 2nd and 3rd dimensions so we can FT in 3rd dimension 
td 2, 
ms, 
ft, 
 
; transpose again so direct dimension is displayed horizontally 
td 3, 
ss, 
ip, 
 
end 
 

 

  

4D Processing 

A new arrayed mode and associated data structure was added. The new mode is 4D 
Complex Arrayed mode which packs the data into a 4 dimension data matrix.  

It has its own ProcessType (PT) similar to the Generic 3D called Generic 4D. Once this 
mode has been set with the PT command, the AR command will automatically enter this 
mode when issued without arguments. The AR command with the argument "4" or "4D" 
will force the arrayed mode to start in the 4D Complex Arrayed mode.  

The FT and EM commands are now "array aware" of the 4D mode and the Acquisition 
Parameters Dialog box (available from the View menu) will display the parameters for all 
dimensions when there is a point count greater than 1 in the 4th dimension. 

Truman Brown has supplied some CSI spectroscopy data which is a 4D data set (512 
complex by 8 by 8 by 8) and an import filter for this data has been written and depends 
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on the presence of two files: NAME.ddf and NAME.raw. The DDF file has the 
parameters in a specific format and the RAW file is the data points as 2 byte integers in 
big endian format. 

This is a first pass at displaying 4D CSI data.  The tools developed for displaying chosen 
planes and slices of 3D data work similarly in the 4D mode.   

Image display 
MR or MRI – Image display 

IMAGE – Image display 

An import filter for images supplied by Truman Brown was added to the import function 
of NUTS, and a new routine to display these images was added.  

The command has several optional arguments: 

1. IMAGE (Actualsize or A) displays the image using the same number of pixels on the 
screen as the image has. Otherwise the image is scaled within NUTS. 

2. IMAGE (NegativeImage or Negative or N) toggles the display of the negative of the 
image. Another argument is allowed which can be ON or OFF which allows setting this 
feature in an absolute manner. 

3. IMAGE (SquareImage or Square or S) toggles the forcing of the image to be square; 
otherwise the image is scaled within NUTS. By default NUTS starts in the square image 
display mode. 
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Technical Support 

Acorn NMR’s technical support service is available to NUTS users free during the 90 
days warranty period after initial purchase and by an annual subscription thereafter, for 
15% of current purchase price. 

Technical support is available by phone from Acorn NMR during normal business hours 
(9:00 AM to 5:00 PM Monday through Friday except holidays). The preferred method of 
technical support is by email.  

Telephone support is available at: 

(925) 456-1020 
(925) 456-1024 FAX 

Email support is available from support@acornnmr.com 

Notice of New Features 

The main Help page, www.acornnmr.com/NutsHelp, lists new features.  

Upgrades 

Users with active technical support service from Acorn NMR (90 warranty period or by 
subscription thereafter) can download a new copy of Nuts as often as desired. As long as 
the compile date of the Nuts version falls within the support date of the user’s license, the 
Nuts version will be fully functional. If the user’s support period has expired, the new 
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version will function as a "demo" copy, although the older version will continue to work 
forever. 

Acorn NMR Inc. 
7670 Las Positas Rd  
Livermore, CA 94551 

Appendix - License and support policy and disclaimer 

NUTS is a software program for NMR data processing under Microsoft Windows.  

The software is supplied with 90 days of telephone and e-mail support. The user receives 
a license "key" which contains encrypted information about the licensee and support 
status.  At any time during the support period, the user may download a new copy of 
NUTS from the ftp or WWW site and the license "key" will convert it to a licensed and 
personalized copy.  If the license has expired, the new copy will operate only as a demo, 
but earlier copies of NUTS will still function.  Support can be extended for 15% of the 
purchase price per year, including discounted copies.   

After 90 days, a 1-year support contract is 15% of current list price for the combined 
NUTS package owned. This entitles the user to download updated copies of the program 
at any time. 

Users who choose not to purchase support can use their original copy of Nuts forever. 

Obtaining an updated copy of Nuts, for users who are under support, simply consists of 
downloading a new copy from the web or ftp site, which is converted into a fully 
functional, personally licensed copy when combined with a license "key" file. A new 
copy may be downloaded at any time, and becomes a full copy, provided the support 
period has not expired. 

The Licensee, assumes all responsibility for the selection of the program to achieve 
his/her intended results, and for the installation, use, and results obtained from the 
program. If the Licensee copies or modifies the program in whole or part except as 
expressly provide for in this license, the license is automatically terminated. 

SINGLE-USER LICENSE:  

The Licensee may: 
Use the program on a single machine and copy the program into any  machine-readable 
or printed form for backup or support of your use of the  program on the single machine.  

 The user is also authorized to have the supplied program exist on as many different 
computer systems as desired as long as only one licensed copy of   the program is ever 
used at one time. If it is possible to have more than one   copy of the supplied program in 
use at a time, additional copies of the   program should be purchased. 
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Modify the program and/or merge it into another program for your use on the  single 
machine. Any portion of the program merged into another program will  continue to be 
subject to the terms of this Agreement. You must reproduce    and include the copyright 
notice on any copy, modification, or portion merged   into another program. 

  Transfer the program and license to another party if the other party agrees   to accept the 
terms and conditions of this Agreement. If you transfer the   program, you must at the 
same time either transfer all copies, whether in   machine readable or printed form, to the 
same party or destroy any copies  not transferred; this includes all modifications and 
portions of the  program merged into other programs. 

DEPARTMENTAL (LOCAL) SITE LICENSE: 

The Licensee may: 
Distribute copies of the license "key" to any member of the department to which the 
software is licensed.   The software is licensed to the organization, not the individual.  All 
copies must remain with the organization, and cannot be transferred if an individual 
moves to a new location or organization. 

All other terms apply as for single-user licenses. 

CORPORATE-WIDE LICENSE: 

The Licensee may: 
Distribute copies of the license "key" to any member/employee of the company or 
organization to which the software is licensed, regardless of location.  The software is 
licensed to the organization, not the individual.  All copies must remain with the 
organization, and cannot be transferred if an individual moves to a new organization. 

All other terms apply as for single-user licenses. 

TERM 
The license is effective on the date you accept this agreement, and remains in effect until 
terminated as indicated above or until you terminate it. If the license is terminated for any 
reason, you agree to destroy the program together with all copies, modifications, and 
merged portions in any form. 

WARRANTY DISCLAIMER 
The program is is provided "as is" without warranty of any kind, either expressed or 
implied, including, but not limited to the implied warranties of merchantability and 
fitness for a particular purpose. the entire risk as to the quality and performance of the 
program is with you. should the program prove defective, you (and not Acorn NMR or its 
dealers) assume the entire cost for all necessary repair or correction. 



448 

Some states do not allow the exclusions of implied warranties, so the above exclusion 
may not apply to you. This warranty gives you specific legal rights and you may also 
have other rights which vary from state to state. 

Acorn NMR does not warrant that the functions contained in the program will meet your 
requirements or that the operation of the program will be uninterrupted or error free.  

LIMITATION OF REMEDIES 
In the event that the computer media on which the program is provided is defective in 
materials or workmanship, your exclusive remedy is limited to its replacement, or a 
refund of the purchase price therefore, by Acorn NMR in accordance with its applicable 
product return and replacement policies. 

In no event will Acorn NMR or its dealers be Liable to you for any damages, including 
lost profits, lost savings, or other incidental or consequential damages arising from the 
use or inability to use the program (whether or not due to any defects therein) even if 
Acorn NMR or its dealers have been advised of the possibility of such damages, or for 
any claim by any other party.  (Some states do not allow the limitation or exclusion of 
liability for consequential damages so the above limitation may not apply to you.) 

GENERAL TERMS 
This Agreement can only be modified by a written agreement signed by you and Acorn 
NMR, and changes from the terms and conditions of this Agreement made in any other 
manner will be of no effect. If any portion of this Agreement shall be held invalid, illegal, 
or unenforceable, the validity, legality, and enforceability of the remainder of the 
Agreement shall not in any way be affected or impaired thereby. This Agreement shall be 
governed by the laws of the State of California. 

ACKNOWLEDGMENT 
Your use of the program acknowledges that you have read this agreement, understand it, 
and agree to be bound by its terms and conditions. You further agree that it is the 
complete and exclusive statement of the agreement between you and Acorn NMR which 
supersedes all proposals or prior agreements, oral or written, and all other 
communications between you and Acorn NMR relating to the subject matter of this 
agreement. 

 


